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User Registration Request
Thank you for purchasing YOKOGAWA products.

Please register to the following Partner Portal Member Site.
You can use various services such as confirmation of purchased product information, 
download of related materials, and newsletter.

 https://partner.yokogawa.com/global/
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Introduction
This manual explains how to use Data Logging Software 
GA10 (hereafter referred to as GA10). To ensure correct 
use, please read this manual thoroughly before beginning 
operation.
For details on the functions related to SMARTDAC+ series 
options, see also the manual for the options.
Downloading Manuals
You can download the latest user’s manuals from the fol-
lowing URL:
 www.smartdacplus.com/manual/en/
•	 Electronic Manuals (this manual, and related 

manuals)
Manual Title Manual No.
Model GA10/GA10CL/GA10UP
Data Logging Software User’s Manual (this manual)

IM 04L65B01-01EN

SMARTDAC+STANDARD 
Universal Viewer User’s Manual

IM 04L61B01-01EN

•	 Paper Manuals (manuals supplied with the 
product)

Manual Title Manual No.
GA10 Data Logging Software 
Downloading the Latest Software and Manuals IM 04L65B01-02Z2

Updating the Software
Download the latest version of the software from the fol-
lowing URL:
 www.smartdacplus.com/software/en/
Notes
•	 The contents of this manual are subject to change without 

prior notice as a result of continuing improvements to the 
software’s performance and functions.

•	 Every effort has been made in the preparation of this 
manual to ensure the accuracy of its contents. However, 
should you have any questions or find any errors, 
please contact your nearest YOKOGAWA dealer.

•	 Copying or reproducing all or any part of the contents 
of this manual without YOKOGAWA’s permission is 
strictly prohibited.

QR
The product has a QR Code pasted for efficient plant 
maintenance work and asset information management.
It enables confirming the specifications of purchased 
products and user’s manuals.
For more details, please refer to the following URL.
https://www.yokogawa.com/qr-code

QR Code is a registered trademark of DENSO WAVE 
INCORPORATED.

 

Trademarks
•	 SMARTDAC+ is registered trademarks or trademarks 

of Yokogawa Electric Corporation.
•	 Microsoft and Windows are registered trademarks 

or trademarks of Microsoft Corporation in the United 
States and/or other countries.

•	 Modbus is a registered trademark of AEG Schneider.
•	 Adobe and Acrobat are registered trademarks or 

trademarks of Adobe Systems Incorporated.
•	 Intel Core is a trademark of Intel Corporation in the 

United States and/or other countries.
•	 Kerberos is a trademark of Massachusetts Institute of 

Technology (MIT).
•	 Company and product names that appear in this 

manual are registered trademarks or trademarks of 
their respective holders.

•	 The company and product names used in this manual 
are not accompanied by the registered trademark or 
trademark symbols (® and ™).

14th Edition:  May, 2020 (YK)
All Right Reserved, Copyright  © 2014, Yokogawa Electric Corporation

http:www.smartdacplus.com/manual/en/
http://www.smartdacplus.com/software/en/
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How to Use This Manual
Structure of the Manual
This manual contains the following chapters.
Chap. Title Description

1 Before Using the Product

Provides an overview of Data Logging 
Software GA10. It also explains the 
main specifications of the software 
and the PC system requirements.

2 Preparing to Collect and Record Data
Provides a flowchart and the 
procedure to prepare the software for 
data collection and recording.

3 Configuring and Starting Data 
Collection and Recording

Explains two configuration modes 
for data collection and recording with 
GA10: Simple Settings and Detail 
Settings.

4 Using the Math Function (/MT option) Explains the GA10’s math function  
(/MT option).

5 Using the Report/Print Function 
(/RP option)

Explains the GA10’s report/print 
function (/RP option).

6 Monitoring Data Collection Explains how to use the Monitor Page 
to monitor data collection.

7 Using the Custom Display Function  
(/CG option)

Explains the GA10’s custom display 
function (/CG option).

8 Managing Recording Data
Explains how to edit recording data 
files from a list and how to display 
recording data files on a viewer.

9 Managing Users

Explains how to register, delete, and 
edit information of users that will 
perform data collection and recording 
with GA10.

10 OPC-UA Server Function (/UA option) Explains the OPC-UA server function 
(/UA option).

11 Modbus Server Function Explains the Modbus server function 

12 Integration Display Function (/WH 
option)

Explains the Integration display 
function (/WH option)

13 GateSushi Function (/SU option) Explains the GateSushi function (/
SU option)

14 Troubleshooting

Provides messages that GA10 may 
display and how to deal with them as 
well as answers to frequently asked 
questions.

-- Appendix Provides examples on how to create 
templates and definitions of keywords.

Scope of This Manual
This manual does not explain the operations of your PC’s 
operating system. For this information, read the Windows 
user’s guide or related materials.

Conventions Used in This Manual
Notes

Important Identifies important information required to 
understand operations or functions.

Note Calls attention to information that is important for 
the proper operation of GA10.

Reference Item
Reference to related operation or explanation is 
indicated after this mark.
Example:  section 4.1

Conventions Used in the Procedural Explanations
Bold characters Indicates character strings that appear on the 

screen. Example: Voltage

Images
The images used in this manual may differ from those that 
actually appear in the software. Such differences do not 
affect the procedural explanation.

Version and Functions Described in This Manual
Ed. Product Addition and Change

1 Ver. 1.01.xx —
2 Ver. 1.02.xx Modified to support GX/GP R2. Expansion to Modbus Device 

Definition Files (UTA advanced series), other improvements, 
changes to display and system requirements.

3 Ver. 2.01.xx Modified to support GM10. Modified to include mail function 
enhancements, language switching, and the following options. 
Report/Print function (/RP), OPC-UA server function (/UA), and 
Math function (/MT)

4 Ver. 2.02.xx Modified for functional improvements (retention of settings 
when connected devices are added, warning display when 
communication is disconnected, etc.)

5 Ver. 2.02.02 Modified for functional improvements (fixed report printing 
problems on some printers and the like), improvements to 
descriptions.

6 Ver. 2.03.xx Modified to support GX/GP/GM R3.
Added descriptions for project setting display and print functions. 
Added descriptions for starting multiple client screens and DDE 
server’s Visual Basic 6.0 support. Modification to the operating 
environment.

7 Ver. 2.04.xx Addition of new functions (common alarm ACK setting, sharing 
of the temporary suspension of warning beeps, etc.) and 
improvements to the report/print function (/RP option). Modified to 
support GX/GP/GM R3.02.01 (AO module).

8 Ver.3.01.xx Added descriptions for the custom display function (/CG option).
Modified to support connections with the WT3000/WT3000E. 
Expansion to the number of channels of the math function (/MT 
option). Added descriptions for manual save and other functions. 
Improved screens. Improvements to descriptions.

9 Ver. 3.02.xx Modified to support GX/GP/GM R4.
Added descriptions for functional improvements such as Alarm 
foreground window and Operation dialog boxes (/CG). Improved 
screens. Improvements to descriptions.

10 Ver. 3.03.xx New functions were added such as different alarm sounds, 
individual alarm ACK, clearing of alarm log, storing of viewer 
display condition files in the GA10 server folder, linked viewer 
display of data via a GA10 client, and test mail transmission.

11 Ver. 3.04.xx Added descriptions for the improvement (font size, grid, zone, 
legend position, etc.) to the waveform printing of the report/print 
function, the improvement to the deletion of entries from the 
Register Device list, and the improvement to the manual save 
operation.

12 Ver. 3.05.xx Addition of the Modbus server function, improvements to the 
difference between the GA10 server time and data time, statistics 
on the trend monitor, GA10 server port change function, support 
for the formula ABS, alarm information export selection function 
for EXCEL format recording files, support for 16-character 
channel names in Modbus device definition files, performance 
improvements in displaying large operation logs on Universal 
Viewer, show/hide function for the parameters shown in the 
statistics dialog box on Universal Viewer.

13 Ver. 3.06.xx Addition of the Integration display function (/WH).
Addition of a function for saving data during recording, addition of 
email SSL/TSL support, addition of a register for project’s alarm 
ACK information in the Modbus server, addition of an FTP client 
function. 
Improvements to other functions and descriptions.

14 Ver. 3.07 Addition of the GateSushi function (/SU).
Addition of the AI function (Anomaly detection).
Addition of the group highlight function and popup function for 
alarm display.
Improvements to other functions and descriptions.

Revisions
1st Edition February, 2014
2nd Edition June, 2014
3th Edition January, 2015
4th Edition April, 2015
5th Edition June, 2015
6th Edition December, 2015
7th Edition April, 2016
8th Edition November, 2016
9th Edition June, 2017
10th Edition December, 2017
11th Edition March, 2018
12th Edition June, 2018
13th Edition December, 2019
14th Edition May, 2020
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Software License Agreement

IMPORTANT - PLEASE READ CAREFULLY BEFORE INSTALLING OR USING:
THANK YOU VERY MUCH FOR SELECTING SOFTWARE OF YOKOGAWA ELECTRIC CORPORATION (“YOKOGAWA”). BY INSTALLING OR OTHERWISE USING THE 
SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE, DO NOT INSTALL NOR USE 
THE SOFTWARE PRODUCT AND PROMPTLY RETURN IT TO THE PLACE OF PURCHASE FOR A REFUND, IF APPLICABLE. 

1. Scope
 This Agreement applies to the following software products and associated documentation of Yokogawa (collectively, “Software Product”). Unless otherwise provided by 

Yokogawa, this Agreement applies to the updates and upgrades of the Software Product which may be provided by Yokogawa.
 Software Product: SMARTDAC+ Data Logging Software (Model GA10)

2. Grant of License
2.1 Subject to the terms and conditions of this Agreement, Yokogawa hereby grants to you a non-exclusive and non-transferable right to use the Software Product on a single or, 

the	following	specified	number	of,	computer(s)	and	solely	for	your	internal	operation	use,	in	consideration	of	full	payment	by	you	to	Yokogawa	of	the	license	fee	separately	
agreed upon.

 Granted number of License: the number of purchases
2.2 Unless otherwise agreed or provided by Yokogawa in writing, the following acts are prohibited:

a) to reproduce the Software Product, exce pt for one archival copy for backup purpose, which shall be maintained with due care subject to this Agreement;
b) to sell, lease, distribute, transfer, pledge, sublicense, make available via the network or otherwise convey the Software Product or the license granted herein to any other 

person or entity;
c) to use the Software Product on any unauthorized computer via the network;
d) to cause, permit or attempt to dump, disassemble, decompile, reverse-engineer, or otherwise translate or reproduce the Software Product into source code or other human 

readable format, or to revise or translate the Software Product into other language and change it to other formats than that in which Yokogawa provided;
e) to cause, permit or attempt to remove any copy protection used or provided in the Software Product; or
f)	 to	remove	any	copyright	notice,	trademark	notice,	logo	or	other	proprietary	notices	or	identification	shown	in	the	Software	Product.

2.3 Any and all technology, algorithms, know-how and process contained in the Software Product are the property or trade secret of Yokogawa or licensors to Yokogawa. 
Ownership of and all the rights in the Software Product shall be retained by Yokogawa or the licensors and none of the rights will be transferred to you hereunder. 

2.4	 You	agree	to	maintain	the	aforementioned	property	and	trade	secret	of	Yokogawa	or	licensors	and	key	codes	in	strict	confidence,	not	to	disclose	it	to	any	party	other	than	your	
employees,	officers,	directors	or	similar	staff	who	have	a	legitimate	need	to	know	to	use	the	Software	Product	and	agreed	in	writing	to	abide	by	the	obligations	hereunder.

2.5 Upon  expiration or termination of this Agreement, the Software Product and its copies, including extracts, shall be returned to Yokogawa and any copies retained in your 
computer or media shall be deleted irretrievably. If you dispose of media in which the  Software Product or its copy is stored, the contents shall be irretrievably deleted.

2.6	 The	Software	Product	may	contain	software	which	Yokogawa	is	granted	a	right	to	sublicense	or	distribute	by	third	party	suppliers,	including	affiliates	of	Yokogawa	(“Third	
Party	Software”).	If	suppliers	of	the	Third	Party	Software	(“Supplier”)	provide	special	terms	and	conditions	for	the	Third	Party	Software	which	differ	from	this	Agreement,	the	
special terms and conditions separately provided by Yokogawa shall prevail over this Agreement. Some software may be licensed to you directly by Supplier. 

2.7 The Software Product may contain open source software (“OSS”), for which the special terms and conditions separately provided by Yokogawa shall take precedence over 
this Agreement.

3. Restrictions on Application
3.1 Unless otherwise agreed in writing between you and Yokogawa, the Software Product is not intended, designed, produced or licensed for use in relation to aircraft operation 

or control, ship navigation or marine equipment control, or ground facility or device for support of the aforesaid operation or control, or for use in relation to rail facility, nuclear 
related facility, radiation-related equipment, or medical equipment or facility, or under any other circumstances which may require high safety standards.

3.2 If the Software Product is used for the abovementioned purposes, neither Yokogawa nor Supplier assumes liability for any claim or damage arising from the said use and 
you	shall	indemnify	and	hold	Yokogawa,	Supplier,	their	affiliates,	subcontractors,	officers,	directors,	employees	and	agents	harmless	from	any	liability	or	damage	whatsoever,	
including any court costs and attorney’s fees, arising out of or related to the said use.

4. Limited Warranty
4.1 The Software Product shall be provided to you on an “as is” basis at the time of delivery and except for physical damage to the recording medium containing the Software 

Product, Yokogawa and Supplier shall disclaim all of the warranties whatsoever, express or implied, and all liabilities therefrom.  If any physical defect is found on the recording 
medium not later than twelve (12) months from delivery, Yokogawa shall replace such defective medium free of charge, provided that the defective medium shall be returned to 
the	service	office	designated	by	Yokogawa	at	your	expense	within	the	said	twelve	(12)	months.		THIS	LIMITED	WARRANTY	PROVIDED	IN	THIS	CLAUSE	IS	IN	LIEU	OF	ALL	
OTHER WARRANTIES OF ANY KIND WHATSOEVER AND YOKOGAWA HEREBY DISCLAIMS ALL OTHER WARRANTIES RELATING TO THE SOFTWARE PRODUCT, 
WHETHER EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR 
PURPOSE, NON-INFRINGEMENT, QUALITY, FUNCTIONALITY, APPROPRIATENESS, ACCURACY, RELIABILITY AND RECENCY.  IN NO EVENT SHALL YOKOGAWA 
WARRANT THAT THERE IS NO INCONSISTENCY OR INTERFERENCE BETWEEN THE SOFTWARE PRODUCT AND OTHER SOFTWARE NOR SHALL BE LIABLE 
THEREFOR. The warranty provisions of the applicable law are expressly excluded to the extent permitted.

4.2 At the sole discretion of Yokogawa, Yokogawa may upgrade the Software Product to the new version number (“Upgrade”) and make it available to you at your expense or 
free	of	charge	as	Yokogawa	deems	fit.		In	no	event	shall	Yokogawa	be	obliged	to	upgrade	the	Software	Product	or	make	the	Upgrade	available	to	you.

4.3 Certain maintenance service may be available for some types of Software Product at Yokogawa’s current list price. Scope and terms and conditions of the maintenance 
service	shall	be	subject	to	those	separately	provided	by	Yokogawa.	Unless	otherwise	provided	in	Yokogawa	catalogues	or	General	Specifications,	maintenance	services	
will be available only for the latest version and the immediately preceding version. In no event will service for the immediately preceding version be available for more than 5 
years after the latest version has been released. In addition, no service will be provided by Yokogawa for the Software Product which has been discontinued for more than 5 
years. Notwithstanding the foregoing, maintenance service may not be available for non-standard Software Product. Further, in no event shall Yokogawa provide any service 
for	the	Software	Product	which	has	been	modified	or	changed	by	any	person	other	than	Yokogawa.

5. Infringement
5.1 If you are warned or receive a claim by a third party that the Software Product in its original form infringes any third party’s patent (which is issued at the time of delivery of 

the Software Product), trade mark, copyright or other intellectual property rights (“Claim”), you shall promptly notify Yokogawa thereof in writing.
5.2	 If	the	infringement	is	attributable	to	Yokogawa,	Yokogawa	will	defend	you	from	the	Claim	at	Yokogawa’s	expense	and	indemnify	you	from	the	damages	finally	granted	by	the	

court or otherwise agreed by Yokogawa out of court. The foregoing obligation and indemnity of Yokogawa shall be subject to that i) you promptly notify Yokogawa of the Claim 
in writing as provided above, ii) you grant to Yokogawa and its designees the full authority to control the defense and settlement of such Claim and iii) you give every and all 
necessary information and assistance to Yokogawa upon Yokogawa’s request.
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5.3 If Yokogawa believes that a Claim may be made or threatened, Yokogawa may, at its option and its expense, either a) procure for you the right to continue using the Software 
Product, b) replace the Software Product with other software product to prevent infringement, c) modify the Software Product, in whole or in part, so that it become non-
infringing, or d) if Yokogawa believes that a) through c) are not practicable, terminate this Agreement and refund you the paid-up amount of the book value of the Software 
Product as depreciated.

5.4 Notwithstanding the foregoing, Yokogawa shall have no obligation nor liability for, and you shall defend and indemnify Yokogawa and its suppliers from, the Claim, if the 
infringement	is	arising	from	a)	modification	of	the	Software	Product	made	by	a	person	other	than	Yokogawa,	b)	combination	of	the	Software	Product	with	hardware	or	software	
not furnished by Yokogawa, c) design or instruction provided by or on behalf of you, d) not complying with Yokogawa’s suggestion, or e) any other causes not attributable to 
Yokogawa.

5.5 This section states the entire liability of Yokogawa and its suppliers and the sole remedy of you with respect to any claim of infringement of a third party’s intellectual property 
rights. Notwithstanding anything to the contrary stated herein, with respect to the claims arising from or related to the Third Party Software or OSS, the special terms and 
conditions separately provided for such Third Party Software or OSS shall prevail.

6. Limitation of Liability
6.1 EXCEPT TO THE EXTENT THAT LIABILITY MAY NOT LAWFULLY BE EXCLUDED IN CONTRACT, YOKOGAWA AND SUPPLIERS SHALL NOT BE LIABLE TO ANY 

PERSON OR LEGAL ENTITY FOR LOSS OR DAMAGE, WHETHER DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES, 
OR OTHER SIMILAR DAMAGES OF ANY KIND, INCLUDING WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OR DESTRUCTION OF DATA, LOSS OF AVAILABILITY AND THE LIKE, ARISING OUT OF THE USE OR INABILITY TO USE OF THE SOFTWARE PRODUCT, OR 
ARISING OUT OF ITS GENERATED APPLICATIONS OR DATA, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, WHETHER BASED IN WARRANTY 
(EXPRESS OR IMPLIED), CONTRACT, STRICT LIABILITY, TORT (INCLUDING NEGLIGENCE), OR ANY OTHER LEGAL OR EQUITABLE GROUNDS.  IN NO EVENT 
YOKOGAWA AND SUPPLIER’S AGGREGATE LIABILITY FOR ANY CAUSE OF ACTION WHATSOEVER (INCLUDING LIABILITY UNDER CLAUSE 5) SHALL EXCEED 
THE DEPRECIATED VALUE OF THE LICENSE FEE PAID TO YOKOGAWA FOR THE USE OF THE CONCERNED PART OF THE SOFTWARE PRODUCT. If the Software 
Product	delivered	by	Yokogawa	 is	altered,	modified	or	combined	with	other	software	or	 is	otherwise	made	different	 from	Yokogawa	catalogues,	General	Specifications,	
basic	specifications,	functional	specifications	or	manuals	without	Yokogawa’s	prior	written	consent,	Yokogawa	shall	be	exempted	from	its	obligations	and	liabilities	under	this	
Agreement or law.

6.2  Any claim against Yokogawa based on any cause of action under or in relation to this Agreement must be given in writing to Yokogawa within three (3) months after the cause 
of action accrues.

7. Export Control
 You agree not to export or provide to any other countries, whether directly or indirectly, the Software Product, in whole or in part, without prior written consent of Yokogawa. 

If Yokogawa agrees such exportation or provision, you shall comply with the export control and related laws, regulations and orders of Japan, the United States of America, 
and any other applicable countries and obtain export/import permit and take all necessary procedures under your own responsibility and at your own expense. 

8. Audit; Withholding
8.1 Yokogawa shall have the right to access and audit your facilities and any of your records, including data stored on computers, in relation to the use of the Software Product 

as may be reasonably necessary in Yokogawa’s opinion to verify that the requirements of this Agreement are being met.
8.2  Even after license being granted under this Agreement, should there be any change in circumstances or environment of use which was not foreseen at the time of delivery 

and, in Yokogawa’s reasonable opinion, is not appropriate for using the Software Product, or if Yokogawa otherwise reasonably believes it is too inappropriate for you to 
continue using the Software Product, Yokogawa may suspend or withhold the license provided hereunder.

9. Assignment
  If you transfer or assign the Software Product to a third party, you shall expressly present this Agreement to the assignee to ensure that the assignee comply with this 

Agreement, transfer all copies and whole part of the Software Product to the assignee and shall delete any and all copy of the Software Product in your possession 
irretrievably.	This	Agreement	shall	inure	to	the	benefit	of	and	shall	be	binding	on	the	assignees	and	successors	of	the	parties.

10. Termination
	 Yokogawa	shall	have	the	right	to	terminate	this	Agreement	with	immediate	effect	upon	notice	to	you,	if	you	breach	any	of	the	terms	and	conditions	hereof.	Upon	termination	of	

this Agreement, you shall promptly cease using the Software Product and, in accordance with sub-clause 2.5, return or irretrievably delete all copies of the Software Product, 
certifying the same in writing. In this case the license fee paid by you for the Software Product shall not be refunded. Clauses 2.4 and 2.5, 3, 5, 6 and 11 shall survive any 
termination of this Agreement.

11. Governing Law; Disputes
   This Agreement shall be governed by and construed in accordance with the laws of Japan. 
			 Any	dispute,	controversies,	or	differences	which	may	arise	between	the	parties	hereto,	out	of,	in	relation	to	or	in	connection	with	this	Agreement	(“Dispute”)	shall	be	resolved	

amicably through negotiation between the parties based on mutual trust. Should the parties fail to settle the Dispute within ninety (90) days after the notice is given from either 
party to the other, the Dispute shall be addressed in the following manner:

 (i) If you are a Japanese individual or entity, the Dispute shall be brought exclusively in the Tokyo District Court (The Main Court) in Japan.
	 (ii)	If	you	are	not	a	Japanese	individual	or	entity,	the	Dispute	shall	be	finally	settled	by	arbitration	in	Tokyo,	Japan	in	accordance	with	the	Commercial	Arbitration	Rules	of	

the Japan Commercial Arbitration Association. All proceedings in arbitration shall be conducted in the English language, unless otherwise agreed. The award of arbitration 
shall	be	final	and	binding	upon	both	parties,	however,	each	party	may	make	an	application	to	any	court	having	jurisdiction	for	judgment	to	be	entered	on	the	award	and/or	for	
enforcement of the award.

12. Miscellaneous
12.1  This Agreement supersedes all prior oral and written understandings, representations and discussions between the parties concerning the subject matter hereof to the extent 

such understandings, representations and discussions should be discrepant or inconsistent with this Agreement.
12.2	 If	any	part	of	this	Agreement	is	found	void	or	unenforceable,	it	shall	not	affect	the	validity	of	the	balance	of	the	Agreement,	which	shall	remain	valid	and	enforceable	according	

to its terms and conditions. The parties hereby agree to attempt to substitute for such invalid or unenforceable provision a valid or enforceable provision that achieves to the 
greatest extent possible the economic, legal and commercial objectives of the invalid or unenforceable provision.

12.3  Failure by either party to insist on performance of this Agreement or to exercise a right when entitled does not prevent such party from doing so at a later time, either in relation 
to that default or any subsequent one.

End of document

Software Licensing Agreement
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Using Open Source Software

Expat
The report generation section and print section in the Report/Print function of the following 
products use Expat source code. In accordance with the Expat license; copyright, 
distribution terms, and license are provided below.

SMARTDAC+ Data Logging Software GA10, or GA10CL

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the “Software”), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, publish, 
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the 
Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS 
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.

Heimdal
The password-management function of the following product uses Heimdal source code for 
AES authentication key generation.
In accordance with the Heimdal license agreement, the copyright notice, redistribution 
conditions, and license are listed below.

SMARTDAC+ STANDARD Universal Viewer

Copyright (c) 2006 Kungliga Tekniska Högskolan (Royal Institute of Technology, Stockholm, 
Sweden). All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.

3. Neither the name of the Institute nor the names of its contributors may be used to endorse 
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE INSTITUTE AND CONTRIBUTORS "AS IS'' 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE INSTITUTE OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY 
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Using Open Source Software

OpenSSL
The OPC-UA server function of the following product uses OpenSSL source code for 
communication. This product includes software developed by the OpenSSL Project for 
use in the OpenSSL Toolkit (http://www.openssl.org/) This product includes cryptographic 
software written by Eric Young (eay@cryptsoft.com) In accordance with the OpenSSL 
license agreement, the copyright notice, redistribution conditions, and license are listed 
below.

SMARTDAC+ Data Logging Software GA10

LICENSE ISSUES
==============
The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL 
License and the original SSLeay license apply to the toolkit. See below for the actual license 
texts. Actually both licenses are BSD-style Open Source licenses. In case of any license 
issues related to OpenSSL please contact openssl-core@openssl.org.

OpenSSL License
---------------
====================================================================
Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.

3. All advertising materials mentioning features or use of this software must display the 
following acknowledgment:
“This product includes software developed by the OpenSSL Project for use in the OpenSSL 
Toolkit. (http://www.openssl.org/)”

4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or 
promote products derived from this software without prior written permission. For written 
permission, please contact openssl-core@openssl.org.

5. Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” 
appear in their names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:
“This product includes software developed by the OpenSSL Project for use in the OpenSSL 
Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS’’ AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING 
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.
====================================================================
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). 
This product includes software written by Tim Hudson (tjh@cryptsoft.com).
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log4net
The AI analysis function of the following products uses the source code of log4net. In 
accordance with the log4net license agreement, the copyright notice, redistribution 
conditions, and license are listed below.
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Copyright (c) 2017 by Contributors

Licensed under the Apache License, Version 2.0 (the “License”);
you may not use this file except in compliance with the License.
You may obtain a copy of the License at 

   http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the 
License is distributed on an “AS IS” BASIS, WITHOUT WARRANTIES OR CONDITIONS OF 
ANY KIND, either express or implied.
See the License for the specific language governing permissions and limitations under the 
License.

   Apache log4net
   Copyright 2004-2017 The Apache Software Foundation

   This product includes software developed at
   
The Apache Software Foundation (http://www.apache.org/).

Math.NET Numerics License (MIT/X11)
The AI analysis function of the following products uses the source code of Math.NET 
Numerics License. In accordance with the Math.NET Numerics License license agreement, 
the copyright notice, redistribution conditions, and license are listed below.
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Copyright (c) 2002-2019 Math.NET

Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the “Software”), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, publish, 
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the 
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS 
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.
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Microsoft.VisualStudio.Azure.Containers.Tools.Targets 1.9.10
The AI analysis function of the following products uses the source code of Microsoft.
VisualStudio.Azure.Containers.Tools.Targets 1.9.10. In accordance with the Microsoft.
VisualStudio.Azure.Containers.Tools.Targets 1.9.10 license agreement, the copyright notice, 
redistribution conditions, and license are listed below.
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## MICROSOFT SOFTWARE LICENSE TERMS
## MICROSOFT VISUAL STUDIO CONTAINER TOOLS TARGETS
---
These license terms are an agreement between Microsoft Corporation (or based on where 
you live, one of its affiliates) and you. They apply to the software named above. The terms 
also apply to any Microsoft services or updates for the software, except to the extent those 
have additional terms.

---
**IF YOU COMPLY WITH THESE LICENSE TERMS, YOU HAVE THE RIGHTS BELOW.**
1. **INSTALLATION AND USE RIGHTS.** You may install and use any number of copies of 
the software to develop and test your applications.
2. **TERMS FOR SPECIFIC COMPONENTS.**
    * **Utilities.** The software may contain some items on the Utilities List at https://
go.microsoft.com/fwlink/?linkid=823097.  You may copy and install these Utilities, if included 
with the software, onto devices to debug and deploy your applications and databases you 
developed with the software. Please note that Utilities are designed for temporary use, 
that Microsoft may not be able to patch or update Utilities separately from the rest of the 
software, and that some Utilities by their nature may make it possible for others to access 
devices on which the Utilities are installed. As a result, you should delete all Utilities you 
have installed after you finish debugging or deploying your applications and databases.  
Microsoft is not responsible for any third party use or access of Utilities you install on any 
device.
    * **Build Tools.** The software may include build tools which have specific use terms.   
For build tools, you may copy and install files from the software onto your build devices, 
including physical devices and virtual machines or containers on those machines, 
whether on-premises or remote machines that are owned by you, hosted on Azure for 
you, or dedicated solely to your use (collectively, “Build Devices”).  You and others in your 
organization may use these files on your Build Devices solely to compile, build, and verify 
applications or run quality or performance tests of those applications as part of the build 
process.  For clarity, “applications” means applications developed by you and others in your 
organization who are each licensed to use the software.
    * **Microsoft Platforms.**  The software may include components from Microsoft 
Windows; Microsoft Windows Server; Microsoft SQL Server; Microsoft Exchange; Microsoft 
Office; and Microsoft SharePoint. These components are governed by separate agreements 
and their own product support policies, as described in the Microsoft “Licenses” folder 
accompanying the software, except that, if license terms for those components are also 
included in the associated installation directory, those license terms control.
    * **Third Party Components.**  The software may include third party components with 
separate legal notices or governed by other agreements, as may be described in the 
ThirdPartyNotices file(s) accompanying the software. 
3. **DATA.**
    * **Data Collection.** The software may collect information about you and your use of the 
software, and send that to Microsoft. Microsoft may use this information to provide services 
and improve our products and services.  You may opt-out of many of these scenarios, but 
not all, as described in the product documentation.  There are also some features in the 
software that may enable you and Microsoft to collect data from users of your applications. If 
you use these features, you must comply with applicable law, including providing appropriate 
notices to users of your applications together with a copy of Microsoft’s privacy statement. 
Our privacy statement is located at https://go.microsoft.com/fwlink/?LinkID=824704. You 
can learn more about data collection and use in the help documentation and our privacy 
statement. Your use of the software operates as your consent to these practices.
    * **Processing of Personal Data.** To the extent Microsoft is a processor or subprocessor 
of personal data in connection with the software, Microsoft makes the commitments in the 
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European Union General Data Protection Regulation Terms of the Online Services Terms to 
all customers effective May 25, 2018, at http://go.microsoft.com/?linkid=9840733. 
4. **SCOPE OF LICENSE.** The software is licensed, not sold. This agreement only gives 
you some rights to use the software. Microsoft reserves all other rights. Unless applicable 
law gives you more rights despite this limitation, you may use the software only as expressly 
permitted in this agreement. In doing so, you must comply with any technical limitations in 
the software that only allow you to use it in certain ways. For more information, see www.
microsoft.com/licensing/userights. You may not
    * work around any technical limitations in the software;
    * reverse engineer, decompile or disassemble the software, or attempt to do so, except 
and only to the extent required by third party licensing terms governing use of certain open-
source components that may be included with the software;
    * remove, minimize, block or modify any notices of Microsoft or its suppliers in the 
software; 
    * use the software in any way that is against the law; or
    * share, publish, rent, or lease the software, or provide the software as a stand-alone 
offering for others to use.
5. **EXPORT RESTRICTIONS.** You must comply with all domestic and international export 
laws and regulations that apply to the software, which include restrictions on destinations, 
end users and end use.  For further information on export restrictions, visit (aka.ms/
exporting).
6. **SUPPORT SERVICES.** Because this software is “as is,” we may not provide support 
services for it.
7. **ENTIRE AGREEMENT.** This agreement, and the terms for supplements, updates, 
Internet-based services and support services that you use, are the entire agreement for the 
software and support services.
8. **APPLICABLE LAW.**  If you acquired the software in the United States, Washington law 
applies to interpretation of and claims for breach of this agreement, and the laws of the state 
where you live apply to all other claims. If you acquired the software in any other country, its 
laws apply.
9. **CONSUMER RIGHTS; REGIONAL VARIATIONS.** This agreement describes certain 
legal rights. You may have other rights, including consumer rights, under the laws of your 
state or country. Separate and apart from your relationship with Microsoft, you may also 
have rights with respect to the party from which you acquired the software. This agreement 
does not change those other rights if the laws of your state or country do not permit it to 
do so. For example, if you acquired the software in one of the below regions, or mandatory 
country law applies, then the following provisions apply to you:
    * **Australia.** You have statutory guarantees under the Australian Consumer Law and 
nothing in this agreement is intended to affect those rights.
    * **Canada.** If you acquired this software in Canada, you may stop receiving updates 
by turning off the automatic update feature, disconnecting your device from the Internet (if 
and when you re-connect to the Internet, however, the software will resume checking for and 
installing updates), or uninstalling the software. The product documentation, if any, may also 
specify how to turn off updates for your specific device or software.
    * **Germany and Austria.**
        1. **Warranty.** The properly licensed software will perform substantially as described 
in any Microsoft materials that accompany the software. However, Microsoft gives no 
contractual guarantee in relation to the licensed software.
        2. **Limitation of Liability.** In case of intentional conduct, gross negligence, claims 
based on the Product Liability Act, as well as, in case of death or personal or physical injury, 
Microsoft is liable according to the statutory law.

        Subject to the foregoing clause (2), Microsoft will only be liable for slight negligence 
if Microsoft is in breach of such material contractual obligations, the fulfillment of which 
facilitate the due performance of this agreement, the breach of which would endanger the 
purpose of this agreement and the compliance with which a party may constantly trust in 
(so-called “cardinal obligations”). In other cases of slight negligence, Microsoft will not be 
liable for slight negligence.
10. **DISCLAIMER OF WARRANTY. THE SOFTWARE IS LICENSED “AS-IS.” YOU 
BEAR THE RISK OF USING IT. MICROSOFT GIVES NO EXPRESS WARRANTIES, 
GUARANTEES OR CONDITIONS. TO THE EXTENT PERMITTED UNDER YOUR LOCAL 
LAWS, MICROSOFT EXCLUDES THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT.**
11. **LIMITATION ON AND EXCLUSION OF DAMAGES. YOU CAN RECOVER FROM 
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MICROSOFT AND ITS SUPPLIERS ONLY DIRECT DAMAGES UP TO U.S. $5.00. YOU 
CANNOT RECOVER ANY OTHER DAMAGES, INCLUDING CONSEQUENTIAL, LOST 
PROFITS, SPECIAL, INDIRECT OR INCIDENTAL DAMAGES.**
    
    This limitation applies to (a) anything related to the software, services, content (including 
code) on third party Internet sites, or third party applications; and (b) claims for breach of 
contract, breach of warranty, guarantee or condition, strict liability, negligence, or other tort to 
the extent permitted by applicable law.
    
    It also applies even if Microsoft knew or should have known about the possibility of the 
damages. The above limitation or exclusion may not apply to you because your country may 
not allow the exclusion or limitation of incidental, consequential or other damages.

**Please note: As this software is distributed in Quebec, Canada, some of the clauses in this 
agreement are provided below in French.**

**Remarque : Ce logiciel étant distribué au Québec, Canada, certaines des clauses dans ce 
contrat sont fournies ci-dessous en français.**

**EXONÉRATION DE GARANTIE.** Le logiciel visé par une licence est offert « tel quel ». 
Toute utilisation de ce logiciel est à votre seule risque et péril. Microsoft n’accorde aucune 
autre garantie expresse. Vous pouvez bénéficier de droits additionnels en vertu du droit 
local sur la protection des consommateurs, que ce contrat ne peut modifier. La ou elles sont 
permises par le droit locale, les garanties implicites de qualité marchande, d’adéquation à 
un usage particulier et d’absence de contrefaçon sont exclues.

**LIMITATION DES DOMMAGES-INTÉRÊTS ET EXCLUSION DE RESPONSABILITÉ 
POUR LES DOMMAGES.** Vous pouvez obtenir de Microsoft et de ses fournisseurs une 
indemnisation en cas de dommages directs uniquement à hauteur de 5,00 $ US. Vous 
ne pouvez prétendre à aucune indemnisation pour les autres dommages, y compris les 
dommages spéciaux, indirects ou accessoires et pertes de bénéfices.

Cette limitation concerne:

* tout ce qui est relié au logiciel, aux services ou au contenu (y compris le code) figurant sur 
des sites Internet tiers ou dans des programmes tiers ; et
* les réclamations au titre de violation de contrat ou de garantie, ou au titre de responsabilité 
stricte, de négligence ou d’une autre faute dans la limite autorisée par la loi en vigueur.

Elle s’applique également, même si Microsoft connaissait ou devrait connaître l’éventualité 
d’un tel dommage. Si votre pays n’autorise pas l’exclusion ou la limitation de responsabilité 
pour les dommages indirects, accessoires ou de quelque nature que ce soit, il se peut que 
la limitation ou l’exclusion ci-dessus ne s’appliquera pas à votre égard.

**EFFET JURIDIQUE.** Le présent contrat décrit certains droits juridiques. Vous pourriez 
avoir d’autres droits prévus par les lois de votre pays. Le présent contrat ne modifie pas les 
droits que vous confèrent les lois de votre pays si celles-ci ne le permettent pas.

Moq
The AI analysis function of the following products uses the source code of Moq. In 
accordance with the Moq license agreement, the copyright notice, redistribution conditions, 
and license are listed below.
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BSD 3-Clause License

Copyright (c) 2007, Clarius Consulting, Manas Technology Solutions, InSTEDD All rights 
reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Using Open Source Software



xiIM 04L65B01-01EN

    * 
Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.

    * 
Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials provided 
with the distribution.

    * 
Neither the names of the copyright holders nor the names of its contributors may be used 
to endorse or promote products derived from this software without specific prior written 
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE 
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

NETStandard.Library
The AI analysis function of the following products uses the source code of NETStandard.
Library. In accordance with the NETStandard.Library license agreement, the copyright 
notice, redistribution conditions, and license are listed below.
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The MIT License (MIT)

Copyright (c) .NET Foundation and Contributors

All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the “Software”), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, publish, 
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the 
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS 
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.
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Newtonsoft.Json
The AI analysis function of the following products uses the source code of Newtonsoft.
Json. In accordance with the Newtonsoft.Json license agreement, the copyright notice, 
redistribution conditions, and license are listed below.
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The MIT License (MIT)

Copyright (c) 2007 James Newton-King

Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the “Software”), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, publish, 
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the 
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS 
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.

System.Drawing.Common
The AI analysis function of the following products uses the source code of System.Drawing.
Common. In accordance with the System.Drawing.Common license agreement, the 
copyright notice, redistribution conditions, and license are listed below.
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The MIT License (MIT)

Copyright (c) .NET Foundation and Contributors

All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the “Software”), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, publish, 
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the 
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS 
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.
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Parson
Parson source code is used in the interpretation process of the JSON format of the 
GateSushi HTTP server area of the following products. In accordance with the Parson 
license agreement, the copyright notice, redistribution conditions, and license are listed 
below.
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MIT License

Copyright (c) 2012 - 2020 Krzysztof Gabis

Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the “Software”), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, publish, 
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the 
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS 
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.
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Chapter 1  Before Using the Product
1.1 Overview

Data Logging Software GA10 is used to collect data from measuring instruments and 
controllers via communication and monitor and record the collected data. Recorded data can 
be displayed and printed from the Viewer software.
To use GA10, you need a PC that can connect to target devices. The connection 
between the PC and target devices is established through Ethernet communication, serial 
communication, or USB communication (GM only.)
You can use the Simple Settings mode to easily start data collection.

Server and Client
GA10 is a client-server software application. Users perform various server operations from a 
client. The server collects, records, and manages data received from connected devices on 
the basis of the instructions received from the client.
When you install GA10 to a single PC, the client function and server function are installed 
together. You can also install GA10CL, which is a version that contains only the client 
function, in other PCs. Multiple clients can simultaneously access a single server.

User
Operation

Data 
collection

Data 
collectionInstruction to 

the server

Response to 
the client

GA10CL

GA10

ServerClient

Connectivity with Many Devices
GA10 is a software application that consolidates various devices connected over a network 
and performs data collection. GA10 can connect to YOKOGAWA recorders and data 
loggers. It can also collect data that has been acquired by YOKOGAWA’s data acquisition 
software (MXLOGGER, DAQLOGGER, and DAQ32Plus) Further, it can connect and collect 
data from YOKOGAWA’s data acquisition software (MXLOGGER, DAQLOGGER, and 
DAQ32Plus) and Yokogawa Test & Measurement’s power meters (WT3000/WT3000E).
Moreover, it supports the Modbus protocol, enabling data collection from YOKOGAWA’s 
control instruments (temperature controllers, signal conditioners, and power monitors). 
GA10 can also collect data from other manufacturers’ devices that support Modbus 
communication.

. . .

Server Client Client

Data Logging Software GA10

Converter

RS-232

RS-232

RS-422/485
EthernetData collection

Data collection

Data collection

MXLOGGER
DAQLOGGER

DAQ32Plus
GateWT for GA10

Operation

Instruments supporting 
RS-422/485 

communication

Instruments 
supporting Ethernet 

communication
Instruments 

supporting RS-232 
communication

Instruments 
supporting Modbus 

communication

Source devices for 
MXLOGGER data 

collection

Source devices for 
DAQLOGGER data 

collection

Source devices for 
DAQ32Plus data 

collection

•	 MXLOGGER,	DAQLOGGER,	DAQ32Plus	are	YOKOGAWA’s	data	collection	applications.	
GateWT for GA10 is YOKOGAWA’s driver software.

•	 Modbus	ASCII	protocol	is	not	supported.
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Data Collection Project
GA10 collects data in units of projects. Projects are created by users to suite their purposes. 
For example, a project named “Process A” can be created to collect measured data from a 
process called “A.” In this way, a project can be created for each set of collected data.
For each project, the data to be collected, data to be recorded, the monitor page layout, and 
the like are specified.
Multiple projects can be created in a single server.

Monitoring
Collected data can be monitored on the Monitor Page.
On the Monitor Page, in addition to the four types of displays (trend, digital, meter, and 
alarm), a custom display (on models with the /CG option), integration graph, and demand 
monitor (on models with the /WH option) can be arranged in an easy-to-view layout.

In addition, related data can be displayed in groups to monitor measurements efficiently. In 
the trend display, you can refer to past data.

User Management
GA10 users can be registered and managed. There are two user levels: administrator and 
user. Administrators are responsible for registering and deleting all users. Users enter their 
IDs and passwords to access a server.
Of the users registered in a server, only those that have been granted privileges can access 
projects. The operation scope of each user can be managed by assigning one of four levels: 
owner, manager, operator, and monitor. If a user is accessing a project, other users cannot 
access that project.

Client Client

Administrator: Register and delete users

Client

Monitoring Data collection and recording

Server access privileges

Project operation privileges

Server Project
1

Project
2

Project
3
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 Chapter 1 Before Using the Product

Features to improve reliability
GA10 features the following functions to ensure reliable data collection.

Data supplementing function (Backfill function)
 If a data dropout occurs in the data file that is being recorded due to a communication 

interference, this function automatically acquires data from the internal memory of the 
device and restores the data loss in the file.

Data dropout

 Restores the data loss. (Backfill)

Interference

 Several conditions must be met for the backfill function to operate properly.
 For details, see Q4 on page 14-7.

Auto reconnection when communication is disconnected
 If the communication is disconnected and data collection is interrupted, communication 

retry is performed every approximately 30 seconds. When communication recovers, 
the server resumes data collection and recording. This allows data loss to be kept to a 
minimum.

Protection of data files up to the moment of power failure
 GA10 writes to the data file every approximately 10 seconds. This reduces the chances of 

the data file being lost in the event the PC shuts down unexpectedly.

Convenient Features
•	 You can use the Simple Settings feature to easily start data collection.
•	 You can set the data timestamp to PC time or Device time.
•	 The DDE (Dynamic Data Exchange) server feature allows collected data to be loaded 

into Excel and other applications.
•	 Multiple screens (operation and monitor) can be started on a single PC.
•	 Project settings can be displayed and printed.
•	 GA10 has a trial mode that can be used for 60 days without a license.

Functional Addition Option
The following options can be added to the GA10. 

•	 Report/Print function (/RP option)
•	 Math function (/MT option)
•	 OPC-UA server function (/UA option)
•	 Custom display function (/CG option)
•	 Integration display function (/WH option)
•	 GateSushi function (/SU option)
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Connectable Devices and Software
The following table lists the devices and software 
applications that GA10 can connect to.

Registering devices for connection:  page 3-3, 3-12 
Connectable devices and interfaces:  page 3-18

Compatible Devices and Software Text Appearing on the GA10 
Screen When Connected

DAQSTATION CX1xxx CX1000
CX2xxx CX2000
DX1xxx DX1000
DX2xxx DX2000

FX1000 FX1xxx FX1000/FW1000
FW1000 FW1xxx FX1000/FW1000
DAQMASTER MV1xxx MV1000

MV2xxx MV2000
MX100 MX100
MW100 MW100

μR μR10000 μR10000
μR20000 μR20000

DARWIN DA100 DA100
DR130 DR130
DR230 DR230
DR240 DR240

SMARTDAC+ GX10 GX10 or, GXGPGM_
PIDSlot0 2 
to GXGPGM_
PIDSlot9 2

GX20 GX20
GP10 GP10
GP20 GP20
GM10 1 GM10

UTAdvanced UT32A UP35A or UP35A_R3  2
UT35A UP55A or UP55A_R3  2
UT52A UT52A or UT52A_R3  2
UT55A UT55A or UT55A_R3  2
UT75A UT75A or UT75A_R3  2
UP35A UP35A or UP35A_R3  2
UP55A UP55A or UP55A_R3  2
UM33A UM33A

WT3000 3 WT3000 WT3000
WT3000E WT3000E

Universal Power 
Monitor

UPM100 UPM100
UPM101 UPM101

YS1000 YS1500 YS1500
YS1700 YS1700

DAQWORX DAQLOGGER DAQLOGGER
DAQ32Plus DAQ32Plus
MXLOGGER MXLOGGER

GateWT for GA10 4 GateWT for GA10
Devices supporting the Modbus protocol 5 hardware
GateSushi GateSushi

1 Supported in GA10 R2.01.01. The advanced security function (/AS) option  
is supported in GA10 R2.03.01.

2 The displayed characters of the product name that is used when 
connecting to a GA10 with the custom display function (/CG option). (It 
corresponds to the output channel.)

 On the GX/GP/GM, you use the PID control module by selecting the slot 
in which it is installed on the custom display at the time the module is 
installed.

3 The WT3000 and WT3000E are precision power analyzers by Yokogawa 
Test & Measurement Corporation.

4 GateWT for GA10 is YOKOGAWA’s driver software. It is software for 
connecting to the WT series power meters (excluding the WT3000/
WT3000E) of Yokogawa Test & Measurement Corporation. Only Ethernet 
connection is supported between the GA10 and GateWT.

5	 Devices,	including	YOKOGAWA	control	instruments,	defined	using	
Modbus	device	definition	files.	However,	Modbus	ASCII	protocol	is	not	
supported.

Main GA10 Specifications
Maximum number of simultaneous 
device connections 100

Maximum number of simultaneous 
client connections 1

No limit (operation guaranteed up 
to 32 clients)

Maximum number of simultaneous 
operation projects 30

Maximum number of device 
registrations 1000

Maximum number of project 
registrations 10000

Maximum number of user 
registrations 100

Maximum number of clients that 
can run simultaneously on the 
same PC

Multiple clients possible (See
“Starting Multiple Screens” 
described later.)

Monitor interval  
(when set to PC time)

100 ms, 200 ms, 500 ms, 1 s, 2 s, 
5 s, 10 s, 20 s, 30 s, 1 min, 2 min, 
5 min, 10 min

Monitor interval  
(when set to device time)

The acquisition interval of each 
device 2

Record interval  
(when set to PC time)

100 ms, 200 ms, 500 ms, 1 s, 2 
s, 5 s, 10 s, 20 s, 30 s, 1 min, 2 
min, 5 min, 10 min (limited to an 
integer multiple of the monitor 
interval.)

Record interval  
(when set to device time)

Same as the monitor interval of 
GA10

Maximum number of recording 
channels (tags) per project

2000
Models with the math function: 
4000 (including the maximum 
math tags of 2000)

Number of display groups
50
Models with GateSushi function:
200

Number of channels (tags) per 
display group 50

Language 3 English, Japanese, Chinese, 
French, German, Russian, Korean

1 Make sure that the version of the added client is the same as the server 
version.

2 GX10/GX20/GP10/GP20/GM10 (R4.0 or later): 1 ms (shortest)
 MX/MW, MXLOGGER: 10 ms (shortest). 
 WT3000/WT3000E: Same as the recorder’s data update rate (except 50 

ms). Shortest 100 ms.
3 Make sure to use the same language setting for this software, Windows 

OS, and the recorders that data is to be collected from.
On Models with the Math Function (/MT option)

Computation interval Same as the monitor interval of 
measurement tags

Number of math tags 200 to 2000 1

1 The number is synchronized to the number of measurement tags (number 
of measurement channels) as shown in the following table. 
Measurement tags Math tags
100 200
200 200
500 500
1000 1000
2000 2000

If the number of measurement tags increases due to an upgrade, the 
number of math tags also increases accordingly.

Note
•	 Depending	on	the	model	and	the	model	firmware	

version, older versions of GA10 may not be 
compatible. Update GA10 to the latest version.

•	 Data	acquisition	may	not	be	possible	depending	on	
the communication status, monitor interval, or number 
of data acquisition channels.

•	 Data	update	interval	of	the	monitor	screen	depends	
on the data acquisition interval as follows:
Data acquisition interval Data update interval of the monitor screen
Less than 100 ms 100 ms
100 ms - 10 s As specified
20 s or more Half the specified interval (i.e., 10 seconds 

if 20 seconds is specified)
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1.2 MODEL and SUFFIX Codes
•	 Basic Software

Data Logging Software
Model Suffix Code Optional Code Name
GA10 Data Logging Software

license
Channels -01 100ch

-02 200ch
-05 500ch
-10 1000ch
-20 2000ch

Options /RP Report/Print function
/MT Math function
/UA OPC-UA server function
/CG Custom display function 1
/WH Integration Display 

Function 2
/SU GateSushi Function 3

1 To create custom display monitors, you need DAQStudio (DXA170), 
a software sold separately. The /CG option includes a license for 
DAQStudio.

2 /MT	option	must	be	separately	specified	when	the	/WH	is	selected.
3 The maximum number of display groups is 200.

•	 Additional Channels or Functions
Data Logging Software  Upgrade license
Model Suffix Code Name
GA10UP Upgrade license for GA10
Upgrade

-01
Channel upgrade
100ch→200ch,	200ch→500ch,	
500ch→1000ch,	1000ch→2000ch

-02
Channel upgrade
100ch→500ch,	200ch→1000ch,	
500ch→2000ch

-03 Channel upgrade
100ch→1000ch,	200ch→2000ch

-04 Channel upgrade
100ch→2000ch

-RP Report/Print function

-MT Math function

-UA OPC-UA server function

-CG Custom display function 1 

-WH Integration Display Function 2

-SU 3 GateSushi Function 3

1 To create custom display monitors, you need DAQStudio (DXA170), 
a software sold separately. The -CG option includes a license for 
DAQStudio.

2 If the GA10 does not have the math function (/MT), you also need to 
upgrade to add the math function (-MT).

3 The maximum number of display groups is 200.

•	 Additional Monitoring PCs (Clients)
Data Logging Software  Client license
Model Suffix Code Name
GA10CL Client license for GA10
Number of 
licenses

-01 1 license

-05 5 licenses
-10 10 licenses
-50 50 licenses

•	 How the software is provided
Name Description
License sheet Contains the license keys. Check that the 

correct number of licenses are present.
GA10 Data Logging Software 
Downloading the Latest Software and 
Manuals

1 sheet (A4 size)

 Chapter 1 Before Using the Product

1.3 PC System Requirements
•	 Hardware 1

Item Description
CPU Intel Core2 Duo E6300 or faster x64 or x86 processor.
Internal memory 2 GB or more
Hard disk 500 MB or more of free space, NTFS recommended
Mouse Mouse compatible with the OS
Display 1024 x 768 dots or higher, 65536 colors or more
Communication ports 2 RS-232 or Ethernet port compatible with the OS

To perform RS-232 communication or RS-422/485 
communication with a connected device, the server 
PC needs a RS-232 serial port.
A USB port is required for USB communication.

1 If you plan to use GA10 continuously for a long period of time, we 
recommend that you run it on a desktop PC rather than a notebook.

2 Operation is not guaranteed if you use the converter cables, such as USB-
to-serial, for the communication.

•	 Operating System 1
OS Edition 32 bit 64 bit SP Browser
Windows 8.1 — Yes Yes Update IE11

Pro Yes Yes Update IE11
Windows 10 Home Yes Yes No SP IE11

Pro Yes Yes No SP IE11
Enterprise/
LTSB

Yes Yes No SP IE11

Windows Server 2008 R2 Standard No Yes SP1 IE11
Windows Server 2012 Standard No Yes No SP IE10
Windows Server 2012 R2 Standard No Yes Update IE11
Windows Server 2016 Standard No Yes No SP IE11

1 Yokogawa will also stop supporting OSs that Microsoft Corporation no 
longer supports.

•	 Other Operating Environment
Item Description
Microsoft Office Excel 1 2007, 2010, 2013, 2016
Windows Internet Explorer IE10, IE11 2 (Corresponding OSs are shown above.)
Windows Media Player Version 10 or later
Adobe Reader Adobe Reader X or later (latest version 

recommended)
RS-232 - RS-422/485 
converter

To perform RS-422/485 communication with a 
connected device, use a converter. (YOKOGAWA 
ML2 recommended)

1	 Use	Microsoft	Office	Excel	2010	or	later	to	view	Excel	reports	generated	
with the Report/Print function (/RP option).

2 The Gate Sushi screen only supports IE11.
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1.4 Menu and Icons
This section describes the GA10 menus and icons and page references on how to use them.

Menu before logging in

 Tool Bar (see the table below)

Menu Description See pages...
File(F)

Login Login server 2-4 

Exit Exit application -
View

Style Switch the display style 2-5
Tool Bar Show or hide the tool bar -

Language Switch the language -
Help(H)

User's &Manual F1 Display user operation manual -
Input Server License... Display server license dialogue 2-14
About... Display program information, version number and copyright 2-14

Server information... Display server version information dialogue 2-18
To Update Website Display website of Data Logging Software -

Menu after logging in

Append mark to the current group
Append mark to all groups

Mark edit box
Stop the waring beep

Alarm ACK

Acknowledge of device 
communication interference

Mark Bar Warning Action BarTool Bar
(see the table below)

Menu Description See pages...
File

Logout... Logout from server 2-5
New Project... Create a Project 2-8, 1-6, 

3-7
Import Project... Import Project information to create Project from file. 3-7
Export Project... Export Project information to file 3-7
Import tags... Import tags from tag information tag message file 3-28
Export tags... Export tags from tag information tag message file 3-28
Server Port No.... Display or change the server port number. 2-13 
Modbus Server Setting... Display or change the port number or timeout value of the Modbus 

server.
2-13 

Start DDE Start DDE service 3-55
Stop DDE [DDEServer Connection: 
Host name/IP address] (P)

Stop DDE service. While the DDE server is running, the host 
name or IP address of the server connected to the DDE server is 
displayed.

3-55

Exit Exit application -
Edit

Copy Ctrl+C Copy the selection and put it on the Clipboard 3-11

Paste Ctrl+V Paste the copied content 3-11

Delete Delete Delete the selected content 3-4, 9-4 

View
Project List Page Switch  to Project list page 2-8 , 3-5 , 

6-1 
User Management Page Switch  to user management page 2-7, 9-2 

Chapter 1 Before Using the Product
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Menu Description See pages...
Log... Display log dialogue 6-17 

Refresh Update the current page 8-2 

Alarm Show or hide alarm 6-7 

Alarm List... Show alarm  list dialogue 6-12 
Foreground Alarm Show this window in front when an alarm occurs. 6-14 

Popup(1) Enable popup function. 6-11 

Group Highlight(2) Enable Group highlight function. 6-11 

Group Link Linkage shows when switching between different groups 6-2 

Cursor value... Open the Cursor Window 6-6 
Cursor Value Transparency Switch cursor value transparency 6-6 
Erase Cursor Erase Cursor 6-6 
Statistics... Display a statistics dialog box. 6-6 
Tag Display Form. Switch tag display format (Tag Index, Tag No., Tag Comment) 3-24 
User Display Form. Switch user display format 3-54 
Style Switch the display style 2-5, 6-3 
Date Format Switch the date format 6-3 
Month Display Form. Switch the month display format 6-3 
Decimal Point Switch the decimal point 6-3 
Tool Bar Show or hide the tool bar -

Mark Bar Show or hide the mark bar -

Warning Action Bar Show or hide the warning action bar -

Language (M) Switch the language (English, Japanese, German, French, Chinese, 
Korean, Russian)

2-18 

Manual Save Button Switching the show or hide Manual Save button 6-1
Manual Save Confirm (Q) Show or hide the manual save confirmation dialog box. -
Frame Size Display Shows or hides the screen size of the custom display monitor. 7-3 
Full Screen (J) Display the selected monitor in full screen 6-2

Project
Open with specified permission Open the project according to the specified permission 9-5 
Modify Basic Information Modify project's basic information 3-11
Modify Owner Modify project's owner 9-4 
Append Mark Append mark to the current group or all groups 6-7 
Reset Computing Reset computing on the server (when math tags are enabled on 

GA10 with the /MT option)
4-9 , 6-15 

Start Device's Computing Start computing in the devices used in the Project 6-15 
Stop Device's Computing Stop computing in the devices used in the Project 6-15 
Reset Device's Computing Reset computing in the devices used in the Project 6-15 
Reset & Start Device's Computing Reset and start computing in the devices used in the Project 6-15 
Alarm ACK Alarm ACK 6-12 
Clear Alarm Log Clears the alarm log. 6-9 
Update Tag Information Updates the selected tag information manually.

"Tag No., Tag Comment" or "Except Tag No., Tag Comment"
3-29

Assign Tag Automatically... Assign tags automatically 3-33

Sorting Tags in Order of the Device 
No.

Sort tags in order by device number 3-28 

Unlock Project Forcibly Change the project's lock state forcibly 9-5 
Setting Printout Config...(G) Configure the setting display (select the settings to be shown) 3-68 
Config Display(I) Displays settings 3-70 

Operation
Start Monitoring Simultaneously All opened Projects start monitoring simultaneously 3-5 

Stop Monitoring Simultaneously All opened Projects stop monitoring simultaneously 3-5 

Start Recording Simultaneously All opened Projects start recording simultaneously 3-5 

Stop Recording Simultaneously All opened Projects stop recording simultaneously 3-5 

Stop Modbus Server Stop the modbus server. -
Re-execute Modbus Server Restart the Modbus server. 3-57 , 11-1 

Chapter 1 Before Using the Product
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Menu Description See pages...
Stop GateSushi Server Stop the GateSushi server (when GateSushi server is running on 

GA10 with /SU option).
Re-Start GateSushi Server Restart the GateSushi server (when GateSushi server is stopped 

on GA10 with /SU option)
Warning Beep Turn on or off the warning beep that sounds when a warning occurs 6-12 

Share the Warning Beep across clients Specifies sharing or non-sharing mode of the temporary 
suspension of warning beeps.

Stop the Warning Beep Stop the warning beep
Acknowledge of Device 
Communication Interface

Perform an acknowledge of device communication interference. 6-13 

Start/Stop Group's anomaly 
detection function

6-23 

User
Change Information Change user's information 2-6, 9-2 
Register New User Register new user in server 2-7, 9-3 

Chapter 1 Before Using the Product



2-1IM 04L65B01-01EN

Preparation

1

2

3

4

5

6

7

8

9

10

11

12

13

14

App

Index

Chapter 2  Preparation
2.1 Preparation from Installation up to Data Collection and Recording

The following flowchart shows an outline of the procedure from GA10 installation up to data 
collection and recording.

Installation

Register the administrator password.

Log in.

Register users.

Create a project for data collection and recording.

Create a new project? Use existing projects.NO

YES

Switching not possible

setting mode.
Select the

C
on

fig
ur

at
io

n
Pr

ep
ar

at
io

n

Start collection and recording.

Configure settings and 
start logging.

Detail Settings

Register devices to connect.

Set tags.

Set display groups.

Set the data collection method.

Register monitoring.

Set data recording method.

Set mail settings.

Set project access privileges.

Set the anomaly detection.

Monitor data. View recorded results. Manage users.

Simple Settings

Quickly start logging

Register devices to connect.

Set the collection and 
record interval.

Set the data save destination.

Start collection and recording.

Switching possible

• Export and import
   Save and load projects (settings).
• Copy and paste
   Copy and paste existing projects (settings).

Sec. 2.2

Sec. 2.3

Sec. 2.4

Sec. 2.5

Sec. 2.6

Sec. 3.3.1

Sec. 3.2 Sec. 3.3

Sec. 3.2.2

Sec. 3.2.3

Sec. 3.2.3

Chapter 6

Sec. 3.3.2

Sec. 3.3.3

Sec. 3.3.4

Sec. 3.3.5

Sec. 3.3.5

Sec. 3.3.6

Sec. 3.3.7

Sec. 3.3.8

Sec. 3.3.9

Chapter 8

Sec. 3.2.4

Chapter 9

Adding functions:
 Sec. 2.8
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2.2 Installation
The GA10 installer package includes a server, client, and viewer programs. Executing the 
procedure below installs all programs in a single PC.
The server runs as a Windows service and starts running as soon as it is installed. 
(Hereafter, a PC with the server function installed will be referred to as a “server PC.”)

Note
•	 Before	installing	the	software,	check	that	your	PC	is	not	infected	by	a	virus.
•	 Install	the	programs	as	a	Windows	administrator.
•	 Uninstall	GA10	before	reinstalling.

1 Right-click the file that you have downloaded and extracted or unzipped, and click Run 
as administrator.

2 If you accept the license agreement, click Next.
The Customer Information dialog box appears.

3 Enter the user name, company name, and license number and then click Next.
 If you do not enter the license number here, a 60-day trial version will be installed.

4 Continue to follow the instructions on the screen to install the software.

5 When the installation is complete, click Finish.
 Check that SMARTDAC+ Data Logging Software has been added to the Start 

menu under All Programs.
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Chapter 2  Preparation 

Trial periods
If the GA10 is installed without the license number, the trial period starts running.
•	 Continuous operation is possible for 60 days. When the trial period expires, the software 

will no longer run.
•	 During the trial period, the maximum number of recording channels (tags) is 4000 (2000 

tags + 2000 math tags), and all options can be used.
•	 Projects created with the trail version can only be passed on to products with 2000 device 

channels (suffix code “-20”) and with all options.
•	 In the software, click About on the Help menu, and check the remaining number of days 

in the dialog box that appears. 

Installing different versions
•	 In case you already purchased a license for the old version but would like to try the new 

version for 60 days:
 You can try the new version. However, install the new version in a PC different from 

the one you are running the old version on.

•	 In case you have tried the old version before and would now like to try the new version: 
 You can try the new version. However, install the new version in a PC different from 

the one that you tried R1 on.

•	 In case you already purchased a license for the old version and would like to upgrade to 
the new version:
 You can upgrade for free. Uninstall the old version, enter your license, and install 

the new version. You can use it with the same specifications as the purchased (old) 
version.

Project Compatibility
•	 Projects created in an earlier server version can be used in later server versions. Projects 

are not displayed for the opposite case.
•	 If an option is added to the GA10, projects created in the previous configuration can 

be used with the GA10 in the current configuration. Projects are not displayed for the 
opposite case.

For details on adding option functions and clients, see the following sections.
Adding Functions (GA10UP-RP, -MT, -UA, -CG, -WH, -SU)
 or
Adding a Client (GA10CL)

For details on the trial period and entering license information after the period ends, 
see the following sections.

Entering a License Number during the Trial Period
 or
Entering a License Number after the Trial Period

About the Universal Viewer
 There are two types of Universal Viewer: standalone installer and GA10 installer. These 

two types can be installed and used on the same computer even if they have different 
versions, but if you show data files with the old version, the display conditions and the 
template content may not be reflected in the display. We recommend showing data files 
using the latest version.
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2.3 Logging In
Logging in is an operation carried out to connect a GA10 client to a server.
Users start the client, log in, and perform various operations. When logging in for the first 
time, you do not enter a password.

1 On the Start menu, click All Programs, SMARTDAC+ Data Logging Software, and 
Data Logging Software.

A Login dialog box appears.

2 Leave the username admin and the password blank.
 User name: admin
 Password: (blank)
If you want to change the port number, specify a number between 1 and 65534.

 For changing the port number:  Sec. 2.7.4

3 Click OK.
The dialog box closes, the initial Project List Page appears.

If	the	software	is	started	for	the	first	time	after	installation,	a	log	dialog	box	appears.
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Chapter 2  Preparation 

4 Adjust the log dialog box display.

•	 Change the displayed position: Drag the dialog box to move it.
•	 Change the size: Point to a corner of the dialog box so that the pointer changes to 

an arrow. Then, drag to change the size.
•	 Hide: Click the × button at the top of the dialog box.
•	 Show again: On the View menu, click Log.

   What is the log dialog box?: 

5 To create a project, on the File menu, click Create New Project.

6 To log out, on the File menu, click Logout.
A	confirmation	message	appears.	Click	OK	to	log	out.

   Registering the administrator password:  Sec. 2.4
   Registering users:  Sec. 2.5

 

Note
You can change the background color from the two available colors by using Style in the View 
menu. The following figure shows the “dark” style window. (The windows shown in all other figures 
of this manual is “light” style.)

 

 Setting general display options:  Sec. 6.1.3

Starting Multiple Screens
•	 You	can	display	multiple	operation	screens	(clients)	on	the	same	PC.	To	start	multiple	

screens, repeat the login procedure from step 1 to 3.
•	 When	multiple	screens	are	shown,	the	screens	use	the	same	display	conditions	stored	

in the PC. Be careful when you change the display settings. 
•	 Limitations	may	be	placed	on	the	number	of	screens	that	can	be	started	depending	on	

the PC performance, collection and recording environment, and the like.
•	 For	details	on	display	conditions,	see	Sec. 6.9.6
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2.4 Registering the Administrator Password
After installation, first set the administrator (admin) password. The administrator can register 
and delete other users and initialize their passwords.

1 After logging in, click Change Information on the User menu.

The Change User’s Information dialog box appears.

2 Enter the new password for the administrator, and click OK.
Enter the password using 4 to 30 alphanumeric characters.

The Change User’s Information dialog box closes. The new administrator password has been set.

Important
After registering their passwords, users will need to enter the passwords to log in to the server.
If the administrator cannot log in, administrator privileges cannot be used. Make a note of the 
administrator password, and do not lose it.
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Chapter 2  Preparation 

2.5 Registering Users
After registering the administrator, register users as necessary. The administrator registers 
users.

1 Start the client, and enter the administrator password that you set earlier to log in.

2 On the View menu, click User Management Page.
Or, click the  icon.
The User Management Page appears.

3 On the User menu, click Register New User.

The Change User’s Information dialog box appears.

4 Type the user name and user full name.
 Enter up to 20 alphanumeric characters (ASCII except for the control characters) for 

the user name.

5 Click OK.
The user is registered, and an icon is added in the window.

6 To add more users, repeat the procedure above.
 Registered users will be able to log in, set their passwords, and perform their as-

signed tasks.

Note
User names are case-sensitive. When logging in, enter the user name exactly as it was registered.

Differences between the administrator and users and changing and deleting users:  Sec. 9.1
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2.6 Creating a Project
After logging in to the server, create a project to manage data collection and recording.
You can create a project in one of the following ways.
•	 Create a new project: You can create a new data collection project.
•	 Export and import: You can export and import a project.
•	 Copy and paste: You can duplicate an existing project.

1 Switch from the User Management Page to the Project List page.

 On the View menu, click Project List Page. Or, click the  icon.

Switch to Project List page

The Project List Page appears.
	 The	first	page	that	appears	when	you	log	in	is	the	Project	List	Page.
  

2 On the File menu, click New Project.
The Create New Project dialog box appears.
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 Chapter 2  Preparation

3. Type the project name and comment. 
 You can enter up to 20 characters for Project's Name and 60 characters for 

Comment. 
 Following characters are unavailable for Project's name: \ /:,;*?”<>|

4 Set Settings Mode to Simple Settings or Detail Settings.
 To start data collection and recording with a few steps, select Simple Settings. 

To set operation details, select Detail Settings.

5 Click OK.
A new project is created in the Project List Page.

A project that you create is shown in the Project List Page along with the information about 
the project.

User who are locking
 (accessing)

Project name

Access 
privilege

Access privilege
and the user name

The following types of access privileges are available.

Owner Manager Operator Monitor

   Project access privileges:  Sec. 3.3.9

6 To continue with the configuration, double-click to open the project.
For the setting procedure, see the following pages.

   Easy Configuration (Simple Settings):  Sec. 3.2
   Detailed Configuration (Detail Settings):  Sec. 3.3
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2.7 Controlling the Server
This section explains how to manually control (start, stop, and change) the GA10 server 
program “DLGServer. ”Perform these operations as necessary.

2.7.1 Checking Whether the Server Is Running

1 On the Start menu, click Control Panel and Administrative Tools, and double-click 
Services.
The Services window appears.

2 Scroll down to find DLGServer in the Name column. Check the Status column.
The DLGServer status should be indicating Started, and Startup Type should be set to Automatic.

Status: StartedDLGServer
Startup Type: Automatic

 If the DLGServer status indicates Started, the GA10 server is running.

3 After confirmation, close the window.

Note
If Startup Type is set to Automatic, the server will start and stop when Windows start and stop.
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 Chapter 2  Preparation

2.7.2 Starting (Restarting) or Stopping the Server
To manually start or stop the GA10 server, follow the procedure below.

Important    
Before stopping the server, stop data collection and recording, and log out.

1 On the Start menu, click Control Panel and Administrative Tools, and double-click 
Services.
The Services window appears.

2 In the Services window, choose DLGServer.

3 To stop the server, on the Action menu, click Stop.
The status turns blank.

The status turns blank.

4 To start the server, on the Action menu, click Start. 
Click Restart on the Action menu to stop the server once and restart.
The status shows Started.
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2.7.3 Changing the Server Startup Type from Automatic to Manual.

1 Carry out steps 1 to 3 in the previous section to stop the server.

2 In the Services window, double-click DLGServer.
The DLGServer Properties appear.

3 Click the Startup type arrow, and click Manual.

4 Click OK to close the dialog box.

 Chapter 2  Preparation
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2.7.4 Changing the Server Port Number
 By default, the GA10 server port number is set to 50310. If necessary, change the port 

number by following the procedure below.

 The port number can be changed only when a GA10 administrator logs in. Because two 
ports will be used, you cannot use other servers.

1 On the File menu, click Server Port Number.
A Server Port Number dialog box appears. (setting range: 1 to 65534)

2 Click OK.
Then, restart the GA10 server. (See the section 2.7.2)

2.7.5 Viewing or Setting the Port Number and Timeout Value of the Modbus Server

 The port number and timeout value can be displayed or changed only when a GA10 
administrator logs in.

1 On the File menu, click Modbus Server.
A Modbus Server Setting dialog box appears. (port number setting range; Port number: 1 to 
65535, timeout value setting range: 1 to 120 minutes)

2 Click OK.
Then, restart the Modbus server. (See the section 2.7.6)

2.7.6 Restarting the Modbus Server
 The Modbus server can be restarted only when a GA10 administrator logs in.

1 On the Operation menu, click Re-excute Modbus Server.

 Chapter 2  Preparation
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2.8 Entering a License Number
When entering a license number, use Windows administrator privileges. Before entering the 
license, we recommend you to back up your projects. 

Checking the Remaining Trial Period
In the software, click About on the Help menu, and check the remaining number of days in 
the dialog box that appears.

Entering a License Number during the Trial Period

1 Right-click Data Logging Software in the Start menu.

2 On the shortcut menu, click Run as administrator.
Data Logging Software starts.

3 Log in to the server.

4 On the Help menu, click Input Server License.
A dialog box appears.

5 Type the license number, and click Register.
A message is displayed.

6 Click OK.
The license number appears in the dialog box.

7 Click Close.
 Restart the server.

Note
After registering the license, you must restart the server.
Restarting the server:  Sec. 2.7.2.

 Chapter 2  Preparation
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Important
If you enter the server license after the trial period has expired, projects that were registered up 
to that point can no longer be used.
Export the project (output and save) before entering the license. Register the license, restart 
the server, and then import the project (reload) for use. For the procedure, see “Exporting and 
Importing” on page 3-7.

Entering a License Number after the Trial Period
If the trial period expires, you will no longer be able to log in. When you start the software, 
you will be prompted to enter the license number. If you have purchased a license, type the 
number.

Adding Functions (GA10UP-RP, -MT, -UA, -CG, -WH, -SU)
To add an option, in the Input Server License dialog box, register the upgrade license 
number.

Model Name
GA10UP -RP Report/Print function

-MT Math function
-UA OPC-UA server function
-CG Custom display function
-WH Integration display function
-SU GateSushi function

1 Right-click Data Logging Software in the Start menu.

2 On the shortcut menu, click Run as administrator.
Data Logging Software starts.

3 Log in.
 Export the project (output and save) before entering the license.
 After registering the license, import the project (reload) for use.

4 On the Help menu, click Input Server License.
A dialog box appears.

5 Type the license number, and click Register.
A message is displayed.

 Chapter 2  Preparation
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6 Click OK.
The description of options is displayed on the second and subsequent lines under license items.

7 Click Close.
Then restart the server.

   Restarting the server:  Sec. 2.7.2

Adding Channels (GA10UP-01, -02, -03, -04)
To add channels (tags), in the Input Server License dialog box, register the upgrade license 
number. The procedure is similar to adding an option.

The following table shows the maximum number of tags in a project after channels are 
added.

Model Name Maximum Number of Tags in a Project
Before After

GA10UP -01 1 level upgrade 100 200
200  500
500 1000
1000 2000

-02 2 level upgrade 100  500
 200 1000
 500 2000

-03 3 level upgrade  100 1000
 200 2000

-04 4 level upgrade  100 2000

Note
On a GA10 with the math function (/MT option), adding measurement tags by upgrading also 
increases the math tags according to the number of tags there are after the addition.:  “Number 
of math tags” on page 1-4

 Chapter 2  Preparation
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Adding a Client (GA10CL)
To add a client, use the installer InstallClient_x86.exe, which installs only clients. 
(InstallClient_x64.exe for the 64 bit edition)
You can download the installer from the following URL.

www.smartdacplus.com/software/en/

You will need to enter the client (GA10CL) license number when you install the client.

Model Name
GA10CL Client license (for GA10)
Number of license -01 1 license

-05 5 licenses

-10 10 licenses

-50 50 licenses

Install additional GA10CLs in different PCs from the one in which the GA10 basic software 
(server and client) is installed. The installation procedure is the same as the GA10 basic 
software.

When you start the client after installation, enter the following information.

•	 Host name/IP Address
 The host name or IP address of the PC in which the GA10 (server) is installed.

•	 Port Number
 GA10 (server) port number (default value: 50310)

•	 User Name
 User name already set on GA10 (default value: admin)

•	 Password
 The password of the above user (default value: blank)

Note
Make sure that the version of the added client is the same as the server version.

 Chapter 2  Preparation
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2.9 Checking the Number of Channels (Tags) and Options That Can Be Used
You can check the maximum number of channels (tags) and the options that can be used in 
the server information dialog box.
On the Help menu, click Server Information to display the information of the server that 
you are logged in to.

Maximum number of channels (tags) and options

Item Display Description
Maximum number of 
channels (tags)

/number of tags Display example: /500

Math function availability /MT Displayed when the Math function (option or added with an upgrade) is 
available.

Report/Print function 
availability

/RP Displayed when the Report/Print function (option or added with an 
upgrade) is available.

OPC-UA server function 
availability

/UA Displayed when the OPC-UA server function (option or added with an 
upgrade) is available.

Custom display function /CG Displayed when the Custom display function (option or added with an 
upgrade) is available.

Integration display 
function

/WH Displayed when the Integration display function (option or added with an 
upgrade) is available.

GateSushi function /SU Displayed when the GateSushi function (option or added with an 
upgrade) is available.

2.10 Changing the Language
On the View menu, click Language to switch the user interface language. You can select 
from English, Japanese, Chinese, French, German, Russian, and Korean.
•	 The language setting is managed at the PC level.
•	 The default language is the OS language. If the OS language is an unsupported 

language, the language is set to English.

 Chapter 2  Preparation
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2.11 Uninstallation
To uninstall GA10, follow the procedure below.

1 On the Start menu, click Control Panel and Programs and Features.
A list of programs installed in your PC appears.

2. Select SMARTDAC+ Data Logging Software.

3 Click Uninstall.

4 A confirmation message appears. To proceed, click Yes.

Uninstallation begins.

Uninstallation is complete when the progress bar disappears.

Note
 On Windows 8, click Settings, Control Panel, and Programs and Features.
 On Windows 10, click Windows system, Control Panel, and Programs and Features.

Important
Do	not	change	or	delete	files	in	the	following	folder:	local	disk	>	ProgramData	>	Yokogawa	>	
SMARTDAC+	Data	Logging	Software	>	Config.	
These	files	contain	user	information,	project	setting	information,	project	status	information,	
and device information.

 Chapter 2  Preparation
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Chapter 3  Configuring and Starting Data Collection and Recording
3.1 What Are Simple Settings and Detail Settings?

In GA10, you need to configure various project settings before beginning data collection 
and recording. There are two modes to configure these settings: Simple Settings and Detail 
Settings. You can select which setting mode to use when you create a project.

In Simple Settings mode, you only have to specify the device to connect to, data collection 
and recording interval, and data file save destination in a single window to begin data 
collection and recording.

In Detail Settings mode, you can configure settings in detail to customize data collection, 
monitoring, and recording.
Detail Settings mode consists of the following seven Setting Pages that you switch between 
to configure the settings.

•	 Device Setting Page
•	 Tag Setting Page
•	 Display Group Setting Page
•	 Collection & Monitor Page
•	 Record Setting Page
•	 Email Setting Page
•	 Access & Others Setting Page

If you select Simple Settings, you can change to Detail Settings while you are configuring a 
new project, but you cannot change from Detail Settings to Simple Settings.

Project configuration

Device connection

Data collection and recording

Simple Settings Page

Simple Settings

Detail Settings Page

Changeable

Report/Print
(/RT option)

Math tag
(/MT option)

Recording

Server Setting
(/UA option)

Email

Access&Others

Device

Tag

Display group

Acquisition&Monitor

Report/Print, math tag, and OPC-UA server Setting Pages appear on GA10 that have the 
corresponding options.
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3.2.1 Creating a Project in Simple Settings 
Mode

1 Start GA10, and log in by typing the user name and 
password. (When logging in for the first time, set 
the user name to “admin” and leave the password 
blank.)

2 On the File menu, click New Project.
The Create New Project dialog box appears.

3 Type the project name and comment. Leave 
Settings Mode at Simple Settings.

Leave this at 
Simple Settings.

4 Click OK.
A new project is created.

3.2 Easy Configuration (Simple Settings)
This section explains how to configure the settings in Simple 
Settings mode before starting data collection.
In Simple Settings mode, you can set the device to 
connect to, data collection and recording interval, and 
data save destination in a single window. You can start 
data collection and recording with fewer steps than in 
Detail Settings mode.

Register 
applicable devices

Create a project

Specify 
the data save destination

Start data collection 
and recording

Select the collection
 and record interval

Note
If you select Simple Settings, you can change to Detail 
Settings while you are configuring a new project, but you 
cannot change from Detail Settings to Simple Settings.

Detailed Configuration (Detail Settings):  Sec. 3.3
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  Chapter 3  Configuring and Starting Data Collection and Recording 

6 Drag & drop the icon of the device that you want to 
register to the Device List on the left side of the page.

In the center of the page, a window appears showing 
the details of the device that you are about to register.

7 If the displayed information is correct, click OK. To 
reselect a different device, click Cancel.

If the security settings on the device being registered 
are enabled, you need to enter the user information* 
for accessing the device. Otherwise, you can leave 
the user information blank and click OK.

* Not the user privileges for GA10

User information
The DX is added to the Device List.

Note
•	 If	a	login	is	required	for	communicating	with	the	

device, you need to specify the user information. 
Check the user name, user ID, and password for the 
device, and enter them.

•	 When	connecting	to	a	DXAdvanced	(DX1000,	
DX1000N, DX1000T, DX2000, or DX2000T) with the 
/AS1 advanced security option through the Ethernet 
interface, log in as an administrator to access the DX. 
In this situation, only one administrator will be able to 
log in.

3.2.2 Registering Devices to Connect
Add devices to the project you created.
Below is an example of connecting a DX1000 to the PC 
through the Ethernet interface and registering the DX1000 
in GA10.

1 Connect the device and the PC through a network 
using LAN cables.

PC

Ethernet
HUB

* The figure shows a one-to-one connection.

2 Configure the Ethernet settings on the device. Set 
the device’s IP address and subnet mask.

On the DX1000
 Press MENU, hold down FUNC for 3 s (to switch 

to basic setting mode), and select the Menu tab > 
Communication (Ethernet). 

Note
For details on where the Ethernet port is located and the 
hierarchy of setting menus, see the user’s manual of the 
relevant device.

3 Check that the PC and the device have been 
connected.
You can check the connection using Windows De-
vice Manager or from the command prompt.

4 Double-click the project that you created.
The Simple Settings page opens.

5 Click Search in the Online Devices List on the right 
side of the page.

Devices connected to the network are detected and 
displayed.
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•	 To delete a registered device, click the device icon to 
select it, and click Delete on the Edit menu or click the 
Delete button. You can also select the device icon and 
press the DELETE key.

Note
There are two ways to register devices to a project. One 
way is to connect the target devices to the network first 
and then register, and the other way is to register without 
connecting the devices (offline registration).
For details on the registration procedure, see the 
following pages.
Offline registration:  page 3-17
Register device dialog box details:  page 3-19

3.2.3 Setting the Monitor and Record Interval 
and Save Destination

After registering the device, set the Monitor and record 
interval and the measurement data save destination.

Click to select the interval.

Click to select the save destination.

1 Choose the interval from the Monitor/Record 
Interval list at the bottom of the page.

Name Default Value Options
Monitor/Record 
Interval

1 Second 100 Millisecond, 200 Millisecond, 
500 Millisecond, 1 Second, 2 
Second, 5 Second, 10 Second, 
20 Second, 30 Second, 1 Minute, 
2 Minute, 5 Minute, 10 Minute

2 Click Refer to, and select the directory for saving 
recording files.

Note
•	 The	Refer	to	button	for	specifying	the	save	destination	

folder is available only when the server and client are 
installed in the same PC.

•	 We	recommend	you	use	the	default	setting	for	the	
data save destination folder. (See “Folder” on page 
3-44.)

3.2.4 Starting Data Monitoring and Recording
You can start data collection and recording using a 
configured project.

•	 To close the project without collecting data, click the  
icon on the right edge of the page.

•	 To return to the list page with the project open, click 
 at the left end of the toolbar.

Controlling an Opened Project Individually
Click the icons that are displayed on the tab on the right 
side of the screen to collect or start and stop recording.

Standby
Monitoring
Recording

Starts data monitoring.
Click again to stop.

Start Monitoring Stop Monitoring 

Under monitoring

Starts data monitoring and recording
to the data file at the same time.
Click again to stop only the recording.

Under recording

Start Recording Stop Recording 

Manual save (hidden by default)
You can show or hide the button by selecting 
Manual Save Button from the View menu.
When clicked, the recording data is split 
at that position.
This button is valid only during recording.

1 Click the  icon to start data collection.

2 Click again to stop.

3 Likewise, click the  icon on the right to start 
recording.

4 Click again to stop only the recording.
 To also stop data monitoring, click  .
 To return to the Setting Page, click .

 Recorded data files are listed when you click 

Data files Page.  Sec. 8.1
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  Chapter 3  Configuring and Starting Data Collection and Recording 

Controlling Multiple Projects Simultaneously
If you want to start or stop recording or start or stop 
monitoring on multiple projects simultaneously, follow the 
procedure below.

1 Click the  icon at the left end of the toolbar.

The Project List Page appears.

2 On the Operation menu, click Start Monitoring 
Simultaneously. Or, click the  icon.

 To start recording, on the Operation menu, click 
Start Recording Simultaneously. Or, click the  
icon.
A	confirmation	message	appears.

3 Click OK.
Data collection (or recording) will start.

Data collecting Recording

4 To stop, on the Operation menu, click Stop 
Monitoring Simultaneously. Or, click the  icon.

 To stop recording, on the Operation menu, click Stop 
Recording Simultaneously. Or, click the  icon.

Note
Projects that you can simultaneously control are those 
that you have Operator or higher privileges for.
 Project Access Privileges:  Sec. 3.3.9

3.2.5 Closing a Project
To close a project, click the  icon on the right edge of 
the page.
•	 Note that clicking the close button in the upper right of 

the window closes the software.

Close the project.

When you close a project, the Project List Page 
appears.

When data collection and recording are stopped and the project is closed

When the project is closed with data collection and recording in progress

•	 An open project is locked (other users cannot edit 
it).  Click  Project List Page to view projects that are 
locked.

Details on the page when data collection and recording is 
in progress: Chapter 6

Note
You cannot perform the following operations while data is 
being collected.
•	 Register	devices	from	the	Online	Devices	List	to	the	

Devices List
•	 Register	a	new	device	on	the	Devices	List
•	 Change	device	registration	positions	on	the	Devices	

List
•	 Delete	registered	devices	from	the	Devices	List
•	 Change	the	settings	of	registered	devices	on	the	

Devices List
•	 Specify	the	record	interval
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3.3 Detailed Configuration (Detail Settings)
In Detail Settings mode, you can customize data collection, monitoring, and recording. This section explains how to 
configure the settings in Detail Settings mode before starting data collection.

Create a project

Register applicable devices

Set tags

Set math tags
(/MT option)

Configure the analysis

Configure the display

Configure the recording

Configure 
reporting and printing

(/RP option)

Configure mail settings

Set access permission

Start data collection 
and recording

Configure Integration 
settings

Configure FTP settings
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  Chapter 3  Configuring and Starting Data Collection and Recording 

3.3.1 Creating a Project in Detail Settings Mode
First, create a project, which is a set of data collection and 
recording. For each project, connected devices and data 
collection and recording conditions can be saved.

Creating a New Project
 Create a new project in Detail Settings mode.

1 Start GA10, and log in.
The Project List Page appears.

2 On the File menu, click Create New Project.

3 Type the project name and comment. Set Settings 
Mode to Detail Settings.

4 Click OK.
A new project is created in the Project List Page.

5 Double-click a new project.
The initial setting window appears.

Setting page area

Configuration navigation area

You can switch between different setting pages by clicking 
the items in the left navigator.

Expand/reduce button

Reduced Expanded

A check mark appears
when you configure 
the settings.

To continue configuring the project, proceed to Sec. 3.2.2.

Exporting and Importing
 You can export the information of a created project 

to a file (.pjf extension).
 This file is referred to as the project information 

file. The procedure to export and import a project is 
explained below.

Note
•	 Projects	created	in	an	earlier	server	version	can	

be used in later server versions. Projects are not 
displayed for the opposite case.

•	 If	an	option	is	added	to	the	GA10,	projects	created	in	
the previous configuration can be used with the GA10 
in the current configuration. Projects are not displayed 
for the opposite case.

 Related topic: 
 

Export procedure

1 From the list of projects, select the project that you 
want to export.

Click to select.

2 On the File menu, click Export Project.
The Save As dialog box appears.

3 Select the save destination, assign a name, and 
save it.
The	project	information	file	(.pjf	extension)	is	saved	
to	the	specified	location.
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Note
•	 If	you	do	not	have	access	permission	to	the	project,	

you cannot export it.
•	 If	the	project	contains	Modbus	device	connections,	

the register and channel information of the Modbus 
devices are not exported. You must save the definition 
files separately.

 Modbus device definition file:  Sec. 3.4
•	 OPC-UA	projects	when	the	OPC-UA	server	function	 

(/UA option) is in use cannot be imported or exported.

Import procedure

1 On the File menu, click Import Project.
An Open dialog box appears.

2 Select the file that you want to import (.pjf 
extension), and click Open.

The imported project is added to the list of projects.

Note
When you import a project, you become the project 
owner.
 Owner:  Sec. 3.3.9
 To modify the owner:  Sec. 9.4.3
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 Chapter 3  Configuring and Starting Data Collection and Recording

 Importing a project created on a GA10 with a different system configuration (GA10 version R2.02.xx or later)
 If you try to import a project created on a GA10 with option functions (additional channels, math, etc.), a message 

(W2008) may appear.
 This is because the project being imported contains functions that the importing GA10 does not have. You can 

continue importing by clicking OK in the message dialog box. The following table shows the result of importing.

Result of importing

GA10
Settings

Functions not available on the import destination GA10 server

Channels
(Tags)

Math function
(Option, /MT)

Report function
(Option, /RP)

Device -- -- --

Tag Tags outside the server’s tag range are set 
to None.

--

Math Tag -- Not displayed. --

Display
Display Group

Tags outside the server’s tag range are set 
to None.

Math tags are set to None. --

Display
Aquisition&Monitor

-- -- --

Record

When Start Condition or Stop 
Condition is Alarm.

If the start tag or end tag is outside the 
server’s tag range, the range is set to the 
server’s maximum Tag Index.

If the start tag exceeds the server’s tag range, 
Start Condition is set to Immediate and Stop 
Condition is set to Continuous.

If both the start tag and end tag are math tags, 
Start Condition is set to Immediate and Stop 
Condition is set to Continuous.

If the start tag is a measurement tag and the 
end tag is a math tag, the range is set to the 
server’s maximum Tag Index.

--

Integration Tags outside the server’s tag range are set 
to None.

-- --

FTP -- -- --

Report/Print

When Task is Report Output.

Tags outside the server’s tag range are set 
to None.

Math tags are set to None. Not displayed.

E-Mail

TRIG:,  
Range

If the start tag exceeds the server’s maximum 
Tag Index, mail is set to OFF.

If the start tag or end tag is outside the 
server’s tag range, the range is set to the 
server’s maximum Tag Index.

In Detail Settings mode, tags exceeding the 
server’s tag range are not displayed.

If both the start tag and end tag are math tags, 
mail is set to OFF, and the start and end tags 
in the selected range are set to the server’s 
maximum Tag Index.

In Detail Settings mode, math tags are not 
displayed.

--

Attached Files:, 
Range 

If the start tag exceeds the server’s maximum 
Tag Index, the inclusion of Alarm Information 
and Instantaneous Value is set to OFF.

If the start tag or end tag is outside the 
server’s tag range, the range is set to the 
server’s maximum Tag Index.

In Detail Settings mode, tags exceeding the 
server’s tag range are not displayed.

If both the start tag and end tag are math 
tags, the inclusion of Alarm Information and 
Instantaneous Value is set to OFF.

In Detail Settings mode, math tags are not 
displayed.

--

Access & Others -- -- --
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GA10
Settings

Functions not available on the import destination GA10 server

Custom Display functon  
(Option, /CG)

Integration Display function  
(Option, /WH)

GateSushi function
(Option, /SU)

Device -- -- GateSushi is not displayed in the Devices List.

Tag -- Integration Overflow is not displayed. --

Math Tag -- Integration Target is not displayed. --

Display
Display Group

-- -- The tag appears as None from Group 51 
onwards.

Display
Aquisition&Monitor

Register button is not displayed. -- --

Record

When Start Condition or Stop 
Condition is Alarm.

-- -- --

Integration -- Not displayed. --

FTP Report file is not displayed. -- --

Report/Print

When Task is Report Output.

-- --

E-Mail

TRIG:,  
Range

-- --

Attached Files:, 
Range 

-- --

Access & Others -- --
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  Chapter 3  Configuring and Starting Data Collection and Recording 

Copying and Pasting
 You can easily copy and paste projects.

1 From the list of projects, select the project that you 
want to copy.

2 On the Edit menu, click Copy, or press Ctrl+c on 
the keyboard.
The project is copied.

3 To paste the copied project, on the Edit menu, click 
Paste, or press Ctrl+v on the keyboard.
The project is pasted in the list.

Note
•	 The	copied	project	is	retained	until	you	log	out.
•	 When	you	import	or	paste	a	project,	if	the	original	

file is on the list, a serial number starting with 001 is 
added to the original project name.

Renaming a project
 To rename a project, follow the procedure below.

1 From the list of projects, select the project that you 
want to rename.

2 On the Project menu, click Modify Basic 
Information.
A Change project’s Basic Information dialog box 
appears.

3 Type the new project name or comment.

4 When you are finished, click OK.

The project name will change.

New name
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3.3.2 Registering Devices to Connect
After you create a project, register the devices to collect and record data from. The Device 
Setting Page that you use to register devices is composed of the following four areas.

Device information display area
   Displays information of the selected device

Online Devices List
   Online devices over Ethernet or serial communication

Devices List
Data collection devices

Registered Devices List
Devices registered in the server

Setting button

Show/Hide Detail button

•	 Devices	List
 List of target devices for data collection and recording.
•	 Registered	Devices	List
 List of devices registered in the GA10 server.
•	 Online	Devices	List
 List of online devices over Ethernet or serial communication.
•	 Device	information	display	area
 Information about the selected device.
•	 Setting	button
 Click to start the device setting page (Web application).

 :   “Starting the Web Application (GX/GP and GM)” on page 3-22
•	 Show/Hide	Detail	button
 Click to display detailed information about the selected device in a worksheet format. 

Click again to hide detail.
Description of the displayed detailed information:  See next page.

Device icons (shown in the following figure) display the devices’ information. These icons 
can be used to register and delete devices.

Selected Not selected

Communication address
Displays the host name or IP address

Device icon

Device name

Device number (displayed only on the Devices List)

Model nameFrame turns blue
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Displaying Detailed Information
When a device icon is selected from Devices List or Registered Devices List, click Show 
Detail to display the channel information of the device in a tabular format. Click again to hide 
detail.

No. Item Name Default Value Setting Description
1 Check box on/off On (Blue) Available When the check box is selected, it 

means that the channel is in use.
When set to “not use,” tags cannot 
be assigned on the GA10’s Tag 
Setting page.
Tags that are already assigned 
appear as “None

2 Used Cnannel No. Channel numbers of the device Not available
3 Tag No. Tag numbers of the device Not available
4 Tag Comment Tag comments of the device Not available
5 Type Tag data types Not available
6 Dec. Point Number of decimal places for tags Not available
7 MIN Minimum scale value set on the 

device
Not available

8 MAX Maximum scale value set on the 
device

Not available

9 Unit Scale unit set on the device Not available
10 Alarm Type Alarm type Not available

1 to 4 Value Input value Not available
11 Tool button

(collectively 
change 
between use 
and not use)

-- -- Selecting and clicking a line 
switches the channel of the 
selected line between use and not 
use (check box selected and not 
selected).

Note
•	 Setting	becomes	possible	only	when	a	device	from	the	Device	List	is	selected.
•	 Buttons	remain	disabled	when	a	device	is	selected	from	the	Online	Devices	List.
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Detailed Information of the WT3000/WT3000E
If the connected device is a WT3000/WT3000E, the measurement functions of the WT 
become the data (tag) that the GA10 collects. Measurement functions (hereafter referred 
to as “data”) vary depending on the model, the number of elements, and options of the 
WT3000/WT3000E (Table 1).

Item Name Default Value
Used Channel No. Assigned from 0001 up to 0251. (depending on the WT3000/WT3000E element and option 

configurations)
Tag No. Displayed in the following format: data group number: data name

In addition, “Total” and “dc,” which indicate the harmonic orders of harmonic data, are 
displayed as “TOT” and “DC,” respectively. For example, data “U” of data group “Element 1” 
is displayed as “1:U.” “1:U(Total)” is displayed as U(TOT) and “U(dc)” as “U(DC).”
For details, see the mapping in Tables 2 and 3 on the next page.

Tag Comment

Type FLOAT
Dec. Point 3
MIN -20.000
MAX  20.000
Unit For the unit of each type of data, see the mapping in Table 4 on the next page.
Alarm Type Blank
1 to 4 Value 0.000

Table1 Configuration table of WT3000/3000E elements, options, and data groups
Number of 
elements

Option Data group name

1 -- Element1
/G6 (Advanced Calculation) ElemHrm1
-- Other
/MTR (Motor Evaluation Function) Motor

2 -- Element1 Element2
/G6 ElemHrm1 ElemHrm2
-- SigmaA
-- Other
/DT (Delta Calculation Function) 1 Delta
/MTR Motor

3 -- Element1 Element2 Element3
/G6 ElemHrm1 ElemHrm2 ElemHrm3
-- SigmaA
-- Other
/DT Delta
/MTR Motor

4 -- Element1 Element2 Element3 Element4
/G6 ElemHrm1 ElemHrm2 ElemHrm3 ElemHrm4
-- SigmaA SigmaB
-- Other
/DT Delta
/MTR Motor

1 The Delta Calculation Function (/DT option) is a standard function on the WT3000E.
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Table2 WT3000/WT3000E data group and data, which become tags collected by GA10
Group Data name Group Data name Group Data name Group Data name
Element1 to 4 U ElemHrm1 to 4 U(dc) SigmaA to B U Other ETA1

I U(1) I ETA2
P U(Total) P ETA3
S I(dc) S ETA4
Q I(1) Q F1
Lambda I(Total) Lambda F2
PHI P(dc) PHI F3
fU P(1) F4
fI P(Total) F5
U+pk S(dc) F6
U-pk S(1) F7
I+pk S(Total) F8
I-pk Q(dc) F9
Time Q(1) F10
WP Q(Total) WP F11
WP+ Lambda(dc) WP+ F12
WP- Lambda(1) WP- F13
q Lambda(Total) q F14
q+ PHI(1) q+ F15
q- PHI(Total) q- F16
WS PHIU(3) WS F17
WQ PHII(3) WQ F18

Uthd F19
Ithd F20
Pthd

Delta DELTA1
DELTA2
DELTA3
DELTA4

Motor Speed
Torque
SyncSp
Slip
Pm

Table3 WT3000/WT3000E data group number mapping table
Group Data group number
Element1 to Element4 1 to 4
ElemHrm1 to ElemHrm4 1 to 4
SigmaA SIGM
SigmaB SIGMB
Other Omitted
Delta Omitted
Motor Omitted

1 These are omitted in the initial display of tags and tag comments.

Table4 WT3000/WT3000E unit mapping table
Data name Unit Data name Unit
U V q Ah
I A q+ Ah
P W q- Ah
S VA WS Vah
Q var WQ varh
PHI deg PHIU deg
fU Hz PHII deg
fI Hz Uthd %
U+pk V Ithd %
U-pk V Pthd %
I+pk A ETA1 %
I-pk A ETA2 %
Time sec ETA3 %
WP Wh ETA4 %
WP+ Wh Slip %
WP- Wh Others Blank
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Searching for Network Devices
Search for devices connected to the network to display 
them in the Online Devices List. Simply click the button to 
search and display the devices as icons in the list.

1 Set the search filter to Ethernet or Serial.

Search filter

2 Click Search.

The connected devices are detected and displayed 
in the Online Devices List.

Note
The icons of the following devices will not appear by 
searching. To add them to the project, use the Register 
Device button as explained in the next section.

Devices that cannot be detected on the Ethernet network
GX10, GX20, GP10, GP20 (up to R1.03.02)
DA100, DR130, DR230, DR240
DAQLOGGER, DAQ32Plus, MXLOGGER
WT3000, WT3000E (devices up to R6.20)
Devices defined using Modbus device definition files 1

GateSushi

Devices that cannot be detected through the serial interface
MX100, MW100
DAQLOGGER, DAQ32Plus, MXLOGGER
Devices whose baud rate is not 9600 bps, parity is not even, or 
stop bit is not 1.
Devices whose interface is RS-422 or RS-485

1	 Modbus	device	definition	file:	  Sec. 3.4

Registering Files to the Devices List

1 Select a device from the Online Devices List.

2 Click Register in the center of the page. Or, drag 
the device to the Devices List.

1. Select the device.

2. Click here (register button)

2. or drag

The details of the device that you are about to regis-
ter (Register Device dialog box) appear.

3 To register the device, click OK. To reselect a 
different device, click Cancel.
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  Chapter 3  Configuring and Starting Data Collection and Recording 

Registering Files to the Devices List (Register Device 
button)

To add a device using the Register Device button, follow 
the procedure below.

1 Click Register Device at the top of the Devices 
List. Or, double-click an empty icon in the Devices 
List.

Double-click

The initial page of the Register device dialog box 
appears.

2 Enter the information about the device to be 
registered.
For details on the input items, see the next page.
Because the available interface varies depending 
on the device that you are connecting, the 
communication parameters in the dialog box will 
change according to the device.

3 Click OK.
The device is added to the Devices List and Regis-
tered Devices List.

Note
To delete a registered entry, click the device icon to select 
it, and press the DELETE key or click the Delete button.

Registering Offline
Devices that are not connected to the network can be 
registered before they are connected.

1 Click Register Device. Or, double-click an empty 
icon in the Devices List.
A Register device dialog box appears.

2 In the Register device dialog box, enter the 
device name, and select the device type and 
communication kind.

3 If Comm. Kind is set to Serial, also select the 
communication type.

4 Click Offline Registration.
The device is registered.

Note
•	 Devices	that	are	registered	offline	are	registered	with	

channel set to 0 and no options.
•	 When	you	click	Update	Setting,	GA10	connects	to	the	

registered devices and updates the setting information 
of those devices. In addition, those devices are added 
to the Registered Devices List.

•	 If	a	registered	device	is	not	detected	on	the	network,	
none of the setting information of that device is 
updated. However, even in this case, the registered 
information will be retained.
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Adding Devices
To add devices to the Devices List, repeat the “Registering 
Files to the Devices List” procedure.

Note
If you move to another setting page, return to the 
Register Device Page, and add devices, a confirmation 
message (M1015) will appear when you try to move to 
another page.
Clicking OK will add the tag of the added device after the 
existing tags on the Tag Setting Page. Clicking Cancel 
will not add the tag.

Connectable Devices and Interfaces
The following table shows the devices that can connect to 
the GA10 and the interfaces that can be used.
When you are registering the device type on the Register 
device	dialog	box,	clicking	▼	will	show	the	following	
devices in the list.
The names shown in green cells are used when 
connecting to GA10s with the custom display function (/
CG option).

Supported Models
or Software Name

Interface 1

Serial USB
Ethernet 

(connection port 
number)

GM10 GM10 RS-
422/485 

only
Yes Yes 34434 3

GX10 2 GX10 Yes No Yes 34434 3

GX20 2 GX20 Yes No Yes 34434 3

GP10 2 GP10 Yes No Yes 34434 3

GP20 2 GP20 Yes No Yes 34434 3

GX/GP/GM
 (PID control module)

GXGPGM_
PIDSlot0 to 
GXGPGM_
PIDSlot9

RS-
422/485 

only

No Yes 502

DX1xxx DX1000 Yes No Yes 34260
DX2xxx DX2000 Yes No Yes 34260
CX1xxx CX1000 Yes No Yes 34260
CX2xxx CX2000 Yes No Yes 34260
FX1xxx FX1000/

FW1000
Yes No Yes 34260

FW1xxx FX1000/
FW1000

Yes No Yes 34260

MV1xxx MV1000 Yes No Yes 34260
MV2xxx MV2000 Yes No Yes 34260
MX100 Same as left No No Yes 34316
MW100 No No Yes 34316
μR10000 Same as left Yes No Yes 34260
μR20000 Yes No Yes 34260
DA100

Same as left

Yes No Yes 34150
DR130 Yes No Yes 34150
DR230 Yes No Yes 34150
DR240 Yes No Yes 34150
UT32A 4 UT32A

RS-
422/485 

only

No See 
note 4 502UT32A_R3 5

UT35A UT35A No Yes 502UT35A_R3 5
UT52A 4 UT52A No See 

note 4 502UT52A_R3 5
UT55A UT55A No Yes 502UT55A_R3 5
UT75A UT75A No Yes 502UT75A_R3 5
UP35A UP35A No Yes 502UP35A_R3 5
UP55A UP55A No Yes 502UP55A_R3 5
UM33A 4 UM33A No See 

note 4 502

Supported Models
or Software Name

Interface 1

Serial USB
Ethernet 

(connection port 
number)

UPM100 UPM100

RS-
422/485 

only

No See 
note 4 502

UPM101 UPM101 No See 
note 4 502

YS1500 YS1500 No Yes 502
YS1700 YS1700 No Yes 502
Modbus protocol 6
compatible devices
(including YOKOGAWA 
control instruments)

hardware
RS-

422/485 
only

No Yes 502

WT3000 7 WT3000 RS232C 
only

No Yes 10001
WT3000E 7 WT3000E No Yes 10001
GateWT for GA10 GateWT for GA10 No No Yes 50295 8

DAQLOGGER DAQLOGGER No No Yes 50280 8

DAQ32Plus DAQ32Plus No No Yes 50278 8

MXLOGGER MXLOGGER No No Yes 50284 8

GateSushi GateSushi No No Yes 34592 8

1 Yes: Supported  No: Not supported
2 The GX/GP version R1.03.03 and later supports auto searching on an 

Ethernet network.
3	 The	communication	port	can	be	specified	on	the	GX/GP,	but	GA10	only	

supports the default value, 34434.
4 Open network function is not built in. Ethernet connection requires VJET 

(Yokogawa Ethernet/RS485 adapter).
5 Model names with “_R3” correspond to SP and other output channels. 

When connecting to a GA10 with the custom display function (/CG option), 
use the ones with “_R3.”

6 Modbus protocol is not supported.
7 The WT3000 and WT3000E are precision power analyzers by Yokogawa 

Test & Measurement Corporation. Auto searching on Ethernet is available 
on R6.21 and later.

8	 A	port	number	must	be	specified	as	a	parameter	when	the	interface	is	
specified.	(The	port	numbers	in	the	table	are	default	values.)

Note
•	 GX/GP/GM_PIDSlot0	to	GX/GP/GM_PIDSlot9	are	

used to control from GA10s with the custom display 
function (/CG option) the output and the like of a GX/
GP/GM with PID control modules (GX90UT) installed.

 Related topic: page 7-4
•	 In	the	UTAdvanced	series,	model	names	with	“_R3”	

correspond to SP and other output channels. When 
connecting to a GA10 with the custom display function 
(/CG option), use the ones with “_R3.”
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  Chapter 3  Configuring and Starting Data Collection and Recording 

Register Device Dialog Box Details
The Register Device dialog box is used to register the 
devices that you want to connect to. The following figure 
shows the initial screen after you click the Register Device 
button.

No. Item 
Name How to Specify Default 

Value Description

1 Model 
name

Enter text.
(Input range: up to 
20 alphanumeric 
characters)

Device Enter the name of 
the device to be 
registered.

2 Device 
Type

Select from the list. DX1000 Select the name of a 
supported model or 
software from a list.

3 Comm. 
Kind

Select from the list.
(Selectable range: 
Ethernet, Serial, 
USB. But, depends 
on the model.)

Ethernet Select the interface 
from the list.
If Device Type is 
MX100/MW100, 
DAQLOGGER, 
DAQ32Plus, 
MXLOGGER, or 
GateWT, this is fixed 
to Ethernet.
USB is selectable 
only when Device 
Type is GM10.

4 Host 
name/
IP 
address

Enter text.
(Input range: up to 
255 alphanumeric 
characters)

Blank This appears only 
when Comm. Kind 
is set to Ethernet. 
Enter the host name 
or IP address of the 
device.

5 User 
Name

Enter text.
(Input range: up to 
63 alphanumeric 
characters)

Admin Customer information 
items appear in the 
following conditions.
When Comm. Kind 
is set to Ethernet, 
and Device Type is 
not DAQLOGGER, 
DAQ32Plus, 
MXLOGGER, 
GateWT, or a 
Modbus device
When Comm. Kind 
is set to Serial, and 
Device Type is GX10, 
GX20, GP10, GP20, 
or GM10

User ID Same as above Blank You need to enter 
this if the security 
settings on the device 
being registered are 
enabled. Otherwise, 
leave the user name 
(admin), user ID, and 
password blank, and 
click OK.

Password Same as above Blank

Representative examples for different interfaces and 
connected devices are provided below.

When connecting to DAQLOGGER, DAQ32Plus, 
MXLOGGER, GateWT

•	 Comm. Kind is fixed to Ethernet.
•	 Enter the IP address of the PC in which the software 

specified with Device Type is installed.
•	 To connect to DAQLOGGER or DAQ32Plus, leave the 

System No. at zero (default value).
•	 To connect to MXLOGGER, select the System No. that 

is being used in MXLOGGER.
•	 When connecting to GateWT for GA10, to display 

models after models numbered 02 under GateWT’s 
“WT Setting”, set System No. to None in the GA10’s 
Register Device dialog box. 

 Or, click the Register Device button, and specify the 
system number in the Register Device dialog box. 

 For models numbered 02 under GateWT’s “WT 
Setting”, set the System No. to 01. For example, for 
GateWT numbers 1, 2, 3, and so on, set the GA10’s 
system numbers to 0, 1, 2, and so on.

•	 To	start	GateWT	for	GA10,	right-click	and	choose	Run	
as administrator.

Note
When using GateWT for GA10, see the WX1 GateWT 
User’s Manual (IM No: IM WX1-03EN). Change the terms 
to read as follows:
 "GateWT" to "GateWT for GA10."
 "DAQLOGGER" to "Data Logging Software GA10"

Item Name How to Specify Default Value Description
6 Port No. Enter text.

(Input range: 
1025 to 65535)

See 
Connectable 
Devices and 
Interfaces.

This appears when 
Comm. Kind is set to 
Ethernet and Device 
Type is DAQLOGGER, 
DAQ32Plus, 
MXLOGGER, GateWT.

7 System No. Select from the 
list.
(Selectable 
range: None, 0 
to 60)

0 Same as above
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When connecting to a WT3000/WT3000E
•	 WT3000/WT3000E	can	be	connected	without	using	

GateWT for GA10. Select from the list of target 
devices.

•	 When	using	RS-232C	communication,	in	the	
WT3000/3000E settings, set MISC > Remote Control > 
Device > RS232 control as follows:

 Format (data format): 8-NO-1
 Rx-Tx (handshaking): NO-NO
 Terminator: Lf
•	 When	using	Ethernet	communication,	in	the	

WT3000/3000E settings, set MISC > RemoteControl 
> Network > UserAccount > Timeout to 30 seconds or 
longer. If the timeout is set to the default value (Infinite: 
no time limit), retrials when communication errors occur 
will not be performed.

Detailed information:  WT3000 Precision Power 
Analyzer Communication Interface (IM 760301-17)

When Comm. Kind is set to Serial

Item Name How to Specify Default 
Value Description

8 COM Port 
No.

Select from the list.
(Selectable range: 
1 to 20)

1 This appears when 
Comm. Kind is set to 
Serial or USB.

9 Comm. 
Type

Select from the list.
(Selectable range: 
RS-232C, RS-422/
RS-485)

RS-232C This appears when 
Comm. Kind is set to 
Serial.

10 Baud Rate Select from the list.
(Selectable range: 
9600bps,
19200bps, 
38400bps)

9600bps Same as above

11 Parity Select from the list.
(Selectable range: 
None, EVEN, ODD)

None Same as above

12 Stop Bit Select from the list.
(Selectable range: 
1 or 2)

1 Same as above

13 Address Select from the list.
(Selectable range: 
1 to 99)

1 This appears when 
Comm. Kind is set to 
Serial and Comm. Type 
is set to RS-422/RS-485.

When Comm. Kind is set to Serial and Device Type is 
a Modbus device

No. Item Name How to Specify Default 
Value Description

14 Modbus 
Address

Enter text. (Input 
range: 1 to 247)

1 This appears when 
Device Type is a Modbus 
device.

15 Monitor 
Interval

Select from the list.
(Selectable range:
100 msec, 200 
msec, 500 msec, 1 
sec, 2 sec, 5 sec, 
10 sec, 20 sec, 30 
sec, 1 min, 2 min, 5 
min, 10 min)

1 sec Same as above

16 Timeout Enter text.
(Input range: 100 
msec to 10000 
msec)

5000
msec

Same as above

17 Option Check box Not 
selected

Displays the optional text 
strings defined in the 
Modbus device definition 
file in the order that they 
were defined.

Note
•	 To	register	any	of	the	following	instruments	by	

specifying “Comm. Kind: Serial” and “User,” set the 
A/D scan interval and FIFO writing interval of the 
device to the same value.

 DX1000, DX1000N, DX1000T, DX2000, DX2000T, 
MV1000, MV2000, CX1000, CX2000, FX1000, 
FW1000

•	 When	connecting	to	a	DXAdvanced	(DX1000,	
DX1000N, DX1000T, DX2000, or DX2000T) with the 
/AS1 advanced security option through the Ethernet 
interface, log in as an administrator to access the DX.

 In this situation, only one administrator will be able to 
log in.

•	 When	connecting	an	UTAdvanced	device	(UT32A,	
UT35A, UT52A, UT55A, UT75A, UP35A, UP55A) to 
a GA10 with the custom display function (/CG option), 
select a model name with “_R3” from the list. (This 
corresponds to the SP or other output channel.)
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  Chapter 3  Configuring and Starting Data Collection and Recording 

Changing the Registration Information
 Select a device icon on the Devices List, and double-

click it. A Change Device's Basic Information dialog box 
appears. Edit the items you want to change.

 The items that you can change in this dialog box are 
the same as those in the Register Device dialog box 
when you register devices.

Select the device and double-click

Deleting a Registration
 To delete a registered device, click the device icon to 

select it, and click Delete on the Edit menu or click the 
Delete button.

 You can also select the device icon and press the 
DELETE key.

 If you click DELETE when no device icons are 
selected, all unused devices will be deleted.

Select the device to delete and click

Updating the Settings
If you change the device settings after registering it to 
the Devices List, click Update Setting. The most recent 
information will be retrieved from the device and applied.

click the Update Setting button.

Select the device, and

Important
If Tag No. and Tag Comment are already registered on 
the GA10 (version R2.01.xx or earlier), do not execute 
Update Setting. Doing so may erase the registered 
information.

Registering Devices to the Registered Devices List
The Registered Devices List shows a list of devices 
registered to the server. In the initial page, nothing will 
appear. When you add a new device to the Devices List, it 
is also automatically added to the Registered Devices List.
You can also drag a device from the Online Devices List 
to register it.

Display filter

Update

Click Update to retrieve the most recent list of devices 
from the server.
You can set the Comm. Kind filter to display only the 
devices using the specified interface. If you select Serial, 
the devices connected to the serial port of the server PC 
will be displayed.
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Starting the Web Application (GX/GP and GM)
Click Setting  in the device information display 
area to start the Web application for configuring devices.

1 In the Project List Page, double-click the appropriate 
project.

2 Change the project setting window to the Device 
Setting Page.

3 Select the icon of the device that you want to 
change the settings of.
The information of the selected device appears in 
the bottom device information area.

4 Click Setting in the device information area.
The corresponding setting Web page will appear in 
Windows Internet Explorer.

For instructions on how to use the Web application, see 
the GX/GP User’s Manual (IM 04L51B01-01EN) or the 
GM User’s Manual (IM 04L55B01-01EN).
URL: www.smartdacplus.com/manual/en/

Limitations on the Device Setting Page
•	 The following operations cannot be executed on 

the Device Setting Page while data collection is in 
progress.

•	 Register	devices	from	the	Registered	Devices	List	to	
the Devices List

•	 Register devices from the Online Devices List to the 
Devices List

•	 Register	a	new	device	on	the	Devices	List
•	 Change	device	registration	positions	on	the	Devices	

List
•	 Delete	registered	devices	from	the	Devices	List
•	 Change	the	settings	of	devices	on	the	Devices	List

•	 The Web application can be started only when the 
connected device is GX/GP and the interface is 
Ethernet.

•	 If multiple devices use the same COM port, observe 
the following rules.

•	 Do	not	mix	Modbus	devices	with	other	devices.
•	 Use	the	same	communication	type.
•	 Use	the	same	settings	for	baud	rate,	parity,	and	stop	

bit.

http:www.smartdacplus.com/manual/en/
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 Chapter 3  Configuring and Starting Data Collection and Recording

3.3.3 Setting Tags
GA10 collects and records data from multiple connected devices. Tags are assigned to 
channels of connected devices for identification.
After registering devices in a project, when you open the Tag Setting Page for the first time, 
the channels of registered devices are assigned automatically to the tags as default values. 
You can edit them to customize the data collection.

Basic Operation

1 Select Tag in the navigation area on the left of the window.
The Tag Setting Page appears.

2 Select a tag to use in data collection or recording (1 line = 1 tag = 1 channel).
 Click the check boxes in the Monitor or Record column.
	 To	select	consecutive	boxes,	click	the	first	cell,	and	then	click	the	last	cell	while	

holding down the SHIFT key.

3 Set the tags.
 Clicking a cell in a column other than Collect or Record displays a list box or a win-

dow containing options. Select the desired setting. For the Tag No. and Tag Com-
ment cells, type text strings.

 The type and value of alarms 1 to 4 are view only.

 On models with the integration display function (/WH option) 
	 To	use	the	specified	integration	overflow	values	in	integration	calculation,	click	the	
Specify	box	in	the	Integration	Overflow	column,	and	set	the	value.

4 Register the alarm sound file to assign to the tag.
	 Alarm	sounds	are	.mp3	files.	Up	to	20	files	can	be	used.
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Select the 
number of 
decimal places.

Select the 
tags to use.

Select the device for the assigned channel.
Select the channel to assign.

Select the data type.

Select the 
alarm sound.

Type the tag number and 
comment string.

Tag selection state. Click again to switch.

Set the integration overflow.

Setup Item
Tag settings are used to set display groups and other settings in a project. Therefore, even if 
you change the device channel assigned to a tag, there is no need to change display group 
settings or other settings that use tags.

⑨

The tag settings are explained below.
(1) Monitor (tag index)
 These are unique tag numbers assigned sequentially starting with 0001. You cannot 

change the numbers. Click the boxes to specify whether to enable data monitoring.

(2) Record
 Click the boxes to specify whether to enable data recording.

(3) Device
 Specify the names of the devices to assign to the tags.

(4) Channel
 Specify the channels to assign to the tags. Clicking a button displays a separate window. 

Select a channel number to apply it to the sheet.

(5) Tag No. and Tag Comment
 Enter aliases for the tags as tag numbers and tag comments. Specify up to 16 characters 

for tag numbers and 32 characters for tag comments. You can select which name to 
display (Tag Index, Tag No., or Tag Comment) to suit your purpose. To select which name 
to display, on the View menu, click Tag Display Form.
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 Chapter 3  Configuring and Starting Data Collection and Recording

(6) Type
 Specify the tag data types. Click the arrows, and select from the following data types.

Data Type Description
ANY Any data type
BOOL Boolean
SHORT 2-byte signed integer
USHORT 2-byte unsigned integer
LONG 4-byte signed integer
ULONG 4-byte unsigned integer
FLOAT 4-byte single-precision floating-point number
FLOAT(LOG) Data type for LOG input channels 1

LOG (Old) Data type for LOG input channels (DXAdvanced series)
LOG Data type for LOG input channels (FX1000 series, FW1000 series)

 Refer to the following table for the data types of the channels on data source devices.

Model Channel Type Data Type
DAQLOGGER
DAQ32Plus
MXLOGGER

All channels Undefined (LONG, FLOAT, or 
LOG)

GX/GP
GM

Measurement channels (excluding DI),
math channels, communication channels

LONG

DI channels BOOL
Measurement channel whose input type is LOG *1 FLOAT(LOG)
Excluding the above Same as "Other"

Devices defined using Modbus 
device definition files

All channels Data types of registers defined 
in the Modbus device definition 
file are retained and used for 
displaying and recording.
Data type mapping table : 
“Data Types” on page 3-67

Other Measurement channels SHORT
Math channel LONG
Control channel SHORT
Extra channel SHORT
Math channel whose input is LOG LOG

1 For GX/GP firmware version R2.01 or later with the Log scale option (/LG).

(7) Dec. Point
 Specify the number of decimal places for tags. Click the arrows to select the number of 

digits (0 to 5).
 Select the same setting as the decimal place setting specified on the device. Specify ANY 

to retrieve the decimal place information from the device at the start of data collection.
(See below.)

 Type, Dec. Point, and ANY
•	 GA10 can continue data collection even if you change the connected device in 

the middle of data collection as long as the Type and Dec. Point settings are the 
same. For example, assume you set the tag Type to SHORT. If another device is 
connected in the middle of data collection (for maintenance or other purpose), as 
long as the measurement channels use the same Type and Dec. Points settings, 
you can continue data collection.

•	 You can select ANY if you want to retrieve the channel information from the device 
at the start of data collection and use those settings to perform data collection. 
However, if the data collection time is set to PC time and the device is not 
connected within 3 seconds after the start of data collection, the channel information 
will not be retrieved at the start of data collection even if ANY is specified.

•	 In this situation, the channel information that was retrieved from the device at the 
time of device registration is used. This is not a problem as long as the channel 
information at the start of data collection is the same as the channel information that 
was retrieved from the device at the time of device registration.

•	 Using ANY makes the data type and decimal place settings easier. However, you 
cannot verify the actual data type.

  Related topic:   “Q11” on page 14-11
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Note
•	 If	the	data	collection	channel	is	LOG	input,	set	the	data	type	to	LOG.	If	set	to	LOG,	the	decimal	

place setting is void.
•	 If	the	data	type	is	set	to	BOOL,	the	decimal	place	setting	is	void.

(8)  Specifying whether to use overflow values of integration targets and 
specifying integration overflow values (/WH option) 

	 You can set the overflow values for each calculation target that are used when an 
overflow occurs in an integration calculation. 

 If the use of overflow values is specified, the set overflow values are added as they are. 
 If the use of overflow values is not specified, the overflow values are calculated 

automatically and used in the integration calculation. 
 You can set the values in the range of 1 to 1,000,000,000.

 Integration overflow 
	 If	the	integration	value	that	the	device	is	measuring	exceeds	the	maximum	measuring	
range	of	that	device	(e.g.,	99999999),	an	overflow	occurs,	and	the	integration	value	is	
reset	to	zero.	

	 The	integration	calculation	computes	the	integration	value	per	unit	time	from	the	
integration	value	of	each	scan	interval,	so	if	an	overflow	occurs,	integration	calculation	is	
performed	by	adding	the	integration	overflow.

(9) Type, value, and sound of alarms 1 to 4
 You can assign an alarm sound to each tag.
 The type and value of an alarm are those assigned to the device and cannot be changed.
 The alarm sound settings and alarm sound files are saved in the project file.

Alarm sound Description
None This is when an alarm type is not assigned.
Standard If an alarm type is assigned, this is the GA10’s standard alarm sound.
Alarm sound file If an alarm type is assigned and alarm sound files are registered, file names are displayed 

for you to select from.

Registering and deleting alarm sound files
Alarm sound files can be uploaded to the server, downloaded from the server, or deleted.

•	 Upload
 Click a number, click Upload, and specify an .mp3 file.
•	 Download
 Click a number, click Download, and specify the client’s save destination to save the file.
•	 Delete
 You can select alarm sound files registered in the server. Click a number, and click Delete 

to delete the file.



3-27IM 04L65B01-01EN

C
onfiguring and Starting D

ata C
ollection and R

ecording

1

2

3

4

5

6

7

8

9

10

11

12

13

14

App

Index

  Chapter 3  Configuring and Starting Data Collection and Recording 

WT3000/WT3000E Tag Setting Page
When the connection target is the WT3000/WT3000E, the 
WT3000/WT3000E data group and data become the tags 
collected by GA10. The following table shows the items on 
the Tag Setting Page. For details, see the relevant tables 
in  “Detailed Information of the WT3000/WT3000E” on 
page 3-14.

Data Type Description
Monitor
Record Same as other devices
Device
Channel Assigned from 0001 up to 0251. (depending on the 

WT3000/WT3000E element and option configurations)
Tag No.
Tag Comment

Displayed in the following format: data group number: 
data name
For example, data “U” of data group “Element 1” is 
displayed as “1:U.”
For details, see the mapping on page 3-13.

Type FLOAT
Dec. Point 3

Editing Tags
Clearing, Deleting, and Inserting Rows
To clear, delete, or insert tag setting data (row), select the 
target rows, and then click the appropriate button.
You can select rows by clicking the left edge of rows (the 
numbers of Monitor tags).

Button Result
Clear Click to delete the settings of the selected rows 

and initialize the items.

Delete Click to delete the tag settings of the selected 
rows and shift up.

Inserting Rows Click to insert tag information (default values) for 
the selected number of rows.

Collectively Editing Tags
To collectively edit setup data, you must select the target 
setup data and then click a button on the action bar, 
which is at the bottom of the window. The result varies 
depending on the type of icon you click on the action bar 
(see the following table).

Type Name Result
Enable or 
disable

Switches the check box state between 
selected and unselected.
If all the data values in the selected range are 
the same, clicking this icon will switch all of 
them in the same way.
If the data values in the selected range are 
not all the same, clicking this icon will switch 
all of them to match the first data value in the 
selected range.

Increment Assigns increasing channel numbers starting 
with the first tag in the selected range.

Copy Copies the settings of the first tag in the 
selected range to the other tags in the 
selected range.

Copy flag Switches between selected and unselected 
states for items to be pasted when copying 
setup data. The items are normally selected 
(pasted).
Clicking this button causes the corresponding 
item to become unselected. The item will not 
be pasted.

You can also copy and paste selected content using the Edit 
menu.
To select the range of setup data, follow one of the 
methods below.
•	 Select by dragging

 Click the first line you want to select. Drag to the 
last line you want to select and release the mouse 
button.

•	 Select using the Shift key
 After selecting the first line you want to select, hold 

down the Shift key, and click the last line you want to 
select.

•	 Select all lines
 Click the title area of the Monitor column to select 

all setup data.
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Collective Editing

1 Select the rows that you want to edit collectively.
(1) Click the left edge of the first row.

(2) Drag and release.

2 Click an icon at the bottom for the column that you 
want to edit.
The values in the selected range will be changed.

Sorting tags in order of the device No.
The specified tags can be sorted in order by device 
number registered in the Devices List (first precedence) 
and by channel number of each device (second 
precedence). On the Project menu, click Sorting tags 
in order of the device No. Or, click the  icon on the 
toolbar.

Note
Sorting is not applied to math tags (/MT option).

When you perform Sorting tags in order of the device No., 
various settings are arranged as follows.
•	  Tag settings (Tag No., Tag Comment, Type, Dec. 

Point) remain the same.
•	 Display Group: Remains the same.
•	 Record: Tag indexes (fixed sequence) are changed. If 

a tag range is specified, the numbers are sorted while 
maintaining the range position.

•	 Report/Print (/RP option): Tag Index numbers are 
changed.

•	 Mail: Tag indexes are changed. If a tag range is 
specified for Trigger, the numbers are sorted while 
maintaining the range position. At this point, the Trigger 
setting changes from Easy to Detail.

Exporting and Importing Tags
Tag information can be converted (exported) to a TSV file 
You can edit the TSV file using an appropriate software 
application and load (import) it back into GA10.

Note
Only tag numbers and tag comments are exported and 
imported.

•	 Export Procedure

1 Display the Tag Setting Page of the project whose 
tag information you want to save.

2 On the File menu, click Export tags.

3 Select the save destination, assign a name, and 
save it.
The	tag	information	file	(.tsv	extension)	is	saved	to	
the	specified	location.

 Tag numbers and tag comments are exported in 
pairs in separate lines as shown below.

•	 Import Procedure

1 Display the Tag Setting Page of the project whose 
tag information you want to update.

2 On the File menu, click Import tags.
An Open dialog box appears.

3 Select the file that you want to import, and click 
Open.
The	content	of	the	imported	tag	information	TSV	file	
is applied to the Tag Setting Page.
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  Chapter 3  Configuring and Starting Data Collection and Recording 

Update Tag Information (Refresh)
The tag information on the Tag Setting Page is updated in 
the following situations.
•	 When a channel (device) is changed on the Tag Setting 

Page
 If you change the channel (or device) on the Tag 

Setting Page, Tag No., Tag Comment, Type, and 
Dec. Point are retrieved from the specified channel.

Channel change

Updated with the information of the new channel

•	 When monitoring is started
 At the start of monitoring (when the device is 

connected), the most recent channel information 
is retrieved from the device, and the alarm value, 
range, and unit are updated. These are entered 
in the recording data file at the start of recording. 
However, if PC time is specified and connection 
cannot be established with the device even after 
3 seconds passes after the start of monitoring, 
tag information is not updated, and the channel 
information of the device already registered is used.

•	 When tag information is changed manually
 If the tag information is changed on the connected 

device side, you can update the tag information 
by clicking Update Tag Information on the Project 
menu. The information to be updated can be 
selected from a submenu.

Sub Menu Description
Tag No., Tag Comment Update Tag No. and Tag Comment to 

the latest information on the connected 
device side.

Except Tag No., Tag Comment Update Type and Dec. Point to the latest 
information on the connected device 
side.

1 Open the project that you want to change the tag 
information of.
•	 Open	the	project	with	manager	or	higher	access	

privileges (privileges that allow setting operation).
•	 Only	projects	in	which	data	monitoring	is	stopped	can	

be used.

2 Select Tag in the navigation area on the left of the 
window.

A Tag Setting Page opens.

3 Select the tags you want to update.

Selected range

4 On the Project menu, click Update Tag 
Information. Then, click the information to update 
on the submenu.
A	confirmation	message	appears.

5 Click OK.
Type and Dec. Point information of the selected tags 
is updated.

Note
•	 Even	if	you	execute	Update	Tag	Information,	the	tag	

settings specified on the GA10 are not changed.
•	 In	following	situations,	an	error	message	will	be	

displayed.
•	 Some	of	the	connected	devices	cannot	communicate	

with the server.
•	 The	number	of	registered	devices	on	the	server	is	at	

the maximum.
•	 If	the	A/D	scan	interval	and	the	FIFO	writing	interval	

of the device are not the same, the following devices 
cannot be updated by a “user.” To update, log in as an 
administrator.

 DX1000, DX1000N, DX1000T, DX2000, DX2000T, 
MV1000, MV2000, CX1000, CX2000, FX1000, 
FW1000
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3.3.4 Setting Display Groups
The GA10 Monitor Page can display multiple channels in groups.
The Display Group Setting Page is used to group channels and set the tag data display 
method. The Display Group Setting Page consists of multiple tabbed pages. Each tabbed 
page shows the settings of each waveform in rows and the setup items in columns.

Action bar: Use to collectively edit the settings 
 of the selected lines.

Scroll bars

Displays the waveform of the select number

1 2 3

Basic Operation

1 Select Display Group in the navigation area on the left of the window.
The Display Group Setting Page appears.

2 Click the tab of the group you want to configure.

3 Edit the setup data. Click the No. cells (left-most column) to show or hide the 
waveforms.

   Details of settings:  The details are provided on the next page and subsequent pages. Use 
the numbers in the figure to reference the corresponding descriptions.

Note
On the initial Display Group Setting Page, tags are assigned automatically for each device (when 
there are tags specified as data collection channels on the Tag Setting Page).
If you want to perform Assign Tag Automatically again, do this first before setting the displays.
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 Chapter 3  Configuring and Starting Data Collection and Recording

Group tab number
Specify the group name.

Waveform 
No.

Specify the Y-axis. Select fixed point 
or floating point display.

Meter typeSpecify the tag to assign to the waveform. Type the display
range.

Specify the Y-axis grid line spacing.
Trip line settingsWaveform display position

Waveform color

Setup Item
(1) No.
 These are waveform numbers assigned sequentially starting with W01. You cannot 

change the numbers. Click the boxes to specify whether to display the waveform.

(2) Tag
 Specify the tag to assign to the waveform. Clicking a button displays a separate window 

(figure below). Select a tag number to apply it to the sheet. If you select the “Show 
[Device No.: Device Name: Channel No.]” check box, the following information is 
displayed after the tag number.

Displays tag information after the tag number.

 Device No.: Displays the number in the GA10 Devices List.
 Device Name: Displays the first 9 characters of the device name assigned on the GA10 

Tag Setting Page.
 Channel No.: Displays the channel number of the connected device.

(3) Y-Axis
 No.: Specify the Y-axis to use in the waveform display.
 Mode: Select Detail or Compact mode.
 Type: Specify the type of scale to add to the Y-scale of the waveform. Select Linear or 

Logarithmic.
 Title: Type the Y-axis title of the waveform. Enter up to 30 characters.

(4) Form.
 Set the display format on the Monitor Page to fixed point or floating point.
 F: Fixed point display
 E: Floating point display
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(5) Meter
 Specify the type of meter to display on the Meter Monitor. Select bar meter  or analog 

meter .

(6) Scale MIN and MAX
 Type the minimum and maximum values of the scale on the Monitor Page to define the 

display range.
(7) Scale Interval
 Set whether to specify the Y-axis scale interval of the waveform. Leave unselected to use 

the default scale interval. To specify the scale interval, select the check box and enter a 
value.

(8) Zone
 MAX: Specify the maximum Y-axis position for displaying the waveform.
 MIN: Specify the minimum Y-axis position for displaying the waveform.
 This determines the waveform display position.

(9) Color
 Specify the waveform display color. To change the color, click the appropriate cell to 

display a separate window. Select a color to apply it to the sheet.

(10) Trip
 Use: Click to use the waveform trip line.
 Value: Type the value.
 Color: Specify the trip line color. To change the color, click the appropriate cell to display a 

separate window. Select a color to apply it to the sheet.
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  Chapter 3  Configuring and Starting Data Collection and Recording 

Collectively Edit Setup Data
To collectively edit setup data, you must select the target 
setup data and then click a button on the action bar, 
which is at the bottom of the window. The result varies 
depending on the type of icon you press on the action bar 
(see the following table).

To select the range: The procedure is the same as 
explained on  “Editing Tags”

Type Name Result
Show or hide
Enable or disable
F-Type/E-Type

Switches the check box state between 
selected and unselected.
Switches the item selection state.
If the data values in the selected range 
are not all the same, clicking this icon will 
switch all of them to match the first data 
value in the selected range.

Increment Assigns increasing tag index numbers 
starting with the first tag in the selected 
range.

Default Resets the value to default.

Y-axis grouping
(unit)

Groups Y-axes whose unit is the same 
together.

Y-axis grouping
(unit & scale)

Groups Y-axes whose unit and scale value 
are the same together.

Copy Copies the settings of the first tag in the 
selected range to the other tags in the 
selected range.

Copy flag Switches between selected and 
unselected states for items to be pasted 
when copying setup data. The items are 
normally selected (pasted).
Clicking this button causes the 
corresponding column to become 
unselected and will not be pasted to.

You can also copy and paste selected content using the Edit 
menu.

Assigning Tags Automatically
Tags assigned on the Tag Setting Page can be assigned 
automatically to display groups.
There are two methods for automatic assignment.
•	 Assign According to Tag Number

 When you specify the number of tags to assign to 
each display group, the specified number of tags are 
assigned in order from the first number of display 
group 1 on the Tag Setting Page.

 For example, if the total number of tags is 50 and 
you set the number of tags to 10, 10 tags will be 
assigned to each group from Group 1 to 5.

 If the Math function (/MT) is installed, math tags will 
be assigned in order after tags are assigned.

•	 Assign According to Device
 The tags of a single device are assigned to each 

display group. For each device (device number) 
that a tag has been assigned to, assign the tag to 
a display group. Tags are assigned in ascending 
order by device number starting with display group 
1. Within a display group, tags are assigned in 
ascending order by tag number.

 If the number of tags of a device is greater than the 
number of waveforms in a display group, multiple 
display groups will be used for the device.

Note
•	 When	you	assign	tags	automatically,	the	settings	of	

all display groups are reset to their default conditions. 
After automatic assignment, you must configure the 
settings again.

•	 Tags	that	are	automatically	assigned	are	those	whose	
Monitor item is selected on the Tag Setting Page and 
whose channel is specified.

•	 Math	tags	are	assigned	automatically	using	Assign	
According to Tag Number.

•	 Automatic Assignment Procedure

1 On the Project menu, click Assign Tag 
Automatically.
An Assign Automatically dialog box appears.

2 Select the assignment method.

To assign according to 
device, do not change.

3 To assign according to tag numbers, select Assign 
According to Tag Number and type the number of 
tags to share in each group.

4 Click OK.
All display group settings are initialized, and tags 
are assigned to display groups on the Display Group 
Setting Page.
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3.3.5 Registering Data Collection Method and Monitor Page
After setting the display groups, register the data collection method and monitor page.
Data collection is performed for tags that are set to collect data on the Tag Setting Page.
On the Acquisition & Monitor Page, set the data collection conditions, namely the type of 
timestamps to attach to data and data collection interval. In addition, specify the number of 
windows to divide the Monitor Page into and their layout.

Area for setting the MonitorArea for setting data 
acquisition conditions

1 2 3

Basic Operation

1 Select Acquisition&Monitor in the navigation area on the left of the window.
The Acquisition&Monitor Page appears.

2 Set the data acquisition conditions, namely the type of timestamps to attach to data 
and acquisition interval.

3 Configure the Monitor Page (monitor type, layout, etc.).

The Acquisition&Monitor Page is divided into two areas: an area for setting data acquisition 
conditions and another for configuring the monitor. The details of each are provided in 
the following pages. Use the letters (a to j) in the figure to reference the corresponding 
descriptions.

Acquisition area
a: Data time c: Pre-set mark

b: Monitor interval
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Setting Data Collection Conditions
a Data time
 Timestamps are attached to data that GA10 collects from devices. You can set the type 

of timestamp to use to Device time or PC time. Device time is the time information that 
the data collection device uses. PC time is the time information that the PC in which the 
server is installed uses.

If Device time is selected
 By selecting Device time, you can synchronize the data in GA10 with the data in the 

corresponding device.
 In addition, the backfill function becomes available.
 However, if data is collected from multiple devices, time offset can occur between the 

devices and the collection interval may be different. In other words, data cannot be 
collected simultaneously with synchronized timestamps.

 Moreover, if you are using the multi batch function, the backfill function will not work.
 Operating conditions of the backfill function:  “Q4” on page 14-7

Important
The Math function (/MT option) and the Anomaly detection function do not work when Device 
time	is	in	use.	If	you	change	to	Device	time	after	setting	these	functions,	a	confirmation	
message appears, so click Cancel. If you click OK, the changes are applied, and the Math and 
Anomaly detection settings are disabled.

Note
Data collection using device time has the following limitations.
•	 You	cannot	specify	the	data	collection	and	record	interval	on	GA10.	The	acquisition	interval	of	

each device is used.
•	 If	different	acquisition	intervals	are	used	during	recording	in	different	devices	or	even	within	the	

same device, the collected data will be saved to separate files according to the intervals.
•	 The	trend	monitor	on	the	Monitor	Page	displays	data	based	on	a	single	time	axis.	Therefore,	if	

there are multiple devices whose time or interval is different in a display group, the Monitor Set 
will be divided and waveforms in the display group will be displayed in windows divided at the 
interval level. Only up to four divided windows can be displayed. Anything in excess will not be 
displayed.

•	 A	similar	behavior	will	also	occur	in	alarm	lists.	The	page	will	be	divided,	and	the	lists	will	be	
displayed separately at the device level. If there are multiple acquisition intervals in the same 
device, the page will not be divided at the interval level but at the device level.

If PC time is selected
 If PC time is selected, data will be created using synchronized timestamps. You can 

specify the data collection interval and record interval, and save data to a single data file 
during recording. There are no display limitations on the Monitor Page.

Note
•	 Data	collected	using	PC	time	will	not	necessarily	be	the	same	as	those	of	the	corresponding	

devices:
   “Q9” on page 14-10
•	 The	timestamps	attached	to	data	in	PC	time	mode	are	determined	so	that	data	collection	would	

always occur at 0:00 am (00:00:00).

The difference between setting the Data time to PC time and setting the Data time to Device 
time is also described in “Q12” on page 14-11.

b Monitor Interval
Click the arrow, and select from the following intervals. If Data time is set to Device time, you 
cannot specify the Scan Interval.
 Interval:  100 Millisecond, 200 Millisecond, 500 Millisecond, 1 Second, 2 Second, 5 

Second, 10 Second, 20 Second, 30 Second, 1 Minute, 2 Minute, 5 Minute, 10 
Minute
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Note
Data update interval of the monitor screen depends on the data acquisition interval as follows:
Data acquisition interval Data update interval of the monitor screen
Less than 100 ms 100 ms
100 ms - 10 s As specified
20 s or more Half the specified interval (i.e., 10 seconds if 20 seconds is specified)

c Pre-set mark
Specify text strings to assign to marks if you want to add marks on the Trend Monitor Page.
You can assign up to 16 characters to each mark. You can register up to five marks.
When you register text strings here, they appear in a list on the Monitor Page as shown 
below, allowing you to easily add marks.

they appear in the mark list on the Monitor Page.

When you register text strings here, 

If you click , the mark appears on the monitoring page.
And if you click , the marks appear on all monitoring pages.

Monitor area

d: Monitor Data Set Number
e: Split Screen Direction

f: Set Number in 
   Splitting Direction

g: Split Screen Data Set

h: Resize the Monitor Set
i: Alarm Shape

j: Alarm Color
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Configuring the Monitor Page
The GA10 Monitor Page can display four types of displays trend, digital, meter, and alarm 
as well as integration graph display and demand monitor display (on models with the /WH 
option) (referred to as monitor sets). A total of up to 16 monitor sets can be arranged on the 
Monitor Page.
To display multiple Monitor Data Sets simultaneously, specify how to divide the page and 
where to arrange each Monitor Data Set.
When you specify items d to g below, a display layout appears in the Monitor Set Layout 
area. By dragging the splitters that appear between rows and columns when you move the 
pointer over the boundaries, you can adjust the size of Monitor Data Sets.

d Monitor Data Set Number
 Select a number between 1 and 16.
e Split Screen Direction
 Set the direction to arrange the Monitor Sets to Horizontal or Vertical.
f Set Number in Splitting Direction
 Select a number between 1 and 16. Options that exceeds the Monitor Data Set Number 

are not displayed.
g Split Screen Data Set
 Assign Trend, Digital, Meter, Alarm, Integration graph and Demand monitor (/WH option) 

to each Monitor Data Set.

The Monitor Data Sets can be arranged vertically or horizontally on the page.
The following figure shows the layout when the Monitor Data Sets are arranged horizontally. 
The number of vertical divisions is determined by the number of Monitor Data Sets in the 
horizontal direction and the total number of Monitor Data Sets on the entire Monitor Page. 
(When arranged vertically, the horizontal and vertical arrangement of the Monitor Data Sets 
is swapped.)

Horizontal splitter: 
The boundary of the 
divided areas can be 
moved up and down.

The last row is divided equally when the page is divided into 15 monitors.

Vertical splitter: 
The boundary of the 
divided areas can be
moved  left and right.

h Resize the Monitor Set
When set to On, you can make fine adjustments to the arrangement also on the Monitor 
Page.
i Alarm Shape
You can set the shape of the alarm display area to circle (¡) or rectangular (¨).
j Alarm Color
You can change the color that appears when alarms are active (On) and when alarms are 
inactive (Off). Clicking a color displays a Color Setting dialog box where you can select the 
color.
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3.3.6 Configuring the Anomaly Detection Function
Configure the settings for using the anomaly detection function. The anomaly detection 
function is run at the display group level. In the anomaly detection settings, set the display 
group for which you want to run the anomaly detection. 
If there is only one tag assigned to the display group, the analysis result is only for that tag; if 
there are multiple tags assigned, the analysis result is for all of the combined data.
For details on the monitor page, see section “6.13 Using the Anomaly Detection 
Function” on page 6-23.

Note
When using anomaly detection, set 10 seconds or more for the monitor interval. If you set less than 
10 seconds, anomaly detection is not run.
For details on the monitor interval, see section  “3.3.5 Registering Data Collection Method and 

Monitor Page” on page 3-34.

1 Select Analysis > Anomaly detection in the navigation area on the left of the window. 
A page to set the display groups for anomaly detection appears.

  

2 Select the check boxes of the display groups that you want to configure.

Item How to Specify Default Value Description
Display Group Check box Off Display the display group.

This selects whether to use the anomaly detection function 
by specifying On or Off. 

Type Fixed Anomaly 
detection

This selects the module to learn and determine anomaly 
detections. 

Detection level Select from the list Standard This sets the standard detection threshold when detecting 
anomalies and determining "whether to send the result or 
not".
Standard:  Notifies that there is an anomaly if the detection 

score value is smaller than 0 (negative). 
High:  Notifies that there is an anomaly if the detection score 

value is smaller than 1.

About the anomaly detection function
Anomaly detection is a function that learns from a set of data that has been accumulated 
over a period of time and detects "statuses that are different than usual" based on the 
learning outcome. The function can learn from normal data derived from regular operations. 
You do not need to prepare error data for learning in advance. In this document, the learning 
outcome is called the learning model.

Anomaly detection unit
In GA10, the anomaly detection function is run at the display group level. A learning model 
is determined from the collection of data that has been accumulated within a display group. 
Anomaly is then detected for that group based on the learning model. 
Example: If a display group has 3 tags, learning and detection is made based on the data 
collected from the 3 tags.
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Behavior of the anomaly detection function
The following table shows the four statuses of the anomaly detection function.
Anomaly detection 
status Explanation

No analysis Anomaly detection is not run. 
Learning The system is learning how to detect anomalies. 

If any of the following applies, the status becomes Learning: 
•	Anomaly	detection	was	ran	for	the	display	group	for	the	first	time.
•	The	period	was	changed	for	the	display	group	in	the	learning	period	dialog	box.

Detection The system is detecting anomalies. 
The detection is run per monitor interval. 
Display groups that have been studied are moved to the Detection status according to 
the determined learning model and are not studied again. However, if you have changed 
the period from the learning period dialog box, the group returns to Learning status and a 
learning model is determined once again. 

Analysis error This happens when there is too much invalid data that cannot be used for learning, so a 
learning model cannot be determined. The system moves to this status when the learning 
period is over. 
Invalid data refers to the following: 
•	Error	data:	Sec. 6.9.2
•		The	value	is	significantly	out	of	the	range	of	the	collected	data	that	was	expected	for	the	

operation.
The system does not study the data again automatically, so specify a learning period that 
does not include invalid data as much as possible and study the data again.

The following image shows the behavior of the anomaly detection function.

Start of the learning End of the learning

No analysis Learning Detection

Period of time required to learn the data
The learning period is determined by the monitor interval and the number of tags in the 
display group. 

[When the period has not been specified (initial values)]
 The appropriate learning period is set as the initial value based on the following formula: 

 Monitor interval x No. of tags in the display group x 200
 E.g.  If the monitor interval is 10 seconds and there are 3 tags, learning is conducted 

for 100 minutes. 
 However, there is a limitation to the maximum period. 
 If there are 17 or more tags in the display group, the learning period is calculated as if 

there are 16 tags, and you cannot set a longer learning period than that. 

[When the period has been specified]
 The specified range is set as the learning period. 
 However, there are limitations to the minimum and maximum periods. 
 The minimum period is determined using the following formula and you cannot set a 

shorter period as the minimum period: 
 Monitor interval x No. of tags in the display group x 100
 E.g.  If the monitor interval is 10 seconds and there are 3 tags, 50 minutes or more 

must be set as the learning period. 
 For the maximum period, if there are 33 or more tags in the display group, the learning 

period is calculated as if there are 32 tags, and you cannot set a longer learning period. 
The system finishes learning faster than the specified period and moves to the detection 
phase.
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Detection result
The detection result is stored with the following scores inside the software. 
Anomaly detection is notified using the group highlight display function based on these 
scores and the configured detection level.
Score Detection level: Standard Detection level: High
1 or more Determined to be normal. No notification is sent.
0 or more, but less than 1 Determined to be normal. No notification is 

sent.
Determined to be an anomaly. A notification 
is sent.

Less than 0 Determined to be an anomaly. A notification is sent.

The score cannot be monitored regularly, but if you have the Math function (/MT option), you 
can monitor the score as math tag data using the HealthScore calculation. The data items 
that can be monitored are the scores shown in the previous table.
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3.3.7 Setting the Data Recording Method
GA10 saves the data collected at the collection interval to data files at a specific record 
interval. The instantaneous values of data are recorded. The collected data at each record 
interval is saved to files without any data processing.
The figure shows an example of how data is recorded when the collection interval is 1 
second, the record interval for instantaneous values is 5 seconds, and recording is started 
at 0:00:00. In instantaneous-value recording, the collected data at 0:00:00, 0:00:05, and 
0:00:10 are saved as record data. The first collected data is called “recording start point.”

Collection interval (1 sec)
Record interval of instantaneous values (5 sec)

Time

Collected 
data

0:00:00 0:00:05 0:00:10 0:00:15 0:00:20 0:00:25

Recording 
data

Recording start point
▲

Click the Start Recording button to start data recording.
Note that the actual recording of data to data files starts when the recording start conditions 
are met. Therefore, GA10 may enter the recording standby state when the Start Recording 
button is clicked.
The following figure shows an example of how GA10 operates when an interval (everyday, 
every week, every month) and start time are specified as recording start conditions.

Start Recording
Start of recording 
to file 1

End of recording 
to file 1

Start of recording 
to file 2

End of recording 
to file 2

Start 
Recording
clicked

Recording standby

Recording start 
condition met

Recording stop 
condition met

Recording standby Recording standby

Recording start 
condition met

Recording stop 
condition met

Recording data
Collected data

Repeated from 
this point

The following settings are available on the Record Setting Page.
•	 Record Interval
•	 Record File Type
•	 Start/Stop Condition
•	 File Division
•	 Number of Files
•	 Folder
•	 File Name
•	 Comment

The details of these settings are provided in the following pages.

Note
•	 The	data	recording	settings	vary	depending	on	whether	the	data	collection	condition	was	set	to	

PC time or Device time. Also, the handling of alarm information and the number of record data 
files vary.

•	 If	the	server	stops	for	some	reason	during	recording,	the	recording	will	resume	when	the	server	
recovers. However, if the server is stopped manually, or if the PC in which the server is installed 
stops, the data file is cut at this point and saved. Recording will not resume even if the server is 
restarted. When the server stops.
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Click here to display the Record Setting Page.
(1) (2)

(3)
(4)
(5)
(6) (7) (8)

(9)

(10)

(1) Record Interval
Select the interval from the drop-down list.
Options: 100 Millisecond, 200 Millisecond, 500 
Millisecond, 1 Second, 2 Second, 5 Second, 10 Second, 
20 Second, 30 Second, 1 Minute, 2 Minute, 5 Minute, 10 
Minute
The intervals that are displayed in the list are integer 
multiples of the collection period specified on the Monitor 
Page. If Data time is set to Device time, you cannot 
specify the record interval.

(2) Record File Type
Specify the data output format.
You can save the recorded file in binary format (.dld 
extension) or Excel format (.xlsx extension).

Note
If you want to record data on a device with the scan 
interval set shorter than 10 ms using multiple projects, we 
recommend that data be recorded in binary format.

(3) Excel Files' Alarm Info
Select whether to export alarm information to Excel.

Setting Description
Exist Alarm information is exported to an Excel file.
None Alarm information is not exported to an Excel file.

(4) Start Condition
You can specify the following for the start condition.

Start Condition Description
Immediate Starts recording when the Start Recording button is 

clicked.
Specified Time Starts recording when the specified time arrives.
Specified Period Records at the specified period.
Alarm Starts recording using the alarm status as a trigger.
Level Starts recording using a collected data value as a 

trigger.

(5) Stop Condition
You can specify the following for the stop condition.

Stop Condition Description
Continuous Stops recording when the Stop Recording button is 

clicked.
Specified Time Stops recording at the specified time. If the start 

condition is set to Alarm or Level, GA10 enters a 
recording standby state.

Specified 
Duration

Stops recording when the specified time elapses after 
recording starts. If the start condition is set to Alarm or 
Level, GA10 enters a recording standby state.

Data Number Stops recording at the specified number of data points. 
If the start condition is set to Alarm or Level, GA10 
enters a recording standby state.

Specified Period Stops recording at the specified period and enters 
recording standby state.

Alarm Stops recording using the alarm status as a trigger and 
enters recording standby state.

Level Stops recording using a collected data value as a 
trigger and enters recording standby state.

Note
•	 If	you	set	the	start	condition	to	Specified	Period,	the	

stop condition is fixed to Specified Period.
•	 If	the	start	condition	is	set	to	Specified	Period	and	

the recording start time is set to the same time as the 
record stop time, the recorded data file is not divided 
at every interval.

•	 If	the	start	condition	is	set	to	Specified	Period	and	the	
period is set to the 31st of every month, for months 
that do not have 31 days, the date is automatically set 
to the last day of the month.

•	 If	you	set	the	start	condition	to	Specified	Time,	
you cannot specify a nonexistent time due to DST 
(daylight saving time) transition.

•	 If	the	specified	time	overlaps	due	to	the	DST	
transition, the first time is used to start recording.
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  Chapter 3  Configuring and Starting Data Collection and Recording 

If the Start Condition is set to Alarm

1 Set Start Condition to Alarm.
The tag range, Level (1 to 4), and Alarm Change 
are displayed.

Tag range

Alarm levels

2 Click the first or last tag selection button.
The Tag Index dialog box appears.

3 Select the applicable tag range.
The dialog box closes, and the tag selection button 
display changes to the selected tag.

4 Select Level (alarm level).

5 Set the Alarm Change to OFF to ON (alarm 
activated state) or ON to OFF (alarm released 
state).

Click the Start Recording button to enter the record-
ing standby state. When the monitored alarm reach-
es	the	specified	alarm	value,	recording	starts.

If the Stop Condition is set to Alarm
The setting procedure is the same as described 
above.	When	the	specified	alarm	value	is	reached	
during recording, GA10 stops recording and enters 
the recording standby state.

If the Start Condition is set to Level

1 Set Start Condition to Level.
Tag range, threshold value, and operation direction 
appear.

Operation directionType the threshold.

Tag range

2 Click the first or last tag selection button.
The Tag Index dialog box appears.

3 Select the applicable tag range.
The dialog box closes, and the tag selection button 
display changes to the selected tag.

4 Enter the threshold value.

5 Set the operation direction to Up (data value is 
greater than or equal to the threshold) or Down 
(data value is less than or equal to the threshold).
Click the Start Recording button to enter the record-
ing standby state. When the monitored tag value 
reaches	the	threshold	in	the	specified	direction,	
recording starts.

If the Stop Condition is set to Level
The setting procedure is the same as described 
above.
When the monitored tag value reaches the threshold 
in	the	specified	direction,	GA10	stops	recording.

(6) File Division
Set the conditions for dividing data files. The settings vary 
depending on the selected condition. The figure below 
shows an example when Specified Period is selected.

Select Every Hour, Everyday, 
Every Week, or Every Month.

Type the time.Set the conditions 
for dividing.

Off
 File is not divided.
Specified Duration
 Based on the time of the first recorded data, the file 

is divided at every specified hour and minute.
 Example: If the division time is 1 hour, the time of 

the first recorded data is 3:00:00, and the record 
interval is 1 second, the first file will contain the data 
from 3:00:00 to 3:59:59, and the second file will 
contain the data from 4:00:00 to 4:59:59.

Specified Period
 Select Every Hour, Everyday, Every Week, or Every 

Month and the absolute time to divide the data file.
Data Number
 The file is divided when the number of data values 

in the data file reaches the specified number. Input 
range: 100 to 2600000

Note
The file is divided in the following situations.
•	 When	the	data	file	size	exceeds	1	GB
•	 When	the	data	file	output	format	is	Excel	and	the	

number of recorded tags is 180 or less, the files will 
be divided every 65535 rows.

 When the number of recorded tags is 181 or more, the 
files will be divided in groups of the maximum number 
of rows that meets the following condition: number of 
tags No number of rows < 11796428.

•	 When	the	data	file	output	format	is	binary	and	the	
number of recorded data points exceeds 10 million

 This number is the number of timestamps that is 
recorded and is not related to the number of tags.
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(7) Number of Files
If you use File Division, you can specify a upper limit to 
the number of files to save for the data files that have 
been divided during one iteration from recording start to 
recording stop.
You can limit the number of data files that are saved from 
the start of recording to the end of recording. When the 
number of data files reaches the limit, the oldest file is 
deleted to save the most recent file.
The handling of the number of files is different when the 
data time of collected data is set to PC time or Device 
time. The range of values that you can enter is 4 to 2000.

PC time
 Because the data of every device is saved in a 

single file, the number of data files of one iteration 
from recording start to recording stop is applicable.

Number of saved files = Number of files

Recording start Recording stop

File division

Device time
 Because a file is saved for each device or each 

interval, the number of data files of one iteration 
from recording start to recording stop for each 
device or interval is applicable.

Number of saved files = Number of files x unit (device or cycle)

Device A

Device B

Device C

Recording start Recording stop

File division

(8) Folder
Specify the data file save destination.

Server PC Operation System Default destination
Windows XP C:\Documents and Settings\All Users\

Documents\SMARTDAC+Data Logging 
Software\Data

Windows Vista, 7, 8 C:\Users\Public\Documents\SMARTDAC+ 
Data Logging Software\Data

Note
We recommend you use the default setting for the data 
save destination folder.
If you want to change the save destination, select a folder 
that the server (Network service account) can write to.
Note that files cannot be saved to the desktop or 
Document folders. If you select an area where writing is 
not possible, an error message (E3055) will appear.

(9) File Name
Specify the name of the data file. When recording data 
using Specified Period, it is convenient to add the date 
or time to the file name. The date or time of the first data 
point is added to the file name.

(10) Comment
You can attach comments to data files. You can view 
these comments when you display the data in Universal 
Viewer.
You can change the comments until you click Start 
Recording but not afterwards.

(11) Math Action (Appears only when the /MT 
option is in use)
On GA10 with the Math function (/MT option), the Math 
Action item appears on the Record Setting Page. To 
reset math when recording starts, select the check 
box. However, the math reset timing is delayed by one 
recording interval from the record start timing. Also 
depending on your PC environment, it could be delayed 
by more than two record intervals.

 Record Setting Page When the Math Function (/MT 
option) Is in Use
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  Chapter 3  Configuring and Starting Data Collection and Recording 

Note
 Differences in Data Recording When PC Time Is 

Used and When Device Time Is Used
The table below summarizes the differences in the 
recording files created when Data time is set to Device 
time and when set to PC time.

Data Time
Influence

Specified Data Time
PC Time Device Time

Number of recording 
files

One data file is created. A data file is created for 
each device. Or if there 
are multiple acquisition 
intervals in the same 
device, a data file is 
created for each interval.

Alarm information Alarm information is 
recorded by taking the 
logical OR of the alarm 
information from the 
collected data immediately 
after the previous recording 
data point to the current 
recording data point.

The data files and alarm 
information are aligned.

DST (daylight saving 
time) when a recording 
file is displayed on the 
viewer

When a recording file is 
displayed on the viewer, 
the time information 
is displayed correctly 
according to the DST.

When the DST settings on 
the PC and device are the 
same, the time information 
is displayed correctly. If 
they are not the same, 
the DST information of 
the device is not reflected 
correctly.

When device settings 
are changed during 
recording

The changes are not 
reflected.

Recording stops.

Changes to devices during data collection and recording:  “Q11” on page 
14-11

What is PC time, or Device time?: “Q12” on page 14-11
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3.3.8 Configuring Mail Settings
GA10 can send email when alarms occur or when the communication status changes.
Configure email settings on the Mail Setting Page.
You can specify up to 20 sets of mail settings of your choice.
The Email Setting Page consists of an area for SMTP server settings and an area for 
detailed mail settings.

1 2

4

3

Basic Operation

1 Select E-Mail in the navigation area on the left of the window.
The Email Setting Page appears.

2 Specify the following SMTP server settings.
•	 SMTP	Server:	SMTP	server	name	(up	to	255	characters)
•	 Port	No.:	Port	number	that	the	SMTP	server	will	use	(0	to	65535)
•	 Resend Times:  Select 0, 1, 2, 3, 4, or 5. If email transmission fails, GA10 retries 

the specified number of times. GA10 will retry to transmit 5 min-
utes after the previous transmission failure.

•	 Authentication	Methods:	OFF	(no	authentication),	SMTP	Authentication,	or	POP	
Before SMTP.

•	 Encryption:	[OFF]	(no	encryption),	[SSL/TLS],	[STARTTLS]

3 Select the mail tapped pages, and enter their names. (“Mail01” is used in this 
example.)

4 Set On/Off to On.
The Email Event Setting Page appears.
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Email Event Setting Page
You can set the following items on the Email Event Setting Page. Set one set of conditions 
on each tabbed page.

(1) Name
 Enter the name of the mail event. This name becomes the tab name.
 Default values: Mail01 to Mail20 
 Input range: Up to  30 characters
(2) On/Off
 Enable or disable the mail event setting. The default value is OFF. Selecting ON displays 

a setting page.
(3) Condition and (4) Trigger
 Select the conditions for sending email.
 Default value: Alarm Status

Send Conditions Description
Alarm Status Send an email when the alarm of the specified tag changes.
Comm. Status Send an email when the communication status between the server and a data acquisition 

device changes or when a data dropout occurs on the server.
Specified Period Send an email at specified intervals (such as everyday, every week, and every month) or at 

a specific time within the interval.
Specified Time Send an email at specified intervals after data acquisition starts.
File is created Send an email when the creation of a data file is completed.

 Depending on the send condition you select, the trigger display changes as shown in the 
following table.
Send Conditions Trigger

Default Value Range
Alarm Status Easy Easy or Detail1

Comm. Status Communication 
Disconnect

Communication Disconnect, Communication Recover, Loss Data

Specified Period Everyday
Time: 00:00:00

Everyday, Time
Every Week, Sunday to Saturday, Time
Every Month, 1st to 31st, Time

Specified Time 00:01:00 Enter the trigger time interval.
File is created No trigger setting ---

1 If you select Easy, set Tag Range and Level 1 to Level 4. If you select Detail, select the alarm 
level for each tag in the Select alarm dialog box shown on the next page.
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If Send Condition Is Alarm Status and Trigger Is Set to Easy
Start tag button End tag button

Click to select the level.

1 Click the start tag button of Tag Range.
A Tag Index dialog box appears.

2 Select the start tag.
The	Tag	Index	dialog	box	closes,	and	the	selection	is	reflected	on	the	Email	Event	Setting	Page.

3 Likewise, set the end tag.
The tag range is now set on the Email Event Setting Page.

4 Specify the changes in the alarm levels of Level 1 to Level 4.

If Send Condition Is Alarm Status and Trigger Is Set to Detail

1 Click Setting.
A Select alarm dialog box appears.

2 Click the check boxes of the tags you want to select.
To clear a selected check box, click it again.

3 Click the arrows of alarm Level 1 to Level 4, and select the changes in the alarm 
levels.
Options:	---,	On,	Off,	On/Off.	Default	value:	---

4 To apply the selections, click OK. To cancel, click Cancel.
The dialog box closes, and the Email Event Setting Page returns.



3-49IM 04L65B01-01EN

C
onfiguring and Starting D

ata C
ollection and R

ecording

1

2

3

4

5

6

7

8

9

10

11

12

13

14

App

Index

 Chapter 3  Configuring and Starting Data Collection and Recording

Trigger Display When Send Condition Is Set to Comm. Status

Trigger Display When Send Condition Is Set to Specified Period

Trigger Display When Send Condition Is Set to Specified Duration

When Send Condition Is Set to File is created (No trigger display)

(5) Sending Basic Settings
Enter the following sending basic settings. You can specify up to 10 email addresses 
for Sent to and CC. To specify multiple email addresses, separate each address with a 
semicolon.

Sent from: Sender email addresses  (up to 100 characters.)
Sent to:  Recipient email addresses  (up to 500 characters, up to 255 for each address.)
CC:  Carbon copy email addresses (up to 500 characters, up to 255 for each address.)
Title: Subject of the email (up to 250 characters.)
Custom Header:  Enter up to 30 alphanumeric characters in first and second fields. (Colon 

and space excluded. Characters outside the range are replaced with 
hyphens.) If you enter “Mailer” in the first field and “GA10” in the second 
field, the email’s custom header will be “X-Mailer : GA10.”

First field Second field

Content:  Body of the email message. Enter up to 1000 characters per line and up to 500 
lines (up to 1000 characters for the entire body of text).

(6) Message Language
The body of email messages consists of the message specified by the user and the 
message automatically added according to the send conditions.
The following figure shows the message that is automatically added. It displays the event 
information (send conditions) divided into the time of occurrence, type, and details.
When Send Condition is Alarm Status, if alarms occur simultaneously on multiple channels, 
up to 200 pieces of detailed channel information are displayed.

Time of occurrence
Type

Details

You can change the language of these messages. You can select from English, Japanese, 
Chinese, German, French, Korean, and Russian. The default value is the OS language.
For details on the body of messages, see the table on the next page.
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Details on the Body of Messages
Send Condition Event Information Message Strings
Alarm Status Alarm Status If a message occurs at alarm level 1:

Time: YYYY/MM/DD hh:mm:ss
Type: Alarm
Detail Information: 
Tagindex [AlarmLevel1] in ProjectName is occured./is released.
……
Tagindex [AlarmLevel1] in ProjectName are occured./is released.

If a message occurs simultaneously at alarm level 1 and alarm level 2:
Time: YYYY/MM/DD hh:mm:ss
Type: Alarm
Detail Information: 
Tagindex [AlarmLevel1,AlarmLeve2] in ProjectName are occured./is 
released.
……
Tagindex [AlarmLevel1,AlarmLeve2] in ProjectName are occured./is 
released.

Comm. Status Comm. Status Communication Disconnect/Communication Recover
Time: YYYY/MM/DD hh:mm:ss
Type: Communication Status
Detail Information: The connection of DeviceIndex : DeviceName in 
ProjectName is disconnected/recovered.
Loss Data (PC time)
Time: YYYY/MM/DD hh:mm:ss
Type: Communication Status
Detail Information: Data Lack in ProjectName is detected. 
Loss Data (Device time)
Time: YYYY/MM/DD hh:mm:ss
Type: Communication Status
Detail Information:  Data Lack in DeviceIndex : DeviceName in 
ProjectName is detected. The duration of Data Lack is from YYYY/MM/
DD hh:mm:ms to YYYY/MM/DD hh:mm:ms.

Specified Period Specified Period Everyday
Time: YYYY/MM/DD hh:mm:ss
Type: Periodically Notification
Detail Information: The condition of sending mail in ProjectName is at 
hh:mm:ss of every day.
Every Week
Time: YYYY/MM/DD hh:mm:ss
Type: Periodically Notification
Detail Information: The condition of sending mail in ProjectName is at 
hh:mm:ss of each xxday.
Every Month
Time: YYYY/MM/DD hh:mm:ss
Type: Periodically Notification
Detail Information: The condition of sending mail in  ProjectName is at 
hh:mm:ss of each month.

Specified Duration Specified Duration Time: YYYY/MM/DD hh:mm:ss
Type: Regularly Notification
Detail Information: The condition of sending mail in ProjectName is 
every hh:mm:ss.

File is created File is created Time: YYYY/MM/DD hh:mm:ss
Type: Data file
Detail Information: A data file(FileName) in ProjectName is created.
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(7) Attached Files
The alarm information and instantaneous value of tags can be attached as a file to outgoing 
messages. The types and selectable range of Attached Files vary depending on the sending 
condition.

Send Condition File Attachment File Type Tag Specification
Alarm Status Yes Alarm information, 

instantaneous value
A tag range can be specified, or tags can be 
specified in detail (individually).

Comm. Status No Not available Not available
Specified period Yes Alarm information, 

instantaneous value
A tag range can be specified, or tags can be 
specified in detail (individually).

Specified duration Yes Alarm information, 
instantaneous value

A tag range can be specified, or tags can be 
specified in detail (individually).

File is created Yes Data file Not available

When Range Is Used for Attached Files

1 Click the start tag button of Tag Range.
A Tag Index dialog box appears.

2 Select the start tag.
The Tag Index dialog box closes, and the start tag is updated.

3 Likewise, set the end tag.
The tag range is now set.

When Individual Is Used for Attached Files

1 Click Setting.
A Select Tags dialog box appears.

2 Click the check boxes of the tags you want to select.
To clear a selected check box, click it again.

3 To apply the selections, click OK. To cancel, click Cancel.
The dialog box closes, and the Email Event Setting Page returns.
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Note
On a GA10 with the Math function (/MT option), a Math 
tag page is displayed in the Tag Index, Select alarm, and 
Select Tags dialog boxes. The following figure shows an 
example of a Math tag page in the Select alarm dialog 
box.

Note that the method of specifying math tags is the same 
as that for normal measurement tags.

(7) Send Test Mail
A test mail is sent according to the settings on the Mail 
tabbed page.
Attachments are not sent during a test transmission.
Note

Test mail transmission to multiple clients is not possible to 
prevent affecting server communication.

Behavior When Sending Email When Alarms Occur
If email send condition is set to Alarm Status, note the 
following points.
•	 The timing for sending email is different when Data 

time is set to PC time and when Data time is set to 
Device time.
PC time
 The specified tag range is assumed to be a single 

group. If any of the alarms of the tags in the group 
occurs, an email is sent.

Device time
 The specified tag range is grouped by device or 

interval. If any of the alarms of the tags in the group 
occurs, an email is sent.

 In each 1 second interval of each group, the data 
timestamp of the earliest occurring alarm is used as 
the alarm timestamp, and a single email message is 
sent for this alarm.

 The alarm information and instantaneous value 
in the file attachment will only be for this earliest 
occurring alarm.

 Email is not sent for all other alarms that occur.

•	 The condition for sending email is based on the alarm 
information of data collected at the data collection 
interval. The condition for starting and stopping 
recording is based on the alarm information of data 
recorded at the record interval.

Behavior When Sending Email at Specified Intervals
If email send condition is set to Specified Period, note 
the following points.
•	 Do not change the time during data collection and 

recording. Doing so will affect the timestamps of data 
attached to e-mails.

•	 The timing for sending email is different when Data 
time is set to PC time and when Data time is set to 
Device time.
PC time
 The time on the PC in which the server is installed 

is used. The data in the file attachment is all the tag 
data within the specified range.

Device time
 If Device time is specified, tags are grouped by 

device or interval. Because the timestamps attached 
to the data is used in each group, multiple emails 
may be sent at the device level or interval level.

 If there are no tags that belong to a group in the 
specified range, file attachment is not created.

Note
•	 The	maximum	number	of	emails	that	the	server	can	

hold is 40 per project. (This includes emails that fail 
transmission and retransmissions.)

•	 Emails	held	in	the	server	are	deleted	when	the	
specified retransmission count is reached or when the 
server stops.
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3.3.9 Setting Project Access Privileges
In GA10, you can set access privileges at the project level separately from the server access 
privileges (administrator and user privileges).
These privileges define the operation scope of the project; they apply in the same way to the 
administrator and users.

There are four types of project access privileges: Owner, Manager, Operator, and Monitor. 
Only the owner can assign access privileges. The person creating the project is the initial 
owner of the project. (To change owners:  Sec. 9.4.3)

User B User E

Owner OperatorManager Monitor

Project A

User DUser C

All operations Edit
Operation
Monitor

Operation
Monitor

Monitor

Administrator A

Privileges are assigned on the Access & Others Setting Page of the project.
From the users registered in the server, you can specify the users that can access the 
current project and their operation scope.

Other settings (Keep Lock State, DDE Server, Share Alarm ACK)

Access user list
Click here to display the Access&Others Setting Page.

Server user list
Users registered in the server
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Access Privilege Types and Operation Scope
The table below shows the available project access 
privilege types and their operation scope.

Level Privilege 
Type

Allowed 
Operations

Operation Details

1 Owner All operations All operations (including deleting the 
project)
Set project access privileges.

2 Manager Setup
Operation
Monitor

Edit setup data.
Start/stop data monitoring or recording.
View recorded data files.
Open data files.
Delete data files.
Monitor collected data.

3 Operator Operation
Monitor

View setup data.
Start/stop data monitoring or recording.
View recorded data files.
Open data files.
Delete data files.
Monitor collected data.

4 Monitor Monitor View recorded data files.
Open data files.
Monitor collected data.

To assign access privileges, follow the procedure below.
Skip steps 1 and 2 if you are already setting the details of 
a project.

1 The user who has owner privileges to the project 
logs in.

2 In the Project List Page, double-click the appropriate 
project to open the project.
The selected project appears on the Project Page.

3 Change the project setting window to the Access & 
Others Setting Page.
A list of users registered in the server appears.

 

Note
You can change how the users are displayed between 
User Name and User Full Name by clicking User Display 
Form on the View menu.

4 Drag the appropriate user to the appropriate 
privilege area.

 
User list

Manager 
privileges

Operator 
privileges

Monitor 
privileges

5 Or, select the user, and click the Move button 
pointing to the appropriate privilege area.

 

Move button

The	user	moves	to	the	specified	privilege	area.
The user can now perform the granted operations in 
the project.

Note
You can select multiple users by clicking while holding 
down the SHIFT or CTRL key on the keyboard.

All Users
 The user list displays a user named “All Users.” You 

can use this to assign access privileges to all users in 
the server user list.

 You can assign access privileges to both “All Users” 
and individual users. If you do, the higher privilege 
takes effect for such users.

Note
•	 If	you	assign	access	privileges	to	All	Users	on	the	

Setting Page and then add or delete individual users, 
All Users will also be updated.

•	 Before	deleting	project	access	privileges	of	a	user,	
check the user status.

If you delete an owner user:  Sec. 9.4.3
To open a project with lower access privileges:  Sec. 
9.4.4
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3.3.10 Holding the Lock State
When Keep Lock State is enabled under Others on the 
Access & Others Page, only the user that starts data 
collection will be able to operate the relevant project.
The Keep Lock state is retained until the user that started 
data collection logs in again and stops the data collection.
This feature is set to OFF by default. To use it, select ON.

Select ON to set the Keep Lock State feature.

Note
The administrator can clear the Keep Lock state if there 
is some reason in which data collection must be stopped.
To clear the Keep Lock state:  Sec. 9.4.5

3.3.11 Using the DDE Server Feature
GA10 supports the DDE (Dynamic Data Exchange) 
Server feature, which is used to send data to other 
applications.

By using a DDE client, such as Excel, to access the DDE 
server, you can retrieve the tag values that are being 
collected in the project. You can begin retrieving the data 
from a DDE client after the DDE server starts.

Retrievable 
Information

Description

Date The date when the data was collected
Time The time when the data was collected (excluding 

the millisecond)
Millisecond The millisecond when the data was collected
Data number The serial number of the data. The first data value 

collected when data collection is started is number 
zero.

Value The collected tag value

The application name, topic name, and item name that 
are used to retrieve data are shown below.

Item Text String to Specify and Output Information
Application name DLGDDE (fixed)
Topic name Specify the name of the target project.
Item 
name

Date date Outputs the date as a text string.
The date format is YYYY/MM/DD.

Time time Outputs the time as a text string.
The time format is hh:mm:ss.

Millisecond msec Outputs the millisecond as a text 
string.
The millisecond format is msec.
The millisecond is expressed 
using a number between 000 
and 999.

Data 
number

no Outputs the data number as a 
number. The data number starts 
with zero.

Value tagxxxx
xxxx is the tag 
index number.

Outputs the tag value as a 
number.
The value is displayed using the 
number of decimal places for 
tags that is specified on the Tag 
Setting Page.

Even when multiple operation screens (clients) are 
displayed on the same PC, there is only one DDE server. 
The clients share the first DDE server that is started. 
Clients connected to another GA10 server cannot share 
the same DDE server.

When a DDE server is started, the host name or IP 
address of the connected GA10 server is displayed after 
Stop DDE on the File menu.
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Example in Which Excel Is Used as a DDE Client
Create a link to Excel for using DDE in advance.

1 In an Excel sheet, enter the indexes for the data you 
want to retrieve.

Enter the index (item name).

2 In the cells you want to display data (column B in 
this example), enter the link expressions.

Example: =DLGDDE|project!Date
(=application name|topic name!item name)
•	 The	pipe	symbol	(|)	and	exclamation	point	(!)	are	

delimiters that are necessary in expressions.
•	 For	details	on	the	application	name,	topic	name,	and	

item name, see the table on the previous page.
•	 In	the	above	figure,	column	B	is	intentionally	set	to	

display the expressions.

3 After you enter the expressions, save the Excel file, 
and close it.

4 On the GA10’s File menu, click Start DDE.
The DDE server starts on the PC running the GA10 
client.

5 In the Project List Page, double-click the project that 
you want to use the DDE server with to open the 
project.

6 Change the project setting window to the Access & 
Others Setting Page.

7 Set DDE Server to ON.

Start the DDE server and data collection.

8 Click  to start data collection.
 Start collection and recording: Sec. 3.2.4

9 Open the Excel file.
If a message appears asking you whether to update 
the links, update them.
The collected data will be displayed in Excel cells.

10 To stop the DDE server, on the File menu, click 
Stop DDE.
The host name or IP address of the GA10 server 
connected to the DDE server is displayed after Stop 
DDE.

Important
•	 While	DDE	is	running,	do	not	change	the	project	name	

(topic name).
•	 To	save	files	using	Excel	as	a	DDE	client,	set	Files	of	

type to Excel 97-2003 book (*.xls).

Note
•	 If	data	collected	by	the	DDE	server	is	in	error,	it	is	

output using indications other than values.
 For the different types of error data, see Sec. 6.9.2.
•	 The	time	information	that	is	used	for	DDE	queries	is	

the PC time in which the server is installed. The time 
when the collected data is set to the DDE server is the 
time that is output.

 Therefore, if Data time is set to Device time, the time 
and value of the data on the Monitor Page or data 
recorded to the data file will not be synchronized to 
the time and value output by the DDE server.

•	 The	data	number	is	output	only	when	Data	time	is	
set to PC time. It is not output when Data time set to 
Device time.In the Project List Page, double-click

•	 If	communication	between	the	data	collection	device	
and the server is disconnected and Data time is 
set to PC time, OFF is output for the data value. If 
set to Device time, data updating stops regardless 
of whether FIFO is being used. This is the same 
behavior as when the data collection from the device 
is delayed.

•	 For	information	on	how	to	use	a	DDE	client,	see	the	
manual for the DDE client.
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3.3.12 Sharing Alarm ACK Operations
If Share Alarm ACK under Others of the Access&Others 
Setting Page is set to ON, the ACK operation can be 
shared among multiple clients connected to the same 
server. If an alarm occurs in a project, you do not have to 
perform ACK operation on each client.

1 Log in with a user who has privileges for editing the 
settings of the project.

2 Open the project in which you want to share the 
alarm ACK operation.

3 Click Access&Others.

4 Click ON next to Share Alarm ACK.

The alarm ACK operation is shared among clients 
that are connected to the same server.

Alarm ACK operations:  Sec. 6.6.3

3.3.13 Starting the Modbus Server and Setting 
the Modbus Address

If Modbus Server under Others of the Access&Others 
Setting Page is set to ON, responses are returned when 
requests are received from a Modbus client.

1 Log in with a user who has privileges for editing the 
settings of the project.

2 Open the project you want to access from the 
Modbus client.

3 Click Access&Others.

4 Click ON next to Modbus Server.

5 Set the address in Modbus Address.

Assign an address (setting range: 1 to 247) to each 
GA10 project.

For Modbus Server function:  “Chapter 11 Modbus 
Server Function”
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3.3.14  Configuring Integration (/WH option) 
The GA10 allows monitoring and demand monitoring of integration graphs (integration bar, 
integration trend) for each integration group. In addition, integration report data and demand 
monitor data of integration groups can be exported. 
You can set up to 20 integration groups by specifying integration settings as you like. 
The Integration Setting Page consists of an area for report settings and tabbed pages for 
detailed integration settings.

1 2

3

Basic Operation

1 Select Integration in the navigation area on the left of the window. 
The Integration Setting Page appears.

2 Specify the following report settings. 
	 •	 Report	File	Naming	Rule	

Select	whether	to	automatically	create	file	names	of	report	files	or	specify	them	manu-
ally.

•	 Default	values:	Auto
•	 Options:	Auto,	Specify

 When Auto is selected
 File name example: YYMMDD_hhmmssHD.GRE
 YY: Last two digits of the year
 MM:month
 DD: day
 hh: hour
 mm: minute
 ss: sec
 HD: Fixed
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 Chapter 3  Configuring and Starting Data Collection and Recording

 When Specify is selected
 You can specify text strings. Enter up to 32 characters.
 File name example: ReportYYMMDD_hhmmssHD.GRE
 Default text string: report
 The portion other than the text string is the same as when Auto (described earlier) is 

selected.

	 •	 Report	File	Output	Folder	
Specify	the	output	destination	folder	for	report	files.

3 Select the integration tabbed pages, and enter their names. ([Integration Group 01] in 
the displayed example) 
Up to 30 characters

Integration Group Setting Page 
You can set the following items on the Integration Group Setting Page. Set one set of 
conditions on each tabbed page. 
Select the integration tabbed pages, and enter their names.
Default values: Integration Group 01 to Integration Group 20
Input range: Up to 30 characters

(1)

(2)
(3)
(4)
(5)
(6)

(7)
(8)

(9)
(10)

(11)

(1) Integration Tag
 Specify the report channel (tag) of the integration group.

 No
 Specify the report channel number. 
 These are report channel numbers assigned sequentially from 01 to 50. You cannot 

change these numbers.

 Tag No.
 Specify the tag. 
 When you click a tag, a tag selection dialog box appears. Click the tag you want to 

specify to apply it.

 Color
 Specify the report channel display color. If you want to change, clicking a color displays a 

Color Setting dialog box where you can select the color.
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(2) Integration Graph
 Enable or disable the integration graph display. The default value is OFF. Select ON to 

enable the integration graph display.
 Default values: OFF
 Selectable range: OFF, ON
(3) Demand Monitor
 Enable or disable the demand monitor. The default value is OFF. Selecting ON enables 

the demand monitor.
 Default values: OFF
 Selectable range: OFF, ON
(4) Demand Period
 Specify the demand period. When the demand period elapses, the monitor is reset.
 Default values: 30 min
 Selectable range: 15 min, 30 min, 1 hour (when the monitor interval is less than 5 min)
(5) Contract Power
 Specify the contract power.
 Default values: 1000
 Input range: 1 to 99999999
(6)Target Power
 Specify the target demand.
 Default values: 1000
 Input range: 1 to 99999999
(7) Cut-off Margin Power
 Specify the cut-off margin power.
	 Default	values:	10
 Input range: 1 to 99999999
(8) Alarm Mask Time
 Specify the alarm mask time. 
 The alarm mask time is a given time period during which alarm monitoring is not 

performed immediately after demand monitor starts.
 Default values: 5
 Input range: 

Demand Period Range
15 min 0 to 10
30 min 0 to 20
1 Hour

(9) Estimated Comparison
 Specify the estimated compare time. 
 The estimated compare time is used to calculate the rate of increase (slope) of the 

demand value.
 Default values: 10s
 Input range: It varies according to the monitor interval.

 Monitor interval Input Range
10 s and less 10 s/20 s/30 s/1 min/2 min/5 min/10 min
20 s 20 s/1 min/2 min/5 min/10 min
30 s 30 s/1 min/2 min/5 min/10 min
1 min 1 min/2 min/5 min/10 min
5 min 5 min/10 min
10 min 10 min

(10)Basic Alarm
 Level No.
 These are alarm level numbers assigned sequentially from 01 to 04. You cannot change 

these numbers.

 On/Off
 Specify ON to use an alarm.
 Default values: OFF
 Selectable range: OFF, ON

 Value
 Specify the alarm value.
 Default values: 1000
 Input range: 1 to 99999999
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 Chapter 3  Configuring and Starting Data Collection and Recording

 Hysteresis
 Set the hysteresis.
 Default values: 50
 Input range: 1 to 99999999

 Alarm Shape
 Specify the shape of the alarm indication.
 Default values: circle (¡)
 Selectable range: circle (¡) or rectangular (¨)

 Alarm Color
 Specify the alarm indication color. 
 Clicking a color displays a Color Setting dialog box where you can select the color.

Alarm state Description Default values
ON Specify the displayed color when the alarm is on. Red
OFF Specify the displayed color when the alarm is off. Green

 Line Color
 Specify the color of the basic alarm setting trip line of the demand monitor screen. 
 Clicking a color displays a Color Setting dialog box where you can select the color.
 Default values: Red
(11) Cut-off Alarm
 On/Off
 Specify On to use an alarm.
 Default values: Off
 Selectable range: Off, On

 Value
 Specify the cut-off alarm value.
 Default values: 1000
 Input range: 1 to 99999999

 Hysteresis
 Set the cut-off alarm hysteresis.
 Default values: 50
 Input range: 1 to 99999999

 Alarm Shape
 Specify the shape of the cut-off alarm indication.
 Default values: circle (¡)
 Selectable range: circle (¡) or rectangular (¨)

 Alarm Color
 Specify the cut-off alarm indication color. 
 Clicking a color displays a Color Setting dialog box where you can select the color.

Alarm state Description Default values
ON Specify the displayed color when the cut-off alarm is on. Red
OFF Specify the displayed color when the cut-off alarm is off. Green
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3.3.15 Configuring FTP Settings
On the GA10, recording files, report files, integration report data files, and demand monitor 
data files (/WH option) can be transferred via FTP. 
Up to 20 processes can be displayed simultaneously.

1 2

Basic Operation

1 Select FTP in the navigation area on the left of the window. 
The FTP screen appears.

2 Set On/Off to ON.
The FTP Transfer Setting Page appears.
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FTP Transfer Setting Page
You can set the following items on the FTP Transfer Setting Page.

(1)
(2)
(3)
(4)

(8)

(5)

(7)
(6)

(1) FTP Server
 Specify the following FTP server settings.
	 •	 	FTP	Server:	FTP	server	name	(up	to	255	characters)	
	 •	 Port	No.:	Port	number	that	the	FTP	server	will	use	(1	to	65535)	
	 •	 	Resend	Times:	Select	0,	1,	2,	3,	4,	or	5.	The	data	is	sent	the	specified	number	times	

when FTP transfer fails.
(2) Encryption
 Specify the encryption. 
 Select OFF or SSL/TSL.
(3) Authentication
 Specify the authentication method. 
 OFF: Uses “anonymous” for the user name. 
 ON: Uses the specified user name.
(4) User Name
 Specify the user name. Enter a text string using up to 64 characters.
(5) Password
 Specify the password. Enter a text string using up to 40 characters.
(6) Directory
 Specify the save destination directory for report files. Enter a text string using up to 255 

characters.
(7) PASV Mode
 Enable or disable the PASV mode.
(8) Transfer File
 Specify the files to be transferred via FTP. 
 Options: Recording files (*.XLSX, *.dld), report files (*.XLSX, *.pdf), integration report files 

(*.GRI), demand monitor data files (*.DRE)
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3.4 Registering Modbus Devices
3.4.1 Registration of Modbus Devices
GA10 can connect to devices that use the Modbus 
protocol.
To register such a device, you must create a Modbus 
device definition file in advance and save it in a specific 
server folder (step 3 below).

•	 If you are using GA10 R1.02 or later, UTAdvanced 
series devices can be connected without creating 
definition files. Select from the devices list.

•	 When connecting an UTAdvanced device (UT32A, 
UT35A, UT52A, UT55A, UT75A, UP35A, UP55A) to 
a GA10 with the custom display function (/CG option), 
select a model name with “_R3” from the list. (This 
corresponds to the SP or other output channel.)

Basic Operation

1 Create a Modbus device definition file using the 
Modbus Device Definition File Creating Tool. 

 You can download the Modbus Device Definition File 
Creating Tool from the following URL.

 www.smartdacplus.com/software/en/

Or,	create	the	file	in	XML	format	by	referring	to	the	
provided example. We suggest that you use the 
Windows standard Notepad or a text editor to edit 
the	file.

 

2	 Save	the	file	using	UTF-8	encoding.

3 Place the Modbus device definition file in the C:\
Program Files\Yokogawa Electric Corporation\
SMARTDAC+ Data Logging Software\Modbus folder 
of the PC in which the server is installed.

4 Start the GA10 client, and log in to the server.

The name of the registered Modbus device appears 
next to Device Type in the Register Device Dialog 
Box.*

* A dialog box for registering new devices.

5 Select the registered Modbus device from the 
Device Type.
The input items for communication appear. 

6 Input the information, then click OK.

Note
When using a Modbus definition file to perform 
communication through the Ethernet interface, set the 
scan interval to a value less than the communication 
timeout value of the device.

3.4.2 What Is a Modbus Device Definition File?
The Modbus device definition file is a file that is referred 
to when a new Modbus device is registered on the Device 
Setting Page.
A Modbus device definition file is composed of the 
following four sections.

Option list
 This is where the Modbus device options are 

defined.
Register list
 This is where the Modbus device’s registers that 

are read during data collection are defined. Modbus 
Function codes, register addresses, data types, and 
register names are specified in this section.

Channel list
 This is where the Modbus device’s channels that are 

read during data collection are defined. You can also 
specify channel settings, collection data positions, 
and related alarm information.

Value conversion table
 This is where the table for converting the data read 

from the Modbus device’s registers into values for 
actual use is defined.

Modbus device definition files are in XML format. 
Descriptions in files have a hierarchical structure.
For details on the format, see "Node Structure" and 
subsequent pages.

 Modbus device definition file example:  page App-10
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Node Structure of Modbus Device Definition Files
Level 0 Level 1 Level 2 Level 3 Level 4 Level 5 Description Quantity

ModbusDevice Definition file root element 1
Options Option list node 0 or 1

Option Option information 0 to 5
Registers Register list node 1

Register Register information 1 to 3000
Channels Channel list node 1

Channel Channel information 1 to 500
Init Channel default setting 0 or 1

DecimalPos Default decimal place 0 or 1
Min Default minimum span 0 or 1
Max Default maximum span 0 or 1
Unit Default unit 0 or 1

Value Channel value 1
Write Write register 0 or 1
DataError Error data status 0 or 1
ADError A/D converter status 0 or 1
PlusOver +OVER status 0 or 1
MinusOver -OVER status 0 or 1
Burnout Burnout information 0 or 1

Type Burnout type 0 or 1
Value Burnout status 0 or 1

Alarms Alarm list node 0 or 1
Alarm Alarm information 0 to 4

Type Alarm type 0 or 1
Value Alarm value 0 or 1
Set Value Alarm set value 0 or 1

TransTables Value conversion table node 0 or 1
Table Value conversion table 0 to 100

Value Conversion value 0 to 100
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Node Attributes of Modbus Device Definition Files
If an attribute is not specified, the default value will be applied. However, if the Option, Mask, or Trans attribute is not 
specified, GA10 assumes that the corresponding function is not used and does not apply the default value.

Node Name Attribute Type Mandatory Range Default Value Description
ModbusDevice Type string (A) Alphanumeric characters, 1 to 15 

characters
Modbus device type
Note: Match this with the file name of 
Modbus device definition file.

PortNo int 1 to 65535 502 Ethernet port number of the Modbus 
device

CommandDelay int 0 to 10000 0 Command delay of the Modbus device. 
Unit: msec

Option Name string (B) Alphanumeric characters, 1 to 15 
characters

Names of options supported by the 
Modbus device

Register Name string (A) Alphanumeric characters, 1 to 15 
characters

Register names in the Modbus device

FunctionCode int (A) Read: 1, 2, 3, or 4
Write: 5, 6 or 16

Modbus communication function code

Address int 2 (A) 1-465535 Modbus register
DataType enum (A) INT16 UNIT16 INT32_B Read data type

INT32_L UINT32_B UINT32_L
FLOAT_B FLOAT_L BIT

Channel Name string (A) 1 to 16 Unicode characters Channel name

DecimalPos int 0 to 5 0 Channel decimal place
Min double -1E16 to 1E16 0 Minimum channel span
Max double -1E16 to 1E16 100 Maximum channel span
ScaleRatio double -1E16 to 1E16 1 Channel scaling coefficient
ScaleOffset 4 double -1E16 to 1E16 0 Channel scaling offset
Unit string Up to 6 Unicode characters “” Channel unit
Option string Alphanumeric characters, up to 15 

characters
Option name

Channel\Value
DecimalPos
Min
Max
Unit
DataError 5
ADError 5
PlusOver 5
MinusOver 5
Burnout\Type 5, 6

Burnout\Value 
Alarm\Type
Alarm\Value

Register string (A) Alphanumeric characters, 1 to 15 
characters

Register name

Mask 1 int 2 Hexadecimal number, 0 to 65535 Data bit mask
Trans string Alphanumeric characters, up to 15 

characters
Value conversion table name

Write Register string (A) Alphanumeric characters, 1 to 15 
characters

Register name

Alarm\Type Kind enum “OFF”,“H”,“L”,“dH”,“dL”,“RH”,“RL”,“tH”,
“tL”,“PVH”,“PVL”,“DVH”,“DVL”,“DVO”,“
DVI”,“SPH”,“SPL”,“OTH”,“OTL”,“ETC”

“OFF” Default alarm type

Alarm\SetValue Register string Alphanumeric characters, 1 to 15 
characters

Register name

Alarm\SetValue Value double -1E16 to 1E16 0 Initial value of the alarm set value
Table Name string (C) Alphanumeric characters, 1 to 15 

characters
Value conversion table name

ToDataType enum Int, String Int Target conversion data type
Value From int 2 (C) -2147483648 to 2147483647 Conversion source value

To string (C) Up to 15 Unicode characters Conversion target value
To convert to a value, specify the value 
using a character string.

(A): Mandatory item. However, for attribute name Register, node name Type is not mandatory.
(B): Mandatory item to use the option
(C): Mandatory item to convert data
1 If only a mask is available, bit mask is applied to the data value read from the register, and the result is handled as TRUE or FALSE.
2 Decimal and Hexadecimal integers are supported. For hexadecimals, the number must be preceded by a “0x.”
3 For a description of Data Type, see the table below.
4	 These	are	retrieved	from	registers	or	the	definition	file.	The	user	can	specify	either	one	or	both.	In	the	latter	case,	register	information	takes	precedence.
5	 Scaling	calculation:	Y	=	ScaleRatio	*	X	+	ScaleOffset
 X:  Modbus register value (after decimal point calculation; after conversion is a value conversion table is available)
 Y:  Computed result 
6 Channel data status is processed in the following order of precedence: ADError, DataError, Burnout, PlusOver, MinusOver.
7	 If	the	burnout	type	is	set	to	DownScale	(type	value	is	2)	and	the	burnout	status	is	1,	the	data	status	will	be	−BURNOUT.	If	the	burnout	type	is	set	to	UpScale	(type	value	

is not 2) and the burnout status is 1, the data status will be +BURNOUT.
8 Node channels include optional attributes. When registering a device in the Register Device dialog box, if you do not select this option, this channel will not be available 

in the registered device. 
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Description of Data Type
Value How to Use

INT16 Use when a signed 16-bit integer is assigned to the device register.
UINT16 Use when an unsigned 16-bit integer is assigned to the device register.
INT32_B Use when a signed 32-bit integer is assigned to the device register and the smallest register number is assigned to the highest bit.
INT32_L Use when a signed 32-bit integer is assigned to the device register and the smallest register number is assigned to the lowest bit.
UNIT32_B Use when an unsigned 32-bit integer is assigned to the device register and the smallest register number is assigned to the highest bit.
UINT32_L Use when an unsigned 32-bit integer is assigned to the device register and the smallest register number is assigned to the lowest bit.
FLOAT_B Use when a 32-bit floating-point number is assigned to the device register and the smallest register number is assigned to the highest bit.
FLOAT_L Use when a 32-bit floating-point number is assigned to the device register and the smallest register number is assigned to the lowest bit.
BIT Use when a bit value (e.g., DI, DO) is assigned to the Modbus device register.

Data Type Defined in a MODBUS Device Definition File
GA10 (R2.02.xx and later) retains the data types of registers defined in the Modbus device definition file and uses them 
for displaying and recording. The data types of each register correspond to the following channel data types.

Register Data Type Channel Data Type
INT16 SHORT
UINT16 USHORT
INT32_B LONG
INT32_L LONG
UNIT32_B ULONG
UINT32_L ULONG
FLOAT_B FLOAT
FLOAT_L FLOAT
BIT BOOL

Note
A read error will occur in the following situations.
•	 A	mandatory	item	is	missing.
•	 	There	is	a	syntax	error.	However,	in	the	following	situations,	an	error	will	not	occur	and	the	value	

will be corrected when it is read.
•	 There	is	a	limit	to	the	string	length	for	a	node	attribute,	and	this	limit	is	exceeded.
•	 	There	is	an	allowable	range	for	a	node	attribute,	and	the	value	is	outside	the	range.
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3.5 Displaying Project Settings
Project settings can be displayed in tables on a browser. You can select whether to show or 
hide the settings for each item.

3.5.1 Selecting the Settings to Be Shown
Follow the procedure below to select the project settings you want to show on the browser.

1 In the Project List Page, double-click the appropriate project to open the project.

2 On the Project menu, click Setting Printout Config.
The	Setting	Printout	Config	dialog	box	opens.
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3 Select the items you want to show.
 By default, all items are selected. Click the items you want to hide to clear the check 

boxes.
Check boxes when selected

4 For Tag Display Form,	click	▼	to	select	Tag No., Tag Comment, or Tag Index.

5 Click OK.
The selected items in the dialog box are saved.

 Click Display to show the project settings on the browser according to the se-
lected items.

 Click Cancel to cancel the items selected in step 3.

Note
The saved settings are applied to all projects at the client level. These settings are retained even 
after you log out.

The following table shows the items and descriptions in Setting Printout Config. The 
details of each item are displayed when the corresponding check box is selected.

Items Contents to be specified
Device Shows or hides device information.

Display only registered devices Shows or hides unregistered devices.
Display only registered device's channels Shows or hides detailed channel information of 

registered devices.
Tag Shows or hides tag information.

Display tags that are assigned to device channels Shows or hides tags that are not assigned to 
channels.

Math Tag Shows or hides math tag information.
Display math tags that are being monitored Shows or hides tags that are not being 

monitored.
Display registered math constants Shows or hides unregistered math constants.

Display Group Shows or hides display groups.
Display the waveforms that are selected under 
display group

Shows or hides waveforms that are not 
assigned to tags.

Acquisition& Monitor Shows or hides acquisition and monitor 
information.

Anomaly detection Shows or hides the anomaly detection setting 
information

Show selected display groups designated 'ON' Shows anomaly detection only for display 
groups that have been turned "On" when 
the check box is marked; or shows anomaly 
detection for all display groups, including those 
that have been turned "Off" when the check 
box is not marked

Record Shows or hides recording setting information.
Integration (/WH option) Shows or hides integration information

Display report channels that are assigned to tags Shows or hides report channels that are not 
assigned to tags

Hide when the demand On/Off setting is Off. Shows or hides demand settings when demand 
is set to Off

Report/Print Shows or hides report and print.
No display if there are no report/print task Shows or hides report settings when Task is 

set to None.
Display report channels selected under Report 
Output Task

Shows or hides report channels that are not 
assigned to tags.
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Items Contents to be specified
E-Mail Shows or hides email setting information.

No display if email setting is "off" Shows or hides email setting information when 
email is set to Off.

Display the selected tags that are listed under 
TRIG

Shows or hides tags that are not specified as 
email triggers.

OPC-UA (/UA option) Shows or hides OPC-UA server setting 
information.

Access&Others Shows or hides Access&Others setting 
information.

3.5.2 Showing Settings
Follow the procedure below to show project settings on the browser. You can also show the 
settings by clicking Display in the Setting Printout Config dialog box.

1 In the Project List Page, double-click the appropriate project to open the project.
The selected project appears on the Project Page.

2 On the Project menu, click Config Display.
The Web browser starts, and the settings are displayed in tables.

 To change or omit the displayed items, follow the procedure in section 3.5.1.

Structure of the Setting Display Screen
The following figure illustrates the structure of the setting display screen. Each information is 
displayed in a table.

Basic information

Setting information

*: Options

Project configuration details

Client time, server options, user list, etc.

Project name, owner name, etc.

Detailed display settings

(1)

(2)

(3)

(4)

Anomaly detection

Device

Tag

Math Tag *

Display Group

Acquisition & Monitor

Record

Integration

Report/Print *

FTP

Setting Printout Config

Project information

Basic information

E-mail

OPC-UA *

Access&Others
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 Chapter 3  Configuring and Starting Data Collection and Recording

(1) Basic information
 Items displayed as basic information are GA10 server and client information. They are 

displayed at the top of the display screen.

Items Explanation/Display contents
PC time Time of output of the PC in which the GA10 client showing the information is installed.
Version GA10 server version
Option Options added to the GA10 server
User List List of users registered in the GA10 server

(2) Project information
 The items shown as basic project information are as follows.

Items Explanation/Display contents
Project's name Name of the project showing the information
Owner Project owner name
Comment Comment added to the basic project information

(3) Setting Printout Config
 The display settings saved using Setting Printout Config. on the Project menu (section 

3.5.1) are shown in table format.

(4) Setting information
 The project setting details are displayed for each setting item.
•	 Device
 Up to 20 devices are displayed in a table. If there are more than 20 devices, the tables 

are divided. If the entire width of the table cannot be displayed depending on the print 
paper size (A4 portrait), the table is divided into several tables.

Table Items Explanation/Display contents
Device Device No. Device number

Device Name Device name (e.g.,: Device01)
Device Type Device type (e.g.,: GX10)
Version No. Firmware version for the connected device.
Communication Comm. Kind Ethernet, Serial, or USB

Host Name/IP Address “N/A” is displayed when Comm. Kind is set to 
Serial.

Port No. “N/A” is displayed when Device Type is not 
DAQWORX.

System No. Same as above
COM Port No. COM1 to COM20.

“N/A” is displayed when Comm. Kind is set to 
Ethernet.

Comm. Type RS-232C or RS-422/RS-485
“N/A” is displayed when Comm. Kind is not set to 
Serial.

Baud Rate “N/A” is displayed when Comm. Kind is not set to 
Serial.Parity

Stop Bit
Address “N/A” is displayed when Comm. Kind is not set to 

RS-422/RS-485.
User Name User name and user ID when the security function 

of the connected device is set to communication 
login.

User ID

Modbus Modbus Address “N/A” is displayed when Device Type is not a 
Modbus device.

Monitor Interval 
Timeout
Option

Channel Meas Ch. Displays the number of channels of each.
Math Ch. 
Ctrl Ch. 
Extra Ch. 

Device's 
channels
(Device 
No.:x, Device 
Name:xxx)

Channel Channel number
Use ON or OFF
Tag No. Specified tag number
Tag Comment Entered tag comment
Type Tag (channel) data type
Dec. Point Number of decimal places
MIN Minimum scale
MAX Maximum scale
Unit --
Alarm 1 to 4 Type Alarm type

Value Input value
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•	 Tag
 Up to 20 tags are displayed in a table. If there are more than 20 tags, the tables are 

divided. If the entire width of the table cannot be displayed depending on the print paper 
size (A4 portrait), the table is divided into several tables.
Items Explanation/Display contents
Tag Index Tag0001 to Tag2000
Monitor ON or OFF
Record ON of OFF

Not displayed when the project is an OPC-UA project (/UA option)
Device Device number : Device name
Channel Channel number
Tag No. Specified tag number
Tag Comment Input tag comment
Type Tag data type
Dec. Point Number of decimal places
Integration 
Overflow

Specify ON or OFF

Value Input value
Alarm 1 to 4 Type Alarm type

Value Alarm threshold
Sound Assigned alarm sound fil

•	 Math	Tag	(/MT	option)
 Math tag settings are displayed in math tag and math constant tables. Up to 20 tags or 

constants are displayed in a table. If there are more than 20, the tables are divided. If 
the entire width of the table cannot be displayed depending on the print paper size (A4 
portrait), the table is divided into several tables.

 
Items Explanation/Display contents
Math Tag Tag Index A0001 to A2000

Acquisition & Computing ON or OFF
Record ON or OFF
Integration Target Tag index (Tag0001 to Tag2000)
Expression Expression
Span Dec. Point Number of decimal places

MIN Input value
MAX Input value

Unit Input value
Tag No. Tag number
Tag Comment Tag comment string
Alarm 1 to 4 Type Alarm type

Value Input value
Hysteresis Input value
Sound Assigned alarm sound fil

Constant Label Input value
Value Input value
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 Chapter 3  Configuring and Starting Data Collection and Recording

•	 Display	Group
 Each display group is displayed in a table. If there are more than 20 waveforms, the 

tables are divided. If the entire width of the table cannot be displayed depending on the 
print paper size (A4 portrait), the table is divided into several tables.

 
Items Explanation/Display contents
No. W01 to W50
ON/OFF ON or OFF
Tag Index/Tag No./Tag comment Displays the item name selected in the display settings
Y-Axis No.    Y01 to Y50

Mode Detail or compact mode
Type Linear or logarithmic
Title mode Default, or customize (customize when you enter a 

title)
Title Waveform’s Y-axis title

Form. F, or E
Meter Bar, or analog
Scale MIN Input value

MAX Input value
Scale interval Use ON or OFF

Value Input value
Zone MIN Input value

MAX Input value
Color RGB value

Use ON or OFF
Trip1 to Trip4 Value Input value

Color RGB value

•	 Acquisition	&	Monitor
 Acquisition and monitor information is shown in Acquisition, Pre-set mark, Monitor, and 

Split Screen Data Set tables. The following items are displayed.
Items Explanation/Display contents
Acquisition Data time Device time or PC time

Monitor Interval If Device time is selected, “–” is displayed.
If PC time is selected, Monitor interval selected from 
options is displayed.

Pre-set mark No. Pre-set mark
1 to 5 Displays the set mark

Monitor Monitor Data Set Number 1 to 16
Split Screen Direction Horizontal or vertical
Set Number in Spliting Direction 1 to the Monitor Set Number
Resize the Monitor Set ON or OFF
Alarm Shape Round or rectangle
Alarm Color ON RGB value

OFF RGB value
Split Screen 
Data Set

No. 1 to 16

Split Screen Data Set Trend, Digital, Meter, Alarm, Integration gaph, Demand 
monitor 

•	 Anomaly	detection
 The anomaly detection setting information is shown in Group name, Analysis, Type, and 

Detection level tables. 
 The following items are displayed.

Items Explanation/Display contents
Anomaly 
detection

Group Name Group 01 to Group 200
Analysis ON or OFF
Type Anomaly detection
Detection level Standard or High
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•	 Record
 Recording setting information is displayed in Record and Comment tables. The following 

items are displayed.
 

Items Explanation/Display contents
Record Record Interval If Device time is selected, N/A is 

displayed.
If PC time is selected, Record interval 
selected from options is displayed.

Record File Type Binary/Excel/Binary & Excel
Start Condition Displays specified conditions.
Stop Condition
File Division
Number of Files Limit the Number of Files ON or OFF

Number Number of files, or N/A
Folder Path to the save directory

File Name File name
File Name Attach the Date ON or OFF

Attach the Time ON or OFF
Computing Reset When Recording Starts ON or OFF 

Displayed only on models with the 
math function (/MT option)

Comment No. 1 to 8
Title Title string
String Comment string

Note
In report/print setting information and email setting information, the time of Condition and Range is 
displayed using the following symbols.
• YYYY: year • MM: month • DD: day
• hh: hour • mm: minute • ss: second • ms: millisecond
• w Weekday every week: Monday to Sunday • d Day every month: 1 to 31

•	 Integration	setting	information	(/WH	option)	
 Integration setting information is displayed in a table for each integration group.

Items Explanation/Display contents
Integration Report File 
Name Naming Rule

Rule Auto/Specify

Name Specified file name, or N/A
Integration Report File 
Output Folder

Path to the save directory

Name Group name
Integration Tag No. 1 to 50

Tag No. Tag0001 to Tag1000, displays the item 
name selected in the display settings

Color RGB value
Integration Graph ON or OFF
Demand Monitor ON or OFF
Demand Period 15 min/30 min/1 Hour
Contact Power Input value
Target Power Input value
Cut-off Margin Power Input value
Alarm Mask Time Input value
Estimated Compare Ti... 10 s/20 s/30 s/1 min/2 min/5 min/10 

min
Basic Alarm Level No. 01 to 04

On/Off ON or OFF
Value Input value
Hysteresis Input value
Alarm Shape Circle (¡) or rectangular (¨)
Alarm Color ON RGB value

OFF RGB value
Line Color RGB value

Cut-off Alarm Level No. 1
On/Off ON or OFF
Value Input value
Hysteresis Input value
Alarm Shape Circle (¡) or rectangular (¨)
Alarm Color ON RGB value

OFF RGB value
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 Chapter 3  Configuring and Starting Data Collection and Recording

•	 Report/Print	(/RP	option)
 For Report/Print setting information, report/print schedule list of the entire project is 

displayed in a table first. Then, for each report in the list, the schedule, graph, and 
template file tables are displayed. The items in the graph information display varies 
depending on Print Type.

  Report/Print-Schedule list
Items Explanation/Display contents
Schedule No. Report01 to Report20
Name Report name
Task None/Standard Print/Custom Print/Report Output

  Report/Print-Schedule (Task: Standard Print)
Items Explanation/Display contents
Name Report name
Task Standard Print
Condition Displays specified conditions. (e.g., Every Hour mm:ss)
Range Start Time Displays specified start time. (e.g., Prev. Hour mm:ss)

End Time Displays specified end time. (e.g., Current Hour mm:ss)
Print Type Trend Graph/Circular/Sheet/Alarm List/Mark List
Group Start group to end group (e.g., 01~10)
Print Header Header items File name, type, serial number, time change, number of measurement 

channels, print comment, number of math channels, sample interval, 
comment (one from 1 to 8 for the comment)

Comment

Printout Setup Print Graph Format Single page or multiple pages
Font size 6pt to 20pt
Line Thick 0.25pt/0.5pt/1.0pt/1.5pt/3.0pt
Tag Display Form. Tag No./Tag Comment/Tag Index
Pring Graph Grid Standard Grid, Dense Grid 1 to 4

1min, 2min, 5min, 10min, 20min, 30min, 1h, 2h, 3h, 4h, 6h, 8h, 12h, 
1day, 7days, 1month when the waveform print format is multiple pages.

Sub Grid Same as above. (depends on the Print Graph Grid setting)
Y-axis grid Standard Grid, Dense Grid1, Dense Grid2, Dense Grid3, Dense Grid4
Y-axis zone Full Zone, Slide Zone, Auto Zone, Free Zone
Active Y-axis 1 to 50
Y Axis Column Num 1 to 50
Legend Yes/No
Legend position Top, Bottom, Left, Right
Color Mode Black and white/color
Mark Color RGB value

Print Setup Printer Printer name
Paper Size Print paper size
Orientation Portrait or landscape

Output Language Japanese/English/Chinese/German/French/Korean/Russian

  Report/Print-Schedule (Task: Custom Print)
Items Explanation/Display contents
Name Report name
Task Custom Print
Condition Displays specified conditions. (e.g., Every Hour mm:ss)
Template File Template file name
Printer Specified printer name
Output Language Japanese/English/Chinese/German/French/Korean/Russian

 
  Report/Print-Schedule (Task: Report Output)

Items Explanation/Display contents
Name Report name
Task Report Output
Type Hourly + Daily, Daily + Weekly, Daily + Monthly, Batch, Daily custom
Condition Displays specified conditions.
Filename Naming Rule Rule Auto/Specify

File Name Specified file name, or N/A
Output Folder Folder type Data Folder, Subfolder in the data folder, Specified folder

Folder Path to the save directory
Template File Template file name
Print Setup Print Out Yes/No

Printer Specified printer name
Output Language Japanese/English/Chinese/German/French/Korean/Russian
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  Report/Print-[Report name] 's graph (Print Type: Trend Graph)
Items Explanation/Display contents
Print Type Trend Graph
Range Start Time Displays specified start time. (e.g., Prev. Hour mm:ss)

End Time Displays specified end time. (e.g., Current Hour mm:ss)
Group Group name
Printout Setup Line Thick 0.25pt/0.5pt/1.0pt/1.5pt/3.0pt

Font size 6pt to 20pt
Tag Display Form Tag No./Tag Comment/Tag Index
Print Graph Grid Standard Grid, Dense Grid 1 to 4
Y-axis grid Standard Grid, Dense Grid1, Dense Grid2, Dense Grid3, Dense 

Grid4
Y-axis zone Full Zone, Slide Zone, Auto Zone, Free Zone
Active Y-axis 1 to 50
Y Axis Column Num 1 to 50
Legend Yes/No
Legend position Top, Bottom, Left, Right
Color Mode Black and white/color
Mark Color RGB value
Print Quality Standard/High

  Report/Print-[Report name]'s graph (Print Type: Alarm List)
Items Explanation/Display contents
Print Type Alarm List
Range Start Time Displays specified start time. (e.g., Prev. Month 1Day hh:mm:ss)

End Time Displays specified end time. (e.g., Current Month 1Day hh:mm:ss)
Printout Setup Tag Display Form Tag No./Tag Comment/Tag Index

Color Mode Black and white/color
Print Quality Standard/High

  Report/Print-[Report name]'s graph (Print Type: Mark List)
Items Explanation/Display contents
Print Type Mark List
Range Start Time Displays specified start time. (e.g., Prev. Cycle hh:mm:ss)

End Time Displays specified end time. (e.g., Current Cycle hh:mm:ss)
Printout Setup Color Mode Black and white/color

Print Quality Standard/High

  Report/Print-Template File
Items Explanation/Display contents
No. 01 to 20
File Name Displays registered template file name.(Displayed as "Unregistered" if 

there are no registrations.
Type ---/Print/PDF/Excel (Displayed as “---” if there are no registrations)

•	 FTP
Items Explanation/Display contents
On/Off ON or OFF
FTP Server Server name specified by the user.
Port No. Port number specified by the user.
Encryption OFF, SSL/TSL
Authentication ON or OFF
User Name User name specified by the user.
Password Password
Directory Path to the save directory
PASV Mode ON or OFF
Transfer File Recording File(*XLSX, *.did), Report File (*.XLSX, *pdf), 

Integration Report File (*.GRI), Demand Monitoring Data 
File (*.DRE)
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 Chapter 3  Configuring and Starting Data Collection and Recording

•	 E-mail
For email setting information, mail server, mail setting list, mail setting*(up to 20), and mail 
trigger settings are displayed. The following items are displayed.

*: The displayed items of mail setting information varies depending on Condition.

 E-Mail-Mail server
Items Explanation/Display contents
SMTP Server Server name specified by the user.
Port No. Port number specified by the user.
Resend Times 0 to 5
Authentication Methods OFF/SMTP Authentication/POP Before SMTP
POP Server Displays the server name when the authentication method is set to POP Before 

SMTP.
Port No. Displays the port number when the authentication method is set to POP Before 

SMTP
User Name User name

 E-Mail-Mail setting list
Items Explanation/Display contents
Schedule No. Schedule number of the specified mail

Mail01 to Mail20
Name Mail name
On/Off OFF/ON
Condition Alarm Status/Comm. Status/Specified Period/Specified Duration/File is created

 E-Mail-Mail setting (Condition: Alarm Status)
If Condition is set to Alarm Status, the mail and its trigger settings are displayed.
Items Explanation/Display contents
Name Mail name (e.g., Mail 01)
On/Off OFF/ON
Condition Alarm Status
TRIG Easy/Detail
Sending Basic 
Settings

Sent from Sender email addresses
Sent to Recipient email addresses
CC Carbon copy (CC) email addresses
Title Message title
Custom Header Header information entered by the user
Content Message content

Message Language Japanese/English/Chinese/German/French/Korean/Russian
Attached Files Alarm Information ON/OFF

Instantaneous Value ON/OFF
Tag select type Range/Detail
Specified tag Range: Start tag to end tag (e.g., Tag001 to Tag0100)

Detail: List of selected tags (e.g., Tag001, Tag002, Tag005...)

 E-Mail-[Mail name]'s trigger
Items Explanation/Display contents
Range If Tag select type is Easy, start tag to end tag are displayed (e.g., Tag001 to Tag0100).
Tag Index If Tag select type is Detail, a list of selected tags is displayed.

(e.g., Tag001, Tag002, Tag005...)
Use If Tag select type is Detail, ON/OFF is displayed for each tag.
Level 1 to 4 ---, ON, OFF, On/Off

 E-Mail-Mail setting (Condition: Comm. Status)
Items Explanation/Display contents
Name Mail name
On/Off OFF/ON
Condition Comm. Status
TRIG Communication Disconnect/Communication Recover/Loss Data
Sending Basic Settings Sent from Sender email addresses

Sent to Recipient email addresses
CC Carbon copy (CC) email addresses
Title Message title
Custom Header Header information entered by the user
Content Message content

Message Language Japanese/English/Chinese/German/French/Korean/Russian
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 E-Mail-Mail setting (Condition: Specified Period)
Items Explanation/Display contents
Name Mail name
On/Off OFF/ON
Condition Specified Period
TRIG Every day hh:mm:ss

Every week w day hh:mm:ss
Every month d hh:mm:ss

Sending Basic Settings Sent from Sender email addresses
Sent to Recipient email addresses
CC Carbon copy (CC) email addresses
Title Message title
Custom Header Header information entered by the user
Content Message content

Message Language Japanese/English/Chinese/German/French/Korean/Russian
Attached Files Alarm Information ON/OFF

Instantaneous Value ON/OFF
Tag select type  Range/Detail
Specified tag Range: Start tag to end tag (e.g., Tag001 to Tag0100)

Detail: List of selected tags (e.g., Tag001, Tag002, Tag005...)

 E-Mail-Mail setting (Condition: Specified Duration)
Items Explanation/Display contents
Name Mail name
On/Off OFF/ON
Condition Specified Duration
TRIG hh:mm:ss
Sending Basic Settings Sent from Sender email addresses

Sent to Recipient email addresses
CC Carbon copy (CC) email addresses
Title Message title
Custom Header Header information entered by the user
Content Message content

Message Language Japanese/English/Chinese/German/French/Korean/Russian
Attached Files Alarm Information ON/OFF

Instantaneous Value ON/OFF
Tag select type  Range/Detail
Specified tag Range: Start tag to end tag (e.g., Tag001 to Tag0100)

Detail: List of selected tags (e.g., Tag001, Tag002, Tag005...)

 E-Mail-Mail setting (Condition: File is created)
Items Explanation/Display contents
Name Mail name
On/Off OFF/ON
Condition File is created
Sending Basic Settings Sent from Sender email addresses

Sent to Recipient email addresses
CC Carbon copy (CC) email addresses
Title Message title
Custom Header Header information entered by the user
Content Message content

Message Language Japanese/English/Chinese/German/French/Korean/Russian
Attached Files None/Data file
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 Chapter 3  Configuring and Starting Data Collection and Recording
 

•	 OPC-UA	(/UA	option)
For OPC-UA server information, monitor, server setting, and server certificate are displayed.
The following items are displayed.

 Server Operation-Acquisition
Items Explanation/Display contents
Data time PC time/Device time
Monitor Interval If Device time is selected, “–” is displayed.

If PC time is selected, Monitor interval selected from options is displayed.

 Server Operation-Server Setting
Items Explanation/Display contents
Server Name Server name specified by the user
Port No. Port number specified by the user
Anonymous Login

 Server Operation-Server Certificate
Items Explanation/Display contents
Version Version
Serial No. Serial number
Signature Algorithm Signature Algorithm
Signature Hash Algorithm Signature Hash Algorithm
Issuer Issuer
Valid from YYYY/MM/DD hh:mm:ss
Valid to YYYY/MM/DD hh:mm:ss

•	 Access	&	Others	
For Access&Others setting information, access and other settings are displayed.

 Access&Others-Access
Items Explanation/Display contents
Manager User name

e.g., User01/User02/User03/...Operator
Monitor

 Access&Others-Others
Items Explanation/Display contents
Keep Lock State ON/OFF
DDE Server ON/OFF
Share Alarm ACK ON/OFF
Modbus Server ON/OFF
Modbus Address 1 to 247
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3.5.3 Printing and Saving Displayed Information
You can print or save the setting display screen using the Web browser functions. The 
following are examples using Internet Explorer 11 (IE).

Printing the Display Screen

1 On the IE’s File menu, click Print.
A Print dialog box appears.

2 Click Print.
The	setting	display	screen	on	the	browser	are	printed	on	the	specified	printer.

•	 To	a	print	preview,	on	the	IE’s	File	menu,	click	Print	Preview.

Saving the Display Screen

1 On the IE’s File menu, click Save As.
A Save Webpage dialog box appears.

2 Move to the folder in which to save the page.

3 Enter a new name in File name.

4 Click Save.
The	setting	display	screen	(HTML	page)	is	saved	in	the	specified	location.

Note
•	 You	can	use	Copy	on	the	IE’s	Edit	menu	to	copy	the	displayed	information	to	Excel	or	other	

applications.
•	 For	details	on	the	IE	functions	and	how	to	use	them,	see	the	Microsoft	user’s	guide,	support	

sites, and the like.
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Chapter 4  Using the Math Function (/MT option)
4.1 Setting Math Tags

The GA10’s Math function (/MT option) can be used to set expressions with constants, 
operators, and functions to display and record (save) the calculated results. To use the Math 
function, you need to set the math tags on the Math Tag Setting Page. You can set up to 
2000 math tags. If the number of measurement tags increases due to a GA10 upgrade, the 
number of math tags also increases accordingly. The following table shows the relationship 
between the number of measurement tags and the number of math tags.

Measurement tags Math tags
100 200
200 200
500 500
1000 1000
2000 2000

Note
Before using the Math function, set the data time acquisition condition (on the Acquisition&Monitor 
Page) to PC time.

Basic Operation

1 Select Math Tag in the navigation area on the left of the window.
 Math Tag appears when the license for the Math function (/MT option) is already registered.

The Math Tag Setting Page appears.

1

2

4

3

Scroll to show the Unit, Tag No., Tag Comment, and Alarm items.

2 Select a tag to use (1 line = 1 tag = 1 math tag).
Click the check boxes in the Acquisition & Computing or Record column.

3 Set the expressions and the like of the math tags you want to use.
 Setting details:  next page
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You can set the following items for math tags.

(1) Acquisition & Computing (Math Tag Index)
 These are unique tag numbers assigned sequentially from A0001 to A2000. You cannot 

change the numbers. Click to specify whether to acquire and compute. Blue is on 
(record).

(2) Record
 Click to specify whether to record (save the math data). If you set Record to On, 

Acquisition & Computing will also be automatically set to On.
(3) Integration Target (/WH option)
 Click to specify the tag of the integration calculation target. 
 When you select a tag, the calculation expression appears automatically. You cannot edit 

the expression. 
 For Tag No. and Tag Comment, the same content as the specified tag is applied.

•	 Default values: None
•	 Selectable range: Tag0001 to Tag2000

 Math target tag 
 If you select the “Show Device No.: Device Name: Channel No.” check box, the following 

information is displayed after the Tag Index/Tag No./Tag Comment.

画像変更済み

Displays the connected device information after Tag Index/Tag No./Tag Comment.

 Device No.: Displays the number in the GA10 Devices List.
 Device Name: Displays the first 9 characters of the device name assigned on the GA10 

Tag Setting Page.
 Channel No.: Displays the channel number of the connected device.

 To Edit the Expression 
 After selecting the tag, changing the integration target to None will enable you to edit the 

expression.

(4) Expression
 Set the expression. If the expression that you enter is invalid, it will be displayed with red 

characters.
•	 Default value: TAG(0001)
•	 Input range: Enter a text string using up to 127 characters. Constants and functions 

are not case sensitive. 
Available operators and functions:  page 4-5

(5) Dec. Point
 Select the number of decimal places.

•	 Default value: 2

 Chapter 4  Using the Math Function (/MT option)
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(6) Span
 Enter the minimum and maximum values of the span.

•	 Default value: -100.00 (minimum value) 100.00 (maximum value)
•	 Input range: –3.4028235E+38 to 3.4028235E+38

Constants are detailed later.

Alarm 1

Alarms 2 to 4

13

(7) Unit
 Enter the unit.

•	 Default value: Blank
•	 Input range: Enter up to 6 characters.

(8) Tag No.
 Enter the tag number.

•	 Default value: TagA0001 to TagA2000
•	 Input range: Enter up to 16 characters.

(9) Tag Comment
 Enter the tag comment.

•	 Default value: TagCommentA0001 to TagCommentA2000
•	 Input range: Enter up to 32 characters.

(10) Alarm 1 to 4* Type
 Select the alarm type from the list.

•	 Default value: Off
•	 Selectable range:  Off, High (high limit alarm), Low (low limit alarm), rHigh (high 

limit on rate-of-change alarm), rLow (low limit on rate-of-change 
alarm)

* For alarms, you can set Alarm 1 to Alarm 4.

(11) Alarm 1 to 4 Value
 Enter the alarm value.

•	 Default value: 0.00
•	 Input range: –3.4028235E+38 to 3.4028235E+38

(12) Alarm 1 to 4 Hysteresis
 Enter the alarm hysteresis.

•	 Default value: 0.00
•	 Input range: 0 to 3.4028235E+38

(13) Alarm 1 to 4 Sound
 Set the alarm sound.
You can assign an alarm sound to each math tag.
The alarm sound settings and alarm sound files are saved in the project file.

Alarm sound Description
None This is when an alarm type is not assigned.
Standard If an alarm type is assigned, this is the GA10’s standard alarm sound.
Alarm sound file If an alarm type is assigned and alarm sound files are registered, file names are displayed 

for you to select from.

Chapter 4  Using the Math Function (/MT option)
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Registering and deleting alarm sound files
Alarm sound files can be uploaded to the server, downloaded from the server, or deleted.

•	 Upload
 Click a number, click Upload, and specify an .mp3 file.
•	 Download
 Click a number, click Download, and specify the client’s save destination to save the file.
•	 Delete
 You can select alarm sound files registered in the server. Click a number, and click Delete 

to delete the file.

Setting Math Constants
You can use the following three types of constants. (They cannot be used in event functions 
or time functions.)

•	 User-defined math constant: A constant that the user sets for specific text strings 
(labels).

•	 Predefined math constant: A constant that is already defined in the GA10 Math 
function.

•	 Numeric math constant: A constant that the user enters directly in expressions using 
a number without setting a definition.

 User-Defined Math Constant
 User-defined math constants are set in the Constant area (the right side) of the Math Tag 

Setting Page. You can set up to 200 pairs of labels and values.

ba

Basic Operation

1 Click a cell in the Label column under Constant, and enter a name for identifying the 
constant.

2 Click a cell in the Value column, and enter the value.

a. Label
 The name of the label. Set using a text string that is not already used in predefined 

constants. If duplicate constant names exist, the first definition is used by expressions.
•	 Default value: Blank
•	 Input range: Enter up to 10 characters.

b. Value
 Enter the constant value.

•	 Default value: 0
•	 Input range:  –3.4028235E+38 to 3.4028235E+38
•	 Value’s displayed number of decimal places: The number of displayed decimal 

places is undefined (the number of significant numeric digits is seven). When 
necessary, it is displayed in exponential form to match the display of the actual 
value (e.g., 1.234E12).
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 Predefined Math Constant
 The following table shows the predefined math constants.

Constant Name 
(Label)

Description

NaN Undefined or error value
POver +Overrange
MOver –Overrange
Pi π	(3.14...)
e Base of natural logarithm (2.718...)

 Numeric Math Constant
 To express a constant by entering a number directly in an expression, use the following 

syntax.
 [digits][.digits][{d | D | e | E}[digits]]
 Example: “1.0d+1” represents “10.0.”

Available Operators
The following operators can be used in expressions.

Operator Description
+ Unary plus operator
- Unary minus operator
! Logical negation operator, 1 if 0, otherwise 0
+ Addition
- Subtraction
* Multiplication
/ Division
% Remainder
< Less than, 1 if true, 0 if false
> Greater than, 1 if true, 0 if false
<= Less than or equal to, 1 if true, 0 if false
>= Greater than or equal to, 1 if true, 0 if false
== Equal to, 1 if true, 0 if false
!= Not equal to, 1 if true, 0 if false
&& Logical AND, continue calculation even if false
|| Logical OR, continue calculation even if true
^^ Exclusive OR
?: Conditional operator
, Comma operator

The operator precedence is shown below. The operator on the left of the arrow has higher 
precedence than that on the right.
“+	–	!”(unary	operator)	←“+	–	*	/	%”(arithmetic	operator)	←“<	>	<=	>=	==	!=”(relational	
operator)	←“&&	||	^^”(logical	operator)	←“?”(conditional	operator)	←“,”(comma	operator)

Available Functions
The following functions can be used in expressions. (Math constants cannot be used in 
event functions.)

 Event Functions
  Functions that perform specific actions. (Math constants cannot be used in event 

functions.)
Function Action Example
ResetMath() Resets math. TAG(00010)>=1.0 ? 

ResetMath() : 0
Mark("mark") Creates a mark. Characters of your choice inside the double 

quotations.
Mark("alarmMark")

Chapter 4  Using the Math Function (/MT option)
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 Reference Functions
 Functions for retrieving measured values and alarm values.

Function Action Example
Tag(<TagIndex>) Returns the current value of the specified tag. Either 

tag index or tag number can be specified.
Tag(0001)

PreTag(<TagIndex>) Returns the previous value of the specified tag. 
Either tag index or tag number can be specified.

PreTag(0001)

Alarm(<TagIndex>,<alarmLevel>) Returns the alarm value of the specified tag.
ON=1, OFF=0
Either tag index or tag number can be specified.

Alarm(0001,4)

Alarm(<TagIndex>) Returns the alarm value of the specified tag.
ON=1, OFF=0
Either tag index or tag number can be specified.

Alarm(0001)

Alarm() Returns the alarm value of any tag.
ON=1, OFF=0

Alarm()==1

 Arithmetic Functions
Function Action Example
sin(<Value>) Returns the sine of <Value>. sin(TAG(0001))
cos(<Value>) Returns the cosine of <Value>. cos(TAG(0001))
tan(<Value>) Returns the tangent of <Value>. tan(TAG(0001))
asin(<Value>) Arc sine. asin(TAG(0001))
acos(<Value>) Arc cosine. acos(TAG(0001))
sinh(<Value>) Hyperbolic sine. sinh(TAG(0001))
cosh(<Value>) Hyperbolic cosine. cosh(TAG(0001))
tanh(<Value>) Hyperbolic tangent. tanh(TAG(0001))
pow(<Value1>,<Value2>) <Value1> to the power of <Value2> pow(TAG(0001),TAG(0002))
abs(<Value>) Absolute value abs(TAG(0001))
sqrt(<Value>) Square root sqrt(TAG(0001))
logE(<Value>) Natural logarithm logE(TAG(0001))
log10(<Value>) Common logarithm log10(TAG(0001))
expE(<Value>) E to the power of <Value> expE(TAG(0001))
exp10(<Value>) 10 to the power of <Value> exp10(TAG(0001))
max(<Value>,…, <Value>) Maximum value among mul t ip le 

specified values.
max(TAG(0001),TAG(0002),T
AG(0003))

min(<Value>,…, <Value>) Minimum value among multiple specified 
values.

min(TAG(0001),TAG(0002),T
AG(0003))

pp(<Value>,…, <Value>) (Maximum value – minimum value) 
among multiple specified values.

pp(TAG(0001),TAG(0002),TAG(0003))

sum(<Value>,…, <Value>) Sum of multiple specified values. sum(TAG(0001),TAG(0002),T
AG(0003))

ave(<Value>,…, <Value>) Average of multiple specified values. ave(TAG(0001),TAG(0002),T
AG(0003))

poly(<x>,<a0>,<a1>,…, <an>) Polynomial, variable parameters
Calculates a0xn+a1xn-1+…+anx0.

poly(TAG(0001),TAG(0002),T
AG(0003))

ceil(<Value>) Returns the minimum integer greater 
than or equal to <Value>.

ceil(TAG(0001))

floor(<Value>) Returns the maximum integer less than 
or equal to <Value>.

floor(TAG(0001))

limit(<x>, <a>, <b>) Rounds the value to [a] or [b] if x is 
outside the range [a,b].

limit(TAG(0001),10,20)

rnd() Returns a random number between 0 
and 1.

TAG(0001)*rnd()

IsNaN(<Value>) Returns 1 if <Value> is NaN, 0 otherwise. IsNaN(TAG(0001))
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Time Functions
 The following table shows the available time functions. (Math constants cannot be used in 

time functions.)

Function Action
time(<year>,<month>,<day>,<hour>,<minute>) Edge action on the date and time
bfTime(<year>,<month>,<day>,<hour>,<minu
te>)

Previous edge action on the date and time

time(<year A>,<month A>,<day A>,<hour 
A>,<minute A>,<year B>,<month B>,<day 
B>,<hour B>,<minute B>)

Level action between time A and B

monthly(<day>,<hour>,<minute>) Edge action on <day> every month at <hour>, <minute>.
bfMonthly(<day>,<hour>,<minute>) Previous edge action on <day> every month at <hour>, 

<minute>.
monthly(<day A>,<hour A>,<minute A>,<day 
B>,<hour B>,<minute B>)

Level action between <day A>, <hour A>, <minute A> and <day 
B>, <hour B>, <minute B> every month.

weekly(<day of week>,<hour>,<minute>) Edge action on <day of week> every week at <hour>, <minute>.
bfWeekly(<day of week>,<hour>,<minute>) Previous edge action on <day of week> every week at <hour>, 

<minute>.
weekly (<day of week A>,<hour A>,<minute 
A>,<day of week B>,<hour B>,<minute B>)

Level action between <day of week A>, <hour A>, <minute A> 
and <day of week B>, <hour B>, <minute B> every week.

daily(<hour>,<minute>) Edge action at <hour>, <minute> every day.
bfDaily(<hour>,<minute>) Previous edge action at <hour>, <minute> every day.
daily(<hour A>,<minute A>,<hour B>,<minute 
B>)

Level action between time A and B every day

hourly(<minute>) Edge action at <minute> every hour.
bfHourly(<minute>) Previous edge action at <minute> every hour.
hourly(<minute A>,<minute B>) Level action between minute A and B every hour.

•	 Edge: Returns 1.0 at the time of computation immediately after the specified 
duration or time.

•	 Previous edge: Returns 1.0 at the time of computation immediately before the 
specified duration or time.

•	 Level: Returns 1.0 during the specified duration or time.
•	 Parameter setting range

  <year>: 1970 to 2036
  <month>: 1 to 12
  <day>: 1 to 31
  <day of week>: 0 to 6 (0: Sunday, 1: Monday, ..., 6: Saturday)
  <hour>: 0 to 23
  <minute>: 0 to 59

Bit Operation
 This is an operation function that retrieves the value of the specified bit position of an 

integer that is 32 bits maximum.

Function Action Example
Bit(<Value1>,<Value2>)) Returns the value of the <Value2>th bit of <Value1>.

Value2: 0 to 31 (values below zero are assumed to be 
zero, and values above 31 area assumed to be 31)

Bit(5,1)
Bit(Tag(0001),1)

Integration Function (/WH option)
Function Action Example
HourlyIntegration(<TagIndex> Returns the active energy/flow rate 

value per hour for the specified tag. 
TagIndex: Math target tag

HourlyIntegration(Tag(0001))

DaliyIntegration(<Tagindex>) Returns the active energy/flow rate 
value per day for the specified tag.
TagIndex: Math target tag

DaliyIntegration(Tag(0001))
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Anomaly detection score calculation formula
 This is the formula for calculating the anomaly detection score.

Function Action Example
HealthScore (nnn)

nnn: display group number

Obtain the anomaly detection score for the collection and 
computation interval of the specified display group and 
reflect it into the math tag.
Note:  This formula is only used to obtain the anomaly 

detection results, and not to detect anomalies.

HealthScore (001)

Detection score
1 or more
0 or more and less than 1

Less than 0

Normal
Intermediate value between 
normal and anomaly (See note)

Regarded as an anomaly
When not detecting anomalies
Detection score
Status

1
OFF

Note
•	 This	formula	is	only	used	to	obtain	the	anomaly	detection	results,	and	not	to	detect	anomalies.	
•	 Even	if	the	HealthScore	math	tag	is	registered	in	the	display	group	that	is	subject	to	anomaly	

detection, the HealthScore math tag value does not affect the results of learning and detecting 
anomalies. For that reason, you can use it, for example, by obtaining the detection score 
of display group 1 using the A0001 math tag, registering that tag to display group 1, and 
monitoring the waveforms of the collected data and detection score in display group 1 at the 
same time. 

•	 The	recommended	settings	for	the	HealthScore	math	tag	is	shown	below.	The	scale	can	be	
changed from the display group settings. 
 Span decimal place: 4
 Min scale: -2.0000
 Max scale: 2.0000

•	 When	anomalies	are	not	being	detected,	the	HealthScore	results	are	"1”	for	the	math	tag	value	
and "OFF" for status. "OFF" appears on the monitor.

•	 If	the	detection	score	is	0	or	more	but	less	than	1,	the	mean	value	of	the	normal	and	anomaly	
detection is shown. How this mean value is treated differs depending on the operation. As a 
reference, in the anomaly detection function, the value is treated as normal when the detection 
level is "Standard," and as an anomaly when the detection level is "High."

 For the behavior of the anomaly detection function,  
see “3.3.6 Configuring the Anomaly Detection Function” on page 3-38.

4.2 Performing Computations
Computation starts when data collection starts. Click the  icon displayed on the tab on 

the right side of the screen to start data collection. Click the  icon to start data collection 
and recording.
The execution interval of computation is the same as the monitor interval (for PC time).

 Chapter 4  Using the Math Function (/MT option)
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 Chapter 4  Using the Math Function (/MT option)

4.3 Resetting Computation
You can reset computation from the menu, separately from the acquisition and recording 
operation.
On the Project menu, click Reset Computing.

This command appears only if the user who opened the project has operator or higher 
privileges and data collection (computation) is in progress.

You can also configure the software to reset computing automatically when recording is 
started. On the Record Setting Page of the project, select the Reset Math When Recording 
Starts check box next to Math Action.

Select this check box.

In this situation, the math reset timing is delayed by up to two recording intervals from the 
record start timing.

Setting the data recording method:  Sec. 3.3.7
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Chapter 5  Using the Report/Print Function (/RP option)
5.1 Configuring Auto Print

5.1.1 Print Types and Basic Operation
The GA10’s Report/Print function (/RP option) can be divided into the following three 
functions.
You can set which function to use and with what kind of schedule to print from the Report/
Print Setting Page.

Standard Print
 You can select the display group and display format (trend graph, circular, sheet, alarm 

list, mark list) and print from a data file at the specified time on the specified printer.
Custom Print
 You can select the display group and display format (trend graph, alarm list, mark list) and 

print from a data file according to the specified template file at the specified time on the 
specified printer.

Report Output
 You can create a report file (PDF, Excel) from a data file according to the specified 

template file and specified report settings. You can create report data (PDF, Excel) of the 
average, maximum, minimum, sum, and instantaneous values over a specified duration.

In addition, custom print and report output can be performed manually from the Data files  
 :  Sec. 5.3

The following table shows the print types and their characteristics.

Standard Custom Report Output

Use

Auto printing at the 
specified time

Auto printing at the 
specified time using the 
specified layout

Auto printing at the 
specified time using the 
specified layout and 
report type

Condition

Hourly, Daily, Weekly, 
Monthly, Periodically, 
End of record

Hourly, Daily, Weekly, 
Monthly, Periodically,  
End of record

Hourly + Daily,  
Daily + Weekly,  
Daily + Monthly, Batch, 
Daily custom

Print Layout

Cannot be specified Can be specified Can be specified
None Report templates for 

PDF report files (*.tpl)
Report templates for 
Excel report files (*.xlsx, 
*.xlsm),
Report templates for 
PDF report files (*.tpl)

Graph

Print type Trend Graph, 
Circular, Sheet, 
Alarm List, 
Mark List

Trend Graph, 
Alarm List, 
Mark List

Trend Graph, 
Alarm List, 
Mark List

Number of graphs 1 graph/setting Up to 4 graphs/setting Up to 4 graphs/setting
Items Specified with Print 

Header
Specified with keyword Specified with keyword

Output channel Cannot be specified Cannot be specified Max. 100ch

Print Destination Local printer Local printer
PDF file

Local printer
Excel file

Number of Graph Print Pages Multiple pages Number of pages 
defined in the template

Number of pages 
defined in the template
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When using the Report/Print function (/RP option), note the following points
•	 Report	schedule	is	executed	only	when	a	project	is	"Recording".
•	 Report	output	and	auto	printing	may	be	delayed	up	to	10	minutes	depending	on	the	

specified conditions. This is because the execution time is shifted after a temporary file is 
created internally.

•	 If	the	recording	duration	is	long	and	the	number	of	data	points	in	the	target	range	is	large,	
standard print, custom print, and report output may take time.

•	 To	perform	custom	print	or	report	output,	you	must	specify	a	template	file	(Sec. 5.1.2).
•	 If	Data	time	is	set	to	Device	time	and	data	of	multiple	devices	is	being	recorded,	data	is	

saved to separate files for each device and for each data acquisition interval. Therefore, 
report files are also created for each device and for each data acquisition interval. If Data 
time is set to PC time, a single report file is created even when multiple devices are being 
recorded.

•	 The	printers	that	can	be	used	with	the	Report/Print	function	are	the	local	printers	
registered on the server PC. Network printers are not displayed in print settings. Virtual 
printers of local printers are displayed, but interactive virtual printers (e.g., WindowsXPS 
DocumentWriter) that require users to enter the file name cannot be used.

Report Output When Communication Is Disconnected
 If a communication interference occurs between the GA10 server and the connected 

devices, dropouts may occur in the report or print data. Only when Data time is set to 
Device time, the data in the dropout section is consolidated as “Off data,” and the dropout 
section is output with compensation. (See the figure below.)

f1 f2 f3 f4

Consolidated as OFF data

Data dropout occurrence

f1, f2, f2’, f3, and f4 are included in reports and printing.

f1 f2 f2’ f3 f4

•	 This function is not supported on versions earlier than GA10 R2.03.xx. (The file is 
divided at the data dropout section and output.) We recommend that you use the 
latest version of GA10.

Chapter 5  Using the Report/Print Function (/RP option)
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Basic Operation
The following procedure is for setting a schedule and printing automatically.

1 Select Report/Print in the navigation area on the left of the window.
 Report/Print appears when the license for the Report/Print function (/RP option) is already 

registered.

The	Report	Setting	Page	appears.	(See	the	figure	on	the	next	page.)

•	 The Report Setting Page consists of a tabbed page area for setting schedules in the 
top half and an area for registering template files in the lower half. You can register 
up to 20 schedule settings (tabbed pages) and up to 20 template files (PDF, Excel).

•	 The template registration area can be shown or hidden by clicking the up/down 
slide bar. By default, the template registration area is shown, but once you change 
its state, it is stored for each Windows user.

Area for registering template files

Area for setting report schedules1

2

Click this bar to show or hide the template registration area.

Chapter 5  Using the Report/Print Function (/RP option)
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2 Select the task (default value: None).
Settings appear in the schedule setting area depending on the selected task.

3 Set the print schedule in line with the task.
•	 For	details	on	the	settings	for	each	task,	see	Standard Print, Custom Print, 

and Report Output.
•	 For	Custom	Print	and	Report	Output,	you	use	a	template	file.	For	instructions	on	

how to register templates, see the next page.

4 Start recording .
The report is output or printed according to the schedule.

Note
•	 You	can	view	the	schedule	and	history	of	report	schedules	that	have	been	set	on	the	Status	

Page.
  Viewing report schedules:  Sec. 5.2
•	 The	results	of	auto	report	printing	is	displayed	in	the	project	log	of	the	Log	dialog	box.	A	log	

entry is sent when printing completes successfully or unsuccessfully.
  Opening the Log dialog box:  Sec. 6.10
•	 All	unexecuted	report	schedules	of	the	relevant	project	registered	in	the	server	are	executed	

after the last recording file is created upon the completion of a recording.
•	 Auto	print	schedules	that	have	not	been	completed	due	to	a	PC	shutdown	are	executed	again	

when the server recovers. However, output results of auto print executed in this way may have 
up to 10 minutes of data missing before the shutdown.

Chapter 5  Using the Report/Print Function (/RP option)
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5.1.2 Registering Template Files
Before performing a custom print or report print, register template files. The area for 
registering template files is in a two-column tabular form. You can register up to 20 report 
template files in the following format.

Template Files That You Can Use
Template File Save Format Extension Remarks
Excel format  *.xlsx A template created by entering keywords* and text of 

your choice in Excel cells.
Excel macro-enabled format *.xlsm Same as above
PDF format *.tpl Created using the SMARTDAC+ Report Template 

Builder (a tool for creating and viewing report 
templates in PDF format). You can download Report 
Template Builder from the following URL.
www.smartdacplus.com/software/en/

* Keywords specify the type of data that will be entered into a cell. Entering keywords makes it 
possible to print the information. :  “Keyword Definitions” on page App-3

On the template file registration area, you can use the control buttons in the upper right to 
register (to a PC), save, and delete template files.

1 2

1 Click the No. cell for the File Name that you want to perform the action on.
 To register, select a row showing “Unregistered.”
The selected row turns blue. You cannot select multiple rows.

2 Click a control button.
Clicking Upload displays a standard Open dialog box.
Clicking Download displays a standard Save As dialog box.
Clicking	Delete	deletes	the	file	registered	in	the	GA10	server.

3 If you click Upload, select the file you want to register, and click OK.
If you click Download, select the save destination, and click OK.
The	file	will	be	registered	or	saved.

Note
•	 If	you	place	the	SMARTDAC+	Report Template Builder installer in the same folder as the GA10 

installer, Report Template Builder will be installed automatically when you install GA10.
•	 For	information	on	how	to	use	SMARTDAC+	Report	Template	Builder,	see	the	Help	menu	of	

Report Template Builder.
•	 For	instructions	on	how	to	create	report	templates	for	Excel	report	files	and	examples	of	how	to	

write keywords, see “Appendix 1 Creating Report Templates”.

Chapter 5  Using the Report/Print Function (/RP option)
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5.1.3 Standard Print
If you set Task to Standard Print, the schedule page shows the Standard Print settings.
In standard print, the specified content is printed automatically from a data file at the 
specified time.

Setup Item
In a Standard Print schedule, set the following items.
(1) Name
 Enter the name of the schedule.

•	 Default value: Report01 to Report 20
•	 Input range: Enter a text string using up to 30 characters.

(2) Task
 Select Standard Print.

•	 Options: None, Standard Print, Custom Print, Report Print

(3) Condition
 From the list, select the time to execute printing.

•	 Default value: 00:00:00 every day
•	 Options: Every Hour, Everyday, Every Week, Every Month, Interval, Recording is 

finished
 The range (4) will vary depending on this condition.

(4) Range
 Set the target data range. For details, see Schedule Conditions and Range described 

later.

(5) Print Type
 Select the print type from the list.

•	 Default value: Trend Graph
•	 Options: Trend Graph, Circular, Sheet, Alarm List, Mark List

Chapter 5  Using the Report/Print Function (/RP option)
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(6) Group
 Specify the range of display groups to print using group numbers.

•	 Default value: 01-01
•	 Input range: Enter the display group numbers in the range of Group 01 to 50. Enter 

them so that the start group number is less than the end group number.

(7) Print Header
 Click the Detail button, and click the items you want to print in the Print Header Detail 

dialog box shown below. For File Name, the character strings of Schedule Name and 
Date will be output.

(8) Printout Setup
 Set the graph details. The items vary depending on the print type set in (5).

Item Default 
Value

Show or hide Range

Print Graph Format 1 page Displayed for Standard Print and Trend Graph 1 page, Multiple Pages
Line Thick 1.0pt Displayed for Trend Graph and Circular 0.25pt, 0.5pt, 1.0pt, 1.5pt, 

3.0pt
Font size 6pt Displayed for Trend Graph 6pt, 7pt, 7.5pt, 8pt, 9pt, 10pt, 

11pt, 12pt, 14pt, 16pt, 20pt
Print Graph Grid 1h(/div) Displayed for Trend Graph and Multiple Page 1min, 2min, 5min, 10min, 

20min, 30min, 1h, 2h, 3h, 
4h, 6h, 8h, 12h, 1day, 7days, 
1month

Print Graph Grid Standard 
Grid

Displayed for Standard Print or Trend Graph 
when 1 Page is selected
Displayed for Custom Print or Report Output.

Standard Grid, Dense Grid1, 
Dense Grid2, Dense Grid3, 
Dense Grid4

Sub Grid None Displayed for Trend Graph and Multiple Page Varies depending on the 
Print Graph Grid setting. 
(See the separate table.)

Split Circular 
Interval

1h(/rev.) Displayed for Circular 1h, 2h, 6h, 8h, 12h, 16h, 
1day, 2days, 1week, 2weeks, 
4weeks

Sub Split None Displayed for Circular Varies depending on Split 
Circular Interval. (See the 
separate table.)

Y-axis grid Standard 
Grid

Displayed for Trend Graph Standard Grid, Dense Grid1, 
Dense Grid2, Dense Grid3, 
Dense Grid4

Y-axis zone Full zone Displayed for Trend Graph Full Zone, Slide Zone, Auto 
Zone, Free Zone

Active Y-axis 1 Displayed for Trend Graph 1 to 50
Tag Display Tag No. Displayed for Trend Graph, Circular, Sheet,

and Alarm List.
Tag No., Tag Comment, Tag 
Index

Y Axis Column Num 1 Displayed for Trend Graph and Circular Enter a number between 1 
to 50.

Legend No Displayed for Trend Graph and Circular Yes or No
Legend position Right Displayed for Legend [Yes] Top, Bottom, Left, Right
Color Mode Color Displayed always. Black/White or color
Mark Color Orange Displayed for Trend Graph, Circular, and Sheet Click the color to select the 

color from a Color Setting 
dialog box.

Print Quality Standard Displayed for Custom Print, Report Output 
as well as when Graph Type is set to None 
for manual Custom Print and manual Report 
Output.

Standard, High
Standard: 300 dpi
High: 600 dpi

Chapter 5  Using the Report/Print Function (/RP option)
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 Sub Grid Range (Trend)
Print Waveform Grid Range
1min None, 30sec, 10sec, 5sec, 2sec, 1sec
2min None, 1min, 30sec, 10sec, 5sec, 2sec
5min None, 2min, 1min, 30sec, 10sec, 5sec
10min None, 5min, 2min, 1min, 30sec, 10sec
20min None, 10min, 5min, 2min, 1min, 30sec
30min None, 10min, 5min, 2min, 1min, 30sec
1h None, 30min, 10min, 5min, 2min, 1min
2h None, 1h, 30min, 10min, 5min, 2min
3h None, 1h, 30min, 10min, 5min, 2min
4h None, 2h, 1h, 30min, 10min, 5min
6h None, 3h, 1h, 30min, 10min, 5min
8h None, 4h, 2h, 1h, 30min, 10min
12h None, 6h, 3h, 1h, 30min, 10min
1day None, 12h, 6h, 3h, 1h, 30min
7days None, 1day,  12h, 6h, 3h, 1h
1month None, 15days, 10days, 5days, 1day, 12h

 Sub Split Range (Circular)
Split Circular Interval Range
1h None, 2min, 1min, 30sec, 10sec, 5sec
2h None, 5min, 2min, 1min, 30sec, 10sec
6h Nonec, 10min, 5min, 2min, 1min, 30se
8h None, 30min, 10min, 5min, 2min, 1min
12h None, 30min, 10min, 5min, 2min, 1min
16h None, 1h, 30min, 10min, 5min, 2min
1day None, 1h, 30min, 10min, 5min, 2min
2days None, 2h, 1h, 30min, 10min, 5min
1week None, 12h, 6h, 3h, 1h, 30min
2weeks None, 12h, 6h, 3h, 1h, 30min
4weeks None, 12h, 6h, 3h, 1h, 30min

(9) Printer Setup
•	  Printer:  Displays a list of registered printers. Select the printer on the server side to 

perform printing. Network printers are not displayed. Select a local printer 
registered on the server PC.

•	  Paper size:  Displays a list of paper sizes retrieved from the specified printer. Use 
paper whose size is between A4 and A3.

•	  Orientation: Set to Portrait or Landscape.

(10) Output Language
 Specify the language for the printed materials. The date format and decimal point format 

vary depending on the language.
•	 Default value: Language of each user (the registered language if a schedule 

registered on the server has already been displayed)
•	 Options: Japanese, English, Chinese, German, French, Korean, Russian

 Language vs. Date Format and Decimal Point Format
Output Language Date Format Decimal Point Format
Japanese YY/MM/DD Point (.)
English MM/DD/YY Point (.)
German DD.MM.YY Comma (,)
French DD/MM/YY Comma (,)
Russian DD.MM.YY Comma (,)
Chinese YY/MM/DD Point (.)
Korean YY/MM/DD Point (.)

 Chapter 5  Using the Report/Print Function (/RP option)
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5.1.4 Custom Print
If you set Task to Custom Print, the schedule page shows the Custom Print settings. In 
custom print, the specified content is printed automatically from a data file according to a 
template at the specified time.

Auto print is performed only when a template is specified. Be sure to register a template in 
advance.
: “Registering Template Files” on page 5-5

Setup Item
In a Custom Print schedule, set the following items.
(1) Name
 Enter the name of the schedule. (The default value and input range are the same as 

those for Standard Print.)

(2) Task
 Select Custom Print.

(3) Condition
 From the list, select the time to execute printing.
 The range (7) will vary depending on this condition. : Schedule Conditions and Range

(4) Template file
 From the list, select the template file (*.tpl) to apply to printing. If no template files (*.tpl) 

are registered, only None is displayed.

Note
•	 You	can	create	template	files	(*.tpl)	using	SMARTDAC+	Report Template Builder. You can 

download it from the YOKOGAWA website for free.
•	 If	the	template	file	is	set	to	None,	custom	print	is	not	possible.
•	 Excel	templates	cannot	be	used	for	custom	print.

(5) Printer
 Displays a list of printers registered in the server.

Chapter 5  Using the Report/Print Function (/RP option) 
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(6) Output Language
 Specify the language for the printed materials. The date format and decimal point format 

vary depending on the language (See Language vs. Date Format and Decimal Point 
Format provided earlier).

(7) Graph 1 to 4
 Print Type
 Select the type of graph defined in the template file.

•	 Options: None, Trend Graph, Alarm List, Mark List

 Range
 Set the print target data range. : Schedule Conditions and Range

 Group
 Specify the number of the group to print. Only the valid group numbers (groups that are 

assigned tags) among Group 01 to 50 are displayed as options.

 Printout Setup
 Same as “Printout Setup” on page 5-7. See the items in the table.

Note
The graph output varies depending on the defined size as follows.
•	 For	a	trend	graph,	all	trends	in	the	setting	range	are	output	according	to	the	size.
•	 For	an	alarm	list	and	mark	list,	the	number	of	output	lines	is	calculated	from	the	vertical	length	

and font size, and data is printed over the calculated output lines in order from the latest time.
•	 Set	the	width	of	the	alarm	list	to	at	least	102	mm	and	that	of	the	mark	list	to	at	least	196	mm.	

Otherwise, character strings that do not fit width wise will be cut and not be output.

 Chapter 5  Using the Report/Print Function (/RP option)
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5.1.5 Report Output
If you set Task to Report Output, the schedule page shows the Report Output settings. In 
Report Output, report files (PDF, Excel) are created according to the specified template.

Report files are output only when a template is specified. Be sure to register a template in advance. 
: “Registering Template Files” on page 5-5

Setup Item
(1) Name
 Enter the name of the schedule. (The default value and input range are the same as 

those for Standard Print.)

(2) Task
 Select Report Output.

(3) Type
 Select the report type. Condition (explained next) varies depending on the selected report 

type. See the table below.
•	 Default value: Hourly + Daily

 Relationship between Report Type and Condition
Report Type Condition
Hourly + Daily Fixed to Everyday. hh:mm can be set.
Daily + Weekly Fixed to Every Week. The day of week and hh:mm can be set.
Daily + Monthly Fixed to Every Month. The day and hh:mm can be set.
Batch Condition is not displayed.
Daily custom Fixed to Interval. The hour and base time (hh:mm) can be set.
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(4) Condition
 From the list, select the time to execute printing.

•	 Default value: Everyday
 The range (11) will vary depending on this condition. : Schedule Conditions and 

Range

Save Interval (Hidden on the initial page because the report type is Hourly + 
Daily)
 This appears only when the report type is Batch or Daily custom. Set the data recording 

interval.
•	 Default value: 10min
•	 Options: 1min,  2min, 3min, 4min, 5min, 10min, 15min, 30min, 1hour

(5) Filename Naming Rule
•	 Default value: Auto
•	 Options: Auto, Specify

 When Auto is selected
 PDF file name example: YYYYMMDDhhmmss_serial number.pdf
 Excel file name example: YYYYMMDDhhmmss_serial number.xlsx
 When Specify is selected
 You can specify the front text string of the report file name. Enter up to 32 characters.
 The default value is “Report.”
 PDF file name example: Report_YYYYMMDDhhmmss_serial number.pdf
 Excel file name example: Report_YYYYMMDDhhmmss__serial number.xlsx

YYYY (year), MM (month), DD (day), hh (hour), mm (minute), and ss (seconds) are the date and 
time of the condition date.

(6) Output Folder
 Select the folder to save the generated reports in.

•	 Default value: Data Folder
•	 Options: Data Folder, Subfolder in the data folder, Specified Folder

Save Location Description
Data Folder Displays the GA10 data folder.

Example: C:\Users\Public\Documents\SMARTDAC+ Data Logging Software\Data
Subfolder in the data folder Enter the name of a subfolder in the data folder. Enter up to 255 characters.
Specified Folder Enter the path to the specified folder or use the Browse button to specify it. When 

entering the path, use up to 255 characters.

Note
If Output Folder is set to Desktop, My Documents, or any other Windows user folder, report file 
output will fail. Select a folder other than a Windows user folder.

(7) Template File
 From the list, select the template file (*.tpl) to apply to printing or an Excel template file 

(*.xlsx, *.xlsm). If no template files are registered, only None is displayed.

Note
•	 You	can	create	template	files	(*.tpl)	using	SMARTDAC+	Report Template Builder. You can 

download it from the YOKOGAWA website for free.
•	 If	the	template	file	is	set	to	None,	report	output	is	not	possible.

(8) Print Out
 Displays a list of printers registered in the server. This item is valid for a template file 

(*.tpl). It does not appear for an Excel template file. (When using an Excel template file, 
you cannot print directly from GA10).
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(9) Output Language
 Specify the language for the printed materials. The date format and decimal point format 

vary depending on the language (See Language vs. Date Format and Decimal Point 
Format provided earlier).

(10) Report channel
 Set the channel to output in reports.

Note
The device’s LOG input channel is not output. If a tag corresponding to the device’s LOG input 
channel is specified, the report channel value will be blank, and the status will be error.

 

b ca

d e

Report Channel Settings
Symbol Item Name Default 

Value
Range Description

a No. R001 to 
R100

001 to 100 (fixed) Report channel number. Click a No. 
cell to select the row.

b Tag Index1 Valid 
tags are 
assigned in 
ascending 
order.

Tag range (including math tags) 
of the project.

Select the tag. Click the tag to display 
the Tag Index dialog box. Then, click 
the tag you want to specify.

c Sum scale Off Off, /sec, /min, /hour, /day Displays the sum scale of the report 
channel.

d Auto increment button None R001 to R100 Assigns tag indexes in ascending 
order from the first tag in the selected 
range.

e All On button None R001 to R100 Clicking the button collectively turns 
on the sum scales in the selected 
range.

* To select a tag, click a tag button under Tag Index, and select the tag from the displayed dialog 
box shown below. If the Math function (/MT option) is installed, you can also select math tags.

(11) Graph 1 to 4
 Print Type
 Select the type of graph defined in the template file.

•	 Options: None, Trend Graph, Alarm List, Mark List

 Range
 Set the target data range. : Schedule Conditions and Range

 Group
 Specify the number of the group to print. Only the valid group numbers (groups that are 

assigned tags) among Group 01 to 50 are displayed as options.

 Printout Setup
 Same as in Standard Print (“Printout Setup” on page 5-7). See the items in the table.

Chapter 5  Using the Report/Print Function (/RP option)
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5.1.6 Schedule Conditions and Range
Display examples of Condition (report output and time to execute printing) and Range on the 
report schedule setting page are provided below. The schedule range display allows you to 
view the specified range on a time table. The condition time is displayed with , the start time 
of the specified range with , and the end time with . The range display for each condition 
applies both to auto print and manual print. You can view the schedule and history of report 
schedules that have been set on the Status Page.

Note
•	 If	the	Beginning	Time	of	Recording	and	the	time	of	the	report	schedule	condition	are	the	same,	

a report is output for the data at that time.
•	 When	recording	is	finished,	all	scheduled	events	will	be	executed.

When Condition Is Set to Every Hour
 Below is the display example for Condition and Range when Condition is set to Every 

Hour.
•	 Time span: 2 hours
•	 Scale (minute): 0, 15 , 30 , 45, 0, 15, 30, 45, 0

Start Time

Condition time

End time

Item Default Value Selectable Range
Condition: 
Every Hour

0:00 (mm:ss) 
every hour

Every Hour
Minute: 00 to 59 

Range Prev. Hour 0:00 to
Current Hour 0:00

Prev. Hour and 
Current Hour
Minute: 00 to 59
Second: 00 to 59 

•
•
•
•

Start Time: 0 minutes or later of the Prev. Hour
End Time: Up to the specified minute of the condition
The maximum time between start and end is 1 hour.
Start Time < End Time (Standard Print, Custom Print, 
Report Output)

 Chapter 5  Using the Report/Print Function (/RP option)
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When Condition Is Set to Everyday or When Report Type Is Set to Hourly + 
Daily
 Below is the display example for Condition and Range when Condition is set to Everyday.

•	 Time span: 2 days
•	 Scale (every 6 hours): 0:00, 6:00, 12:00, 18:00, 0:00, 6:00, 12:00, 18:00, 0:00

Start Time

Condition time

End time

Item Default 
Value

Selectable Range

Condition: 
Every Hour

Everyday
00:00:00

Everyday
Hour: 00 to 23
Minute: 00 to 59

Range Standard 
Print
Custom Print

Prev. Day
0:00:00 to 
Current 
Day
0:00:00

Hour: 00 to 23
Minute: 00 to 59
Second: 00 to 59

•
•

•

Start Time: 0:00:00 or later of Prev. Day
End Time: Up to the specified time of the condition
The maximum time between start and end is 24 
hour.
Start Time < End Time (Standard Print, Custom 
Print, Report Output)

Hourly + 
Daily Report

Prev. Day 
0:00:00 to
Current 
Day 
00:00:00

Same as above •
•
•
•

•

Start Time: Time of Prev. Day Condition or later
End Time: Up to the time of Current Day condition
The maximum time between start and end is 24 
hour.
Start Time < End Time (Standard Print, Custom 
Print, Report Output)
Not split even the time spans over two days.

Example: Hourly + Daily output data time
Note

To create a report using the data from 1:30:00 (not including 1:30:00) of the previous day to 1:30:00 
(including 1:30:00) of the current day, set the conditions and range as follows.
 If you want to create a report every day with these conditions, set Stop Condition to Continuous 
and File Division to Everyday 1:30:00.

 Condition: Everyday 01:30:00
 Range: Prev. Day 01:30:00 to Current Day 01:30:00

 Data times will take on the following values.
 Hourly data
 yyyymmdd  02:30:00
 yyyymmdd  03:30:00
 yyyymmdd  04:30:00
 ...
 yyyymmdd  23:30:00
 yyyymmdd  00:30:00
 yyyymmdd  01:30:00

 Daily data
 yyyymmdd  01:30:00

Chapter 5  Using the Report/Print Function (/RP option)
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When Condition Is Set to Every Week or When Report Type Is Set to Daily + 
Weekly
 Below is the display example for Condition and Range when Condition is set to Every 

Week.
•	 Time span: 2 weeks
•	 Scale (day-of-week steps): SUN, MON, TUE, WED, THU, FRI, SAT, SUN, MON, 

TUE, WED, THU, FRI, SAT, SUN, ...

Start Time

Condition time

End time

Item Default 
Value

Selectable Range

Condition: 
Every Week

Every 
Week
Sunday
00:00:00

Every Week
Sunday to 
Saturday
Hour: 00 to 23
Minute: 00 to 59

Range Standard 
Print
Custom Print

Prev. Week
Sunday
0:00:00 to
Current 
Week
Sunday
0:00:00

Prev. Week and 
Current Week
Day of week: 
Sunday to 
Saturday
Hour: 00 to 23
Minute: 00 to 59
Second: 00 to 59

•
•
•
•

Start Time: 0:00:00 or later on Sunday of Prev. 
Week
End Time: Up to the specified time on the specified 
day of the condition
The maximum time between start and end is 7 
days.
Start Time < End Time (Standard Print, Custom 
Print, Report Output)

Daily + 
Weekly 
Report

Prev. Week
Sunday
0:00:00 to
Current 
Week
Sunday
0:00:00

Same as above •
•
•
•

•

Start Time: Time on the day of the week of 
Condition in Prev. Week or later
End Time: Up to the time on the day of the week of 
Condition in Current Week
The maximum time between start and end is 7 
days.
Start Time < End Time (Standard Print, Custom 
Print, Report Output)
Not split even the time spans over two weeks.

 Chapter 5  Using the Report/Print Function (/RP option)
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When Condition Is Set to Every Month or When Report Type Is Set to Daily + 
Monthly
 Below is the display example for Condition and Range when Condition is set to Every 

Month.
•	 Time span: 2 months
•	 Scale (10-day steps): 1 day, 11 days, 21 days, 1 days, 11 days, 21 days, 1 day, ...
•	 Displayed using the previous month’s color and current month’s color (light green 

and green) from the start time to the end time.

Start time

Condition time

End time

Item Default 
Value

Selectable Range

Condition: 
Every Month

Every 
Month
1 day
00:00:00

Every Month
Day: 1 to 31
Hour: 00 to 23
Minute: 00 to 59

Range Standard 
Print
Custom Print

Prev. 
Month
1 day
0:00:00 to
Current 
Month
1 day
0:00:00

Prev. Month and 
Current Month
Day: 1st to 31st
Hour: 00 to 23 
Minute: 00 to 59
Second: 00 to 59

•
•

•

•

Start Time: 0:00:00 on the 1st of Prev. Month
End Time: Up to the specified time on the specified 
day of the condition
The maximum time between start and end is 31 
days.
Start Time < End Time (Standard Print, Custom 
Print, Report Output)
If a day that does not exist in the relevant month 
(e.g., 31st, 30th, or 29th) is specified, it is corrected 
to the last day of the month.

Daily + 
Monthly 
Report

Prev. 
Month
1 day
0:00:00 to
Current 
Month
1 day
0:00:00

Same as above •
•
•
•

•

•

Start Time: Time on the day of the week of 
Condition in Prev. Week or later
End Time: Up to the time on the day of the week of 
Condition in Current Week
The maximum time between start and end is 7 
days.
Start Time < End Time (Standard Print, Custom 
Print, Report Output)
If a day that does not exist in the relevant month 
(e.g., 31st, 30th, or 29th) is specified, it is corrected 
to the last day of the month.
Not split even the time spans over two months.

Example: Daily + Monthly output data time
 Condition: 25th of every month  01:30:00
 Range: 25th of Prev. Month  01:30:00 to 25th of Current Month  01:30:00

 Data times will take on the following values.
 Daily data
 yyyymm26  01:30:00
 yyyymm27  01:30:00
 ...
 yyyymm01  01:30:00
 ...
 yyyymm24  01:30:00
 yyyymm25  01:30:00
 
 Monthly data
 yyyymmdd  01:30:00
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When Condition Is Set to Interval or When Report Type Is Set to Daily custom
 Below is the display example for Condition and Range when Condition is set to Interval.

•	 Time span: 2 cycles
•	 Scale: When Interval = 4 hours: 0:00, 1:00, 2:00, 3:00, 0:00, 1:00, 2:00, 3:00, 0:00

When Interval = 6 hours: 0:00, 2:00, 4:00, 0:00, 2:00, 4:00, 0:00
When Interval = 8 hours: 0:00, 2:00, 4:00, 6:00, 0:00, 2:00, 4:00, 6:00
When Interval = 12 hours: 0:00, 4:00, 8:00, 0:00, 4:00, 8:00, 0:00
When Interval = 24 hours: 0:00, 8:00, 16:00, 0:00, 8:00, 16:00, 0:00

•	 Displayed using the previous cycle’s color and current cycle’s color (light green and 
green) from the start time to the end time.

Start time

Condition time

End time

Item Default Value Selectable Range
Condition: 
Interval

Interval
6h
Base time
00:00:00
(For Daily custom, 
the interval is 
the file division 
interval.)

Interval
Hour: 4h, 6h, 
8h, 12h, 24h
Base time
Hour: 00 
to 23
Minute: 00 
to 59

• Interval and specifiable base time range
When Interval = 4h, 00:00:00 to 03:59:00
When Interval = 6h, 00:00:00 to 05:59:00
When Interval = 8h, 00:00:00 to 07:59:00
When Interval = 12h, 00:00:00 to 11:59:00
When Interval = 24h, 00:00:00 to 23:59:00

Range Prev. Cycle
0:00:00 to
Current Cycle
0:00:00

Prev. Cycle 
and Current 
Cycle

Start Time
Hour: 0 to 3, 
5, 7, 11, 23 
(interval – 1 
hour)
Minute: 00 
to 59
Second: 00 
to 59

End Time
Hour: 0 to 4, 
6, 8, 12, 24
Minute: 00 
to 59
Second: 00 
to 59

•
•
•
•

Start Time: Base time of the previous Condition or later
End Time: Up to the time the Condition is met
The maximum time between start and end is 1 cycle.
Start Time < End Time (Standard Print, Custom Print, Report 
Output)

When Report Type Is Set to Batch
 If Report Output is set to Batch, you do not need to set Condition. The graph range is the 

entire duration (the following figure), and a time table is not displayed.

If Condition Is Set to Recording is finished
 If Condition is set to Recording is finished, the range is fixed to the entire duration. A time 

table is not displayed.
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Note
Graphs are created on the basis of the End Time of Range. As such, if the device time is changed, 
the start time of the graph may differ from the start time of the range.

Note
The following limitations apply to DST (Daylight Saving Time).
•	 If	the	time	for	Condition	or	Range	is	set	to	a	time	that	does	not	exist	in	DST	(Daylight	Saving	

Time), it is executed at the time DST takes effect.
  Example: If the setting is at 02:30:00 and the time for switching to DST is between 02:00:00 

and 03:00:00, the condition will be executed at 03:00:00.
•	 If	Condition	is	set	to	Interval,	Base	time	to	a	time	on	the	hour	(e.g.,	0:00:00),	and	Range	to	a	

duration equal to Interval, the range of the graph will be longer than the specified interval when 
the time changes from DST to standard time.

  Example:  If the time change from DST to standard time is 1:00 to 0:00, Interval is 4hours, Base 
time is a time on the hour, and the range is from 0:00:00 to 4:00:00, the actual graph 
will be 5 hours between 0:00:00 and 4:00:00.

•	 If	the	Start	Time	(or	the	End	Time)	of	the	specified	range	in	manual	Custom	Print	or	manual	
Report Output is in the DST transition time period, the range will assumed to be from before the 
DST transition (or up to the end of the DST transition).

	 	Example:		If	the	transition	from	DST	to	standard	time	is	1:00	→	0:00	and	the	specified	start	and	
end times are 0:50 and 2:00, the range will be 2 hours 10 minutes.

Chapter 5  Using the Report/Print Function (/RP option)
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5.2 Viewing Report Schedules
On GA10 with the Report/Print function (/RP option), you can view the execution schedule 
and history of reports and printing that have been set.
Click the Status Page icon  on the Project tab to display the Status Page. The Report/
Print History and Report/Print Schedule tabs appear behind the device status tab described 
earlier.

5.2.1 Report/Print Schedule
The Report/Print Schedule tab shows the print execution schedule in a list. To view the 
details of a selected schedule, you can click Display the details.

Displays the details of the selected schedule
Updates the display

The following items are displayed in the list. If all the items do not fit on the screen, you can 
use the scroll bar to see the hidden items.
Item Description
Execute Plan
Absolute Time The time when the schedule will be 

executed
Schedule 
Name

The name of the report schedule
For projects whose Data time is set to 
Device time, the name will be schedule 
name + (device number + recording 
interval).

Condition The condition for executing the 
schedule.

Task Task Standard Print, Custom Print, Report 
Print

Type Report type
“---” is displayed for Standard Print 
and Custom Print.

Output Print None, Exist
Report File PDF, Excel, None

Output Folder Printer The selected printer.
Folder The specified output folder.

Details-of-schedule Screen

On the Details-of-schedule screen, the details of the specified print schedule are displayed.
Setting the Report/Print function (/RP option): Sec. 5.1

 Chapter 5  Using the Report/Print Function (/RP option)
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5.2.2 Report/Print History
The Report/Print History tab shows the print execution history in a list. The result of each 
schedule is displayed as “Completed” or “Error” in the Execute column.
In addition, the following control buttons can be used to display the result of a selected 
schedule, re-execute the schedule, and delete logs. However, with the exception of Delete, 
you cannot operate more than one schedule at once.

(1) (2) (3) (4) (5)

(1) Refresh
 Click this button to refresh the list.
(2) Display the details
 Select a schedule from the list and click this button to display the details of the schedule.
(3) Open the report file
 Select a schedule from the list and click this button to display the report file that has been 

generated.
(4) Re-execute
 Click this button to re-execute the selected schedule.
(5) Delete
 Deletes the print execution log. From the list, select the schedule that you want to delete, 

and click to display a confirmation message. Click OK to delete it. If you select schedules 
while holding down the SHIFT key, you can delete several logs at once.

Note
•	 A	history	of	up	to	the	most	recent	100	schedules	is	displayed.
•	 Clicking	an	item	name	in	the	list	sorts	the	list	using	the	item.	The	first	click	specifies	ascending	

order; the second descending order. The sort condition is displayed with an icon next to the item 
name.

•	 Entries	whose	schedule	result	is	error	are	displayed	using	red	characters.

Chapter 5  Using the Report/Print Function (/RP option)
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5.3 Printing Recorded Data Manually
On GA10 with the Report/Print function (/RP option), the Custom Print and Custom Report 
buttons are displayed at the top of the Data File List screen  (Page 8-1). You can use 
these buttons to print manually.

5.3.1 Manual Custom Print
You can use the Custom Print button at the top of the Data File List screen to manually 
perform printing that is equivalent to the Custom Print of scheduled (auto) printing.

Click this to switch the display.

Manual custom print Manual report output

Basic Operation

1 Click the Data files Page icon .
The Data File List screen appears.

2 Click the file (a single file or several files that have been linked into one) you want to 
print.
The selected line turns blue.

3 Click Custom Print.
A Custom Print dialog box appears.

 Chapter 5  Using the Report/Print Function (/RP option)
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4 Select the template file to apply to printing.
 To use a template registered in GA10, click Server.
 To use a template from a PC, click Local.

5 Click Browse. (This example assumes that Server has been selected.)
 A Template File dialog box appears.
 If you selected Local in step 4, a standard Open dialog box will appear.

6 From the list, select the template file you want to use.
The dialog box closes, and the template appears in the Custom Print dialog box.

7 Set the Print Type, Range, Group, and Printout Setup items on the Graph 1 to 4 
tabs.

8 Click OK.
Printing will be executed.

Setup Item

Data File
 Displays the data file name of the print target (line) selected in the list. If the entire file 

name cannot be displayed, the end is abbreviated with ellipses.

Template File
 Displays the name of template file selected from the server or the local PC. If the entire 

file name cannot be displayed, the end is abbreviated with ellipses.

 Server
 Select this to use a template file registered in GA10. Registered templates will be 

displayed in a list (Template File dialog box).

 Local
 Click this to use a template file from a PC. An standard Open dialog box will appear.

Printer
 Displays a list of registered printers. Select a printer on the server side that will be used. 

Network printers are not displayed. Select a local printer registered on the server PC.

Output Language
 Specify the language for the printed materials. The date format and decimal point format 

vary depending on the language.
Display format of each language: “Language vs. Date Format and Decimal Point Format” on 
page 5-8

Chapter 5  Using the Report/Print Function (/RP option)
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Graph 1 to 4

 Print Type
 Select the type of graph defined in the template file.

•	 Options: None, Trend Graph, Alarm List, Mark List

 Range
 From the start time of the first file to the end time of the last file in the selected data file 

list.

 Group
 Select the number of the group to print from the Group 01 to 50 options.

 Printout Setup
 Same as “Printout Setup” on page 5-7.

 Chapter 5  Using the Report/Print Function (/RP option)
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5.3.2 Manual Report Output
You can use the Custom Report button at the top of the Data File List screen to manually 
perform printing that is equivalent to the Report Output of scheduled (auto) printing.

Basic Operation

1 Click the Data files Page icon .
The Data File List screen appears.

2 Click the file (a single file or several files that have been linked into one) you want to 
print.
The selected line turns blue.

3 Click Custom Report.
A Custom Report dialog box appears.

4 Select the report type from the list.

5 Set the condition.

6 If you set the report type to Batch or Daily custom, select the save interval.

Chapter 5  Using the Report/Print Function (/RP option)
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7 Set the report output range.
Date: Click the drop-down button and select from the calendar that appears.
Time: Enter the hour, minute, and second.
A value cannot exceed the data start time or end time.

8 Select the template file to apply to printing.
 To use a template registered in GA10, click Server.
 To use a template from a PC, click Local.

9 Click Browse, and select the template.
 The procedure for selecting the template is the same as step 5 in “Custom Print” 

on page 5-9.

10 Set the File Name, Output Folder, Output Printer, and Output Language items.

11 Set the report channel.

12 Set the Print Type, Range, Group, and Printout Setup items on the Graph 1 to 4 
tabs.

13 Click OK.
Printing will be executed.

Setup Item
Data File
 Displays the data file name of the print target (line) selected in the list. If the entire file 

name cannot be displayed, the end is abbreviated with ellipses.

Type
 Select the report type from Hourly + Daily, Daily + Weekly, Daily + Monthly, Batch, and 

Daily custom.

Condition
 The condition varies depending on the report type.
 For details, see “Schedule Conditions and Range” on page 5-14.

 Chapter 5  Using the Report/Print Function (/RP option)
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Save Interval (Hidden on the initial page because the report type is Hourly + Daily)
 This appears only when the report type is Batch or Daily custom. Set the data recording 

interval.
•	 Default value: 10min
•	 Options: 1min,  2min, 3min, 4min, 5min, 10min, 15min, 30min, 1hour

Range
 Set report output data range.

•	 Default value: From the start time to the end time of the selected data file.
•	 Input range: Same as above (from the start time of the first data file to the end time 

of the last data file)

Template File
 Displays the name of template file selected from the server or the local PC. If the entire 

file name cannot be displayed, the end is abbreviated with ellipses.

 Server
 Select this to use a template file registered in GA10. Registered templates will be 

displayed in a list (Template File dialog box).
 Local

 Click this to use a template file from a PC. An standard Open dialog box will appear.

File Name
 Enter the name of the report file to create manually (using up to 60 characters).
 The file name is created according to the following rules.
 Input file name_creation time_serial number
 Creation time: YYYYMMDDhhmmss (no spaces)
 Serial number: 6 digits, 0 filled

Output Folder
Select the folder to save the generated reports in.

•	 Default value: Data Folder
•	 Options: Data Folder, Subfolder in the data folder, Specified Folder

Save Location Description
Data Folder Displays the GA10 data folder.

Example: C:\Users\Public\Documents\SMARTDAC+ Data Logging Software\Data
Subfolder in the data folder Enter the name of a subfolder in the data folder. Enter up to 255 characters.
Specified Folder Enter the path to the specified folder or use the Browse button to specify it. When 

entering the path, use up to 255 characters.

Output Printer
 Select whether to print. Selecting Yes displays a list of registered printers. However, 

Output Printer does not appear for an Excel template file. (When using an Excel template, 
you cannot print directly from GA10).

Output Language
 Specify the language for the printed materials. The date format and decimal point format 

vary depending on the language.

Display format of each language: “Language vs. Date Format and Decimal Point Format” on 
page 5-8
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Report channel
 Set the channel to output in reports.

Note
The device’s LOG input channel is not output. If a tag corresponding to the device’s LOG input 
channel is specified, the report channel value will be blank, and the status will be error.

b ca

d e

 Report Channel Settings
Symbol Item Name Default 

Value
Range Description

a No. R001 to 
R100

001 to 100 (fixed) Report channel number. Click a No. 
cell to select the row.

b Tag Index1 Tag0001 
to 
Tag0100

Tag range (including math tags) 
of the project.

Select the tag. Click the tag to display 
the Tag Index dialog box. Then, click 
the tag you want to specify.

c Sum scale Off Off, /sec, /min, /hour, /day Displays the sum scale of the report 
channel.

d Auto increment 
button

None R001 to R100 Assigns tag indexes in ascending 
order from the first tag in the selected 
range.

e All On button None R001 to R100 Clicking the button collectively turns 
on the sum scales in the selected 
range.

* To select a tag, click a tag button under Tag Index, and select the tag from the displayed dialog 
box shown below. If the Math function (/MT option) is installed, you can also select math tags.

Graph 1 to 4
 Print Type
 Select the type of graph defined in the template file.

•	 Options: None, Trend Graph, Alarm List, Mark List
 Range
 Set the data range of the graph to be output in reports.

•	 Display format:  If the report type is Batch, an absolute time (clock time) is displayed. 
Otherwise, a relative time (interval from the current time) is 
displayed.

•	 Default value:  The start time and the end time of the selected data file if the report 
type is Batch. Otherwise, it is the same as the graph range setting 
when auto printing report schedule is set.

•	 Input range:  From the start time to the end time (maximum-minimum value) in the 
report output range if the report type is Batch. Otherwise, it is the same 
as the graph range setting when auto printing report schedule is set.

    For details, see “Schedule Conditions and Range” on page 5-14.
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 Group
 Specify the number of the group to print. Select the number of the group to print from 

the Group 01 to 50 options.

 Printout Setup
 Same as “Printout Setup” on page 5-7.

Chapter 5  Using the Report/Print Function (/RP option)
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Chapter 6  Monitoring Data Collection

6.1 Monitoring on the Monitor Page
This section explains the Monitor Page for Detail Settings 
mode. In Simple Settings mode, the Monitor Page 
consists of the Trend Monitor Set and Digital Monitor Set. 
The operation is the same.
6.1.1 Displaying the Data Collection Status
You can monitor data collection in the following page.

 

Project tab

Client and server 
communication status

Setting Page
Monitor Page
Status Page
Data files Page
Close

Start and stop data recording
    Not recording
    Recording

Start and stop data monitoring
    Not monitoring
    Monitoring

Manual Save

•	 Client and Server Communication Status
 The client and server communication status is indicated 

as Good, Ordinary, or Bad.

•	 Project Tab
 The tab shows the project name, and operation icons. 

The project alarm status is indicated in red.*
* Blinking red: Alarm occurring
 Solid red: Alarm acknowledged

•	 Start and Stop Data Monitoring
 Click to start or stop data collection.

•	 Start and Stop Data Recording
 Click to start or stop data recording.

•	 Setting Page, Monitor Page, Status Page, and Data 
files Page

 Click to display the corresponding page.
 Setting Page  Sec. 3.2, Sec. 3.3  
 Monitor Page  Sec. 6.1.2
 Status Page  Sec. 6.7
 Data files Page  Sec. 8.1

•	  Manual Save Button
 When clicked, the recording data is split at that 

position. This button is valid only during recording.
 You can show or hide the button by selecting Manual 

Save Button from the View menu.
 

•	 Close
 Click to close the project.

•	 Viewing the Project Status in the Project List Page
 Click the  icon to show the Project List Page. You 

can view the project status.
Data not being monitored

Data monitoring in progress

Data recording standby

Data recording in progress

The boundary color changes.

 You can check the alarm status and alarm ACK status 
for the opened project.

When an alarm is not occurring

When an alarm is occurring

(indicated in red)

Related topic:   Sec. 6.6.3
 If communication with a data acquisition device is 

disconnected, you can check which projects are 
affected.

Normal device connection

(displayed with a green icon)

Disconnected device connection

(displayed with a red icon)

Related topic:   Sec. 6.6.4
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6.1.2 Displaying the Monitor Page
Open a project, and click the Monitor Page icon on the 
Project tab to open the Monitor Page.
In Simple Settings mode, the Monitor Page consists of 
the Trend Monitor Set and Digital Monitor Set as shown 
below.

Maximize iconMonitor set boundary Monitor sets

In Detail Settings mode, the Monitor Page that you 
configured opens.

Maximize iconMonitor set boundary Monitor sets

•	 Resizing the Monitor Set
 To resize the Monitor Set, Resize the Monitor Set on 

the Acquisition & Monitor Setting page must be set to 
On.

 Move the pointer near the boundary of the Monitor Set 
to change the pointer to  or . In this condition, 
drag the pointer to move the boundary to the desired 
position.

•	 Maximizing the Monitor Set
 Click the Maximize icon  in the upper right of the 

Monitor Set to expand the Monitor Set to fill the entire 
window. Click  to return to its original size.

•	 Full Screen
 If you click Full Screen on the View menu, the selected 

Monitor Set is displayed in a full screen. When there 
are multiple Monitor Sets, the selected Monitor Set is 
indicated with a light blue frame. Press ESC to change 
the full screen display back to the normal condition.

 Maximize Full Screen

•	 Switching the Display Group at Once
 On the View menu, click Group Link. Or, click the  

icon on the toolbar.
 When you change the display group of one Monitor 

Set, the display group of other Monitor Sets also 
changes.

 To cancel linking, on the View menu, click Group 
Link to unselect it. Or, click the icon on the toolbar to 
unselect it.

Chapter 6  Monitoring Data Collection
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6.1.3 Setting General Display Options

•	 Tag Display Form
 From the list of options that appears when you click 

Tag Display Form on the View menu, select the items 
to display as tags. This applies to all pages.

•	 User Display Form
 From the list of options that appears when you click 

User Display Form on the View menu, select the 
items to display as user names. This applies to all 
pages.

•	 Screen Background Color
 On the View menu, click Style, and click Light or 

Dark to select the background color. This applies to all 
pages.

•	 Date Format
 From the list of options that appears when you click 

Date Format on the View menu, select the date 
format. This applies to all pages.

•	 Month Display Form
 From the list of options that appears when you click 

Month Display Form on the View menu, select the 
month display format. This applies to all pages.
Item Description
Digit Example: “10” for October
Character Example: “OCT” for October

•	 Decimal Point
 On the View menu, click Decimal Point to select the 

symbol to use for the decimal point. This applies to all 
pages.
Item Description
. Period
, Comma

 Chapter 6  Monitoring Data Collection

6.2 Monitoring on the Trend Display
6.2.1 Displayed Content

Scan interval
Group tab

Waveform
Grid

Trip line

Alarm display
Time axis

Y-axis

Legend

Vertical splitter

Active 
waveform mark

Time axis scroll bar

Trip line value

•	 Scan Interval
 The data collection interval.

•	 Group Tab
 Switches the displayed group. Alarms occurring in tags 

of each group are indicated in red.

•	 Waveform
 Displays each waveform according to its corresponding 

data tag color.
 See "Waveform Display" on next page.

•	  Grid
 The grid shown in the waveform display area.

•	 Trip Line
 Trip line assigned to a tag. Only the trip line of the 

active waveform is displayed.
 Moving the trip line
 Drag the value of the trip line to the desired position.

•	 Y-axis
 Displays the Y-axis scale, title, and unit. Each y-axis is 

displayed according to its corresponding tag color.

•	 Legend
 Displays tags, tag colors, waveform display on/off 

check boxes, and Y-axis display on/off check boxes.

•	 Alarm Display
 Displays alarms using bars from occurrence to release.

•	 Time Axis
 The right end shows the most recent data time.
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•	 Vertical Splitter
 Use the vertical splitter to adjust the width of the Y-axis 

display area.
 When you move the pointer over the vertical splitter, 

the pointer changes to . In this condition, drag the 
pointer to expand or reduce the width of the Y-axis 
display area.

Waveform Display

•	 Active Waveform
 The front-most displayed waveform is called the active 

waveform.

•	  Changing the Active Waveform
 Click a tag in the Legend or a Y-axis to make the 

corresponding waveform the active waveform. When 
a Y-axis is shared among multiple waveforms, the 
waveform with the smallest waveform number will 
become the active waveform. The active waveform 
mark ( ) moves below the Y-axis of the active 
waveform.

•	  Automatically Updating the Displayed Data (monitor 
mode)

 When the time-axis scroll bar is at the right end 
or when it is not displayed, the data display is 
automatically updated. This mode is called monitor 
mode. The right end of the waveform is the most recent 
data.

•	  Viewing Past Data (playback mode)
 Move the time-axis scroll bar from the right end to 

view past data. This mode is called playback mode. 
Automatic updating of the data display stops.

 Returning the scroll bar to the right end switches GA10 
back to monitor mode. If you do not operate the scroll 
bar for 30 minutes, GA10 will return to monitor mode.

When Collecting Data Using Device Time
 The window is divided by a combination of device 

and scan interval. Trends of up to four devices can be 
displayed at each scan interval.

6.2.2 Changing the Display
You can change the display using the icons in the upper 
right.

Show or hide the legend
Zoom in on or out of the time axis

Y-axis display zone
Waveform line thickness

Grid density
Waveform 
display limit

Logging trend display

•	 Logging trend display
 Clicking this icon starts Universal Viewer and displays 

the data being logged. If Universal Viewer is already 
running, the data is displayed in a new window. 

 When the data being logged is displayed in Universal 
Viewer, the window is activated, but the data will not be 
updated to the latest logging data.

•	  Show or Hide the Legend
 You can show or hide the legend.

•	  Zoom in on or out of the Time Axis
 You can zoom in on or out of the time axis.

•	  Y-axis Display Zone
 You can switch the Y-axis display zone.

  Sec. 6.2.3

•	  Waveform Line Thickness
 You can change the waveform line thickness. This 

applies to all waveforms.

•	  Grid Density
 You can change the grid density.

•	  Waveform Display Limit

   
 With limit  Without limit
 When you click the icon to select it, waveform display 

limit is enabled. When you apply the waveform display 
limit, the Y-axis display range is limited to the minimum 
and maximum values that you specified using Scale 
in Display Group. Measured values that are less than 
the minimum scale value are set to the minimum 
value, and values that are greater than the maximum 
scale value are set to the maximum value. When you 
click the icon to unselect it, waveform display limit is 
disabled. In this condition, measured values outside the 
scale are displayed as they are.
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Note
If multiple operation screens are displayed on the same 
PC, the display conditions stored in the PC are shared. 
Be careful when you change the display conditions on the 
screen.
Display conditions when multiple screens are shown:

 Sec. 6.9.6

6.2.3 Controlling the Y-axis

•	 Y-axis Display Zone
 You can select the Y-axis display zone.
 Y-axis display zone specifies the scale position and 

length. It is the waveform position and range.
Full zone

Slide zone
Auto zone

Free zone

•	 Full Zone: Displays all waveforms in the maximum 
range

•	 Slide	Zone:	Displays	each	waveform	cascaded	from	
the top to the bottom of the waveform display area

•	 Auto	Zone:	Divides	the	waveform	display	area	
into equally spaced zones in accordance with the 
number of waveforms and displays the waveforms

•	 Free	Zone:	Displays	waveforms	in	user-specified	
zones

•	 Operations in Free Zone
 In Free Zone mode, you can change the Y-axis display 

zone as you like.
 Zoom in/out on the Y-axis
 When you move the pointer near the lower or upper 

edge of the Y-axis scale, the pointer changes to . In 
this condition, drag the pointer to move the desired 
position to zoom in or out on the Y-axis.

 Moving the Y-axis
 When you move the pointer on an Y-axis scale, the 

pointer changes to . In this condition, drag the pointer 
to move the desired position to move the Y-axis to the 
desired position.

•	 Compact Mode and Detail Mode
 A Y-axis can be displayed in compact or detail mode. In 

compact mode, scale values are hidden, narrowing the 
width of the Y-axis.

 In detail mode, if you move the pointer on the Y-axis 
and click the  icon at the top of the Y-axis, the 
mode changes to compact. In compact mode, if you 
click the  icon, the mode changes to detail.

•	 Scrolling a Y-axis Scale
 When you move the pointer on an Y-axis scale, the 

pointer changes to  or .
 Spinning the mouse wheel in this condition causes 

the Y-axis scale to scroll, maintaining the difference 
between the upper and lower limits of the scale.

 Click the scale initialization icon  to return the scale 
to its original position.

•	 Zooming in or out on an Y-axis Scale
 When you move the pointer on an Y-axis scale, the 

pointer changes to  or . Clicking when the pointer 
is  shows a scale zoom in/zoom out icon .

 Click an arrow of the icon or spin the mouse wheel to 
zoom in or out on the scale value in reference to the 
icon position.

 Click the scale initialization icon  to return the scale 
to its original position.

•	 Changing the Active Waveform
  “Waveform Display”

6.2.4 Showing and Hiding Waveforms (Using the 
Legend)

The legend can be displayed in tag display mode or axis 
display mode. Each time you click the display mode icon, 
the mode toggles between tag display and axis display.

Tag name
Tag color

Waveform check icon

Tag display mode Axis display mode

Click + to display tags.
Axis check icon

Display mode icon

•	 Tag Display Mode
 The tags assigned to the display group are displayed. 

Waveforms whose waveform check icons are selected 
are shown. If you click an icon to clear the check box, 
the waveform will be hidden.

•	 Axis Display Mode
 A list of Y-axes used by tags is displayed. Expand a 

Y-axis to display a list of tags that are using the Y-axis. 
If you click an Y-axis check icon to clear the check box, 
the axis and waveform data sharing the axis will be 
hidden.
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6.2.5 Viewing the Alarm Occurrence Status
When you click Alarm on the View menu to add a check 
mark, alarm bars are displayed in the alarm display area. 
Remove the check mark to hide the alarm bars.

Alarm bar

The bars show the data range in which alarms are 
occurring for the tags displayed in the group. The alarms 
are from the top alarm level 1, alarm level 2, alarm level 3, 
and alarm level 4.
•	 Alarm	bars	are	displayed	with	tag	display	colors.
•	 The	alarm	bars	of	the	active	waveform	area	always	

shown in front. If the alarm bars of multiple tags are 
overlapped and you want to view the alarm bars in 
the back, make the appropriate waveform the active 
waveform.

6.2.6 Reading Values with Cursors
You can use cursors to read values from waveforms. You 
can display two cursors: cursor A and cursor B.

•	  Showing and Hiding Cursors

1 Click a point in the waveform graph.
Cursor A (vertical line) appears, and the value at the 
intersection of the cursor and waveform is displayed.

2 Drag the cursor, and release the mouse button.
Cursor B (vertical line) appears, and the value at the 
intersection of the cursor and waveform is displayed.

3 To clear the cursors, on the View menu, click Erase 
cursor.

 If the cursor value displays of multiple tags are 
overlapped and you want to view the cursor values in 
the back, make the appropriate waveform the active 
waveform. Or, use the cursor value dialog box.

 When a cursor is displayed, the waveform display 
enters playback mode, and automatic updating of data 
display stops.

 

Cursor Cursor

•	  Cursor Value Transparency
 On the View menu, click Cursor value transparency 

to choose Transparent or Opaque.

•	  Reading the Difference between Two Cursors
 On the View menu, click Cursor value. The Cursor 

Value dialog box appears. From this dialog box, you 
can read the difference between cursors A and B.

 Click the cursor move icon ( ) to move the cursor by 1 
data point.

Alarm indicator
Cursor movement icon

•	 Data	No.
 A sequence number of collected data points taking 

the first collected data point to be zero.
•	 Alarm	indicator
 The status of alarm level 1, alarm level 2, alarm 

level 3, and alarm level 4, are displayed from the 
left.

Displayed Content Description
Red Alarm occurrence
Green Alarm release
Gray Alarm not set

 When Alarm in the View menu is not checked, 
alarm indicators are not shown.

 To close the cursor value dialog box, click the  icon 
in the upper right.

6.2.7 Displaying Statistical Results
The minimum, maximum, P-P, mean, and rms values for 
each waveform in the range specified by cursors A and B 
are calculated and displayed.

1 On the View menu, click Statistics.

Time

Number of the last data point in the computed region (cursor B)

Copy

Column show button

Recompute

Number of the first data point in the computed region (cursor A)

Column show button
(This appears when the 
column is hidden.)

Note
•	 Calculated	results	are	not	synchronized	to	the	cursor	

positions or waveform group. If you change the cursor 
A or B position or the display group, click Re-calc. to 
update the calculated results.

•	 The	formula	for	calculating	the	rms	value	is	as	follows:

1
n

(x  ) 2
k=0

n-1
 k

k

RMS =

n  : Number of data
x  : value 

Σ
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•	  Copying Data to the Clipboard
Clicking the Copy button copies the contents of the 
Cursor Value dialog box to the clipboard. You can paste 
the contents to a tab separated text file or to an Excel 
spreadsheet.

•	  Showing or Hiding Columns
When you move the cursor over a column title, a hide 
button appears. Clicking the hide button hides the target 
column. To show a column, click the show button.

6.2.8 Adding Marks
You can add marks to data. To add a mark, specify the 
mark string and the data to add the mark to.

1 Type the string in the mark edit box.
 You can edit the displayed string as well as select 

from a list of strings that you used in the past from 
the drop-down menu. The drop-down menu displays 
the most recent five strings.

Mark edit box
Current group

All groups

2 Click the data position you want to add a mark to 
display a cursor.

 To add a mark to the most recent data, perform step 
3 in monitor mode. Step 2 is not necessary.

3 On the Project menu, click Append Mark and then 
Current Group or All Groups. Or, click the Current 
Group or All Groups icon.
A	mark	is	added	to	the	specified	position.

Mark

•	 Adding a Mark to the Current Group
 If you select Current Group, a mark is added only to the 

group shown on the trend monitor.

•	 Adding a Mark to All Groups
 If you select All Groups when data is being collected 

using PC time, a mark is added to all groups.
 If data is being collected using device time,

•	 In	playback	mode,	a	mark	is	added	at	the	same	
position as cursor A to all display groups that contain 
tags of the same device and of the same collection 
interval as the monitor set subwindow that you 
added a mark to.

•	 In	monitor	mode,	a	mark	is	added	to	all	groups.

•	 When Marks Are Overlapped
 Sometimes marks overlap and the string of the lower 

mark cannot be read. Clicking a mark with Shift held 
down moves the mark to the back.

Note
•	 Marks	that	have	been	added	cannot	be	deleted	or	

edited.
•	 Mark	information	is	saved	in	data	files.	(Only	binary	

data files.) Mark information added to data positions 
in files that have already been closed is saved in the 
data file that is currently being recorded. You can view 
these marks by displaying connected data files.

•	 The	maximum	number	of	marks	that	can	be	added	
from the start to the end of monitoring is 10,000.

•	 The	maximum	number	of	marks	that	the	expression’s	
mark function (/MT option) can add to a data point at 
the same time position is 200.

•	 The	data	range	that	can	be	referenced	in	playback	
mode is up to 3600 points from the most recent 
acquired data. However, if recording is in progress 
and the recording interval is the same as the data 
acquisition interval (Monitor Interval), data can 
be referenced up to the start point of recording 
(exceeding the 3600 point limitation). Displaying may 
take some time if the amount of data to be played 
back is large.

Chapter 6  Monitoring Data Collection 
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6.3 Monitoring on the Digital Display
6.3.1 Displayed Content

Alarm indicator

Tag display area

Tag color
Tag name

Measurement bar display
Unit

Measured value

•	 Tag Display Area
 Tag alarm status is indicated in the alarm color.

* The alarm colors specified on the Acquisition & 
Monitor page.

•	 Alarm Indicator
 The status of alarm level 1, alarm level 2, alarm level 

3, and alarm level 4, are displayed from the top. Tag 
alarm status is indicated in the alarm color. Alarm 
indicators show a character that indicates the alarm 
type.*

* It is not shown if the display area is limited.
 Characters that indicate alarm types  Sec. 6.5.3

6.3.2 Showing and Hiding Alarm Indicators
When you click Alarm on the View menu to add a check 
mark, alarm indicators are shown. To not show alarm 
indicators, click Alarm on the View menu to unselect the 
command.

6.4 Monitoring on the Meter Display
6.4.1 Displayed Content
There are bar meters and analog meters.

Alarm indicator

Bar meter

Alarm zone and 
alarm value mark

Unit

Tag color
Tag name Measured value

Alarm indicator

Analog meter

Alarm zone
Measured value 
and unit

Tag color
Tag name

Bar meter

Analog meter

•	 Tag Display Area
 Tag alarm status is indicated in the alarm color.

•	 Alarm Zone
 The zone where alarms occur is indicated in the alarm 

color.

•	 Alarm Value Mark (bar meters only)
 Indicates the alarm value of data collection devices. 

This appears when the alarm type is set to high limit, 
low limit, difference high limit, difference low limit, delay 
high limit, or delay low limit.
Displayed Content Description

▲

Indicates that the alarm type is high 
limit or difference high limit.

▲

Indicates that the alarm type is low 
limit or difference low limit.

▲

Indicates that the alarm type is delay 
high limit.

▲ Indicates that the alarm type is delay 
low limit.

•	 Alarm Indicator
 The status of alarm level 1, alarm level 2, alarm level 

3, and alarm level 4, are displayed from the left. Tag 
alarm status is indicated in the alarm color. A character 
that indicates the alarm type is displayed.*

* It is not shown if the display area is limited.
 Characters that indicate alarm types  Sec. 6.5.3
 You can show and hide alarm indicators.
  Sec. 6.3.2

Chapter 6  Monitoring Data Collection 
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6.5 Monitoring Alarms
An alarm Monitor Set displays alarm information of 
monitored tags in three formats.
6.5.1 Group Overview
Click the Group tab. Alarm information is displayed at the 
group level. Groups that do not have alarms set on any 
tags are not displayed.

Group name

•	 Alarm Occurrence Display
 Alarm occurrence is displayed in the alarm color in the 

group display area.ACK operation can be performed on 
groups in which alarms activated.

6.5.2 Tag Overview
Click the Tag tab. Alarm information is displayed for tags 
in the display group. Tags that do not have alarms set are 
not displayed.

Alarm indicator
Tag name

•	 Alarm Occurrence Display
 Alarm occurrence is displayed in the alarm color in the 

tag display area.ACK operation can be performed on 
groups in which alarms activated.

•	 Alarm Indicator
 The status of alarm level 1, alarm level 2, alarm level 

3, and alarm level 4, are displayed from the left. Tag 
alarm status is indicated in the alarm color.

6.5.3 Alarm Overview
Click the Log tab. The history of all monitored tags’ alarm 
occurrences and releases is displayed. The top line is the 
most recent entry. The display is automatically updated as 
alarms occur and are released.
If data is being collected in device time, the history is 
displayed by dividing the window for each device.

Date Time

Most recent alarm

Tag name

Alarm level
Alarm type

Status

Alarm list Scroll bar

Alarm status icon
Alarm type icon

•	 Most Recent Alarm
 The top line always displays the most recent entry.

•	 Alarm List
 The history of alarms are displayed in the order of 

occurrence. Move the scroll bar down to view past 
alarms. This condition is called playback mode. In 
playback mode, the history is not automatically updated 
(the line showing the most recent alarm is automatically 
updated). Move the scroll bar to its top position to exit 
playback mode.

•	 Alarm Status Icon
Indication Description
Alarm-on color* Alarm occurrence
Alarm-off color* Alarm release
* The alarm colors specified on the Acquisition & Monitor page.
  If ACK has not been executed, the icon background blinks.

•	 Clearing the alarm log
 On the Project menu, click Clear Alarm Log to clear the 

alarm log of all devices.

Chapter 6  Monitoring Data Collection 
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•	 Alarm Type Icons
Displayed Content Description

High limit alarm, measurement high limit 
alarm, deviation high limit alarm, setting 
high limit alarm, output high limit alarm
Low limit alarm, measurement low limit 
alarm, deviation low limit alarm, setting 
low limit alarm, output low limit alarm
Difference high limit alarm
Difference low limit alarm
High limit on rate-of-change alarm
Low limit on rate-of-change alarm
Delay high limit alarm
Delay low limit alarm
Deviation out limit alarm
Deviation in limit alarm
Other alarm

•	 Date and Time
 The date and time of alarm occurrence and release.

•	 Alarm Level
Displayed Content Description
L1 Alarm level 1
L2 Alarm level 2
L3 Alarm level 3
L4 Alarm level 4

•	 Alarm Type
Displayed Content Description
H high limit alarm
L Low limit alarm
dH Difference high limit alarm
dL Difference low limit alarm
RH High limit on rate-of-change alarm
RL Low limit on rate-of-change alarm
tH Delay high limit alarm
tL Delay low limit alarm
PVH Measurement high limit alarm
PVL Measurement low limit alarm
DVH Deviation high limit alarm
DVL Deviation low limit alarm
DVO Deviation out limit alarm
DVI Deviation in limit alarm
SPH Setting high limit alarm
SPL Setting low limit alarm
OTH Output high limit alarm
OTL Output low limit alarm
ETC Other alarm

•	 Status
Displayed Content Description
ON Indicates that an alarm has occurred.
OFF Indicates that an alarm has been 

released.

•	 Changing Alarm Types during Data Collection and 
Recording

 If alarm types (including use and not use) are changed 
on the connected device side during data collection, 
recording, or record standby, the changes are reflected 
on the alarm monitor. Changes in alarm types are 
not reflected in the alarm list of the recording file. 
Further, this applies only when the connected device 
is a SMARTDAC+ series (GX/GP, GM) device and the 
GA10 version is R2.02.xx or later.

 
 The changes are reflected in the following areas.

•	 Digital,	alarm,	and	meter	monitor	sets
•	 Alarm	display	of	the	value	display	area	in	the	cursor	

value dialog box
•	 Alarm	list	display
•	 Alarm	zone	and	alarm	value	mark	of	the	meter	

display

Chapter 6  Monitoring Data Collection 
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6.5.4 Using the Group Highlight Function
On the View menu, click Group highlight to add a check 
mark. 
If an alarm occurs in the trend display, digital display, 
or meter display, the monitor screen frame (monitor set 
frame) of the corresponding display group turns red 
(yellow for anomaly detection) as notification to the user.  
If an alarm and anomaly detection occur at the same time, 
the alarm is prioritized.

6.5.5 Using the Popup Function
On the View menu, click Popup to add a check mark. 
If an alarm occurs, the corresponding tag pops up in 
digital display on the monitor screen. You can also show 
the alarm log from the digital display that has popped up.

Item Description
Max. displayed tags 4 (pagination is used for 5 or more)
Max. owned tags 200 (deleted from the oldest if 200 is 

exceeded)
Tag display order Displayed from the most recent based on 

the time at which the alarm occurred.

Page number

Previous page button
Next page button

Exit button

The exit button appears on the tag 
where the cursor is.

Displayed content Description
Page number Displays the page number.
Previous page button Displays the previous page.
Next page button Displays the next page.
Exit button Closes the popup and clears the content.

•	 Displaying the alarm log
If you click the digital display of the popup, the Alarm 
Information dialog box appears.

Displayed content Description
Absolute Time Indicates the time and date on which the 

alarm occurred or was turned off.
Level Indicates the alarm level.
Type Indicates the alarm type.
Status Indicates whether the alarm is turned On 

or Off.
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6.6 Checking Alarms
6.6.1 Displaying the Alarm Overview Dialog Box
While displaying the Monitor Page, click Alarm List on the 
View menu to display the alarm overview dialog box.
The displayed content and operation in this dialog box are 
the same as those of the alarm list of the alarm Monitor 
Set.
Click  in the upper right of the dialog box to close it.

•	 Page Switching and Dialog Box Display
 The dialog box stays open until you close it. If you 

move to another page with the dialog box open, the 
dialog box disappears. But, if you return to the Monitor 
Page, the dialog box will appear again.

 If you change the project while the dialog box is open, 
the alarm information of the opened project will be 
displayed in the dialog box.

6.6.2 Notification of Alarms and Communication 
Errors with Sound

On the Operation menu, click Warning Beep to add a 
check mark. When an alarm or communication error with 
connected devices occurs, the PC will beep.
To stop the sound, on the Operation menu, click Stop the 
Warning Beep. Or, click the  icon.
To disable the alarm sound, on the Operation menu, click 
Warning Beep to remove the check mark.

Note
•	 To	generate	sounds,	the	PC	must	be	equipped	with	a	

sound generating function and sound must be turned 
on.

•	 You	cannot	change	the	sound.

•	 Sharing of the Temporary Suspension of Warning 
Beeps

 If multiple clients are connected to the same server, the 
Stop The Warning Beep operation can be shared.

 On the Operation menu, click Share the Warning Beep 
across clients. Add a check mark to use shared mode; 
clear it to use non-shared mode. You can configure 
this function on each client. If warning beeps are 
temporarily stopped on a client that is set to shared 
mode, warning beeps are also stopped on other clients 
(see Note). If set to non-shared mode, other clients are 
not affected even if you perform the same operation.

Note
•	 The	suspension	of	warning	beeps	is	shared	among	

clients that are connected to the same server and that 
are set to shared mode.

•	 This	mode	setting	is	stored	internally,	so	it	will	be	valid	
when the clients are restarted the next time.

6.6.3 Perform Alarm ACK Operations
If an alarm occurs in a monitored tag after data monitoring 
is started, the corresponding area blinks in the alarm color 
to indicate the alarm occurrence. An alarm ACK operation 
refers to the act of stopping this blinking.

The following three ACK operation methods are available. 
The blinking alarm indication stops when you perform an 
ACK operation.
•	 Alarm ACK on all tags
 On the Project  menu, click Alarm ACK. Or, click the 

 icon.
•	 Alarm ACK on each group
 Open the Group tabbed page of the alarm monitor 

screen, click the applicable group to perform ACK 
operation.

•	 Alarm ACK on each tag
 Open the Tag tabbed page of the alarm monitor screen, 

click the applicable tag to perform ACK operation.
To display the alarm monitor screen, see section 3.3.5, 
“Registering Data Collection Method and Monitor Page.”

•	 Alarm ACK Operation and Alarm Indication 
Transition

 The following figure shows how the alarm indication 
transitions as an alarm occurs, is released, and is 
acknowledged with alarm ACK. The figure shows an 
example of a Digital Monitor Set tag.

Blinks in alarm-on color

Turns on in alarm-on colorBlinks in alarm-off color

Alarm releaseAlarm ACK

Alarm occurrence

Alarm release Alarm ACK
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•	 If	an	alarm	occurs	and	is	released	before	the	alarm	
ACK operation, the color changes to that when 
alarm is not occurring, but blinking continues until 
the alarm ACK operation is executed.

•	 If	an	alarm	occurs	again	after	an	alarm	ACK	
operation is executed, blinking will start again.

•	 Alarm	ACK	operations	do	not	affect	data	collection	
devices.

•	 Sharing Alarm ACK Operations
 The alarm ACK status of a project can be shared 

among multiple clients that are connected to the same 
server. Alarm ACK can be shared by setting Share 
Alarm ACK under Others on the Access&Others 
Setting Page. This feature is set to OFF by default. If 
set to ON, the setting is applied starting from the next 
acquisition. 

Access & Others

 If a single client performs an ACK operation for an 
alarm that occurs in a project whose this setting is set 
to ON, the blinking stops on all clients connected to 
the same server. If set to OFF, other clients are not 
affected even if you perform an ACK operation on a 
single client.

Related topic:  Sec. 3.3.12

6.6.4 Performing an Acknowledge of Device 
Communication Interference

If communication with connected devices is disconnected 
during data collection and recording, the icon on the 
toolbar blinks in the alarm color to indicate the error. 
Acknowledge of Device Communication Interference is an 
operation for checking the communication error and the 
affected projects.

•	 Stopping the Warning Beep
 To stop the warning beep, click the  icon or 

click Stop the Warning Beep from the Operation 
menu.

 You cannot stop the sound just by performing an ACK 
operation. Note that even when the beep is stopped, 
if a communication disconnection occurs again, it will 
beep again.

Related topic: Sec. 6.6.2

•	 Checking the Device Communication Disconnection
 On the Operation menu, click Acknowledge of Device 

Communication Interference. Or, click the  
icon. The icon blinking stops, and the Project List Page 
appears. On the Project List Page, you can determine 
which projects are affected by the communication 
disconnection by checking the changes in the 
communication status icon of each project. The status 
icons are valid only when the project is open.

Blinks in warning-on color

Move to the Project List Page

Disconnected

Blinking stops ACK

At least one device 
is disconnected.

All devices 
are connected.

Communication status icons

Normal

Disconnected Normal

•	 When communication is restored, data collection and 
recording resume.

•	 If communication recovers before an Acknowledge of 
Device Communication Interference is performed, the 
communication status icon will return to normal.

Chapter 6  Monitoring Data Collection 
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6.6.5 Showing the Alarm Indication Window in 
Front

The client window can be shown in front when an alarm 
occurs.
•	 You can set it by clicking Move The Window To The 

Top When Alarm Occurred on the View menu.
•	 If there are multiple client windows, you can select 

whether to show the window in front for each of the 
windows.

•	 If an alarm occurs in an opened project, the 
corresponding window moves to the front of all other 
windows (except the window you are using).

•	 Even when an alarm is activated, if the alarm type 
changes, it is considered a new alarm.

•	 If the window is minimized, it is restored.
•	 Even if you close the window, the setting is applied each 

time the window is opened.

 Chapter 6  Monitoring Data Collection

6.7 Checking the Project Operation 
Status

Click the Status Page icon on the Project tab to display 
the Status Page. A Status Page is used to monitor:
•	 The	project	data	collection	and	recording	status
•	 The	communication	status	between	the	data	collection	

device in the project and the server
The displayed data is automatically updated periodically.
6.7.1 Displayed Content

Device communication status
Project operation status

•	  Project Status
 Stopped, Monitoring, Record Standby, or Recording

•	 Loss Data
 Recording data dropout status

•	 Write Error
 Whether data writing to the data file is being performed 

normally

•	 Modbus Server Status
 Stopped, Executing, or Error (an error occurs when the 

Modbus address overlaps with that of another project.)

•	 Time Correction
 ----, Valid, Correcting, Invalid
 Corrects the difference between the PC time and the 

data time of each project. This requires a connection to 
a time server.

 If a difference of 1 second to 15 seconds occurs 
between the PC time and the data time of each 
project, the data time is gradually corrected to match 
the PC time. If a difference of more than 15 seconds 
occurs between the GA10 server time and data 
time, subsequent times (at the project level) are not 
corrected. Time correction is performed for each project 
separately. The time correction state is reset when the 
data monitoring of a project is stopped.

 If monitoring has not been started on a “Device time” 
project or “PC time” project, “----” is displayed.
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•	  Beginning Time of Recording
 The time of the first data value in the first data file that 

is created after recording to data files is started

•	 Total Time of Recording
 The elapsed time since the start of recording.
 The timer continues until all recordings stop or when 

Recording Standby is reached.

•	 Number of Generated Files
 The number of data files that have been created after 

recording was started

•	 Remaining Disk Capacity
 The free space on the disk that contains the data file 

save destination directory.
 In the following conditions, “-----” is displayed, and the 

bar does not display the amount of space used.
•	 Not	recording.
•	 The	data	file	save	destination	folder	is	set	to	a	

network folder.

•	 Device Communication Status
 The status of communication with the devices in the 

Device List is displayed. Nothing is displayed when 
data collection is stopped.

Device name
Model name
Communication address
Communication status

Model icon

Item Description
Model icon Device icon
Device name Device name and device number
Model name Model name and release number or software 

name and release number
Communication 
address

IP address

Communication 
status

Communication status between the server 
and device
Normal, Error, Retrying

6.8 Controlling Device Computation 
from GA10

On the Project menu, click Start Device's Computing, Stop 
Device's Computing, Reset Device's Computing, or Reset 
& Start Device's Computing.
Computation is collectively controlled on the devices that 
meet the following conditions.
•	 Devices	that	are	in	the	Device	List	of	the	project
•	 Devices	that	have	computation	functionality
•	 Devices	that	support	Start Device's Computing, Stop 

Device's Computing, Reset Device's Computing, or 
Reset & Start Device's Computing

Connected 
Device,
Software

Start 
Comp.

Stop 
Comp.

Clear 
Comp.

Clear&Start 
Computing

μR10000,
μR20000

Yes Yes No Yes

DX1000, 
DX1000N, 
DX1000T

Yes Yes Yes Yes

DX2000, 
DX2000T

Yes Yes Yes Yes

MV1000, 
MV2000

Yes Yes Yes Yes

CX1000, 
CX2000

Yes Yes Yes Yes

FX1000 Yes Yes Yes Yes
FW1000 Yes Yes Yes Yes
MX100, MW100 No No No No
DA100, DR130, 
DR230,
DR240

Yes Yes Yes Yes

GX10,
GX20,
GP10,
GP20

Yes Yes Yes Yes

DAQLOGGER, 
DAQ32Plus, 
MXLOGGER

No No No No

Devices 
supporting 
the Modbus 
protocol

No No No No

Yes: Supported No: Not supported
* When connected over an Ethernet network, the user registered 
in the device must have privileges to use computation for this 
feature to work.

Chapter 6  Monitoring Data Collection 
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6.9 Things to Consider
6.9.1 Time Zone and Daylight Saving Time
Be sure to set the same time zone and daylight saving 
time settings on the PC running the GA10 server, the PC 
running the GA10 client, and the data collection devices. 
If they are not the same, data time may not be displayed 
correctly.
6.9.2 Error Data
If collected or recorded data is in error, it is displayed 
or recorded using indications other than values. For the 
different types of error data, see “Data that indicates 
errors.”

•	 Data Display in a Digital Monitor Set or Meter 
Monitor Set

Display Data Condition*

+OVER +OVER
–OVER -OVER
INVALID INVALID
BURNOUT BURNOUT
ILLEGAL ILLEGAL
LACK LACK
OFF OFF
* See “Data that indicates errors.”

•	 Display in the Trend Monitor Set
Waveform Cursor Value Data Condition*

Drawn exceeding the 
scale upper limit

+OVER +OVER

Drawn exceeding the 
scale lower limit

-OVER -OVER

Nothing INVALID INVALID
BURNOUT BURNOUT
ILLEGAL ILLEGAL
LACK LACK
(blank) OFF

* See “Data that indicates errors.”

•	 Data in Recording Data Files
Data in Binary Data 
Files

Data in Excel Data 
Files

Data Condition*

+OVER +OVER +OVER
–OVER –OVER -OVER
INVALID INVALID INVALID
BURNOUT BURNOUT BURNOUT
ILLEGAL ILLEGAL ILLEGAL
LACK LACK LACK
OFF OFF OFF
* See “Data that indicates errors.”

•	 Data That Indicates Errors
 The following table shows the different types of data 

that indicates errors.
Data Description
+OVER +Over-range data
–OVER -Over-range data
SKIP Channels that have been set to skipped
INVALID Invalid data

The data type and decimal place specified on 
the Tag Setting Page do not match those of the 
collected data.

BURNOUT Burnout data
ILLEGAL Illegal data
LACK Indicates that the device failed to acquire the data
OFF Indicates one of the following conditions.

• Data collection has not been performed since 
the project was opened.

• Channels are not assigned to tags.
• When the data time is set to PC time, the 

collected data is SKIP data.
• Communication error condition
• Initialized condition as a result of changing the 

Device Setting Page or Tag Setting Page while 
data collection is stopped

• An attempt was made to collect data from a 
device using the backfill function, but there is 
no data recorded in the device.

6.9.3 Reflecting Changes Made on the Monitor 
Page to the Setting Page

If the access privilege is Owner or Manager, changes 
made to the following settings on the Monitor Page are 
reflected on the corresponding Setting Page (Display 
Group or Acquisition & Monitor). If the access privilege is 
Operator or Monitor, the changes are not reflected.

•	 Monitor	Set	size	adjustment
•	 Waveform	display	on/off	state,	Y-axis	display	on/

off state, Detail/Compact, Zoom in/Zoom out, and 
movement in the Trend Monitor Set

•	 Trip	line	position

6.9.4 Changing the Time on the Device after 
Starting Data Collection and Recording

Do not change the time on the device after starting data 
collection and recording, because doing so will cause 
adverse effects on the monitor screen and recorded data.

 Related topic “Changes to devices during data 
collection and recording”:   Q11 on page 14-11

6.9.5 Changing the PC Time after Starting Data 
Collection and Recording

If the PC time is changed after starting data collection with 
the [PC time] setting, adjustments exceeding 5 seconds 
will not be reflected in the data time.

 Chapter 6  Monitoring Data Collection
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6.9.6 Conditions When Multiple Screens Are 
Shown

When multiple screens (clients) are shown on the same 
PC, the screens use the same display conditions in the 
PC. If a setting included in these conditions is changed on 
a given screen, the change is not immediately applied to 
the other screens. However, such changes are applied the 
next time the clients are started.
The display conditions held in the PC are listed below.
•	 Window size and position
•	 Alarm show/hide stateGroup link state
•	 Cursor value transparency
•	 Display items of tag display
•	 User display form
•	 Screen background color (style)
•	 Date and moth display form
•	 Decimal point
•	 Toolbar show/hide state
•	 Mark bar show/hide state
•	 Warning action bar show/hide state
•	 Language
•	 Width of each column on the setting page (Tag, Math 

Tag, Display Group, Data File List, Report/Print History, 
Report/Print Schedule) sheets

•	 Show/hide state of each column on the Display Group 
and Data File List sheets

•	 Sort method on the Data File List page, Report/Print 
History, and Report/Print Schedule sheets

•	 Login information in the startup login dialog box
•	 Show/hide state of tooltips on the Simple Settings page

The CPU and memory usage when multiple clients are 
running varies depending on the collection and recording 
environment (PC performance, number of tags, interval, 
number of projects, etc.) and the number of monitor sets 
on the Monitor Page. As such, limitation may be placed on 
the number of screens that can be started. See the table 
below for the CPU and memory usage rates.
•	 When running a single project with four monitor sets

Clients Tags Acquisition 
interval

CPU usage Memory usage

2 2000 500 msec Approx. 19% Approx. 470 MB
4 2000 500 msec Approx. 36% Approx. 940 MB
2 500 100 msec Approx. 18% Approx. 400 MB
4 500 100 msec Approx. 38% Approx. 800 MB

This example was verified in the following environment.
CPU: Intel Core i5 (2.67GHz), Memory: 4.0 GB,  
OS: Windows 7 Ultimate SP1

6.10 Viewing the Log
You can view the log that the server sends in the Log 
dialog box. You can open the Log dialog box at any time 
when you are logged in to the server. The dialog box stays 
open until you close it. If you log in for the first time after 
installation, a log dialog box appears. At this point, if you 
switch between show and hide, the state is stored and 
reflected the next time the software is started.

6.10.1 Displayed Content in the Log Dialog Box
Up to 1000 log events that occur from when the user logs 
in to the server until the user logs out are displayed.
There are two types of logs: system log (displayed in 
yellow), which deals with the server, and project log 
(displayed in blue), which deals with projects.
System log includes events such as server login and 
logout. Project log includes data collection start and stop. 
System logs are sent to all users. Project logs are sent to 
users that have the projects opened.

6.10.2 Opening the Log Dialog Box
On the View menu, click Log. The log dialog box opens.

Most recent log entry

Log list

Filter

•	 Filter
 The events that correspond to the filter box that you 

clicked and turned blue appear. For details, see 
“Transmission scope.”

•	 Log List
 The log events are displayed in the order of 

occurrence. If there are events that do not fit in the 
dialog box, a scroll bar appears.

Transmission date and time
Transmission scope

Sent information

Log number
Jump icon

Source

•	 Most Recent Log Entry
This line always displays the most recent log entry.

•	 Transmission Date and Time
 The date and time when the log was transmitted.
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•	 Transmission Scope
 Indicates the log transmission scope
Icon Description

Sent to all users (system log).
Set the Filter to Log to display the corresponding log.
Sent to users that that have the relevant projects 
opened (project log).
Set the Filter to project to display the corresponding log.

•	 Source
 SYS or the project name.

•	 Sent Information
 The log information.

•	 Log Number
 Displays the number that corresponds to the log event.

•	 Jump Icon
 Displayed when there is a page associated with the log 

event. Clicking the icon shows the relevant page. For 
example, if you click the icon for a “recording started” 
event, the corresponding project’s Monitor Page will be 
displayed.

To close the log dialog box, click the  icon in the upper 
right.

6.10.3 Changing the Size of the Log Dialog Box
Point to a corner of the dialog box so that the pointer 
changes to an arrow. Then, drag to change the size.

6.10.4 Log Shown in the Log Dialog Box
System Log

Number Message Description
SY002 Server is trial version. When an attempt is made to 

log in to a running server using 
a trial version.

SY003 [UserName] has logged on. --
SY004 [UserName] has logged off. This does not appear when 

a logout occurs due to a 
communication error.

Project Log
Number Message Description
WK001 [Username] executes 

monitoring [Projectname].
--

WK002 [UserName]  executes 
stopping monitoring 
[ProjectName].

--

WK003 [UserName] executes 
recording [ProjectName].

--

WK004 [UserName] executes 
stopping recording  
[ProjectName].

--

WK005 [ProjectName]'s recording 
started.

--

WK006 [ProjectName]'s recording 
stopped.

--

WK007 In [ProjectName] data 
file([FileName]) has been 
generated.

--

WK008 [ProjectName]'s data file has 
been deleted automatically.

When the number of data files 
has reached the limit and a 
data file is deleted to create a 
new data file

Number Message Description
WK009 Data loss happened in 

[ProjectName].
When a data dropout occurs 
during data recording.
If data dropouts occur 
consecutively, a log entry is 
made on the first dropout.
If the data time is set to PC 
time, a log entry is made when 
a communication timeout 
occurs and the data dropout is 
confirmed.
If the data time is set to Device 
time, a log entry is made when 
the data dropout is confirmed 
from the FIFO data acquired 
after the communication 
recovers.

WK010 [UserName] has opened 
[ProjectName].

--

WK011 [UserName] has closed 
[ProjectName].

This includes the case when 
a project is forcibly closed 
as a result of losing access 
privileges to the project.

WK012 [UserName] has locked 
[ProjectName].

When a user with operator 
or higher privileges opens a 
project.

WK013 [UserName] has unlocked 
[ProjectName].

When a user with operator 
or higher privileges closes a 
project. When an administrator 
unlocks a project forcibly or 
when an unlock occurs due to 
a communication error.

WK014 Project([ProjectName])'s 
owner changed from 
[FormerUserName] to 
[NextUserName].

--

WK015 In [ProjectName], disconnect 
from [Device name]

When the communication 
between the server and device 
is disconnected.

WK016 In [ProjectName], have 
connected from [Device 
name] again.

When the communication 
between the server and device 
is restored

WK017 Disk remaining capacity of 
[ProjectName] is less than 
50M.

Transmitted periodically (once 
a minute) while the free space 
on the data save destination 
drive is less than 50 MB.

WK018 Failed to send mail to 
[ProjectName](MailName).
(Cause)

--

WK019 Fail to write data file in  
[ProjectName].

When data cannot be written 
due to some problem at the 
data save destination.
Some problems include the full 
data file path exceeding 260 
characters, starting to record 
to a read-only destination, or 
not having write privileges.

WK020 The event of  [ProjectName]
(ScheduleName) executed 
successfully.

--

WK021 Failed to execute the 
event of  [ProjectName]
(ScheduleName) .

--

WK022 Sending mail of 
[ProjectName](MailName) 
completed successfully.

--

WK023 Transfer of data file 
ProjectName completed

--

WK024 Transfer of data file 
ProjectName failed

--

UserName: User that executed the operation.
Tag: Tag that the alarm occurred on
FileName:	Name	of	the	data	file.
DeviceName: Name of the connected device.
ProjectName: Name of the project.
FormerUserName: User name of the project’s owner before the change
NextUserName: User name of the project’s owner after the change
ScheduleName: Schedule name for auto report printing.
MailName: Name of the mail event.

Chapter 6  Monitoring Data Collection 
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Cause: Cause of the mail transmission failure.
The following causes are displayed.
Fail to connect POP server.
Fail to connect SMTP server.
Authentication failed.
Sender address does not exist.
All of sending address do not exist.
Some of sending address do not exist.
Communication with SMTP server failed while sending mail. (This message 

is	displayed	also	when	the	attached	file	size	is	larger	than	the	supported	
size.)

System error occurred.

Chapter 6  Monitoring Data Collection 

6.11 Monitoring on the Integration 
Graph (/WH option)

6.11.1 Displayed Content
The explanation in this section uses an integration bar 
graph display as an example. 
The integration trend does not have a total integrated 
quantity display. Everything else is the same as the 
integration bar graph.

Legend/Cursor value Total
 integrated
quantity*

Time axis

ToolbarIntegration graph
Cursor

Scale

* The total integrated quantity is not displayed
   in the integration trend.

Scale

•	 Cursor
 Displays the cursor position.

•	 Integration Graph
 Displays the integration bar or integration trend. 
 Bars or trends are accumulated in order from the first 

integration channel in the integration settings.

•	 Toolbar
 A toolbar for the integration display. 
 For details, see the next section.

•	 Legend/Cursor value
 Displays the legend and cursor values.

•	 Cursor value
 Displays the value of each channel and the total for 

the data in the time display range selected with the 
cursors.

•	 Time axis
 The time axis of the integration graph.

•	 Scale
 A scale for integration bars and total integrated 

quantity. 
 The scale is set automatically from the total of all 

channel data.

•	 Total integrated quantity
 Displays the total integrated quantity of each channel.
 The integration trend does not have a total integrated 

quantity display.
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6.11.2 Changing the Display
You can perform the following operations using the toolbar 
displayed in the upper right corner. 
The toolbar is fixed in the upper right corner.

Report type

Compare 2 rows

Time display range Legend, 
cursor 
display On/OffDate specify

Integration graph type

•	 Time display range
 The current display can be switched to display the 

previous or subsequent time based on the time display 
range.
Item Description[ データファイル一覧画面］へ Go to Previous 

Report
The display range from the current 
display to the display for the previous 
time is displayed.
Example: When the report type is Daily 
Report, the data of the previous day 
from the currently displayed day is 
displayed.[ データファイル一覧画面］へ Go to Next 

Report
The display range from the current 
display to the display for the 
subsequent time is displayed.
Example: When the report type is Daily 
Report, the data of the subsequent 
day from the currently displayed day is 
displayed.

•	 Date specify
 The integration graph of any date can be specified to 

be displayed.
Item Description
Single column display Specify the date of the integration 

graph to be displayed.
Two-column display Specify the respective dates of the 

integration graphs to be displayed in 
the upper/lower field.

•	 Report type
 Select the report type to be displayed from Daily 

Report, Weekly Report, Monthly Report, and Yearly 
Report.
Item Description[ データファイル一覧画面］へ Daily Report An integration graph for one day is 

displayed.[ データファイル一覧画面］へ Weekly Report An integration graph for one week is 
displayed.[ データファイル一覧画面］へ Monthly Report An integration graph for one month is 
displayed.[ データファイル一覧画面］へ Yearly Report An integration graph for one year is 
displayed.

•	 Integration graph type
 Select the graph type for an integration graph to be 

displayed.
Item Description[ データファイル一覧画面］へ Integration bar graph Displays the Integration bar 

graph.[ データファイル一覧画面］へ Integration trend Displays the Integration trend 
graph.

•	 Compare 2 Rows
 Displays the integration graphs of the specified dates in 

the top and bottom rows. 
 You can compare the integration graphs of two dates.

•	 Legend, cursor display On/Off
 Turns on / off the legend/cursor values display.

Item Description[ データファイル一覧画面］へ Legend Dis-
play	On/Off

Turn	on/off	the	legend	display.	Click-
ing this button each time switches 
between Show and Hide. A legend 
can be moved by drag & drop within 
a drawing area in a graph. Even 
when the legend display is turned 
off,	if	the	cursor	display	is	turned	on,	
a legend is displayed.[ データファイル一覧画面］へ Cursor Dis-

play	On/Off
Turn	on/off	the	cursor	value	dis-
play. Clicking this button each time 
switches between Show and Hide.
For the data in the selected time 
display range, the value for each 
channel and the total value are 
displayed.
When displaying two graphs on top 
of each other for comparison, the 
values	indicating	the	difference	and	
rate of change between the lower 
row (current time) and upper row 
(previous time) are displayed.

Chapter 6  Monitoring Data Collection 
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6.12 Monitoring on the Demand Monitor 
Display (/WH option)

6.12.1 Displayed Content
The demand monitor display consists of an update interval 
display and the following display areas.

•	 Toolbar
•	 Detail	data
•	 Legend
•	 Demand	Monitoring
•	 Alarm

Legend

Toorbar

Alarm

Detailed data

Demand monitor

Estimated comparison

Toolbar
The toolbar displays the estimated comparison time. You 
can also perform the following operations on the demand 
monitor graph. The toolbar is fixed in the upper right 
corner.

Show or hide the legend
Waveform line thickness Grid density

•	 Estimated Comparision
 Displays the estimated comparison time of the demand 

monitor.

•	 Show or Hide the Legend
 You can show or hide the legend.
 A legend is displayed for the contract power, target 

demand, and current demand.

•	 Waveform Line Thickness
 You can change the waveform line thickness. This 

applies to all waveforms.

•	 Grid Density
 You can change the grid density.

Detailed data 
The following detailed data is displayed.

•	 Contract	Power
 The contract power setting.
•	 Target	Power
	 The	target	demand	setting.
•	 Current	Reference	Power
 The computed current reference power. 

 Current reference power = target demand/demand 
monitor period× monitor time)

•	 Current	Demand
 The current demand value.
•	 Forecast	Demand
 The computed forecast demand. 

	 Forecast	demand	=	(current	demand	+	ΔP×time	left/Δt)
	 ΔP	=	Current	demand	–	demand	estimated	

comparison	time	(Δt)	earlier

⊿P

⊿t

Time Left

Current demand

Current

Forecast DemandContract Power

Demand period

Target power

Current Reference Power

•	 Excess	Power
 The computed excess power.

 Excess Power=(Current Demand–Contract Power)
•	 Regulated	Power
 The computed regulated power. 

 Regulated power = (forecast demand – target 
demand)× (demand monitor period/time left)

•	 Cutt-off	Margin	Power
 The cut-off margin power setting.
•	 Cutt-off	Alarm	Hysteresis
 The cut-off alarm hysteresis setting.
•	 Time	Left
 The time left of the demand monitor period.
•	 Basic	Alarm	Value	1	to	4
 The values of the set basic alarm levels 1 to 4.
•	 Today's	Maximum	Power	Record
 The maximum power and the time of occurrence within 

the demand monitor period of one day.

Chapter 6  Monitoring Data Collection 
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Legend
Displays a legend for the contract power, target demand, 
and current demand.

Demand monitpring
The demand monitor graphically displays the current 
demand monitor information. 
When the demand time elapses, the information is reset, 
and the next demand monitor information is displayed.

Displayed Content

Basic Alarm Value
Alarm mask time Time axis Scale

Contract Power
Forecast Demand

Target Power
Reference power line

Current deman

Basic alarm setting
Displays the basic alarm setting with a trip line.

Alarm mask
Displays the range of the alarm mask time by filling the 
area.

Time axis
Displays the demand monitor date, the demand time from 
start to finish, and time grid. 
The start time is on the hour.

Scale
The scale for demand values. 
It is set automatically from the total of all channel data.

Contract Power
Displays the contract power with a line.

Reference power line 
Displays a line between the start of demand to the target 
demand value.

Current demand 
Displays the demand values from the start of demand to 
the current point.

Forecast Demand
Displays a graph from the demand value of the current 
point to the forecast demand value.

Alarm
Displays the occurrence status of the basic alarm and 
cut-off alarm.

Basic alarm generation and recovery conditions 
Generation condition: Forecast demand > Alarm value 
Recovery	condition:	Forecast	demand	≤	Basic	alarm	

recovery power* 
* Basic alarm recovery power = Alarm value – Basic 

alarm hysteresis

Cut-off alarm generation and recovery conditions 
Generation condition: Regulated power > Cut-off margin 

power 1 and current demand > Current reference power 
Recovery	condition:	Regulated	power	≤	Cut-off	alarm	

recovery power 2	and	current	demand	≤	Current	
reference power 

1 Power that can be cut off (power that can be reduced 
by cutting the power off) 

2 Cut-off alarm recovery power = Cut-off margin power 
– Cut-off alarm hysteresis value

Chapter 6  Monitoring Data Collection 
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6.13 Using the Anomaly Detection 
Function

Analyze the measurement data per display group 
(learning and detecting anomalies), detect anomalies with 
regard to data that is behaving differently than normal, 
and display the result. In the trend display, digital display, 
or meter display, the monitor screen frame (monitor set 
frame) turns yellow.

Detection start/stop operation

1 Start data collection. 

2 On the Action menu, click Start/Stop Anomaly 
Detection, or click  on the toolbar. 
An Anomaly detection Group Selection dialog box 
appears. Display groups that have been turned on in 
the anomaly detection settings appear in a list.

3 Select a display group to start anomaly detection. 
Anomaly detection is run for display groups with the 
Start check box marked. 

4 Click OK. 
Anomaly detection is started for the selected display 
groups.

•	 Anomaly detection group dialog box
Item Description
Display group Shows the display groups that have 

been turned on in the anomaly 
detection settings.

Anomaly detection The start and stop of anomaly 
detection is set per display group.

Status Shows the anomaly detection status 
when the dialog is displayed. 
•		For	the	description	content,	refer	to	

"Status" in "Operation explanation."

Operation explanation

•	 Detection notification according to the anomaly 
detection level

 Checks are conducted according to the anomaly 
detection level and a detection notification is sent if the 
detection score exceeds the detection level.
•	 To	display	anomaly	detection,	you	must	turn	on	the	

group highlight function. See section 6.5.4 "Using 
the Group Highlight Function" on page 6-11.

•	 For	details	on	anomaly	detection	settings,	see	
section 3.3.6, "Configuring the Anomaly Detection 
Function" on page 3-40.

Status Learning period 

•	 Status
 The status appears on the right side of the monitor 

interval display.
 

Indication Description
No analysis Indicates that anomaly detection is 

not run (stopped)
Learning Indicates that the system is learning 

how to detect anomalies.
Detection Indicates that the system has finished 

learning anomaly detection and is 
detecting anomalies.

Analysis error Indicates that the system has not 
learned or detected anomalies 
correctly.

•	 Anomaly detection study period specification icon
 The icon only appears for display groups that have 

been configured for the anomaly detection function.
Indication Description

If you click the icon, the Anomaly 
detection Study period dialog box 
appears.
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Anomaly detection Study period dialog box

Item Description
Study period Select Cursor or Specify Time.

Cursor:  Cursors to indicate the time 
for starting and stopping the 
study 1

Specify  Time: The period specified 
for starting and stopping the 
study

Start Time These are only enabled if Specify 
Time was selected for Study period.

Stop Time Sets the date and time to start and 
stop the study.

OK Reflects the settings and closes the 
dialog box.

Cancel Cancels the changes and closes the 
dialog box.

1 To specify the learning time using a cursor, set 
cursor A (start) and cursor B (stop) on the trend 
waveform before the dialog box appears. After that, 
display the dialog box and select Cursor for Study 
period.

•	 Operation explanation for learning
 Once learning has commenced for a display group, 

the learning outcome is retained even if data collection 
or anomaly detection is stopped. When you restart 
data collection or anomaly detection, there is no need 
to study the display group again and you can restart 
detection using the same learning outcome. 

 To restudy a display group, specify the learning period 
in the Learning period dialog box.

•	 Operation limitation
Take note that the anomaly detection has the following 

limitations on detection: 
(1) When using anomaly detection, set 10 seconds or 

more for the monitor interval. If you set less than 10 
seconds, anomaly detection is not run. 

(2) If there are many display groups and tags in the 
groups that are subject to anomaly detection, the 
likelihood of the internal software becoming busy 
increases. If anomaly detection is not ready to be run in 
time as a result of the busy status, anomaly detection is 
skipped for that monitor interval. 

 In the HealthScore calculation of the Math function (/
MT option), the detection score for that monitor interval 
becomes "OFF". 

 Whether a busy state occurs depends on the monitor 
interval and the PC environment that is used. 
 Monitor interval:  The longer the interval, the harder it 

is to become a busy state. 
 PC environment:  The higher the PC specs, the 

harder it is to become a busy state.

Chapter 6  Monitoring Data Collection 
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Chapter 7  Using the Custom Display Function (/CG option)
7.1 What Is the Custom Display Function?

By using the custom display function (/CG option), you can add original monitor pages to 
the GA10’s standard monitor pages (trend, meter, digital, and alarm, integration graph (/
WH option)). These additional monitor pages are called custom display monitors. Custom 
display monitors are created using DAQStudio (DXA170), a software application for creating 
screens. Screen data that you create can be saved to custom display files (.gacd extension).

Note
•	 The	GA10’s	custom	display	function	includes	a	license	for	DAQStudio	(DXA170)	Custom	

Display Builder. This license is different from the GA10’s option license (a number that starts 
with 400-).

•	 Download	DAQStudio	from	YOKOGAWA's	website,	and	install	it	in	your	PC.	For	instructions	on	
how to use it, see the DXA170 DAQStudio User’s Manual (IM04L41B01-62EN).

7.2 Registering a Custom Display
Register the custom display files (.gacd extension) created with DAQStudio in the GA10’s 
Acquisition&Monitor page and Monitor Set Type.

Click here

Basic Operation

1 Open the Collect & Monitor Page setting page of the project.

2 Click Regist for the custom display file.
An Open dialog box appears.
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3 Move to the location where the custom display file created with DAQStudio is saved.

4 Select the file that you want to register, and click Open.
The	file	name	appears	to	the	left	of	the	Register	button,	and	the	custom	display	monitor	becomes	
available in the Monitor Set Type list.

If	the	file	fails	to	be	loaded,	an	error	message	appears.

Note
•	 The	Register	button	appears	only	on	GA10s	that	have	the	/CG	option	installed.
•	 One	custom	display	file	can	be	registered	in	a	single	GA10	project.	If	you	register	a	second	file,	

it overwrites the registration.
•	 Up	to	50	screens	can	be	defined	in	a	single	custom	display	file.

Setting the Monitor Set Type
When you register a custom display file, the custom display monitors defined in that file 
appear in the Monitor Set Type list. The displayed name is the name that is defined when 
the file is created. The method to set the Monitor Set Type, layout, and so on are the same 
as that of a standard Monitor Page.

Related topic: Section 3.3.5
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7.3 Displaying a Custom Display Monitor
Click	the	Monitor	Page	icon	!!!	on	the	Project	tab	to	open	the	custom	display	monitor	page.
In addition to the normal Monitor Set Maximize button, the size of the custom display 
monitor can be adjusted by clicking the following buttons. The custom display is expanded or 
reduced according to the Monitor Page size.
Select the Frame Size Display check box on the View menu to display the screen size in the 
upper right of the window. Remove the check to hide it.

(Light style)
Fit to Monitor Page The custom display is expanded or reduced according to 

the Monitor Page size.
(Dark style)

(Light style)
Fit to Monitor Page keeping the aspect 
ratio constant

The custom display is expanded or reduced to the page’s 
width or height, whichever is shorter, keeping the aspect 
ratio constant.
For the long side, the display is aligned to the center.(Dark style)

Related topic: Displaying the Monitor Page  page 6-2

Fit to Monitor Page

Fit to Monitor Page keeping the aspect ratio constant

Note
If there is only one Monitor Set, the Maximize Monitor Set button does not appear.

Chapter 7  Using the Custom Display Function (/CG option)
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7.4 Custom Display Components
GA10 custom display screens are created using DAQStudio (DXA170), a software 
application. This section provides an overview of the components used to create screens. 
For details on components and settings, see the DXA170 DAQStudio User’s Manual 
(IM04L41B01-62EN).

GA10 Custom Display Monitor Components

Component Type Component Name
Diagram components Line, Triangle, Rectangle, Arc, Ellipse,
Components for channel assignment Simple digital, Digital, Simple bar meter, Simple analog meter, Analog meter, 

Alarm, Representative alarm, Integration graph (integration bar/integration 
trend)

Status display component Disk memory bar
Label components Label, System label
Components with action functions Button operation, Digital output, Value list output, controller component
Components for summary display
(GA10: Components for Alarm list)

Alarm summery

Components for trend display Trend
Components for static image display Image

You can control GA10 and devices on the custom display monitor by using the following 
components. Depending on the action assigned to the components, a confirmation dialog 
box appears when the component is used.

•	 Button	operation

“Page switching,” “data collection and recording operation,” "Display image" and other 
actions assigned to the button is executed when the push button is used.

Assignable Action Dialog  Timing of Execution
Page switching

M1023 Do you want to run the operation??
Executed when you click OK.

Start Monitoring
Stop Monitoring
Start Recording
Acknowledge alarm sound
Alarm ACK
Acknowledge device error
Append Mark
Bit Write
Constant Write
Reset Computing
Manual save
Stop Recording M1006 Do you want to stop the recording?
Display message No confirmation dialog box is displayed. Executed immediately when the button 

is clicked.
Display image A Display image dialog box appears, and the 

image registered when the window was created 
is shown.

Image shown when the button is 
clicked.

•	 Digital	output	

The input value is output to the assigned tag (see Note).

Assignable Action Dialog  Timing of Execution
Value output A dialog box for entering a value appears. Enter a value in the edit box of the dialog 

box and click OK to output the value

Chapter 7  Using the Custom Display Function (/CG option)
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Chapter 7  Using the Custom Display Function (/CG option)

•	 Value	list	output	

The input value is output to the assigned tag (see Note).
Assignable Action Dialog  Timing of Execution

Output the selected value from a list A list box for selecting a value appears. Select a value from the list and click 
OK to output the value.

Note
The tag that the value is output to must have a writable channel of a Modbus device assigned to it.

7.5 Controlling GX/GP/GMs or Controllers with the Custom Display Function
Using the GA10 (R3.02 or later) custom display function, you can monitor and control the 
custom display function status of GX/GP/GMs with PID control modules and UTAdvanced 
series controllers. This section describes the controller component that you use and their 
operation dialog boxes.

Controller Component
The component that you use for the control operation on the custom display is called a 
controller component. There are two display types to the controller component: faceplate 
and controller.

Controller Faceplate
Loop name display

RUN/STOP
REMOTE/LOCAL

PV

SP

AUTO/MANUAL/CASCADE

OUT

Bar Graph

The following table details each component item.
Item Initial value Description
Loop name Name specified on DAQSTUDIO --
Alarm Gray Control alarms L1 to L8 are shown.
AUTO/MANUAL AUTO The assigned tag value is shown during monitoring. “***” 

is shown for values other than AUTO/MANUAL, and you 
cannot click it.

RUN/STOP RUN The assigned tag value is shown during monitoring. 
“***” is shown for values other than RUN/STOP, and you 
cannot click it.

REMOTE/LOCAL LOCAL The assigned tag value is shown during monitoring. “***” 
is shown for values other than REMOTE/LOCAL, and 
you cannot click it.

PV Off The assigned tag value is shown during monitoring. The 
value is shown in red while an alarm is occurring.

SP Off The assigned tag value is shown during monitoring. 
When you set the value, it is written to an assigned, 
writable tag.

OUT Off The assigned tag value is shown during monitoring. 
When you set the value, it is written to an assigned, 
writable tag. The decimal place is fixed to 1.

PV Bar graph -2.000 to 2.0000 The upper and lower limits of the assigned tag value are 
shown during monitoring. The bar is shown in red while 
an alarm is occurring.

OUT Bar graph -- --
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Like other component screens, screens using these components are created using the 
DAQStudio, a software application for creating screens. For instructions on how to create 
screens and descriptions of component attributes, see DXA170 DAQStudio User’s Manual 
(IM04L41B01-62EN).

Basic Operation
The control operation procedure on the GA10 is shown below.

1 Register a GX/GP/GM (firmware version R4.01 or later, with a PID control module) or a 
UTAdvanced series controller in the GA10 devices list.

Select the device to register in the GA10 Register device dialog box from the following.
•	 When	the	connected	device	is	a	GX/GP/GM:	GX/GP/GM_PIDSlot0	to	GX/GP/GM_

PIDSlot9 For “Slot,” select the number of the slot that the PID module is installed in.
•	 When	the	connected	device	is	a	UTAdvanced	controller:	A	UT	model	that	ends	with	

“_R3”

Note
When connecting to a GX/GP/GM, check the following on the main unit.
•	 The	PID control module is installed (detected).
•	 In	the	main	unit	settings,	Communication	(Ethernet)	settings	>	Server	settings	>	Server	list	>	

MODBUS is set to ON.

2 Using DAQStudio, edit the controller component, assign the device tag (e.g., PV, SP) 
registered in step 1 to the component, and save the custom display file (*.gacd).

3 Register the custom display file saved in step 2 in the GA10 Acquisition&Monitor page.
Registration procedure:  page 7-1
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Chapter 7  Using the Custom Display Function (/CG option)

4 On the loaded custom display monitor, click the operation mode (AUTO/MANUAL, 
RUN/STOP, LOCAL/REMOTE), target setpoint (SP), or control output value (OUT) are 
of the controller component to display an operation dialog box.

5 Enter values in the dialog box, and click OK.
If you click Cancel, the dialog box will close, and the settings will not be sent.

Description of the Operation Dialog Box
The following table shows the operating range and operating procedure on the controller 
component’s operation dialog box.

Operation Operating Range Dialog
AUTO/MANUAL switching Selectable range: AUTO/MANUAL

RUN/STOP switching Selectable range: RUN/STOP

REMOTE/LOCAL switching Selectable range: REMOTE/LOCAL Select the operation mode from the list, and 
click OK to send the setting and close the 
dialog box. If you click Cancel, the dialog box 
will close, and the settings will not be sent.

Target setpoint (SP) When the operation mode is LOCAL, 
clicking this displays a setting dialog box.
Data type Range
INT16 -32768 to 32767
UINT16 0 to 65535
INT32 -9999999 to 99999999
UINT32 -9999999 to 99999999
FLOAT -9999999 to 99999999
BIT 0 to 1 

Control output value (OUT) When the operation mode is MANUAL 
and RUN, clicking this displays a setting 
dialog box.
Input range: -50% to 105.0%

The title is either SP or OUT.
Enter the value in the edit box. If the value 
is out of range, it is corrected to the upper or 
lower limit. For SP, the range shows the upper 
and lower limits. For OUT, the range is fixed to 
-5.0% to 105.0%.
Click OK to send the setting and close the 
dialog box. If you click Cancel, the dialog box 
will close, and the settings will not be sent.
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Note
The following displays and operations are not available on the controller component.

• PV error string display • Updating values when the setting dialog box is open
• RSP error string display • Displaying device errors (e.g., access rejection)
• Alarm blinking • Displaying the loop information dialog box
• Deviation display • Alarm ACK
• Alarm type string display • AUTO/MAN/CASCADE switching
• Tag string display • PROGRAM/LOCAL switching
• Alarm setpoint mark display on the PV value bar graph • Writing SP and OUT values in REMOTE mode
• PV switching

Chapter 7  Using the Custom Display Function (/CG option)
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Chapter 8  Managing Recording Data
8.1 Displaying a List of Data Files
Click the Data files Page icon on the Project tab to 
display the Data File List Page.

Data files Page icon

Project tab

The data files in the data file save destination directory are 
listed. Only data files saved in binary format are displayed. 
Data files saved in Excel format are excluded.

Item Displayed Content
File Name Name of the data file
Data Number Number of data values in the data file

The total number of data values if files are 
linked and displayed*

Record Interval Recording interval used to create the data file
Start Time The time of the first data value in the data file

The time of the first data of the entire data if 
files are linked and displayed*

End Time The time of the last data value in the data file
The time of the last data of the entire data if 
files are linked and displayed*

File Size
(Unit: byte)

Data file size
The total data size if files are linked and 
displayed*

Comment 1 Title and content of Comment 1 to 8 that were 
specified when the file was createdComment 2

Comment 3
Comment 4
Comment 5
Comment 6
Comment 7
Comment 8
*  Does not include the values of deleted files and other files that 

do not exist

•	 Showing Files in Link View
 You can link and display files that have been divided by 

the recording stop condition or other factors.
 Click the Show Files in Link View to turn the box 

blue. Files are linked from the start of recording to the 
end of recording and displayed in one line. Clicking 
the box again to turn it to white returns the page to the 
individual file display.

•	 Deleting Files

1 Click the file you want to delete.

 Selecting multiple consecutive files
 Example: Selecting consecutive files: File005, File006, 

and File007
•	 Click	File005.	Drag	to	File007,	and	release	the	

mouse button.
•	 Click	File005	to	select	it.	While	holding	the	Shift	key	

down, click File007.

2 Click Delete.
A	confirmation	dialog	box	appears.

3 Click OK.
The	files	are	deleted.

•	 Showing and Hiding Columns
 If you move the pointer over a column title, a hide icon 

appears. Click it to hide the column. When you hide a 
column, a show icon will appear in the upper right of 
the page. Click this icon to show the hidden columns.

Hide icon

Show icon

 The results of showing and hiding columns apply to 
every project in the same client.
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•	 Adjusting Column Widths
 When you move the pointer near a boundary of 

a column title, the pointer changes to . In this 
condition, drag the pointer to move the boundary to the 
desired position. The results of adjusting column widths 
apply to every project in the same client.

•	 Sorting the File List
 Click a column title to sort the file list on the basis of the 

clicked column. Click it again to sort in reverse order. A 
sort mark ( , ) appears in the column title area.

•	 Refreshing the Display
 On the View menu, click Refresh.
 Or click Updat Data List.( )
 The most recent file information is retrieved from the 

server, and the page is refreshed.

8.2 Displaying Recording Data
Recording data can be displayed in a viewer (Universal 
Viewer).

1 Select the file you want to view.
You	can	select	multiple	link	files.

2 Click Open.
The viewer (Universal Viewer) starts, and the data in 
the	file	is	displayed.

You can also double-click the file to display the 
data.

•	 Editing and Saving Recording Data
 The following file 1 saved on the viewer for the file 

displayed using the above procedure is discarded 
when the GA10 client software is closed.

	 •	Link	settings	file	(.ldx)
	 •	Display	template	file	(.tdx)

 To edit and save data, start the viewer according to the 
following procedure, and directly open the files 2 stored 
in the server. The tag that the value is output to must 
have a writable channel of a Modbus device assigned 
to it.

 Windows Start--> All Programs --> SMARTDAC+ 
Data Logging Software --> Viewer

1 For details on the viewer’s display condition file, see 
chapter 4 in the viewer user’s manual (IM 04L61B01-
01EN).

2 Files saved in the directory specified by Folder on the 
GA10 Record Setting Page.

 To convert data on the viewer, set the file save 
destination to a folder other than the default. The 
default folder is discarded when the Universal Viewer 
software is closed.

Note
•	 For	instructions	on	how	to	use	Universal	Viewer,	see	

the Universal Viewer User’s Manual (IM 04L61B01-
01EN).

•	 GA10	recording	data	(.dld	extension)	can	be	displayed	
on Universal Viewer version R1.03 and later.

•	 The	language set in GA10 do not apply to the 
language of the viewer. To change the language for 
displaying files on the viewer, set it in the viewer.

Chapter 8  Managing Recording Data 
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Chapter 9  Managing Users
9.1 Administrator and Users

In GA10, you can set server access privileges.
There are two types of server access privileges: administrator and user. The administrator 
manages all users. The administrator can perform the following operations in addition to all 
the operations available to users.

•	 Register	users
•	 Delete	users
•	 Initialize	user	passwords
•	 View	the	login	status	of	users

The following sections explain how to use the User Management Page.

User management

Administrator

User CUser B

User A
Logged in

Not logged in

User D
Logged in

ViewView

Delete
Initialize password ViewView

Server New user

Registration

Note that at the GA10 project level, users can be assigned one of four project access 
privileges: Owner, Manager, Operator, and Monitor. These privileges are assigned for each 
project using Details Settings mode.
For details, see “3.3.8 Configuring Mail Settings”.



9-2 IM 04L65B01-01EN

9.3 Changing User Information
This section explains how to change the user full name 
and password. This procedure can also be performed by a 
user who is logged in.
9.3.1 How the Administrator Changes Other 

User Information
The administrator performs the following procedure to 
change the full name and initialize the password of a user.

1 Follow steps 1 and 2 in section 9.2 to display the 
User Management Page.

2 Select the user you want to change.
The user is selected.

The frame turns blue when selected.

3 Double-click the selected user.
The Change User’s Information dialog box opens.

4 To change the full name, type the new name.

 To initialize the password, click Initialize.
Type in this box to change the full name.

Click here to initialize the password.

5 Check the information, and click OK.
The full name or password will be changed.

Note
You cannot change the information if the applicable user 
is logged in or if the user has been deleted from another 
client.

Chapter 9  Managing Users

9.2 Managing User Status
9.2.1 Using the User Management Page
The administrator can view the status of other users on 
the User Management Page.

1 Start the client, and log in to the server with GA10 
administrator privileges.

2 On the View menu, click User Management Page. 
Or, click the  icon.
The User Management Page appears.

3 Check the user status by looking at the icons (see 
below).

Not logged in

Logged in
Number of users logged in

Appears in blue when logged in
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9.4 Registering and Deleting Users
Only the administrator can register and delete other users.
9.4.1 Registering a New Users

1 Start the client, and log in with the administrator 
account that you created earlier.

2 On the View menu, click User Management Page.
Or, click the  icon.

The User Management Page appears.

3 On the User menu, click Register New User.

The Change User’s Information dialog box appears.

4 Type the user name and user full name that you 
want to register.

 Enter a name that is easy for the administrator 
to identify.

5 Check the entered information, and click OK.
The user is registered, and an icon is added in the 
window.

6 In the case of an administrator, on the File menu, 
click Logout to log out.

A registered user can log in without a password.
Follow the instructions in Sec. 9.3.2 to set a pass-

word.

Chapter 9  Managing Users 

9.3.2 How Users Change Their Information
The following example shows how the administrator or a 
user changes his or her full name and password.

1 Start the client, and log in to the server.
The Project List Page appears.

2 On the User menu, click Change Information.
The Change User’s Information dialog box opens.

3 Change the full name or password, view the 
changes, and click OK.

 To change the password, type the current and 
new passwords.

Note
•	 You	can	change	the	full	name	and	password	

simultaneously.
•	 Enter	the	password	using	4	to	30	alphanumeric	

characters..

The default values of the settings in the Change User's 
Information dialog box are shown below.

Item Initial value
Full Name User full name before change
Password Nothing is displayed.
New Password Nothing is displayed.
Confirm New Password Nothing is displayed.
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9.4.3 Changing a Project Owner
If you delete an owner user

 If the administrator deletes a user, the access 
privileges granted to the user is lost. If the deleted user 
had been a project owner, the project will no longer 
have any owner. This condition is displayed as follows.

Displays a dash when there is no owner.

 To change a project owner (specify a new owner), 
follow the procedure below.

Note
Only the owner of the relevant project or the administrator 
can change the owner.

1 Display the Project List Page.
 On the View menu, click Project List Page. Or, 

click the  icon.

2 Select the project you want to change.

3 On the Project menu, click Modify Owner.
A Change Project’s Owner dialog box appears.

Change Project’ s Owner dialog box

4 From the New Owner list, select a user.
Any user registered in the server can become a 

project owner.

Select a new owner.

5 After selecting the new owner, click OK.
The owner will be changed.

9.4.2 Deleting a User
You cannot delete a user that is logged in.
We recommend that you check the user access privileges 
before deleting the user.

1 Follow steps 1 and 2 in section 9.2 to display the 
User Management Page.

2 Select the user you want to delete.
The user is selected.

3 On the Edit menu, click Delete.

Or, click the  icon.
A warning message appears.

4 To proceed, click OK.
The user will be deleted.

Chapter 9  Managing Users
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9.4.5 Unlocking a Project by Force
The administrator can only unlock locked projects.

1 On the Project List Page, select the locked project.

Locked project

Displays the user 
who locked the project

2 On the Project menu, click Unlock Project 
Forcibly.
A	confirmation	message	for	unlocking	appears.

3 To proceed, click OK.
The dialog box closes, and the name of the user 
who locked the project disappears from the project.

9.4.4 Opening a Project at a Specific Privilege 
Level

A user assigned to a project can open the project at a 
privilege level that is lower than the assigned privilege 
level.

1 Display the Project List Page.

2 Select a project.

3 On the Project menu, click Open with Specified 
Permission.
An	Open	with	Specified	Permission	dialog	box	ap-
pears.

4 Select the privilege level that you want to use to 
open the project.

You can select any level up to your assigned level.
 The following figure is an example of a user who 

is assigned the Manager level. The user cannot 
select the Owner level, because it is higher than the 
Manager level.

5 Click OK.
The dialog box closes, the Project Page appears.

Note
Only the operations allowed at the specified privilege 
level can be used in the project. However, if the project 
is locked, users other than the user who applied the lock 
can only access the project at the Monitor level.

Chapter 9  Managing Users 
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Chapter 10 OPC-UA Server Function (/UA option)
10.1 Overview

10.1.1 Basic Functions of the OPC-UA Server
The GA10’s OPC-UA server function enables OPC-UA clients of a host system to access 
GA10’s data. This function can be used to deliver tag information and measured values to 
OPC-UA clients.

Basic functions of the OPC-UA server are listed below.
Specification Description
Compatible profile UA 1.02 Micro Embedded Server

DataAccess Server Facet
Used port 4840: OPC UA TCP Protocol (can be changed)
Maximum number of client connections 16 (Max 16 sessions)
Maximum number of subscriptions 100/session
Maximum number of monitor items 2000/session
Sampling interval 100ms,  200ms,  500ms,  1s,  2s,  5s,  10s,  20s,  30s,  1min,  

2min,  5min,  10min
Supported services FindServers

GetEndpoints
CreateSession
ActivateSession
CloseSession
Browse
BrowseNext
TranslateBrowsePathsToNodeIds
RegisterNodes
UnregisterNodes
Read
CreateMonitoredItems
ModifyMonitoredItems
DeleteMonitoredItems
SetMonitoringMode
CreateSubscription
ModifySubscription
DeleteSubscriptions
Publish
Republish
SetPublishingMode

In terms of security, the GA10 does not perform certificate authentication. All clients are 
allowed to connect. The GA10 supports the following user authentication methods.
Authentication method Description
Anonymous authentication No authentication
Username authentication * Authentication by user name and password

* User names and passwords specified by the user information registered in the GA10 are used.

OPC-UA clients’ access privileges are controlled by the GA10’s user management function. 
The user privilege relationship between GA10 and OPC-UA client users is shown below.
GA10 User Privileges OPC-UA Client User Privileges
Owner Read/Write
Manager Read/Write
Operator Read/Write
Monitor Read Only

Note
OPC-UA clients can access GA10 only while data collection is in progress.
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10.1.2 GA10 Data Structure

Server

Yokogawa Logger

Device001

Device Status

ChannelName_001

All Alarm Status

EURange

EngineeringUnits

InstrumentRange

Alarm 1 Status

Alarm 2 Status

Alarm 3 Status

Alarm 4 Status

Channel Data

Model Name

Serial Number

Status

Root

Objects
Channel Data

Math_GA10

Channel Data

Data

GA

Node 1 Description Class Data Type Note
Server Server information Object -- --
Yokogawa Logger Data Object -- --
DeviceXXX Data of each device Object -- --
Device Status Device status information Object -- --
Status Registered device status Variable Int32 1: normal, 2: error, 

3: error (In 
communication retry)

Model Name Registered device name Variable String ex.) DX1000, GX20
Serial Number Registered device serial number Variable String ex.) X5G905023
Math_GA10 Math tag data Object -- --
Channel Data Channel data Object -- --
ChannelName_XXX 2 Data of each channel Object String --
Data Measured value Variable Float ex.) 123.4
EURange Upper and lower range limits Variable Range

(ExtensionObject)
ex.) -10 ~ 10

EngineeringUnits Unit Variable EUInformation
(ExtensionObject)

ex.) °

InstrumentRange Upper and lower range limits 
(display boundaries)

Variable Range
(ExtensionObject)

ex.) 11~11

All Alarm Status Status of all alarms Variable Boolean true: alarm ON,
false: alarm OFF

Alarm Status 1 to 4 Status of each alarm Variable Boolean true: alarm ON,
false: alarm OFF

1 All nodes are read only.
2 Tag name and tag comment are displayed in the description of ChannelName_XXX.

 Chapter 10  OPC-UA Server Function (/UA option)
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10.1.3 Server Certificate Operations
This function can be used to perform the following server certificate operations. For the 
actual procedure, see Sec. 10.2.4.

Installation
Installs the certificate file that the user has prepared in GA10 to make it an OPC-UA server 
certificate. The certificate must be generated from an internal private key.
A certificate with a Sha-1 signature algorithm can be installed.

Creating a Self-Signed Certificate
A server certificate is typically issued by a certification authority (CA) signing a certificate 
signing request (CSR). This function can generate a self-signed certificate that can be used 
when a certification authority (CA) signature is not necessary. A self-signed certificate can be 
generated from the internal private key and installed.

Creating a Certificate Signing Request (CSR)
A certificate signing request (CSR) to be signed by a certification authority (CA) can be 
created. It is created from the internal private key available at the time of execution.

10.1.4 Subscription operation 
Subscription Service and Monitored Item Service are functions that an OPC-UA server 
mainly performs to transmit data change notification, event notification, and so on to OPC-
UA clients. 
The GA10 OPC-UA server only supports data change notification.

List: Subscription Supported Functions
Group Sub Group Supported Function
Subscription Notification Data Change Notification

Max Subscription 100 (Subscription/Session)
Publish Interval 100 ms, 200 ms, 500 ms, 1 s, 2 s, 5 s, 

10 s, 20 s, 30 s, 1 min, 2 min, 5 min, 
10 min

Max notifications Per Publish 65536 (Notification/Publish)
Lifetime Count 3 to 300 : Default 60
Max Keep Alive 1 to 10 : Default 5
Priority Low(0), Normal(1), High(2) : Default 0
Publish Queue 10
Retransmission Queue 10

List: MonitoredItem Supported Functions
Group Sub Group Supported Function
MonitoredItem Max MonitoredItem 2000 (MonitoredItem/Session)

Sampling Interval 100 ms, 200 ms, 500 ms, 1 s, 2 s, 5 
s, 10 s,
20 s, 30 s, 1 min, 2 min, 5 min, 10 min

Monitoring Mode Disable
Sampling
Reporting

Filter Data Change Filter
Data Queue Size 1 to 100 : Default 1
Discard Policy On, Off : Default On

Chapter 10  OPC-UA Server Function (/UA option) 
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10.2 OPC-UA Server Project
This section describes the various setting pages of the OPC-UA server function and how the 
operations differ from those of normal projects.

10.2.1 Project List Page
When GA10 with the OPC-UA server function starts, the Project Page shows a single “OPC-
UA” server project. You cannot delete this project. Nor can you change its basic information. 
The following figure shows the initial screen that appears when you log in to GA10 with the 
OPC-UA server function.

Note that because an OPC-UA server project does not have a recording function, record 
control buttons are disabled and adding marks is also not allowed.

Selected

Monitoring and recording are disabled.
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10.2.2 Project Tab
An OPC-UA server project consists of a setting page and 
status page. Depending on the privileges of the user who 
opened the project and the lock status, if the setting page 
is enabled, the setting page appears. Otherwise the status 
page appears.
The following figure shows the OPC-UA server project 
tab. Unlike normal projects, the record button and buttons 
for displaying the Monitor Page and Data files Page are 
not available.

Status indication
(monitoring)

Stop monitoring

Setting Page

Status Page

Start
monitoring

Project icon and project name

Item Name Description Condition
Status 
indication

Indicates the project status. The 
behavior is the same as that for typical 
projects.

None

Icon OPC-UA server icon None
Project name OPC-UA None
Start Monitoring 
button

A button for starting or stopping 
monitoring. The behavior is the same 
as that for typical projects.
If monitoring starts, the Status Page 
will appear.
Clicking the Start Monitoring button 
starts the OPC-UA server. If the server 
fails to start, error message E3069 will 
appear.
Then, a consistency check is 
performed between the server 
certificate and private key. If the check 
fails, error message E3070 will appear.

Disabled in a 
locked state.
Disabled for 
monitor users.

Setting Page 
button

A button for calling up the project 
setting window. The behavior is the 
same as that for typical projects.

Disabled in a 
locked state.
Disabled for 
monitor users.

Status Page 
button

A button for calling up the Status Page. 
The behavior is the same as that for 
typical projects.

None

10.2.3 Setting Pages
An OPC-UA server project consists of Device, Tag, Math 
Tag, Server Operation, and Access&Others Setting 
Pages. Device, Tag, Math Tag, and Access&Others are 
the same functions as those of typical projects. There is 
no Simple Settings mode. Math Tag appears when the 
Math function (/MT option) is installed.

Depending on the access privileges of the user when 
the project is opened and the project status, each of the 
displayed setting pages may be enabled or disabled. (See 
the table below.)
Running 
State

Setting Page Access Privileges When the Project Is 
Opened

Owner Manager Operator
Not 
monitoring

Device Enabled Enabled  Enabled2

Tag Enabled Enabled Disabled
Math Tag Enabled Enabled Disabled
Server 
Operation

Enabled Enabled Disabled

Access&Others Enabled  Enabled1 Disabled
Monitoring Device  Enabled2  Enabled2  Enabled2

Tag Disabled Disabled Disabled
Math Tag Disabled Disabled Disabled
Server 
Operation

Disabled Disabled Disabled

Access&Others   Enabled3 Disabled Disabled
1 Only Keep Lock State and DDE Server in the page are enabled. All others 

are disabled.
2 Devices List in the page is disabled. All others are enabled.
3 Keep Lock State and DDE Server are enabled. All others are enabled.

 Chapter 10  OPC-UA Server Function (/UA option)



10-6 IM 04L65B01-01EN

Chapter 10  OPC-UA Server Function (/UA option) 

Device Setting Page
Selecting Device displays the Device Setting Page. The 
function is the same as that for normal projects.
For the procedure, see “3.3.2 Registering Devices to 
Connect”.

Tag Setting Page
Selecting Tag displays the Tag Setting Page. The basic 
tag functions are the same as those for normal projects. 
However, because there is no recording function, the 
corresponding column does not exist.
For the procedure, see “3.3.3 Setting Tags”.

Math Tag Setting Page
Selecting Math Tag displays the Math Tag Setting Page. 
The basic math tag functions are the same as those for 
normal projects. However, because there is no recording 
function, the corresponding column does not exist.
For the procedure, see “4.1 Setting Math Tags”.

Note
Before using the Math function, set the data time 
acquisition condition to PC time. This is set using Data 
time on the Server Setting Page described later.
If set to Device time, the Acquisition & Computing check 
box for the math tag will be cleared, and you will not be 
able to set math tags.

Server Setting Page
Selecting Server Operation displays the Server Setting 
Page. The details are described on the next page.

Access&Others Setting Page
Selecting Access&Others displays the Access&Others 
Setting Page. The function is the same as that for normal 
projects.
For the procedure, see “3.3.9 Setting Project Access 
Privileges”.
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 Chapter 10  OPC-UA Server Function (/UA option)

10.2.4 Server Setting Page
On the OPC-UA server project setting page, selecting Server Operation displays the Server 
Setting Page (see the following figure).

The page is divided into three areas: Monitor, Server Setting, and Server Certificate.
Each area is described below.

•	 Monitor

(1) Data time
 Select the time to assign to data.

•	 Default value: PC time
•	 Input range: PC time, Device time

 You cannot set this when monitoring is in progress.

(2) Monitor Interval
 Select the data monitor interval.

•	 Default value: 1s
•	 Input range:  100ms, 200ms, 500ms, 1s, 2s, 5s, 10s, 20s, 30s, 1min, 2min, 5min, 

10min
 You cannot select this when Data time is set to Device time. In addition, note that if set to 

Device time, math tag settings will be disabled.
Related topic:  “Setting Data Collection Conditions”

If the monitor interval does not match the sampling interval set on the OPC-UA client, the 
timestamps that the OPC-UA client displays may be divided poorly with respect to the 
sampling interval. (For example, if the monitor interval is set to 100 ms and the sampling 
interval is set to 1 s, the timestamps that the OPC-UA displays will be 0.3 s, 1.3 s, 2.3 s, and 
so on.)
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•	 Server	Setting

(1) Server Name
 Enter the OPC-UA server name using a character string.

•	 Default value: GA10 UA Server
•	 Input range: Up to  20 characters

 You cannot set this when monitoring is in progress.

(2) Port No.
 Enter the OPC-UA port number.

•	 Default value: 4840
•	 Input range: 1025 to 65535  

 If the input is outside the range, the value will be reset to 4840 (default value).
 You cannot set this when monitoring is in progress.

(3) Anonymous Login
 Select Allow to allow anonymous connection from an OPC-UA client. The privilege for 

such connection is ReadOnly.
•	 Default value: Allow
•	 Options: Allow, Prohibit

 You cannot set this when monitoring is in progress.

•	 Server	Certificate
Certificate information

The Server Certificate area shows the certificate information (see the following table).
Item Name Description
Version Certificate version
Serial No. Certificate serial number
Signature Algorithm Certificate signature algorithm
Signature Hash Algorithm Certificate signature hash algorithm
Issuer Certificate issuer (common name)
Valid from Start of the certificate’s valid period
Valid to End of the certificate’s valid period

* The area will be blank if there is no certificate.

Clicking the Install a certificate, Generate a self-signed certificate, or Issue a certificate 
signing request(CSR) button displays a dialog box for executing or creating the relevant 
item. (For the procedure, see the next page.)

Chapter 10  OPC-UA Server Function (/UA option) 
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Basic Operation
(1) Installation of certificate

1 Click Installation of certificate.
An Open dialog box appears.

2 Select the certificate file (*.der) that you want to install, and click Open.
The	certificate	is	installed,	and	the	server	certificate	information	is	updated.
If registration fails, an error (E3057) will appear.

Basic Operation
(2) Generate a self-signed certificate

1 Click Generate a self-signed certificate.
A	Generate	a	self-signed	certificate	dialog	box	appears.

2 Enter the items. The input ranges are as follows.
•	 Country:	2	alphabet	characters
•	 State,	City:	Alphanumeric	characters,	spaces,	and	symbols.	Up	to	128	characters.

	 Prohibited	characters:	!"#	$%&';?^|
•	 Organization,	Organization	Unit,	Common	Name,	E-Mail	address:	Alphanumeric	

characters, spaces, and symbols. Up to 64 characters.
	 Prohibited	characters:	!"#	$%&';?^|

3 Click OK.
A	self-signed	certificate	is	created.
If creation fails, an error (E3072) will appear.

Note
•	 If	a	character	string	that	you	enter	exceeds	the	limit,	it	is	truncated	within	the	limit.
•	 Issuer	information	and	subject	information	will	be	the	same.

 Chapter 10  OPC-UA Server Function (/UA option)
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The following table shows the items and descriptions of the self-signed certificate that is 
created.

Item Name Description
Version “V3”
Serial No. Auto generation1

Signature Algorithm Sha1RSA
Signature Hash Algorithm Sha1
Issuer: Country Setting entered in the dialog box
Issuer: State Same as above
Issuer: City Same as above
Issuer: Organization Same as above
Issuer: Organization unit Same as above 
Issuer: Common name Same as above
Issuer: E-Mail address Same as above
Valid from PC time when the certificate was created
Valid to 2037/12/1 21:00:00
Subject: Country Setting entered in the dialog box 
Subject: State Same as above
Subject: City Same as above
Subject: Organization Same as above
Subject: Organization unit Same as above 
Subject: Common name Same as above
Subject: E-Mail address Same as above

1 Generated automatically from the server software license number.

If a certificate does not exist when the GA10 OPC-UA server is started, a self-signed 
certificate is automatically created with the following information. Issuer information and 
subject information will be the same.

Details of the Items in the Self-Signed Certificate Created Automatically
Item Name Description
Version “V3”
Serial No. Auto generation1

Signature Algorithm Sha1RSA
Signature Hash Algorithm Sha1
Issuer: Country “JP”
Issuer: State “Tokyo”
Issuer: City “Musashino”
Issuer: Organization “Yokogawa Electric Corp.”
Issuer: Organization unit “Product Business Center”
Issuer: Common name2 “GA10-UAServer@“+[ComputerName]
Issuer: Domain component2 [ComputerName]
Valid from PC time when the certificate was created
Valid to 2037/12/1 21:00:00
Subject: Country “JP”
Subject: State “Tokyo”
Subject: City “Musashino”
Subject: Organization “Yokogawa Electric Corp.”
Subject: Organization unit “Product Business Center”
Subject: Common name2 “GA10-UAServer@“+[ComputerName]
Subject: E-Mail address2 Blank

1 Generated automatically from the server software license number.
2 The PC name is entered in ComputerName.

Chapter 10  OPC-UA Server Function (/UA option) 
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Basic Operation
(3) Creating a Certificate Signing Request (CSR)

1 Click Issue a certificate signing request (CSR).
A	Issue	a	certificate	signing	request	(CSR)	dialog	box	appears.

2 Enter the items up to File Name. The character input range is as follows.

•	 Country:	2	alphabet	characters
•	 File	Name:	Up	to	60	characters	excluding	\/:,;*?”<>|
•	 State,	City:	Alphanumeric	characters,	spaces,	and	symbols.	Up	to	128	characters.

	 Prohibited	characters:	!"#	$%&';?^|
•	 Organization,	Organization	Unit,	Common	Name,	E-Mail	address:	Alphanumeric	

characters, spaces, and symbols. Up to 64 characters.
	 Prohibited	characters:	!"#	$%&';?^|

3 Click Browse to specify the save destination folder.
The Browse for Folder dialog box appears.

The character input range is as follows.

•	 Up	to	255	characters.
 Prohibited characters: /?”<>|

4 Click OK.
A	certificate	signing	request	(CSR)	is	created	in	the	specified	folder.	The	file	name	extension	is	
.csr.
If creation fails, an error (E3067) will appear.
The	following	table	shows	the	items	and	descriptions	of	the	certificate	signing	request	(CSR)	that	
is created.
Item Name Description
Country Setting entered in the dialog box
State Same as above
City Same as above
Organization Same as above
Organization unit Same as above
Common name Same as above
E-Mail address Same as above

 Chapter 10  OPC-UA Server Function (/UA option)
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10.2.5 Status Page
OPC-UA server projects do not have a recording function, so unlike normal projects, items 
related to recording are not displayed on the Status Page.

•	 Project	Status
 Not monitoring or monitoring
•	 Loss	Data
 Recording data dropout status
•	 Device	Running	State
 The status of communication with the devices in the Device List is displayed. Nothing is 

displayed when data collection is stopped.

Device name

Model icon

Model name

Communication address

Comm. Status
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Chapter 11 Modbus Server Function
11.1 Basic Functions of the Modbus Server

The Modbus server function receives requests from Modbus/TCP client devices and returns 
information about the currently running GA10 project specified by the Modbus address as 
responses.
A Modbus client device can carry out the following operations on the GA10.
•	 Read	the	data	of	tags	and	math	tags
 Value, status, scale upper and lower
•	 Read	project	information	data
 Data collection and recording status, alarm status, alarm ACK status, data dropout 

presence/absence, write error presence/absence, beginning time of recording, total time 
of recording, number of generated files

Data Logging Software GA10

Ethernet

Modbus client device

GX/GP

Modbus Server

Command

Input register

Hold register Read

Read
3XXXXX

4XXXXX

Read

Read

GA10 internal register Client

Basic functions of the Modbus server are listed below.
Specification Description
Protocol Modus TCP
Port number 502 (default value)
Function code 3 (read hold register), 4 (read input register)
Maximum number of connectable clients 30
Data update interval Same as the scan interval of the corresponding GA10 project
Address range 1 to 247 (assigned to the GA10 project)
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11.2 Modbus Server and Register Assignments

11.2.1 Modbus Server
Function code
The GA10 supports the following functions.
Function Code Function Operation
3 Read the hold register

(4XXXX, 4XXXXX)
The client (master) device reads the GA10 tag and math tag data.

4 Read the input register
(3XXXX, 3XXXXX)

The client (master) device reads the GA10 tag and math tag data.

11.2.2 Register Assignments
The Modbus register addresses for tabs and math tags are assigned fixed address in order 
by the GA10 project's tag indexes (1 to 2000) and math indexes (1 to 2000) as shown in the 
following table.

Tag and Math Input Registers
Type Input Register Data Type
Value Tag 300001 to 304000 32-bit floating point (little endian)

Math tag 310001 to 314000 32-bit floating point (little endian)
Status Tag 320001 to 322000 16-bit unsigned integer

Math tag 324001 to 326000 16-bit unsigned integer
Scale lower and upper Tag 330001 to 338000 32-bit floating point (little endian)

Math tag 346001 to 362000 32-bit floating point (little endian)

Tag and Math Hold Registers
Type Hold Register Data Type
Value Tag 400001 to 404000 32-bit floating point (little endian)

Math tag 410001 to 414000 32-bit floating point (little endian)
Status Tag 420001 to 422000 16-bit unsigned integer

Math tag 424001 to 426000 16-bit unsigned integer
Scale lower and upper Tag 430001 to 438000 32-bit floating point (little endian)

Math tag 446001 to 462000 32-bit floating point (little endian)

Project Information Input Registers
Type Register Value Data type
Project Status 365001 0: Stopped, 1: Monitoring, 2: 

Recording
16-bit unsigned integer

Data dropout 365002 0: No, 1: Yes 16-bit unsigned integer
Write error 365003 0: No, 1: Yes 16-bit unsigned integer
Time correction 365004 0: Disabled, 1: Enabled 

(correcting), 2: Enabled, 3: Not 
used

16-bit unsigned integer

Recording 
start time

Year 365005 ― 16-bit unsigned integer
Month 365006 1-12 16-bit unsigned integer
Day 365007 1-31 16-bit unsigned integer
Hour 365008 0-23 16-bit unsigned integer
Minute 365009 0-59 16-bit unsigned integer
Second 365010 0-59 16-bit unsigned integer
Millisecond 365011 0-999 16-bit unsigned integer

Total time of recording 
(s)

365012 ― 32-bit unsigned integer (little 
endian)

Number of Generated 
Files

365014 ― 32-bit unsigned integer (little 
endian)

Total disk capacity 365016 The unit is MB. 32-bit floating point (little endian)
Remaining disk 
capacity

365018 The unit is MB. 32-bit floating point (little endian)

Alarm ACK 365020 0: No, 1: Yes 16-bit unsigned integer
Demand alarm 364001 to 364020 Integration group 1-20: 364001 to 

364020
Bit0-3: Basic alarm 1-4 (On:1 
Off:0)
Bit8: Cut-off alarm (On:1 Off:0)

16-bit unsigned integer

 Chapter 11  Modbus Server Function
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11.2.3 Input Registers
Client	devices	can	read	the	input	registers.

Tag, Math Data
Type Tag data Input Register Data Type
Value Tag Lower bytes of the tag 0001 data 300001 32-bit floating point (little 

endian)Higher bytes of the tag 0001 data 300002
     |      |
Lower bytes of the tag 2000 data 303999
Higher bytes of the tag 2000 data 304000

Math tag Lower bytes of the math tag 0001 data 310001
Higher bytes of the math tag 0001 data 310002
     |      |
Lower bytes of the math tag 2000 data 313999
Higher bytes of the math tag 2000 data 314000

Status Tag Tag 0001 status information 320001 16-bit signed integer
     |      |
Tag 2000 status information 322000

Math tag Math tag 0001 status information 324001
     |      |
Math tag 2000 status information 326000

Scale minimum, 
maximum

Tag Lower bytes of the tag 0001 data 330001 32-bit floating point (little 
endian)Higher bytes of the tag 0001 data 330002

     |      |
Lower bytes of the tag 2000 data 337999
Higher bytes of the tag 2000 data 338000

Math tag Lower bytes of the math tag 0001 data 346001
Higher bytes of the math tag 0001 data 346002
     |      |
Lower bytes of the math tag 2000 data 361999
Higher bytes of the math tag 2000 data 362000

Status

16-bit status
Bit0Bit15

Bit Description
0 Alarm level 1 (On: 1, Off: 0)
1 Alarm level 2 (On: 1, Off: 0)
2 Alarm level 3 (On: 1, Off: 0)
3 Alarm level 4 (On: 1, Off: 0)
4 to 7 Reserved
8 to 15 Error code (5-bit binary into decimal)

0: No error
1: +OVER
2: -OVER
3: Skip
4: Data dropout (recorder)
    Data dropout at the relevant measurement point on the recorder.
5: Undefined data
6: No data
7: Invalid
8: +OVER burnout
9: -OVER burnout
10: Not a number
11: Error
12: Off
13, 14: Not used
15: Data dropout (GA10)
    Data not acquired or data dropout at the relevant acquisition point on the GA10.

Chapter 11  Modbus Server Function
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11.2.4 Hold Registers
Client devices can read the hold registers.

Tag, Math Data
Type Tag data Hold Register Data Type
Value Tag Lower bytes of the tag 0001 data 400001 32-bit floating point (little 

endian)Higher bytes of the tag 0001 data 400002
     |      |
Lower bytes of the tag 2000 data 403999
Higher bytes of the tag 2000 data 404000

Math tag Lower bytes of the math tag 0001 data 410001
Higher bytes of the math tag 0001 data 410002
     |      |
Lower bytes of the math tag 2000 data 413999
Higher bytes of the math tag 2000 data 414000

Status Tag Tag 0001 status information 420001 16-bit unsigned integer
     |      |
Tag 2000 status information 422000

Math tag Math tag 0001 status information 424001
     |      |
Math tag 2000 status information 426000

Scale minimum, 
maximum

Tag Lower bytes of the tag 0001 data 430001 32-bit floating point (little 
endian)Higher bytes of the tag 0001 data 430002

     |      |
Lower bytes of the tag 2000 data 437999
Higher bytes of the tag 2000 data 438000

Math tag Lower bytes of the math tag 0001 data 446001
Higher bytes of the math tag 0001 data 446002
     |      |
Lower bytes of the math tag 2000 data 461999
Higher bytes of the math tag 2000 data 462000

Status
See the status in section 11.2.3, “Input Registers.”

11.2.5 Responses to Requests and Timeout Processing
Responses to requests are described below, including normal cases.
•	 If	the	specified	function	code	is	not	3	(read	hold	register)	or	4	(read	input	register),	

exception code 1 is returned.
•	 If	there	is	no	specified	project	or	if	monitoring	is	not	in	progress,	exception	code	2	is	

returned.
•	 If	the	register	of	the	specified	tag	exceeds	the	range,	exception	code	2	is	returned.
•	 If	the	register	of	the	specified	tag	is	within	range	but	the	tag	does	not	exist,	“no	data”	

status is returned.
•	 For	all	other	cases,	a	normal	response	is	returned.

Timeout Procedure
If there is no communication with a Modbus client for 2 minutes (the value specified on the 
GA10 client screen), the connection to the Modbus client will be disconnected.
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Chapter 12  Integration Display Function (/WH option)
12.1 Overview

The GA10 integration display function allows monitoring of integrated effective power data or 
integrated flow rate data acquired from devices using the integration graph (integration bar, 
integration trend) or demand monitor (for power measurements). 
The acquired integrated effective power data or integrated flow rate data is output in an 
integration report data file or demand monitor data file (for power measurements). 
You can view integration report data and demand monitor data using Universal viewer. 
For power measurements, integrated effective power data can be acquired from a UPM100 
or UPM101 Universal Power Monitor (hereafter referred to as “UPM”), and the data can be 
monitored with the integration graph or demand monitor. 
In addition, data can be acquired from multiple groups by acquiring integrated effective 
power data from Universal Power Monitors via the GM Data Acquisition Unit (hereafter 
referred to as “GM”). This makes it possible to comprehensively monitor the entire factory. 
The connection to the UPM can be through serial communication (RS-485) or Ethernet 
communication (using a VJET Ethernet/RS-485 converter). 
The connection between the UPM and GM can be through serial communication (RS-485), 
Ethernet communication (using a VJET Ethernet/RS-485 converter), or 920 MHz wireless 
communication. 
By using 920 MHz wireless communication, you can reduce the wiring work and labor 
needed to set up new networks.

Connection example using Ethernet communication

     

Ethernet

GA10

Integration graph Deman monitor

・Integration report data
・Deman monitor data

UPM

RS-485

UPM

RS-485

VJET

VJET

GM

UPM RS-485

SMART 920

GM
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Integration Calculation
In the math tag settings, if you set the tag of a channel to perform integration as an 
integration target, an expression will be assigned automatically. 
The integrated effective power data or integrated flow rate data acquired from devices at the 
scan interval is converted into integration values per unit time (1 hour) and saved as hourly 
integration values to the integration data file. 
When an integration overflow occurs in a device, calculation can be performed using the 
specified overflow value or the overflow value calculated automatically.

     

[ データファイル一覧画面］へ

Scan interval

01:00:00 02:00:00

Integration value per unit time

03:00:00 04:00:00
Time

Integration value

00:00:00

Integration Report Data
The integrated effective power data (integrated flow rate data) acquired from devices is 
converted into values per hour by the GA10 math function (/MT option). Integration data per 
hour on the hour is output as integration report data to a file. 
Integration report data can be displayed and monitored with the integration graph.

Deman Monitor Data
Demand monitor data (integrated effective power over the demand monitor period) for each 
integration group is output as demand monitor data to a file. 
The demand up to the current point in the demand monitor period can be monitored with the 
demand monitor.

Integration Graph
 For integration graph, refer to 12.3 Integration Graph on page 12-5

Demand Monitor
For demand monitor, refer to 12.4 Demand Monitor on page 12-6
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Chapter 12  Integration Display Function (/WH option)

12.2 Configuration Flowchart for the Integration Display Function 

This section provides a GA10 configuration flowchart for using the integration function. 
 For the UPM and GM communication settings, see the respective manuals.

Configuration flowchart

     

Register UPM or GM10 (UPM connectied ).

Set the GM10 communication channel that the UPM data
 or UPM data is assigned to as a tag.

Set the tag that integration will be performed on to a 
math tag.

Set integration conditions such as report output, integration 
groups, and demand monitor.

3.3.4 項

Create a project for collecting and recording UPM
 or GM (UPM) data.

3.3.5 項

Set the data acquisition method, display groups, and 
monitor page such as integration graph and demand monitor.

Set the data recording method.
3.3.6 項

Set math tags

Configure the 
display

Configure the 
recording

Set tags

Creating a Project

Set integration

Register applicable 
devices

 3.3.1 Creating a Project in Detail Settings Mode 
on page 3-7

 3.3.2 Registering Devices to Connect on page 
3-12

  3.3.5 Registering Data Collection Method and 
Monitor Page on page 3-34

 3.3.3 Setting Tags on page 3-23

 4.1 Setting Math Tags on page 4-1

  3.3.14  Configuring Integration (/WH option) on 
page 3-58

 3.3.4 Setting Display Groups on page 3-30
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Data flow in the GA10 Setup

1 In the tag settings, set the GM10 communication channel that is acquiring the 
integrated effective power data of the UPM as a tag.

2 In the math tag settings, set the integration target to the tag that integration will be 
performed on.

3 In the integration settings, set the integration channels (up to 10 channels) of the 
integration group as math tags.

     

UPM

Active Power

GM10

Communication 
Channel

C001

GA10

0001 A001

C002 0002 A002

01

02

C005 0005 A005 05

C006

C010

0006 A006

0010 A010

01

05

••
•

••
•

••
•

••
•

••
•

••
•

••
•

••
•

••
•

••
•

••
•

••
•

Integration Group 1

Tag Math Tag
(Integration Tag)

Integration
(Integration Target)

1 2 3

Integration Group 2

Active Power

Active Power

Active Power

Active Power
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12.3 Integration Graph
On the integration graph, data can be viewed by switching between integration bar and 
integration trend graph for each integration group. You can switch the integration group by 
selecting the tabbed pages displayed on the screen. 
The integration bar graph also displays the total integrated quantity. (The integration trend 
does not have a total integrated quantity display.) 
You can select the displayed report type from daily report, weekly report, monthly report, and 
yearly report. 
In addition, you can compare the integration graphs of two specified dates in two rows. 
With the cursor display, you can display the value of each integration channel of the selected 
time axis and the total value of the integration channels. 
When the comparison of two integration graphs is displayed in two rows, the difference and 
the rate-of-change of the two graphs are also displayed.

     

[ データファイル一覧画面］へ
Integration bar Integration trend

Compare 2 Rows

Detail of Itegration Graph, Monitoring
 For details on integration graph, refer to 6.11 Monitoring on the Integration Graph 

(/WH option) on page 6-19

Chapter 12  Integration Display Function (/WH option)
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12.4 Demand Monitor
The demand monitor screen graphically displays the demand up to the current point of 
each integration group, forecast demand, and reference power line. It also displays contract 
power, alarm value, alarm mask, and so on. 
Furthermore, detailed data can be displayed, and basic alarms and cut-off alarms can be 
monitored. 
You can switch the integration group by selecting the tabbed pages displayed on the screen.

     

[ データファイル一覧画面］へ

Detailed data
•	 Contract	Power
•	 Target	Power
•	 Current	Reference	Power
•	 Current	Demand
•	 Forecast	Demand
•	 Excess	Power
•	 Regulated	Power
•	 Cutt-off	Margin	Power
•	 Cutt-off	Alarm	Hysteresis
•	 Time	Left
•	 Basic	Alarm	Value
•	 Today's	Maximum	Power	Record

Details on demand monitor
 For details on demand monitor, refer to 6.12 Monitoring on the Demand Monitor 

Display (/WH option) on page 6-21

Chapter 12  Integration Display Function (/WH option) 
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Chapter 13  GateSushi Function (/SU option)
13.1 Overview

Using the GateSushi function, you can collect and record data from our company's Sushi 
Sensor (wireless solution for industrial IoT) through the LoRaWAN gateway. 
•	You	can	set	up	to	1000	Sushi	Sensors.	
•	You	can	set	up	to	four	levels	of	alarms	for	Sushi	Sensor.
•	Automatically	convert	units	(°C	to	°F).

Ethernet

GA10

Gateway

Sushi Sensor
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13.2 Configuration Flowchart for the GateSushi Function
This section provides a GA10 configuration flowchart for using the GateSushi function.

 This manual assumes that Sushi Sensor and the LoRaWAN gateway have already been 
installed. For instructions on how to install Sushi Sensor and the LoRaWAN gateway, see 
the documents for Sushi Sensor. 
•	 IM	01W06E01-011EN	(XS770A	Wireless	Vibration	Sensor	Functions)
•	 TI01W06A51-50EN	(Sushi	Sensor	System	Setup	Guide)

GA10 Create project Create a project for collecting and recording Sushi Sensor 
data.

 3.2.1 Creating a Project in Simple Settings Mode

GA10 Register GateSushi 
device

Register GateSushi as a device in GA10.

 13.3 Registering GateSushi as a Device

GA10 Open the GateSushi 
screen

Open the GateSushi screen from the detailed device 
information of GateSushi.

 13.4 Opening the GateSushi Screen

GateSushi Configure the 
connection

Set the configuration to connect GateSushi with the 
RoLaWAN gateway.

 13.5.1 Configuration to Connect GateSushi 
with the LoRaWAN Gateway

LoRaWAN Configure the 
connection

Set the configuration to connect the LoRaWAN gateway 
with GateSushi.

 13.5.2 Configuration to Connect the LoRaWAN 
Gateway with GateSushi

GateSushi Configure a Sushi 
group

These are settings to set the group name and assign a 
Sushi Sensor.
These Sushi group settings are reflected into the display 
group settings of GA10. 

 13.6 Configuring a Sushi Group
GateSushi Configure Sushi 

Sensor parameters
These are settings to assign Sushi Sensor parameter data 
to GA10 tags (tag index). 

 13.7 Configuring Sushi Sensor Parameters

GateSushi
Reflect into GA10

This operation reflects GateSushi settings into GA10.

 13.8 Reflecting GateSushi settings into GA10

GA10
Configure the display

These are settings for the monitor interval and monitor 
type.

  3.3.5 Registering Data Collection Method and 
Monitor Page

GA10 Configure the 
recording

These are settings for the record interval and record type 
(binary or Excel).

 3.3.7 Setting the Data Recording Method

GA10 Start data collection 
and recording  Chapter 6  Monitoring Data Collection
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Chapter 13  GateSushi Function (/SU option) 

13.3 Registering GateSushi as a Device
After you have created a project, register GateSushi as a device. 
Register GateSushi as one device in GA10.

1 Click Register Device at the top of the Devices List. Or, double-click an empty icon in 
the Devices List.
The initial page of the Register device dialog box appears.

       

2 Enter the GateSushi details and click OK.
The dialog box closes and GateSushi is added to the Devices List and Registered 
Devices List.

Item How to Specify Default Value Description
Device Name Enter text. Device Enter the name of the device to be registered. 

Input range: Up to 20 alphanumeric characters
Device Type Select from the list. DX1000 Select "GateSushi" from the list.
Comm. Kind Fixed Ethernet Fixed to Ethernet.
Host Name/IP 
Address

Fixed localhost Fixed to localhost.

Port No Enter text. 34592 This is the monitor port number of GateSushi. The default value 
is changed to an unused port if it is already used in the PC.
Input range: 1025 to 65535

System No Fixed 0 Fixed to 0.
[OK] Button Reflects the settings and closes the dialog box.

[Offline 
Register]

Button  See “Registering Offline” on page 3-17.

[Cancel] Button Cancels the changes and closes the dialog box.

Note
•	 One	GateSushi	server	is	shared	and	used	for	all	projects.	The	same	settings	for	device	channel	

and GA10 tag assignment are applied, so use only one project with GateSushi. 
•	 The	Update	Setting	button	cannot	be	used	in	GateSushi.
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13.4 Opening the GateSushi Screen
If you click the device icon on the Devices List and Registered Devices List, GateSushi 
information appears in the device information display area.

      

1 Click Setting in the device information display area.
The GateSushi screen appears.

Note
•	 When	the	GateSushi	screen	appears,	the	project	screen	that	is	currently	displayed	is	

automatically closed temporarily. Before "reflecting settings into GA10", close the project screen 
first.

•	 The	GateSushi	screen	that	has	appeared	is	closed	automatically.

       

Tab menu Sushi group registration area

Sushi panel

Connecting  sensor areaMenu button

Tab menu Menu button Description

GateSushi settings

Used in the settings to connect GateSushi with the RoLaWAN gateway.
Refer to “13.5.1 Configuration to Connect GateSushi with the 
LoRaWAN Gateway” on page 13-6.

Used to save multiple patterns of parameters for each sensor type as setting 
templates.
Refer to “13.9 Creating a Setting Template” on page 13-13.
Used for the batch configuration of Sushi group name settings and Sushi 
group assignments.
Refer to “13.10 Using the Setting Wizard Function (Batch 
Configuration)” on page 13-14.

Used to reflect the displayed changes into GA10 tags and group settings.
Refer to “13.8 Reflecting GateSushi settings into GA10” on page 13-12.

Option

Used to change the temperature unit (°C/°F).

Used to change the HTTP port or GA10 port.

Connecting sensor area
This area shows the Sushi Sensors that have actually received data from the LoRaWAN 
gateway. Sushi Sensor shows information such as product image and sensor type (referred 
to as Sushi panel hereinafter).

Chapter 13  GateSushi Function (/SU option) 
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Sushi group registration area
This area is used to register Sushi Sensors in order to collect and record their measurement 
data using GA10.

GateSushi detailed information display
If you click Show Detail, the channel information of the device appears in a table.

      

Item Description
Device Name Name of the device specified when registering it
Software Name GateSushi
Version No. -
Comm. Address localhost
Port No. Port number specified when registering the device (monitor port number)
System No. 0
Channel Number of Sushi items that have been turned on in GateSushi
Setting button The web browser launches and the GateSushi screen appears.
Show Detail button The detailed information of GateSushi appears.
Hide Detail button The detailed information of GateSushi is closed

Item Description
On/Off check box When the check box is selected, it means that the channel is in "use". 

When set to "Not use," tags cannot be assigned on the Tag Setting page of GA10.
Used Channel No. Channel number from 0001 to 2000 (decided in GateSushi) 

You cannot select tags in GA10 Tag Setting for channels that are turned off.
Tag No. Blank (cannot be set in GateSushi) 
Tag Comment Shows the string for each tag parameter set in GateSushi. 
Type Fixed to LONG. 
Dec. Point Shows the decimal place for each tag parameter set in GateSushi. 
MIN Shows the minimum span for each tag parameter set in GateSushi. 
MAX Shows the maximum span for each tag parameter set in GateSushi. 
Unit Shows the unit string for each tag parameter set in GateSushi.
Alarm 1 to 4 Type/Value Shows the alarm type and value of alarms 1 to 4 for each tag parameter set in 

GateSushi.

Note
There are operation restrictions if the project for which GateSushi is opened is in the middle of 
collecting data. When collecting data, operations such as sensor registration, increasing/decreasing 
the number of parameters used, and "reflecting settings into GA10" cannot be performed. 
Only the following operations can be performed when the project is collecting data:

•	 Replacing	sensors
•	 Changing	sensor	tags
•	 Changing	alarm	settings
•	 Configuring	connections
•	 Changing	the	temperature	unit

Chapter 13  GateSushi Function (/SU option) 
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13.5 Configuring Connections
13.5.1 Configuration to Connect GateSushi with the LoRaWAN Gateway
Configure the communication connection to connect GateSushi with the RoLaWAN gateway.

1 Click Connection settings.
A Connection settings dialog box appears. 

       

2 Enter each item, and then click OK.
The	connection	settings	are	reflected.

Item How to Specify Default Value Description
Authentication Select Off or On. Off Specify whether authentication is needed to connect from 

the LoRaWAN gateway. When set to Off, there is no need 
to configure a user name or password on the LoRaWAN 
gateway side. 

User name Enter text. Blank The user name to connect to the LoRaWAN gateway, which 
requires authentication. Specify this user name when setting 
the Node-RED setting on the LoRaWAN gateway side. 
Input range: Up to 20 alphanumeric characters

New Password Enter text. Blank The password to connect to the LoRaWAN gateway, which 
requires authentication. Specify this password when setting 
the Node-RED setting on the LoRaWAN gateway side. 
Input range: Up to 20 alphanumeric characters

New Password 
Again

Enter text. Blank  Used to confirm the password.

[OK] Button Reflects the settings and closes the dialog box.
[Cancel] Button Cancels the changes and closes the dialog box.

13.5.2 Configuration to Connect the LoRaWAN Gateway with GateSushi
Configure the settings to connect the LoRaWAN Gateway and GateSushi using the Node-
RED software.

 For the setting procedure, see the following document:
•	 TI01W06A51-50EN	(Sushi	Sensor	System	Setup	Guide)

Required settings
Item Setting value
URL http://[GA10 PC IP address]:34591/api/v1/sushi
Use of SSL (On/Off) Off
Use of authentication 
(On/Off)

Set to "On" if you are configuring a user name and password in GateSushi. 
Set to "Off" if you are not configuring a user name and password.

User name The user name set in GateSushi
Password The password set in GateSushi

Chapter 13  GateSushi Function (/SU option) 
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13.6 Configuring a Sushi Group
This section describes how to create a Sushi group. You can create up to 200 Sushi groups. 
This Sushi group setting is reflected into the display groups (Group 001 to 200) of GA10.
•	 Setting	a	group	name
•	 Assigning	a	Sushi	Sensor	to	the	group

(1) Assigning a connecting sensor to the group
(2) Registering a new sensor and assigning it to the group (Unconnected sensor)
(3) Performing batch configuration for group assignment 
  See “13.10 Using the Setting Wizard Function (Batch Configuration)” on page 

13-14.

13.6.1 Configuring the Group Name
Set the group name for the Sushi group. The group name that is set here is reflected into the 
group number and group name in GA10.

  

[Change Gr. name] buttonDisplay title

(Connecting sensor area) (Sushi group registration area)

[+] button

Item How to Specify Default value Description
Display title Group N: xxxx N: 1 to 200

xxxx: String representing group name
[+] Button If you click this, the New sensor registration dialog box 

appears. 
(Refer to “(2) Registering a new sensor and assigning it 
to the group” on page 13-9)

[Change Gr. name] Button If you click this, the Group name settings dialog box appears.

1 Click Change Gr. name.
A Group name settings dialog box appears.

  

2 Enter any name for the group, and click OK.
The group name is changed.

Item How to Specify Default value Description
Group name Enter text. Group N

(N: 1 to 200)
You can set up to 20 characters. 

OK Button Reflects the settings and closes the dialog box.
Cancel Button Cancels the changes and closes the dialog box.
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13.6.2 Assigning a Sushi Sensor to a Group
You can assign up to 50 Sushi Sensors to each group.

(1) Assigning a connecting sensor to the group
 Groups are assigned Sushi Sensors that have actually received data from the LoRaWAN 

gateway by the GateSushi HTTP server. Sushi Sensors that have actually received data 
appear in the Sushi panel in the Connecting sensor area.

1 Drag and drop the Sushi panel in the Connecting sensor area to the group that you 
want to assign to.
The Sushi Sensor is assigned to the group.
To delete a Sushi Sensor that has been assigned, move the cursor to the Sushi panel and click 

.

Drag and Drop

 Sushi panel

When the cursor is placed above the Sushi panel

Item Description
Type Shows the Sushi Sensor type. If it is unknown, "- - -" is shown and there is no image of the 

Sushi Sensor.
•	Pressure	(XS530),	Temperature	(XS550),	or	Vibration	(XS770A)

EUI Shows the unique ID used to identify each Sushi Sensor in the network.
Sensor tag Tag name of the Sushi Sensor. This is configured in Sushi Sensor using a dedicated 

application when setting it up.

 About updating the display
 In the Connecting sensor area, the Sushi Sensor information that has been received 

from the LoRaWAN gateway is updated in real time.

Item Description
Display Sushi panel

Added to the top in the order in which the HTTP server has confirmed connection.
Display update 
interval

30 seconds 

No. of displayed 
panels

Up to 1200 (You can assign up to 1000 to groups.)

Chapter 13  GateSushi Function (/SU option) 
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(2) Registering a new sensor and assigning it to the group
 This section explains the operation to register a sensor to a group as a local setting when 

GateSushi is not connected to the LoRaWAN gateway, or when they are connected but 
sensor data has not been received.

1 Click + for the group that you want to register in the Sushi group registration area.

  

[+] button

The New sensor registration dialog box appears.

  

2 Set the type, EUI, and sensor tag according to the specifications of the Sushi Sensor 
that you are using.

3 Click OK.
The Sushi Sensor is assigned to the group.

Item How to Specify Default value Description
Type Select from the list. Vibration 

(XS770A)
Select the sensor to register. 
•		Selection	options:	Vibration	(XS770A),	Pressure	(XS530),	

or Temperature (XS550)
EUI Enter text. Blank Set the unique ID used to identify each Sushi Sensor in the 

network.
Input range: Up to 23 alphanumeric characters and colon (:)
Enter the information according to the specifications of the 
Sushi Sensor using the following format: 
xx:xx:xx:xx:xx:xx:xx:xx
xx:00 to FF (hexadecimal)

Sensor tag Enter text. SUggg_nnnn 
(*)

Set the tag name of the Sushi Sensor. Enter the information 
according to the specifications of the Sushi Sensor. 
Input range: Up to 10 alphanumeric characters
* ggg: Number of the group that you want to register
* nnnn:  Number of registered sensors right before registering 

this sensor + 1
OK Button Reflects the settings and closes the dialog box.
Cancel Button Cancels the changes and closes the dialog box.

Chapter 13  GateSushi Function (/SU option) 
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13.7 Configuring Sushi Sensor Parameters
After you have registered Sushi Sensors to a Sushi group, set parameters for the Sushi 
Sensor that will be assigned to GA10 tags. GA10 loads the values set here as device 
channel settings. 
•	 You	can	set	up	to	50	Sushi	Sensors	for	each	group.

 For details on Sushi Sensor parameters, see “13.11 List of Sushi Sensor Parameters” 
on page 13-18.

1 Double-click a Sushi panel that was registered to the Sushi group.
A Sushi parameter setting dialog box appears

  

2 Select the Use check box for parameters that you want to assign to GA10 tags and 
configure each setting.
To	configure	parameters	by	loading	a	setting	template,	click	Load	template.	
A Load template dialog box appears. 
If you select a Template No. and click Load, the dialog box closes and the settings in the template 
are	reflected.	

  

 For details on setting templates, see “13.9 Creating a Setting Template” on page 
13-13.

3 Click OK to close the dialog box.

Item How to Specify Default value Description
EUI Enter text. Blank Refer to “(2) Registering a new sensor and 

assigning it to the group” on page 13-9. 
Sensor tag Enter text. SUggg_nnnn Refer to “(2) Registering a new sensor and 

assigning it to the group” on page 13-9.

Chapter 13  GateSushi Function (/SU option) 
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Item How to Specify Default value Description
Parameter Indicates the parameter name.
Use Check box On Specify whether to assign a parameter to GA10 tags or 

not by selecting On or Off.
If a parameter is not selected, the remaining items 
listed in this table are disabled for that parameter.

Tag Enter text. Default value of 
the sensor tag

Reflected in the GA10 tag comment. 
Input range: Up to 32 characters

Span Decimal place Select from the list. Parameter specific 0 to 5
Min Enter a number. Parameter specific Input range: -9999999 to 99999999 (dependent on the 

decimal point)
Max Enter a number. Parameter specific Input range: -9999999 to 99999999 (dependent on the 

decimal point)
Unit Enter text. Parameter specific Up to 6 characters
Alarm 
1 to 4

Type Select from the list. Off Specifies the alarm type. 
Input range: Off, High, Low, rHigh, or rLow
•		High	(upper	limit),	Low	(lower	limit),	rHigh	(upper	limit	

of the change rate), or rLow (lower limit of the change 
rate)

Value Enter a number. 0 Input range: -9999999 to 99999999 (dependent on the 
decimal point)

Hysteresis Enter a number. 0 Input range: -9999999 to 99999999 (dependent on the 
decimal point)

Unit conversion Select from the list. Temperature: 
None
Pressure: MPa

Temperature: None or Kelvin
Pressure: MPa, kPa, hPa, bar, or mbar

Device channel Unavailable Settings that are reflected as the device channel of 
GA10 tags.

GA10 tags Unavailable Settings that are reflected into GA10 tags.
Copy Button Copies the selected row to the clipboard. 

You can paste the copied row into a text editor or Excel 
and edit it.

Paste Button Pastes the data on the clipboard into the selected row. 
You can copy and paste the data that you have edited 
in a text editor or Excel. 

Load template Button Loads and reflects the setting template into the 
displayed parameter setting.

OK Button Reflects the settings and closes the dialog box.
Cancel Button Cancels the changes and closes the dialog box.

Assigning parameters, device channels, and GA10 tags
•	 When	settings	are	"reflected	into	GA10",	device	channels	are	re-assigned	in	the	order	

of group, sensor, and parameter. 
•	 GA10	tags	are	selected	from	the	smallest	number	that	is	not	in	use.	
•	 None	is	shown	for	parameters	that	are	not	selected	under	Use.

Chapter 13  GateSushi Function (/SU option) 
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13.8 Reflecting GateSushi settings into GA10
Reflect the changes made on the GateSushi screen into GA10 tags or groups.

1 On the menu, click Reflect to the GA10.
A	confirmation	dialog	box	appears.

2 Click OK.
The	contents	on	the	GateSushi	screen	is	reflected	into	GA10.

Settings that are reflected into GA10
Settings in GateSushi → Settings reflected into GA10

Main setting Setting Main setting Setting
Sushi group Group No. (N: 1 to 200) → Display group Group No. (N: 1 to 200)

Group name → Display group Group N The Sushi group name is 
reflected into GA10 as the 
group name of Group N.

Sushi EUI/Sensor tag EUI × Not reflected into GA10. This setting information is 
specific to GateSushi.Sensor tag ×

Sushi parameter Use On/Off → Tag n Tag collection On/Off
Tag recording On/Off

Tag → Tag n Tag comment
Span Decimal place → Tag n Decimal place
Span Min → Tag n Min  *1

→ Tag n assigned to display 
group N

Min scale *2

Span Max → Tag n Max *1
→ Tag n assigned to display 

group N
Max scale *2

Unit → Tag n Unit *1
Type/Value/Hysteresis of 
Alarm 1

× Not reflected into GA10. This setting information is 
specific to GateSushi.

Type/Value/Hysteresis of 
Alarm 2

× Not reflected into GA10. This setting information is 
specific to GateSushi.

Type/Value/Hysteresis of 
Alarm 3

× Not reflected into GA10. This setting information is 
specific to GateSushi.

Type/Value/Hysteresis of 
Alarm 4

× Not reflected into GA10. This setting information is 
specific to GateSushi.

Unit conversion × Not reflected into GA10. This setting information is 
specific to GateSushi.

Device channel → Tag n GateSushi channel  
(n: 00001 to 2000)

GA10 tag → Tag n Tag Index  
(n: 00001 to 2000)

*1 Loaded into GA10 as device settings. The Tag Setting page is hidden, but you can access it 
from the device information display area.

*2 This is the display scale on the GA10 monitor display. It does not affect data collection or alarm 
detection.

Chapter 13  GateSushi Function (/SU option) 
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13.9 Creating a Setting Template
You can save up to 5 setting templates with the parameters edited for each sensor type. 
You can reflect a saved template into the parameter setting table using Load template. 
•	If	you	are	using	the	setting	wizard	function,	you	must	save	the	setting	template	in	advance.

1 On the menu, click Setting template.
A Setting template dialog box appears. 

       

2 Enter the value for each setting, and click Save. 
The template is saved.

 For details on Sushi Sensor parameters, see “13.7 Configuring Sushi Sensor 
Parameters” on page 13-10 and “13.11 List of Sushi Sensor Parameters” on page 
13-18.

Item How to Specify Default value Description
Type Select from the list. Blank Select the sensor type.
Template No. Select from the list. 1 Select from 1 to 5. 
Template name Enter text. Blank This is the template name that is saved to the template 

number of the sensor type. The default value that is shown 
when the dialog appears is the template name of template 
number 1.

Copy Button Copies the selected row to the clipboard. 
You can paste the copied row into a text editor or Excel and 
edit it.

Paste Button Pastes the data on the clipboard into the selected row. 
You can copy and paste the data that you have edited in a 
text editor or Excel. 

Save Button Saves the template and closes the dialog box. 
Cancel Button Cancels the changes and closes the dialog box.

Chapter 13  GateSushi Function (/SU option) 
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13.10 Using the Setting Wizard Function (Batch Configuration)
Use the setting wizard function for the batch configuration of Sushi group name settings and 
Sushi group assignments. Follow the dialog wizard for the configuration.

(1) Start → (2) Group name 
settings

→ (3) Register the 
sensor

→ (4) Confirm of the 
settings

→ (5) Reflect the 
settings← ← ← ←

→:	Proceed	to	the	next	dialog	box	(Next	[xxx]	button)	(xxx	represents	the	dialog	box	name.)
←:	Return	to	the	previous	dialog	box	(Back	button)
If you click Cancel in each dialog box, the setting is not configured and the dialog box closes.

1 On the menu, click Setting wizard.
A Setting wizard: Start dialog box appears. 

  

2 Click Next [Group name settings].
A Setting wizard: Group name settings dialog box appears. Set the group name.

  

Item How to Specify Default value Description
Group No. Shows group numbers 1 to 200.
Group Name Enter text. Group N  

(N: 1 to 200)
You can set up to 20 characters.

Copy Button Copies the selected row to the clipboard. 
You can paste the copied row into a text editor or Excel and 
edit it.

Paste Button Pastes the data on the clipboard into the selected row. 
You can copy and paste the data that you have edited in a 
text editor or Excel.

Chapter 13  GateSushi Function (/SU option) 
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3 Click Next [Register the sensor].
A Setting wizard: Register the sensor dialog box appears. 
Register the sensor to a group by selecting either New sensor registration or Connection sensor 
registration for Operation type. 
You	must	configure	the	EUI.	The	Connection	sensor	registration	option	automatically	reflects	the	
EUI from connected sensors.

Item How to Specify Default value Description
Group No. Select from the list. 1 Shows group numbers 1 to 200. 
Quantity: 
Registered sensor

Cannot be 
configured

The number of Sushi Sensors that have been registered to 
this group number

Quantity: 
Parameter that 
selected On

Cannot be 
configured

The total number of parameters that selected On in the 
"setting template" for Sushi Sensors that have been 
registered to this group number

Tag Select from the list. Use the 
template

Specified as tag comment string in GA10 after the last time 
that settings are reflected in GA10. 
Select either "Use the template" or Replace with [Sensor tag 
+ Parameter name] format. 
•		Use	the	template:	Reflect	the	parameter	tags	of	the	setting	

template as they are. If you specify the same template 
number, the same parameter tag string is reflected for the 
same parameter even if the tag is from a different sensor. 

•		Replace	with	[Sensor	tag	+	Parameter	name]	format:	The	
parameter tags of the setting template are ignored and 
replaced with the parameter tags that use the sensor tag 
strings set in the current EUI when settings are reflected.

Item How to Specify Default value Description
Operation type Selection New sensor 

registration
Select either "New sensor registration" or "Connection 
sensor registration". 
•		New	sensor	registration:	Specify	the	sensor	type	and	

the quantity to add for unconnected sensors and register 
locally. 

•		Connection	sensor	registration:	Register	connected	
sensors as additional sensors. The EUI and sensor tags 
are automatically reflected from the connection information.

Chapter 13  GateSushi Function (/SU option) 
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(1) Registering a sensor using new sensor registration 
 Use this to specify the sensor type and the quantity to add for unconnected sensors and 

register locally.

 

Item How to Specify Default value Description
Operation type Selection New sensor registration
Sensor type Selection Vibration 

(XS770A)
Select Vibration (XS770A), Pressure (XS530), or 
Temperature (XS550).

Quantity Numerical 0 You can configure between 0 to 50.
Operation Execute 

registration button
If you click Execute registration, the system checks the 
Sushi Sensor quantity; if successful, a sensor line is added 
to the bottom of the Registered sensor table and the page is 
updated. 
For information about the Registered sensor table, see 
“Registered sensor” on page 13-17.

(2) Registering a sensor using connection sensor registration
 Use this to register connected sensors as additional sensors. The EUI and sensor tags 

are automatically reflected from the connection information.

 

Item How to Specify Default value Description
Operation type Selection Connection sensor registration
Operation Display connected 

sensors button
If you click Display connected sensors, a list of connected 
sensors appears in the dialog box. Select the sensor to add 
on the dialog box.

If you click Display connected sensors, the following dialog box appears.

  

Item How to Specify Default value Description
EUI Cannot be 

configured
Shows the EUI of the connected sensor.

Execute 
registration

Check box Off Specifies whether to register this Sushi Sensor to the group 
(On/Off). 

Sensor type Select from the list. - - - Shows the type of the connected sensor. You must select 
and configure this if the sensor type cannot be obtained.
- - -

Sensor tag Cannot be 
configured

Shows the sensor tag of this Sushi Sensor. 

OK Button If you click OK, the system checks the Sushi Sensor 
quantity; if successful, a sensor line is added to the bottom of 
the Registered sensor table and the page is updated. 
For information about the Registered sensor table, see 
“Registered sensor” on page 13-17. 

Cancel Button Cancels the changes and closes the dialog box.
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Registered sensor

 

Item How to Specify Default value Description
Sensor type Shows the sensor type that is registered to this group.
EUI Enter text. Blank or the 

EUI connected 
to the Sushi 
Sensor

Shows blank as the default value for new sensor registration, 
and the EUI connected to the Sushi Sensor for connection 
sensor registration. 
•		Up	to	23	alphanumeric	characters	(hexadecimal	in	the	

format of xx:xx:xx:xx:xx:xx:xx:xx, where xx is 00 to FF)
Sensor tag Enter text. SUggg_nnnn 

or tag name 
of the Sushi 
Sensor

•	SUggg_nnnn	for	new	sensor	registration
ggg: Number of the group that you want to register
nnnn:  Number of registered sensors right before registering 

this sensor + 1
•		"Tag	name	of	the	Sushi	Sensor"	for	connection	sensor	

registration (if Sushi Sensor has already been loaded) 
Same as new sensor registration if Sushi Sensor has not 
been loaded. (Follows Sushi Sensor specifications.)

Setting template Select from the list. 1 Select a template that matches the sensor type.
Operation Delete button Deletes the registered sensor of the selected row.

Note
•	 Even	if	the	connection	statuses	of	the	connected	sensors	are	updated	when	the	Setting	wizard:	

Connecting sensor dialog box is displayed, they are not reflected in the list of connected 
sensors in this dialog box. 

•	 If	the	following	applies,	an	error	message	appears	even	if	you	click	Next	and	you	cannot	
proceed to the next dialog box: 
•	 If	a	group	exceeds	the	upper	limit	of	Sushi	Sensor	parameters	that	can	be	turned	on	for	one	

group (50)
•	 The	EUI	of	the	registered	Sushi	Sensor	has	the	wrong	format	or	is	blank

4 Click Next [Confirm of the settings].
A Warning dialog box appears.

W2013
The	contents	of	the	setting	wizard	will	be	reflected	into	the	group.	Continue?

5 Click Reflect the settings.
An Information dialog box appears. 

M1029
Reflection	is	completed.

 Click OK to close the setting wizard.
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13.11 List of Sushi Sensor Parameters
13.11.1 Vibration Sensor (XA770A)
Category Parameter name GateSushi display name Explanation
Integrity information UpTime Up time Time elapsed since the power is turned on (max. 31 

years) (min)
BatteryLife Battery life Battery life (%)
RSSI RSSI RSSI (dBm)
PER Packet error ratio Rate of packet error that was detected by the device (%)
SNR S/N ratio Rate of signal/noise that was detected by the device (dB)

GPS information Longitude GPS longitude Longitude (plus for east; minus for west)
Latitude GPS latitude Latitude (plus for north; minus for south)

Data specific to the 
sensor Z axis & 
temperature (0x10)

Data_Status Z status Status of the measurement value
All 0: Good
Bit15: Acceleration error
Bit14: Velocity error
Bit13: Temperature error
Bit12: Over-the-range acceleration
Bit11: Over-the-range velocity
Bit10: Over-the-range temperature
Bit9: (Reserved)
Bit8: Simulation mode
Bit0 to 7: (Reserved)

PV_Acceleration Z acceleration Z axis acceleration peak value (m/s2)
PV_Velocity Z velocity Z axis velocity RMS value (mm/s)

Data specific to 
the sensor XYZ 
axis combination & 
temperature (0x11)

Data_Status XYZ status Status of the measurement value
All 0: Good
Bit15: Acceleration error
Bit14: Velocity error
Bit13: Temperature error
Bit12: Over-the-range acceleration
Bit11: Over-the-range velocity
Bit10: Over-the-range temperature
Bit9: (Reserved)
Bit8: Simulation mode
Bit0 to 7: (Reserved)

PV_Acceleration XYZ acceleration XYZ axis acceleration peak value (m/s2)
PV_Velocity XYZ velocity XYZ axis velocity RMS value (mm/s)

Data specific to the 
sensor
X axis (0x12)

Data_Status X status Status of the measurement value
All 0: Good
Bit15: Acceleration error
Bit14: Velocity error
Bit13: (Reserved)
Bit12: Over-the-range acceleration
Bit11: Over-the-range velocity
Bit9 to 10: (Reserved)
Bit8: Simulation mode
Bit0 to 7: (Reserved)

PV_Acceleration X acceleration X axis acceleration peak value (m/s2)
PV_Velocity X velocity X axis velocity RMS value (mm/s)

Data specific to the 
sensor
Y axis & temperature 
(0x13)

Data_Status  Y status Status of the measurement value
All 0: Good
Bit15: Acceleration error
Bit14: Velocity error
Bit13: (Reserved)
Bit12: Over-the-range acceleration
Bit11: Over-the-range velocity
Bit9 to 10: (Reserved)
Bit8: Simulation mode
Bit0 to 7: (Reserved)

PV_Acceleration Y acceleration Y axis acceleration peak value (m/s2)
PV_Velocity Y velocity Y axis velocity RMS value (mm/s)

Data specific to the 
sensor
Temperature

PV_Temperature Temperature Temperature measurement (°C) or (°F)
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13.11.2 Pressure Sensor (XS530)
Category Parameter name GateSushi display name Explanation
Integrity information UpTime Up time Time elapsed since the power is turned on (max. 31 

years) (min)
BatteryLife Battery life Battery life (%)
RSSI RSSI RSSI (dBm)
PER Packet error ratio Rate of packet error that was detected by the device (%)
SNR S/N ratio Rate of signal/noise that was detected by the device (dB)

Accurate GPS 
information

Longitude GPS longitude Longitude (plus for east; minus for west)
Latitude GPS latitude Latitude (plus for north; minus for south)
Accurate_Altitude GPS altitude Altitude

Data specific to the 
sensor Pressure (0x30)

Data_Status Pressure status Status of the measurement value
All 0: Good
Bit15: Pressure error
Bit13 to 14: (Reserved)
Bit12: Over-the-range pressure
Bit9 to 11: (Reserved)
Bit8: Simulation mode
Bit0 to 7: (Reserved)

PV_Pressure Pressure Pressure value
Data specific to the 
sensor
Temperature (0x31)

Data_Status Temperature status Status of the measurement value
All 0: Good
Bit15: Temperature error
Bit13 to 14: (Reserved)
Bit12: Over-the-range temperature
Bit9 to 11: (Reserved)
Bit8: Simulation mode
Bit0 to 7: (Reserved)

PV_Temperature Temperature Temperature measurement (°C) or (°F)
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13.11.3 Temperature Sensor (XS550)
Category Parameter name GateSushi display name Explanation
Integrity information UpTime Up time Time elapsed since the power is turned on (max. 31 

years) (min)
BatteryLife Battery life Battery life (%)
RSSI RSSI RSSI (dBm)
PER Packet error ratio Rate of packet error that was detected by the device (%)
SNR S/N ratio Rate of signal/noise that was detected by the device (dB)

Accurate GPS 
information

Longitude GPS longitude Longitude (plus for east; minus for west)
Latitude GPS latitude Latitude (plus for north; minus for south)
Accurate_Altitude GPS altitude Altitude

Data specific to the 
sensor Temperature 1 
(0x20)

Data_Status Temperature 1 status Status of the measurement value
All 0: Good
Bit15: Temperature error
Bit13 to 14: (Reserved)
Bit12: Over-the-range temperature
Bit9 to 11: (Reserved)
Bit8: Simulation mode
Bit0 to 7: (Reserved)

PV_Temperature Temperature 1 Temperature measurement (°C) or (°F)
Data specific to the 
sensor Temperature 2 
(0x21)

Data_Status Temperature 2 status Status of the measurement value
All 0: Good
Bit15: Temperature error
Bit13 to 14: (Reserved)
Bit12: Over-the-range temperature
Bit9 to 11: (Reserved)
Bit8: Simulation mode
Bit0 to 7: (Reserved)

PV_Temperature Temperature 2 Temperature measurement (°C) or (°F)

Note
Decimals are truncated for the minimum span, maximum span, and alarm values of the following 
parameters:
•	 Integrity	information:	Up	time
•	 Integrity	information:	RSSI
•	 Integrity	information:	Packet	error	ratio
•	 Every	sensor:	Status
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13.12 Deleting a Registered Sushi Sensor
This section explains the operation to delete a registered Sushi Sensor.

1 Place your cursor above the Sushi panel that you want to delete in the Sushi group 
registration area.

appears in the right-hand corner of the Sushi panel.

  

2 Click  
The corresponding Sushi Sensor is deleted from this Sushi group. 
If the same Sushi Sensor is registered with other groups, it will not be deleted from those groups.

13.13 Replacing a Registered Sushi Sensor
This section explains the operation to replace a registered Sushi Sensor if it is faulty or for 
other reasons. 
•	The	Sushi	Sensor	can	only	be	replaced	with	a	sensor	of	the	same	type.	
•	If	a	Sushi	Sensor	is	registered	with	multiple	groups,	you	only	need	to	do	this	operation	on	

one sensor to replace all.

Replacing with drag and drop

1 Drag and drop the replacement Sushi panel from the Connecting sensor area to the 
old Sushi panel in the Sushi group.

  

Drag and Drop

A	confirmation	dialog	box	appears.

2 Click OK.
All Sushi Sensors with the same EUI are replaced.

Replacing by overwriting the EUI

1 Double-click a Sushi panel in the Sushi group.
A Sushi parameter setting dialog box appears.

2 Overwrite the EUI, and click OK.
A	confirmation	dialog	box	appears.

3 Click OK.
All Sushi Sensors with the same EUI are replaced.

Note
Only the EUI is changed with this replacement operation. The same settings as before are retained 
for sensor tags and parameter settings.
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13.14 Setting Options
13.14.1 Options
You can change the unit of the collected temperature data from °C to °F in GateSushi.

 

Item How to Specify Default value Description
Temperature unit Selection °C Used to determine unit conversion for the temperature data 

when the GateSushi HTTP server receives the measurement 
data of Sushi Sensor. 
°C: Not changed
°F: Change to °F data

OK Button Click this to apply the settings.
Cancel Button Cancels the changes and closes the dialog box.

13.14.2 Changing the Port No.
You can change the port number of GateSushi.

  

Item How to Specify Default value Description
HTTP Enter text. 34591 *1 This is the HTTP communication port used for the following: 

•	LoRaWAN	gateway	and	GateSushi
Use this port for the URL when setting Node-RED. 
•	GateSushi	screen	and	GateSushi

GA10 Enter text. 34592 *1 This is the communication port used by GateSushi to "reflect 
settings into GA10". 
If GateSushi cannot connect to this port, settings cannot be 
reflected into GA10. 
Refer to “13.3 Registering GateSushi as a Device” on 
page 13-3.

OK Button Click this to reflect the port number. 
The GateSushi screen closes if the port number is changed. 

Cancel Button Cancels the changes and closes the dialog box.
*1:  If the default value is already used in the PC, change to an unused port. Before doing so, change the port number 

in the Register device dialog box first.
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Chapter 14  Troubleshooting
14.1 Messages That GA10 May Display
Messages may appear on the screen during operation. This section describes the messages and how to respond to 
them.

Messages
Code Message Description and Solution
M1001 OK to switch to detail setting mode? Unavailable to 

back to simple setting mode.
------

M1002 Do you want to start the monitoring all at once? ------

M1003 Do you want to stop the collecting all at once? ------

M1004 Do you want to start the recording all at once? ------

M1005 Do you want to stop the recording all at once? ------

M1006 Do you want to stop the recording? ------

M1007 Do you want to log out? ------

M1008 Do you want to enforce to be unlock? This is a message that asks the administrator to confirm the unlocking 
of the locked project.

M1009 Do you want the user(%s)'s password to be initialized? This is a message that asks the administrator to confirm the 
initialization of a user password. %s indicates the name of the user 
whose password will be initialized.

M1010 Trial version is time up, operation is prohibited. This message appears when a client accesses the server after the 
server trial period has expired.

M1011 Successed in Activation. This message indicates that the client license has been registered 
successfully.

M1012 Server is activated. Please restart server. After the server license registration is complete, the server needs to be 
restarted.

M1013 Option is added to server. Please restart server to 
enable option.

After an option is added to the server, the server needs to be restarted.

M1014 Is it OK to exit? This message asks whether you want to close the client.

M1015 OK to add new channels of new devices or changed 
devices in the tag settings? (The current tags 
information is not changed)

This message appears when a device is added to the Devices List or 
when a device channel is added. If you click OK, the changed device 
and channel information are reflected in the Tag Setting Page and 
Display Group Setting Page.

M1016 OK to update the selected device's channel 
information? (Updated tag information will appear in 
the tag settings screen.)

This message asks whether you want to update the device channel 
information. If you click OK, GA10 will access the selected device, 
retrieve its channel information, and reflect the information on the Tag 
Setting Page.

M1017 Update the selected tag information? Click OK to update information other than tags and tag comments.

M1018 Schedule re-executed successfully. The re-execution of the specified schedule is complete.

M1019 Print completed successfully. ------

M1020 Generating a report completed successfully. ------

M1021 OK to execute sorting of tags in order of the device 
number? (Resetting is needed in Math tags)

If you click OK, tags are sorted by device number. If you select 
[Cancel], tags are not sorted.

M1022 Reflect Tag No, Tag Comments by Device setting? If you click OK, the character strings of the tags and tag comments set 
in the device are retrieved. If you select Cancel, they are not retrieved.

M1023 Do you want to run the operation? A confirmation message. If you click OK, the operation is executed.

M1024 Mail sending is successful. ------

M1025 Some mail sending is successful. ------

M1026 Mail test is in process in other projects. Please try 
again after a while.

------

M1027 Do you want to save manually? ------

M1028 “The port number is already in use. Specify another 
port number.”

------

M1029 Reflection is completed. This message indicates that the settings have been reflected using the 
batch configuration function.

M1030 You cannot start multiple GateSushi Settings screens. You cannot start multiple GateSushi screens. 
Use the GateSushi screen that is open now.

M1031 Cannot be reflected when GA10 is monitoring. Some functions do not work in GateSushi when the project that you are 
obtaining data from is collecting data.
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Code Message Description and Solution
M1032 Please close the GA10 project screen. You must close the screen of the project that you are obtaining data 

from when "reflecting settings into GA10" from GateSushi.
M1033 Cannot learn again because the specified period is 

short. Please set that the time from the start of the 
period to the end of the period exceeds the following.  
[Monitor interval] x [Number of the tag in group] x 100

Set the learning period according to the navigation.

Warning Messages
Code Message Description and Solution
W2001 Do you want to delete this user(%s)? This message asks whether you want to delete the registered user. %s 

indicates the name of the user that will be deleted.
W2002 Do you want to delete this device(%s)? This message asks whether you want to delete the device from the 

Devices List on the Device Setting Page or the Registered Devices 
List. %s indicates the name of the device that will be deleted.

W2003 Do you want to delete this data file(%s)? This message asks whether you want to delete the data file from the 
Data files Page. %s indicates the name of the data file that will be 
deleted.

W2004 Do you want to delete the Project(%s)? This message asks whether you want to delete the project. %s 
indicates the name of the project that will be deleted.

W2005 The release number(%s)of handled meters is out of 
support.

The release number of the device is not supported. Thus, proper data 
collection cannot be guaranteed.  Consider updating the firmware or 
using a supported device. 
For the supported models and versions, See the General 
Specifications (GS 04L65B01-01EN).

W2006 Total number of channels of registered devices 
exceeded the supported range.

This message notifies that when you are registering a device to the 
device list or updating the device information, the total number of 
channels of registered devices exceeds the number of tags that can be 
supported. Click OK to proceed with the operation.

W2007 If changed to Device time, math tags will be unavailable. This message appears when you try to change Data time to Device time.
The function works when PC time is selected. Clicking OK will change 
the setting to Device time. Clicking Cancel will discard the change.

W2008 Option configuration of project does not have 
compatibility with the server. It will be converted to 
match the options configuration of the server during 
importing. Continue importing?

This message appears when you try to import a project that was 
created on a GA10 with different number of channels or options. (The 
importing GA10 has less channels or does not have the functions.) 
If you click OK, import is executed to the greatest extent possible. 
If you click Cancel, importing does not take place. For details, see  
“Importing a project created on a GA10 with a different system 
configuration (GA10 version R2.02.xx or later)” on page 3-9.

W2009 Failed to add some of new channels. This message appears when new devices or channels on the Devices 
List fail to be assigned completely to the Tag Setting Page. If you click 
OK, you can resume operation.

W2010 Do you want to delete report/print history (%s) ? Confirms whether print logs will be deleted on the Report/Print History 
tab of the report/print function (/RP option). %s indicates the name of 
the schedule that will be deleted.

W2011 Do you want to delete all unused devices? Select whether to delete unused devices.

W2012 If changed to Device time, math tags, integration 
function and anomaly detection will be unavailable.

Same as W2007. Some functions become unavailable if the setting is 
changed to "Device time".

W2013 Change the tag / group settings of GA10. Are you 
sure?
Auxiliary Message
Please change the Settings Mode of the GA10 to 
[Detail Settings], if it is set [Simple Settings].

A confirmation for GateSushi when reflecting the settings in GateSushi 
into the tag or group settings of the project that you are obtaining data 
from.

W2014 Update group settings to setting wizard A confirmation when creating and reflecting a Sushi group using the 
GateSushi setting wizard.

W2015 Replace the sensor. Are you sure?
Auxiliary message
Applies to the same sensor in all groups.

It is displayed when replacing a Sushi from a connected sensor to a 
registered sensor on the GateSushi screen.

W2016 If changed to Device time, anomaly detection will be 
unavailable.

Reflect the device tag that changed in the tags ?

W2017 If changed to Device time, math tags and anomaly 
detection will be unavailable.

Same as W2007. Some functions become unavailable if the setting is 
changed to "Device time".

W2018 Reflect the device tag that changed in the tags ? If you change the sensor tag in the parameter setting dialog box of a 
sensor in GateSushi and if the beginning of the "tag" string for each 
parameter includes the old sensor tag, you can replace that part of the 
string with the new sensor tag. 
If you click OK, the sensor tag part in the beginning of "tag" strings are 
replaced with the new sensor tag. If you click Cancel, the sensor tags 
are not replaced.
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Chapter 14  Troubleshooting 

Error Messages
Code Message Description and Solution

E3001 Unable to connect to the specified server.

Check whether the DLGServer server program is running as a service. 
How to check: page 2-10  2.7.1 Checking Whether the Server Is 
Running
Check for problems in the communication path to the server and IP 
address and port number settings.
If you cannot connect to the server, stop the server firewall, or register 
DFMServer.exe and DLGServer.exe as exceptions in the server firewall 
configuration.

E3002 Login failed. Please confirm the user name or the 
password.

GA10 is connected to the server, but the user information for logging 
in is not correct. Check the user name and password that you have 
entered.

E3003 Connected clients has reached maximum, you can not 
log in. Wait for the other client to log out.

E3004 Unable to connect to the server. Check for problems in the communication path to the server.

E3005 The user name already exists, the user can not be 
registed.

A user with the same name is already registered. Check the user 
name, and register with a different name.

E3006 The password is incorrect. The password that you entered for changing the password is incorrect. 
Check the current password, and re-enter it.

E3007 Please enter at least four characters for the password. Enter 4 to 30 characters for the password.

E3008 The new password and the comfirmed password does 
not match.

Enter the new password and confirmation password so that they 
match.

E3009 You can not delete the logged user. Delete the user after the relevant user logs out.

E3010 Users to change is logged into the server. The basic 
information can not be changed. Modify the basic information after the relevant user logs out.

E3011 User to be initialized is logged in to the server, user 
can not be initialized. Initialize the user after the relevant user logs out.

E3012 The maximum number of logins has been reached, the 
user can not log in. Delete registered users first, and then register additional users.

E3013 Since the Project name you entered already exists, the 
project can not be created.

A project with the same name is already registered. Check the project 
name, and register with a different name.

E3014 Since the Project name you entered already exists, 
you can not change it.

A project with the same name is already being used. Check the project 
name, and change to a different name.

E3015 The Project which is opening, can not be deleted. Delete the project after closing the relevant project.

E3016 The Project which is running, can not be deleted. Delete the project after stopping the relevant project.

E3017 The maximum number of registered devices has been 
reached ,the device cannot be registered.

Delete any of the devices registered in the server first, and then 
register the new device.

E3018 The equipment in use can not to be removed.

The device that you want to delete is being used in a project. Check 
that the device is not being used in another project. Delete the device 
from the Devices List on the Device Setting Page of other projects, and 
then delete the device.

E3019 Original owner is opening projects, you cannot change 
the owner.

When the administrator tried to change the owner of a project, the 
current owner had the project opened. Change the owner after the 
current owner closes the project.

E3020 Server can not receive device information.

• Check the information for accessing the device and the 
communication path between the server and device. 

• Device with the channel set to zero cannot be registered.
Reconfigure the connected devices to detect the I/O modules, 
turn on the communication channel, or perform other appropriate 
measures. (To register temporarily, use offline registration.)

• To register GateWT for GA10 as a connection target in the GA10 
Device List and then  start it, right-click and choose Run as 
administrator.

E3021 Fail to create record folder. The specified drive does not exist. Change the data file save 
destination folder.

E3022 Failed to start Universal Viewer. Check whether Universal Viewer is installed in the PC.
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Code Message Description and Solution

E3023 An error occurred while reading the file. Failed to load the file when importing a project or tag information. 
Check that the file for importing is correct.

E3024 An error occurred while writing the file. Check that the export destination folder is not set to read-only and that 
there is enough free disk space.

E3025 User manual does not excit in the specified  location. Place the PDF manuals in the client installation folder.

E3026 Failed to start Adobe Reader. Check whether Adobe Reader is installed and the version.

E3027 Simultaneous running projects has reached the 
maximum number, failed to start monitoring.

The number of running projects in the server has reached the 
maximum number. Stop data collection in other projects.

E3028 Because the maximum concurrent number of 
connected devices is reached, collecting cannot start.

Data collection cannot be started because the maximum device 
connections will be exceeded. Stop data collection in other projects or 
change the data collection device.

E3029 Because the maximum device number that can be 
registered is reached, the  Project can not be created.

Delete any of the registered projects first, and then register the new 
project.

E3030 Because the maximum number of open projects is 
reached, the project cannot be opened.

The number of projects that the client has opened has reached the 
maximum number. Close any of the opened projects.

E3031 Failed to delete data file. Another client may be using the data file that you want to delete.

E3032 Failed to open data files. Update the information on the Data files Page, and check that the 
relevant data file exists.

E3033 Fail to launch web browser. A Web browser may not be installed.

E3034 Operation failed because there is no right to access  
Project. Ask the project owner to grant project access privileges.

E3035 Operation failed because the target user does not 
exist.

The user may already have been deleted. Update the information on 
the User Management Page, and check whether the user exists.

E3036 Fail to import project because registered devices reach 
the maximum number. Delete unneeded devices from the Registered Devices List.

E3037 Project is closed, because  Project lock status is 
released forcibly. To use the project, open it again.

E3038 Operation failed because the project is locked by 
another user. Use the project after the project is unlocked.

E3039 Specified new owner does not exist, you can not 
change the owner.

The user may already have been deleted. Set the new owner to an 
existing user.

E3040 Operation failed because  Project is deleted. The project may already have been deleted. Update the information on 
the Project List Page, and check that the project exists.

E3041 Serial no is invalid. Activation failed. Check the license number, and enter it correctly.

E3042 Server has not been activated. Adding option to 
software failed. Register the server license first, and then add options.

E3043 Tag upgrade option's serial no is invalid. Fail to add 
option's serial no.

Adding the option would cause the number of tags to exceed the 
maximum recording tags in the project. In the server information dialog 
box, check the current number of tags, and check whether the option 
that you tried to add is appropriate.

E3044 Part of the data files can not be deleted. Some of the data files that you tried to delete could not be deleted. 
They may be in use.

E3045 Part of the data files can not be opened.
Some of the data files that you tried to open could not be opened. 
Update the information on the Data files Page, and check that the data 
files exist.

E3046
Failed in registration. The administrator authority is 
required. Please restart as an administrator or run as 
administrator and restart.

Log on again as a Windows administrator. Or, choose Run as 
administrator when starting Data Logging Software. (In Windows 7, 
right-click the software icon, and click Run as administrator.)

E3047 Insufficient memory available to the OS. Operation 
failed.

Try the following:
•	Stop	other	running	programs.
•	Reduce	the	number	of	simultaneously	running	projects.
•	Increase	the	PC	RAM.
•	If	you	are	using	a	32	bit	edition,	try	a	64	bit	edition.

E3048
Since the number of tags in the imported project 
configuration information exceeded the number of tags 
supported by the current server,failed to import.

The number of tags in the project that you are trying to import exceeds 
the number of tags handled by the current server. Consider increasing 
the number of tags handled by the server.
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Code Message Description and Solution

E3049 Failed to operate some projects or all project at once.

If Start Monitoring Simultaneously cannot be executed, it could be any 
of the following reasons.
•		The	number	of	simultaneously	running	projects	or	simultaneously	

connected devices exceeds the limit.
•	There	is	not	enough	available	memory	on	Windows.	
If Start Recording Simultaneously cannot be executed, it could be any 
of the following reasons in addition to the reasons listed above.
•	The	data	save	destination	folder	failed	to	be	created.
Close projects that do not require data collection. To start recording, 
change the data file save destination folder.

E3050 Insufficient memory available to the OS. Project will 
close. 

Try the following:
•	Stop	other	running	programs.
•	Reduce	the	number	of	simultaneously	running	projects.
•	Increase	the	PC	RAM.
•	If	you	are	using	a	32	bit	edition,	try	a	64	bit	edition.

E3051 Fail to start monitoring because the necessary setting 
is not correct.

There is an error in the information that is used during data collection. 
Check for errors in Modbus device definition files.

E3052 Operation failed because device has been deleted. Update the device information on the Registered Devices List.

E3053 Searching is not allowed because auto-search in 
progress.

Another client is searching devices with different search conditions. 
Wait for the search operation to complete, and try searching again.

E3054 Failed to update the information of some specified tags 
or all tags. 

Check the communication status of the device used by the tag to be 
updated.

E3055 Cannot write to specified recording folder.

Below are possible reasons. Check the condition of the save 
destination.
•	There	is	not	enough	free	space	on	the	data	save	destination	drive.
•		If	the	data	save	destination	is	an	external	storage	device,	the	device	

is not inserted properly or is removed.
•	The	data	save	destination	is	set	to	read-only.
•	The	data	save	destination	drive	is	broken.
•		A	location	(folder)	that	is	restricted	by	the	operating	system	of	the	

server is specified.

E3056 Connecting this version's server is not available.
Make sure that the version of the added client is the same as the 
server version. Download the latest version of the software from the 
following URL: www.smartdacplus.com/software/en/

E3057 Failed to install the certificate. The certificate cannot be stored in the server. Check the certificate 
format, file size, free space in the save destination folder, and write 
privileges.

E3059 Failed to register the template file. The template file cannot be stored in the server.
Check the free space in the save destination folder and write privileges.

E3060 Failed to download the template file. The template file cannot be downloaded to the specified folder.
Check the free space in the specified folder and write privileges.

E3061 Failed to delete the template file. The template file cannot be deleted. Check write privileges of the 
save destination folder. Check that the file is not opened with another 
application.

E3062 Failed to delete the schedule. A schedule that is in the middle of monitoring or recording cannot be 
deleted.

E3063 Excel is not installed. Install Excel.

E3064 Can not open the report file. Check that the report file is in the report folder.

E3065 Failed to generate a report file. Check the disk space of the server’s report file save destination and 
folder’s write privileges. Check the presence of the data file.

E3066 Failed to print. Check the presence of the data file.

E3067 Failed to issue a certificate signing request. Check the presence of the data file. Check that the file name, destination 
folder, and other settings are correct.

E3068 The option is already enabled. The option corresponding to the license number you entered is already 
enabled. You can check enabled options by clicking Server Information 
or Input Server License (license input screen) on the server’s Help menu.

E3069 Failed to start the OPC-UA server. The port number is 
already in use.

There may be a port number collision. Check that the OPC-UA server 
port number is not being used by another process.

E3070 The server certificate is invalid. The private key and certificate are inconsistent.

Chapter 14  Troubleshooting 
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Code Message Description and Solution
E3071 Can not import the project. It contains unavailable 

function.
There is not enough number of channels (tags) or an option is not 
available for importing the relevant project. The number of channels 
(tags) or optionson the server do not meet the configuration 
requirements of the project that you are trying to import.

E3072 Failed to generate a self-signed certificate. The private key does not exist, or you do not have write privileges to 
the folder.

E3073 Failed to paste project. The project cannot be pasted because there is not enough disk space 
on the server.

E3074 Failed to register the custom display file. Custom display setting file cannot be registered. Check the disk space 
of the server and folder’s write privileges.

E3075 Failed to register the alarm sound file. Check the disk space of the server’s alarm sound file save destination 
and folder’s write privileges.

E3076 Failed to download alarm sound file. Check the disk space and write privileges of the client’s specified 
folder.

E3077 Failed to delete alarm sound file. Check the write privileges of the alarm sound file storage folder of the 
server, and check that the file is not opened by another application.

E3078 Failed to send mail. Check that the SMTP server, authentication method, and sender 
settings are correct.

E3079 Failed to execute the GateSushi. The GateSushi server is not running. In the "Operation", run "Restart 
GateSushi".

E3080 EUI has not been entered. The EUI in the Sushi parameter setting dialog box on the GateSushi 
screen is blank. Enter the EUI.

E3081 The sensor cannot be registered because the 
maximum number that can be registered has been 
reached.

You exceeded the upper limit when you tried to register Sushi groups 
on the GateSushi screen. 
Make sure that you do not exceed the following quantity limits: 
•	Up	to	50	sensors	for	1	group
•	Up	to	50	sensor	parameters	can	be	turned	on	for	1	group
•	The	number	of	sensor	parameters	that	can	be	turned	on	for	all	of	
GateSushi is limited to the maximum number of GA10 server tags

E3082 EUI is duplicated. There are duplicate EUIs for the Sushi Sensor that you are trying to 
register on the GateSushi screen. Assign a unique EUI.

E3083 Password is incorrect. The replacement sensor and the sensor type do not match when 
replacing sensors on the GateSushi screen.

E3084 Enter the EUI in the format **-**-**-**-**-**-**-** . (**:00-
FF)

The EUI format is wrong when registering a new sensor on the 
GateSushi screen. Re-enter the EUI in the correct format.

E3085 The sensor cannot be registered because the 
registered EUI and sensor type are different.

You are trying to register a sensor, which has the same EUI as a 
registered sensor but with a different sensor type, in a different Sushi 
group on the GateSushi screen. 
Make sure that the EUI and the sensor type match the registered 
sensor.

E3086 Please enter more than a character. In the connection settings of the GateSushi screen, the authentication 
is turned on, but the user name or password is blank. Set a user name 
and password.

E3087 Duplicated port number. There are duplicate port numbers in the port number settings of the 
GateSushi screen. Assign a unique port number.

E3088 Specify the sensor type. In the "Setting wizard: Register the sensor" dialog box of the GateSushi 
screen, you did not specify the sensor type when trying to register a 
sensor using the "connection sensor registration" option. Specify a 
sensor type.

E3089 Permission denied. Someone tried to start the GateSushi screen with the access 
permission of an operator or on the monitor and configure various 
settings. Log in as the owner or manager.

E3090 Failed to set any settings.
Auxiliary Message 1
Cannot be executed when GA10 is monitoring.
Auxiliary Message 2
Please close the GA10 project screen.

A message displayed when settings failed to be "reflected into GA10" 
on the GateSushi screen. The auxiliary message indicates the reason 
for the failure.

E3091 The parameter cannot be changed ON because the 
maximum number that can be registered has been 
reached.

The number of parameters that can be turned on in the sensor 
parameter settings of GateSushi is limited to the maximum number of 
measurement tags of the GA10 that you are obtaining data from.

Chapter 14  Troubleshooting 



14-7IM 04L65B01-01EN

Troubleshooting

1

2

3

4

5

6

7

8

9

10

11

12

13

14

App

Index

14.2 Frequently Asked Questions (FAQ)

Q1 Can GA10 and GA10CL be installed and run in the same PC?
A1
GA10 and GA10CL cannot be installed on the same PC.

Q2 Is there a way to back up the recording data files automatically?
A2
You can use the mail transmission feature to send generated data files as email 
attachments. You can store the data files as back up in the device receiving the email 
messages.

Q3 The communication between the server and the data acquisition 
device was disconnected. How does the server behave when 
communication is restored?
A3
Resuming data collection and recording
The server will retry to connect approximately every 30 seconds. When reconnection is 
successful, the server resumes data collection and recording.

Recording data
The way that the server handles recording data when communication is restored varies 
depending on whether data is being collected in PC time or device time.
•	 If	data	is	being	collected	using	PC	time

 The data during which communication was not possible will not be recorded.
•	 If	data	is	being	collected	using	device	time

 After communication is restored, the server prioritizes the collection of data that can be 
gathered in real time through communication. Then, the server collects data that could 
not be collected from devices and fills the missing data in the recorded data files. This 
function is called backfill. Backfill only works when the necessary conditions are met. If 
the conditions are not met, the data during which communication was not possible will 
not be recorded. See Q4.

Q4 How does backfill work?
A4
When a communication error occurs between a server and device, data dropout occurs in 
the data file that the server is recording. Backfill is a function that fills the dropped data in the 
recording file by retrieving the missing data from the device after the system recovers. Data 
is retrieved automatically from the device when the operating conditions are met.

When the communication interference is eliminated, the backfill function operates 
automatically. The restored data is saved as a new file, and you can view it on the Data files 
Page. Marks that indicate that backfill has been performed are added to the beginning and 
end of the restored section of the data.

In the case of a short communication interference,* data loss may be restored even when 
the above settings are not specified. In such a case, GA10 does not create a new file but 
writes directly to the recording file.

* The length of interruption time that makes this operation possible varies depending on the 
connected device.
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Backfill Operation Conditions
 On the GA10 side

•	 Applicable data: Binary data (Excel data is not included)
•	 Data time is set to Device time.

 On the connected device side
•	 Applicable devices: GX10, GX20, GP10, GP20, GM10, DX1000, DX2000, 

DX1000N, DX1000T, DX2000T, FX1000, FW1000, MV1000, MV2000
•	 Device’s internal memory contains the event data file corresponding to the data 

loss location.
•	 The scan interval of the device is the same as the recording interval of the event 

data.
•	 FTP transferring of files is enabled.(FTP server function: ON, Port number: 21)
•	 The multi batch function is not in use. If the multi batch function is enabled, 

backfilling is not performed.
•	 The time zone and daylight saving (DST) settings on the main unit are the same 

as those on the PC.

 On the GX/GP/GM with Advanced Security function (/AS option) side
•	 If the advanced security function is disabled, backfill operates.
•	 If enabled, backfill operates when Communication in Security basic settings is set 

to Off.
•	 If Communication in Security basic settings is set to Login, backfill operates only 

when a Monitor user is connected.

 On the DXAdvanced series with Advanced Security function (/AS option)
•	 Backfill operates regardless of whether the advanced security function is enabled 

or disabled.

 Handling of files collected by backfilling
 Files collected by backfilling are the same as normal data files except for the point 

given below.
•	 The file division conditions specified on the recording setting page do not apply. 

Therefore, the files may become larger than normal data files.

 Other information
•	 Backfill is not performed if a communication error or other error had occurred at 

the start of recording.
•	 If a data backfill operation cannot start due to a device access failure, because an 

event data file is being created, or due to some other reason, GA10 will access the 
device every hour.

•	 If the server stops during a backfill operation, the operation will stop. Even if the 
server is restarted, the previous backfill operation will not be performed.

•	 If any of the following settings on the device is changed after starting data 
collection, backfill will not be performed.

   Acquisition interval, time, channel on/off, decimal place, unit, span (scale), alarm 
on/off, alarm type, and alarm value

•	 If the advanced security function (/AS) option is enabled on the GX/GP/GM, 
backfill operation is not performed for user levels other than monitor.
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Q5 The server stopped or the server PC shut down. How does the server 
operate after it restarts?
A5
Server recovery
The server retains the most recent status information just in case the host PC shuts down. 
When the PC restarts, the server recovers the operation based on the status information.

Resuming data collection and recording
The server resumes data collection and recording after it restarts unless the user had 
manually stopped the server or shut down the host PC.
Depending on the power-off condition, monitoring and recording after restarting will behave 
as shown in the following table.

Power-off 
Condition

Description Monitoring/Recording 
after Restart

File Division 
Display Division

Backfill 
Operation

Sudden power-off Unpredictable shutdown 
such as a power failure or PC 
power cord disconnection

Resume Divide No operation

Normal restart Shutdown by a user, restart 
due to Windows updating, and 
the like

Resume (version R2.02.xx 
and later)
Resuming is not possible 
on older versions of 
GA10.

Divide No operation

Monitoring and recording are not affected by logging off of the PC.

When the report/print function (/RP option) is in use
Auto print schedules that have not been completed due to a PC shutdown are executed 
again when the server recovers. However, output results of auto print executed in this way 
may have up to 10 minutes of data missing before the shutdown.

Q6 A communication error occurred between the client and server. Will 
data collection continue?
A6
Because data collection is performed between the server and data collection devices, the 
operation continues even when a communication error occurs between the client PC and 
server PC.
When a communication error occurs between the client PC and server PC, the client logs 
out from the server. The project that was open is closed. In this situation, if data collection 
was in progress and the project’s Keep Lock State was set to ON, the project will remain 
locked.
To control the project before the communication recovers, perform either of the procedures 
below from a client on another PC using the same project.
•	 Open	the	project	using	the	same	user.
•	 Log	in	as	an	administrator.	On	the	Project menu, click Unlock Project Forcibly to unlock 

the project.
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Q7 Unable to control the project. Why?
A7
Below are possible reasons.
•	 The	user	is	not	assigned	privileges	to	control	the	project.	→	Open	the	project	using	a	user	

who has privileges to control the project, such as Owner, Manager, or Operator.
•	 The	project	is	locked.	→	If	an	owner,	manager,	or	operator	user	is	logged	in,	the	project	

is locked. Other users can only monitor the project. Wait until the other user using the 
project closes it.

•	 The	project	is	locked.	→	If	data	collection	is	in	progress	and	the	project’s	Keep	Lock	
State is set to ON, the project remains locked even when an owner, manager, or operator 
closes the project. To control the project, perform either of the following procedures.

•	 Ask the user who locked the project to unlock the project.
•	 Clear the Keep Lock state.

Q8 I forgot the user password. What do I do?
A8
If the administrator password is lost, there is no recovery method. Contact your nearest 
YOKOGAWA dealer.
If a user password is lost, the administrator can initialize the password. Then, the user can 
log in with the initialized password (blank) and set a new password.

Q9 The device data and the data collected and recorded by GA10 are not 
synchronized. Why?
A9
Data collected using Device time is recorded as-is by the software. In this situation, the 
device data and the collected and recorded data are synchronized.
However, data collected using PC time are timestamped with the PC time and the values are 
adjusted accordingly. In this situation, the device data and the collected and recorded data 
based on PC time may not be synchronized.

Q10 Can the recorded data be printed?
A10
Data files can be printed using Universal Viewer. Universal Viewer is supplied with this 
software and installed along with this software.
You can also print a specified range of data at the specified time by adding the /RP option. :

 5.1 Configuring Auto Print
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Q11 Device settings were changed. At what point are the changes applied 
to data collection?
A11
Changes to devices before data collection is started
This software retrieves device information when the device is registered to the Device List. If 
this information is different from the actual device information at the start of data collection, 
the software will collect data but will handle it as invalid data.
Check the following settings and match them.

 Channel data type, unit, span, decimal place, alarm type, and alarm value
You can use Update Setting on the Device List to update the settings.

Changes to devices during data collection and recording
If you change the device settings during data collection and recording, the changes will not 
be reflected to the software. Stop the data collection, apply the setting changes using either 
of the methods below, and restart the data collection.
•	 Execute Update Setting of the devices in the devices List.
•	 Register the device again.

However, if data is being collected using Device time and you change the device’s 
acquisition interval, the software will reset the entire monitor data, restart monitoring, and 
stop recording.

Do not change the time on the device after starting data collection and recording, because 
doing so will cause adverse effects on the monitor screen and recorded data.

When the connected device is a SMARTDAC+ series (GX/GP or GM) device and the GA10 
version is R2.02.xx or later, alarm information changed on devices during data collection is 
reflected on the monitor. Changes in the alarm on/off states and types are reflected on the 
monitor. Note that changes in alarm types are not reflected in the alarm list of the recording 
file.

Q12 What is the difference between setting the Data time to PC time and 
setting the Data time to Device time?
A12
For information on the different data collection conditions, see also Setting Data Collection 
Conditions on page 3-35.
The following table summarizes the major differences. For a detailed explanation, see the 
following pages.

Differences
Mode Description Backfill Collection and 

Record Interval
Display

Saved Data Files
Trend Monitor Alarm Overview

PC time
Time on the 
server PC

No Select from 
available 
options

No display limitations because all 
the data can be displayed on the 
same time axis.

Data can be 
saved to a single 
file.

Device time

Time on the 
device

Yes
(fills 
dropped 
data using 
data on the 
device)

The interval on 
each device is 
used, so it is 
not possible to 
specify a single 
interval.

If there are 
multiple devices 
with different 
times or scan 
intervals, 
Monitor Sets 
are subdivided 
to display each 
combination of 
device and scan 
interval..

The page is 
subdivided and 
a list is displayed 
for each device.

Files are divided 
by a combination 
of device and 
scan interval.
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What is PC time?
PC time is the time information that the server PC uses. In PC time mode, the server 
attaches PC timestamps on the data collected from devices. This data is displayed on the 
Monitor Page and saved in recording files.
•	 Data	collected	using	PC	time	will	not	necessarily	be	synchronized	to	the	data	of	the	

corresponding devices.
  Q9

•	 The	timestamps	attached	to	data	in	PC	time	mode	are	determined	so	that	data	collection	
would always occur at midnight (00:00:00).

•	 The	data	collection	interval	and	record	interval	are	specified	on	GA10.
•	 The	data	of	all	tags	is	saved	to	the	same	file.

What is Device time?
Device time is the time information that the data collection device uses. In Device time 
mode, the server collects and records data at the data acquisition intervals of devices. If 
there are multiple acquisition intervals in a single device, data is collected and recorded at 
each acquisition interval. Device data and collected data are synchronized (the values and 
timestamps match).

•	 Data	collection	and	recording
•	 Data	is	collected	separately	for	each	device	and	for	each	data	collection	interval.
•	 Data	is	collected	and	recorded	at	the	devices’	data	acquisition	intervals.	You	cannot	

specify the data collection interval or record interval on GA10.
•	 Data	is	saved	to	separate	files	for	each	device	and	for	each	data	acquisition	interval.

 

Tag for device A, 
collection interval A1

Device time

Collection 
intervals 
A1 and A2

Device A Device B

Collection
interval
B1

Tags for device A and device BPC time

Server

Tag for device A, 
collection interval A2

Tag for device B, 
collection interval B1

Data
file

Data
file

Data
file

Data
file

 The device number, device name, and device acquisition interval are included in the 
names of data files. Below is the file name format when date and time are included.
FileName-DeviceNo-DeviceName-Interval-YYYYMMDDhhmmss.ext 
FileName: The file name string specified by the user 
DeviceNo: Device number on the Device Setting Page 
DeviceName: Device name on the Device Setting Page 
Interval: The acquisition interval of each device
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•	 Monitor
 The trend monitor displays data based on a single time axis. If there are multiple devices, 

the Monitor Set will be divided and waveforms in the display group will be displayed in 
windows divided at the interval level. Only up to four divided windows can be displayed. 
Anything in excess will not be displayed.

 A similar behavior will also occur in alarm lists. The page will be divided, and the lists will 
be displayed separately at the device level.

•	 Filling	data	dropouts
 If data collection is set to Device time mode, the backfill function can be used.
 What is the backfill function? Q4

•	 Mail	transmission	function
 In the email transmission based on alarm occurrence and release, the software monitors 

relevant tags for each device and for each data collection interval to transmit email.
 In the email transmission based on the specified period, the software sends email for 

each device and for each data collection interval.
 In the email transmission based on the specified duration, the software calculates the 

duration and sends email for each device and for each data collection interval.
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Appendix 1 Creating Report Templates

Creating Report Templates for Report Files in Excel Format

To create a report template, enter keywords and text in the cells of an Excel file. Keywords 
specify the type of data that will be entered into a cell. Text are output as they are in reports. 
Save the report templates that you create in Excel format (.xlsx extension) or Excel macro 
format (.xlsm extension).

  Function: See page App-1 in section 1.12, “Using the Report Template Function (/MT 
option)”.

  Setup: See page App-1 in section 1.11, “Configuring the Report Function (/MT option)”.
  Loading and saving report templates: See page App-1 in section 1.12.5, “Loading and 
Saving Report Template Files”.

Template Example

Channel number $Ch(R001)$ $Ch(R002)$
Name Tank 1 temperature Tank 1 pressure
Unit $Unit(R001)$ $Unit(R002)$
$ReportDataTime(Hour)$ $ReportDataInst(Hour, R001)$ $ReportDataInst(Hour, R002)$
$Repeat$ $Repeat$ $Repeat$
$Repeat$ $Repeat$ $Repeat$

Report Output Example

Channel number TIC-001 PIC-002
Name Tank 1 temperature Tank 1 pressure
Unit °C kPa
2012/12/01  00:00:00 76.5 45.6
2012/12/01  01:00:00 78.9 56.7
2012/12/01  02:00:00 77.7 50.8

Keyword Format
Keywords are written by themselves or with parameters.
$ Keyword(parameter)$ Example: $ReportDataSum(Hour,R001,00,23)$

Basic Rules
•	 The	dollar	sign	on	the	left	indicates	the	start	of	a	keyword,	and	the	dollar	sign	on	the	right	

indicates the end of a keyword.
•	 You	can	only	write	keywords	using	letters	of	the	alphabet,	dollar	signs,	parentheses,	

commas, and spaces. You can put a space after an opening parenthesis, before and after 
a comma, and before a closing parenthesis. Keywords are not case sensitive. You cannot 
use a dollar sign inside of a keyword.

•	 The	maximum	length	of	a	keyword,	including	spaces,	is	100	characters.

Parameter Rules
•	 Parameters	are	enclosed	in	parentheses.
•	 Multiple	parameters	(up	to	4)	are	separated	by	commas.
•	 Examples	of	how	parameters	can	be	omitted	are	shown	below.
$ReportDataSum(Hour, R001, ,23)$ The third parameter has been omitted.
$ReportDataSum(Hour, R001, 01, )$ or The fourth parameter has been omitted.
$ReportDataSum(Hour, R001, 01)$

Appendix
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Excel Format Rules
•	 Set	the	data	format	by	setting	the	cell	format.
•	 Set	the	proper	format	for	each	keyword’s	cell	in	the	cell’s	Number	properties.
•	 The	keyword	in	a	cell	is	only	valid	when	the	keyword	name	and	parameters	are	all	in	the	

same format. When a keyword’s font size or some other property is not consistent, it is 
invalid.

$ReportDataSum(Hour, R001, 00, 23)$ The font size of “Hour” is different, so the 
keyword is invalid.

•	 If	a	single	cell	contains	text	and	a	keyword,	only	the	format	of	the	keyword	has	to	be	
consistent. The format of the text can be different.

Date and time: $DateTime$ The format of the keyword is consistent, so it 
is valid.

Limitations on Report Types and Template Types
If you violate the rules illustrated below, data will not be output.

Keyword
Parameter

Template Type

Report Kind Hour Day Week Month Hour + Day Day + 
Week

Day + 
Month

Batch Day
Custom

Hour  
Day    
Week  
Month  
Batch 
Custom 
Free 

Limitation on Report Types and Parameter Omissions
If you violate the rules illustrated below, it will be considered a keyword format error.
The keyword will not be converted and will remain as is.
Report Kind Start date and time End date and time Start number End number
Hour Start time (hour) End time (hour) — —
Day Start day End day — —
Week — — — —
Month — — — —
Batch Relative start time (minute) Relative end time (minute) Start number End number
Custom Start time (hour:minute) End time (hour:minute) — —
Free — — — —
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Keyword Definitions
For examples and details, see “Report Template Examples”.

•	 System	Keywords
Keyword Meaning Display Format
Time Current time Time4

Date Current date Date4

DateTime Current date and time
DateTimeString Current date and time Character string
Serial Serial number
Ch Channel number1

Tag Tag string1

ChId Tag number1

Unit Unit1
FileName File name
Model Model
MeasCh Number of measurement channels Number
MathCh Number of math channels Number
SampleInterval Sample interval Character string
CommentTitle File comment title2

Range: 1 to 8
CommentDetail File comment details2

Range: 1 to 8
PrintGroup Group number
PrintGroup(p1) Group number of the specified graph*5

PrintGroupName Group name
PrintGroupName(p1) Group name of the specified graph*5

PrintRange Print range3

Range: G1 to G4

1 The parameter is the report channel number (it cannot be omitted).
2 The parameter is the comment number (it cannot be omitted).
3 The parameter is the graph number (it cannot be omitted). Excel templates can show down to 

seconds.
4 The item becomes a character string in PDF and printer output.
5 The parameter is the graph number (it cannot be omitted).

•	 Report	Data	Keywords(*)

*: These keywords cannot be used for the Custom Print.

Keyword Meaning Display Format
ReportDateTime Report creation/print date and time*6 Date and time
ReportDataDate Report creation date1 Date5

ReportDataTime Report creation time1 Time5

ReportDataDateTime Report creation date and time1 Date5

ReportDataDateTimeString Report creation date and time1 Character string
ReportDataElapsedTimeString4 Report data time out date and time
ReportDataStatus Report data status2

ReportDataSum Report data sum2 Number or character 
string3ReportDataInst Instantaneous report data value2

ReportDataAve Average report data value2

ReportDataMax Maximum report data value2

ReportDataMin Minimum report data value2

1 Write the parameters in this order: report type (cannot be omitted), report start date and time 
(can be omitted), report end date, time (can be omitted), start number (can be omitted), and end 
number (can be omitted).

2 Write the parameters in this order: report type (cannot be omitted), report channel number 
(cannot be omitted), report start date and time (can be omitted), report end date and time (can 
be omitted), start number (can be omitted), and end number (can be omitted).

3 The decimal point type (dot or comma) depends on whether the converted data is a value or 
character string. Whether the converted data is a value or character string depends on the 
format of the cell that the keyword is written in. When the cell format is numerical, the decimal 
point type is determined by the cell format. When the cell format is text, the decimal point type 
matches the format of the report data.

4 Valid only when the report type is Batch.
5 The item becomes a character string in PDF and printer output.
6 Write the parameters in this order: data reference (cannot be omitted), date type (cannot be 

omitted).
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•	 Report	Graph	Keywords
Keyword Meaning Display Format Example
ExtGraph Report graph1 Image $ExtGraph(G1)$

Range: G1 to G4

1 The parameter is the graph number (it cannot be omitted).

 Inserting a Graph
 To insert a graph in a report template for Excel report files, follow the procedure below.

 1. Insert a graph (image file) at the appropriate location in the created Excel template.
 2. Right-click the graph, and select Format Picture.
 3. From the menu on the left, select Alt Text.
 4. In the Title box under Alt Text, type the above key word (“$ExtGraph(G1)$”).

Right-click on the picture

•	 Special	Keywords
Keyword Meaning Display Format
Repeat Specifies the output location of the data that corresponds 

the report data keyword and the Index keyword (a 
special keyword).

The same as the 
corresponding keyword.

Copy Outputs all data that corresponds the report data 
keyword and the Index keyword (a special keyword). 
This keyword is valid for PDF and printer output.

The same as the 
corresponding keyword.

Index Outputs serial numbers from the value specified by 
“start” to the value specified by “end.”

Number

Appendix 1 Creating Report Templates
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•	 Parameters
Parameter Name Format Range Description Remarks
Report channel number Rxxx1 R01-R100 The software’s report 

channel
Report Kind Hour — Hourly report

Day — Daily report
Week — Weekly report
Month — Monthly report
Batch — Batch report
Custom — Daily custom
Free — For daily custom reports,

Computed results, such as 
sum values, of data in the 
file are appended to the file.
This piece of data is called 
“Free.”

Start date and time hh2 00 to 23 Specifies the start hour Used in hourly 
reports

dd3 01 to 31 Specifies the start day Used in daily 
reports

mm4 0 to 12000 Specify the start minute Used in batch 
reports

hh:mm5 hh: 00 to 23
mm: 00 to 59

Specifies the start hour:time Used in Daily 
custom reports

End date and time hh2 00 to 23 Specifies the end hour Used in hourly 
reports

dd3 01 to 31 Specifies the end day Used in daily 
reports

mm4 0 to 12000 Specify the end minute Used in batch 
reports

hh:mm5 hh: 00 to 23
mm: 00 to 59

Specifies the end 
hour:minute

Used in Daily 
custom reports

Start number xxx1 001 to 200 Specifies the start number Used in batch 
reportsEnd number xxx1 001 to 200 Specifies the end number

Data Reference Start — Report start reference
End — Report end reference

Date Type Year — Year
Month — Month
Day — Day
Hour — Hour
Minute — Minute
Second — Second
WeekOfMonthSun — Week No. of the month. 

Regard Sunday as the first 
day of a week.

WeekOfMonthMon — Week No. of the month. 
Regard Monday as the first 
day of a week.

WeekOfYearSun — Week No. of the year. 
Regard Sunday as the first 
day of a week.

WeekOfYearMon — Week No. of the year. 
Regard Monday as the first 
day of a week.

1 xxx is a number without a limitation on the number of digits
2 hh is a number without a limitation on the number of digits
3 dd is a number without a limitation on the number of digits
4 mm is a number without a limitation on the number of digits
5 Spaces are allowed before and after colons.
6 Start time and end time are relative to the record start time.
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Starting and Ending Dates and Times
Use the start date and time and end date and time to specify the parts of the report file’s 
report data that you will output to the file that you create with the template.
You can specify the starting and ending dates (for daily reports) or times (for hourly reports).

Report Kind Start Date and Time End Date and Time
Hour Start time (hour) End time (hour)
Day Start time (day) End time (day)
Batch Start time (minute) End time (minute)
Day custom Start time (hour:minute) End time (hour:minute)

Example when the report type is hourly and the report is created at 18:00.

     

18:00 19:00

Report
file 1

Report
file 2

Report
creation
time

$ReportDataSum(Hour,R001,20,22)$ $ReportDataSum(Hour,R001,16,19)$

20:00 21:00 22:00 16:00 17:00 18:00 19:00

Keyword: $ReportDataSum(Hour,R001,20,22)$
From the hourly data from 19:00:01 to 22:00:00, the report data (sums) of report channel 
R001 for 20:00, 21:00, and 22:00 is output.

Keyword: $ReportDataSum(Hour,R001,16,19)$
From the hourly data from 15:00:01 to 19:00:00, the report data (sums) of report channel 
R001 for 16:00, 17:00, and 18:00 is output. Because the report data for 19:00 is in another 
report file, it is not output.

Keyword: $ReportDataSum(Hour,R001)$
One file’s worth (18:00:01 to 18:00:00) of data from report channel R001 is output, starting 
from 19:00.
When you omit the start and end times for an hourly report, the data for the hour after the 
report creation time until the 24th hour is output. For daily reports, the data for the day after 
the report creation time until the end of the month is output.

Keyword: $ReportDataSum(Hour,R001,08)$
From the hourly data from 07:00:01 to 18:00:00, the report data (sums) of report channel 
R001 for 08:00 to 18:00 is output.

Appendix 1 Creating Report Templates
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Report Template Examples
System Keyword Examples
Intermixed Keyword and Text

File header: $FileHeader$

Date and time: $DateTime$
↓

File header: GX20

Date and time: 2012/12/01 12:00:00

Intermixed Multiple Keyword and Text

Device number: $Serial$ File Header: $FileHeader$

↓
Device number: ABCDEFG File Header: GX20

Report Data Keyword Examples
The following examples are for when the hourly report data for report channel R001 is 101, 
102, 103, 104, and 105 and the hourly report data for report channel R002 is 201, 202, 203, 
204, 205, and 206.

The $Repeat$ command applies to the closest keyword above the command in the same 
column.

$ReportDataInst(Hour,R001)$ 101
$Repeat$ 102
$Repeat$ 103
$Repeat$ → 104
$ReportDataInst(Hour,R002)$ 201
$Repeat$ 202
$Repeat$ 203
$Repeat$ 204
$Repeat$ 205

The $Repeat$ command applies to the keyword above it in the same column, even when 
that keyword is not directly above the command.

$ReportDataInst(Hour,R001)$ 101
$Unit(R001)$ °C
$Repeat$ 102
$Unit(R001)$ → °C
$Repeat$ $Unit(R001)$ 103 °C

You can mix system keywords, report data keywords, and text. If the data specified by a 
keyword does not exist, nothing is output.

$ReportDataInst(Hour,R001)$($Unit
(R001)$)

101 (°C)

$Repeat$ 102
$Repeat$ 103
$Repeat$($Unit(R001)$) → 104 (°C)
$Repeat$(°C) 105 (°C)
$Repeat$
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Keywords in merged cells are affected by the leftmost cells above them.

$ReportDataInst(Hour,R001)$ $ReportDataInst(Hour,R002)$
$Repeat$ $Repeat$

$Repeat$ $Repeat$
$Repeat$ $Repeat$
↓
101 201
102 202

203
103 204

When a keyword is written incorrectly or its formatting is wrong, the keyword will be output to 
the file as it is written.

$ReportDataInst(Hour,R)$ $ReportDataInst(Hour,R)$
→

$ReportDataInst(Hour,R002)$ 201
$Repeat$ $Repeat$
$Repeat$ 202
$Repeat$ 203
$Repeat$ 204

$ReportDataInst(Hour,R001)$
$ReportDataInst(Hour,R002)$

1 101
$ReportDataInst(Hour,R002)$

1 When there are multiple system keywords in the same cell, only the first keyword is valid.

Creating Report Templates for PDF Report Files and Printer Output
Report templates for PDF report files (*.tpl) are created using SMARTDAC+ Report 
Template Builder. Report Template Builder can be downloaded from the following URL for 
free.
www.smartdacplus.com/software/en/
In Report Template Builder, keywords, text, and images (JPG, PNG, BMP) are arranged in 
tables, graphs, and text components to create report templates.
Keywords specify the type of data that will be entered into a cell. Text are output as they are 
in reports.

Appendix 1  Creating Report Templates
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To insert a graph in a template, click the Graph for GA10 icon  and enter the 
keyword $ExtGraph(G1)$.

For the keywords that you can use, see Creating Report Templates for Report Files in 
Excel Format.
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Appendix 2 Modbus Device Definition File Example

A sample Modbus device definition file is provided in the following pages. The sample shows 
how the XML file should be structured.
When you create a Modbus device definition file, refer to the description of registers 
in the user’s manual of the Modbus device that you want to connect. You can also use 
the Modbus Device Definition File Creating Tool by downloading it from the YOKOGAWA 
website.
www.smartdacplus.com/software/en/

<?xml version="1.0" encoding="utf-8"?>
<ModbusDevice Type="A" PortNo="502" CommandDelay="0">
  <Options>
    <Option Name="remote" />
  </Options>
  <Registers>
    <Register Name="PVERROR1" FunctionCode="3" Address="42002" DataType="INT16"></Register>
    <Register Name="PV1" FunctionCode="3" Address="42003" DataType="INT16"></Register>
    <Register Name="CSP1" FunctionCode="3" Address="42004" DataType="INT16"></Register>
    <Register Name="OUT1" FunctionCode="3" Address="42005" DataType="INT16"></Register>
    <Register Name="HOUT1" FunctionCode="3" Address="42006" DataType="INT16"></Register>
    <Register Name="COUT1" FunctionCode="3" Address="42007" DataType="INT16"></Register>
    <Register Name="MOD1" FunctionCode="3" Address="42008" DataType="INT16"></Register>
    <Register Name="PID1" FunctionCode="3" Address="42009" DataType="INT16"></Register>
    <Register Name="CSPNO" FunctionCode="3" Address="42010" DataType="INT16"></Register>
    <Register Name="ALM1" FunctionCode="3" Address="42011" DataType="INT16"></Register>
    <Register Name="ALM2" FunctionCode="3" Address="42013" DataType="INT16"></Register>
    <Register Name="PVERROR2" FunctionCode="3" Address="42018" DataType="INT16"></Register>
    <Register Name="PV2" FunctionCode="3" Address="42019" DataType="INT16"></Register>
    <Register Name="CSP2" FunctionCode="3" Address="42020" DataType="INT16"></Register>
    <Register Name="OUT2" FunctionCode="3" Address="42021" DataType="INT16"></Register>
    <Register Name="HOUT2" FunctionCode="3" Address="42022" DataType="INT16"></Register>
    <Register Name="COUT2" FunctionCode="3" Address="42023" DataType="INT16"></Register>
    <Register Name="MOD2" FunctionCode="3" Address="42024" DataType="INT16"></Register>
    <Register Name="PID2" FunctionCode="3" Address="42025" DataType="INT16"></Register>
    <Register Name="A11" FunctionCode="3" Address="42104" DataType="INT16"></Register>
    <Register Name="A21" FunctionCode="3" Address="42105" DataType="INT16"></Register>
    <Register Name="A31" FunctionCode="3" Address="42106" DataType="INT16"></Register>
    <Register Name="A41" FunctionCode="3" Address="42107" DataType="INT16"></Register>
    <Register Name="A12" FunctionCode="3" Address="42154" DataType="INT16"></Register>
    <Register Name="A22" FunctionCode="3" Address="42155" DataType="INT16"></Register>
    <Register Name="A32" FunctionCode="3" Address="42156" DataType="INT16"></Register>
    <Register Name="A42" FunctionCode="3" Address="42157" DataType="INT16"></Register>
    <Register Name="AL11" FunctionCode="3" Address="42801" DataType="INT16"></Register>
    <Register Name="AL21" FunctionCode="3" Address="42805" DataType="INT16"></Register>
    <Register Name="AL31" FunctionCode="3" Address="42809" DataType="INT16"></Register>
    <Register Name="AL41" FunctionCode="3" Address="42813" DataType="INT16"></Register>
    <Register Name="AL12" FunctionCode="3" Address="43901" DataType="INT16"></Register>
    <Register Name="AL22" FunctionCode="3" Address="43905" DataType="INT16"></Register>
    <Register Name="AL32" FunctionCode="3" Address="43909" DataType="INT16"></Register>

Specify all the data to load from the device.

Match Type (Modbus device name) with the file name.

www.smartdacplus.com/software/en/
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PV1 channel settings

Decimal place

Maximum and minimum values

Unit 

PV1 basic information

    <Register Name="AL42" FunctionCode="3" Address="43913" DataType="INT16"></Register>
    <Register Name="BSL" FunctionCode="3" Address="45109" DataType="INT16"></Register>
    <Register Name="PUNI1" FunctionCode="3" Address="45201" DataType="INT16"></Register>
    <Register Name="PDP1" FunctionCode="3" Address="45202" DataType="INT16"></Register>
    <Register Name="PRH1" FunctionCode="3" Address="45203" DataType="INT16"></Register>
    <Register Name="PRL1" FunctionCode="3" Address="45204" DataType="INT16"></Register>
    <Register Name="PUNI2" FunctionCode="3" Address="45221" DataType="INT16"></Register>
    <Register Name="PDP2" FunctionCode="3" Address="45222" DataType="INT16"></Register>
    <Register Name="PRH2" FunctionCode="3" Address="45223" DataType="INT16"></Register>
    <Register Name="PRL2" FunctionCode="3" Address="45224" DataType="INT16"></Register>

    <Register Name="CTRLMODE" FunctionCode="3" Address="45001" DataType="INT16"></Register>
    <Register Name="CTRLTYPEL1" FunctionCode="3" Address="45003" DataType="INT16"></Register>
    <Register Name="CTRLTYPEL2" FunctionCode="3" Address="45004" DataType="INT16"></Register>
    <Register Name="AMR" FunctionCode="3" Address="42301" DataType="INT16"></Register>
    <Register Name="AMW" FunctionCode="6" Address="42301" DataType="INT16"></Register>
    <Register Name="CAMR" FunctionCode="3" Address="42303" DataType="INT16"></Register>
    <Register Name="CAMW" FunctionCode="6" Address="42303" DataType="INT16"></Register>
    <Register Name="RSR" FunctionCode="3" Address="42304" DataType="INT16"></Register>
    <Register Name="RSW" FunctionCode="6" Address="42304" DataType="INT16"></Register>
    <Register Name="LRL1R" FunctionCode="3" Address="42306" DataType="INT16"></Register>
    <Register Name="LRL1W" FunctionCode="6" Address="42306" DataType="INT16"></Register>
    <Register Name="LRL2R" FunctionCode="3" Address="42307" DataType="INT16"></Register>
    <Register Name="LRL2W" FunctionCode="6" Address="42307" DataType="INT16"></Register>
    <Register Name="ATL1R" FunctionCode="3" Address="42308" DataType="INT16"></Register>
    <Register Name="ATL1W" FunctionCode="6" Address="42308" DataType="INT16"></Register>
    <Register Name="ATL2R" FunctionCode="3" Address="42309" DataType="INT16"></Register>
    <Register Name="ATL2W" FunctionCode="6" Address="42309" DataType="INT16"></Register>
    <Register Name="SPNOR" FunctionCode="3" Address="42312" DataType="INT16"></Register>
    <Register Name="SPNOW" FunctionCode="6" Address="42312" DataType="INT16"></Register>
    <Register Name="MOUTL1R" FunctionCode="3" Address="42333" DataType="INT16"></Register>
    <Register Name="MOUTL1W" FunctionCode="6" Address="42333" DataType="INT16"></Register>
    <Register Name="MOUTCL1R" FunctionCode="3" Address="42334" DataType="INT16"></Register>
    <Register Name="MOUTCL1W" FunctionCode="6" Address="42334" DataType="INT16"></Register>
    <Register Name="MOUTL2R" FunctionCode="3" Address="42335" DataType="INT16"></Register>
    <Register Name="MOUTL2W" FunctionCode="6" Address="42335" DataType="INT16"></Register>
    <Register Name="MOUTCL2R" FunctionCode="3" Address="42336" DataType="INT16"></Register>
    <Register Name="MOUTCL2W" FunctionCode="6" Address="42336" DataType="INT16"></Register>

  </Registers>
  
  <Channels>
    <Channel Name="PV1">
      <Init>
        <DecimalPos Register="PDP1"></DecimalPos>
        <Min Register="PRL1"></Min>
        <Max Register="PRH1"></Max>
        <Unit Register="PUNI1" Trans="temperature"></Unit>
      </Init>

Appendix 2  Modbus Device Definition File Example 
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      <Value Register="PV1">
        <PlusOver Register="PVERROR1" Mask="0x0010"></PlusOver>
        <MinusOver Register="PVERROR1" Mask="0x0020"></MinusOver>
        <DataError Register="PVERROR1" Mask="0x4000"></DataError>
        <Burnout>
          <Type Register="BSL"></Type>
          <Value Register="PVERROR1" Mask="0x0001"></Value>
        </Burnout>
      </Value>
      <Alarms>
        <Alarm>
          <Type Register="AL11" Trans="alarmTypesPV"></Type>
          <Value Register="ALM1" Mask="0x0001"></Value>
          <SetValue Register="A11"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL21" Trans="alarmTypesPV"></Type>
          <Value Register="ALM1" Mask="0x0002"></Value>
          <SetValue Register="A21"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL31" Trans="alarmTypesPV"></Type>
          <Value Register="ALM1" Mask="0x0004"></Value>
          <SetValue Register="A31"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL41" Trans="alarmTypesPV"></Type>
          <Value Register="ALM1" Mask="0x0010"></Value>
          <SetValue Register="A41"></SetValue>
        </Alarm>
      </Alarms>
    </Channel>
    <Channel Name="SP1">
      <Init>
        <DecimalPos Register="PDP1"></DecimalPos>
        <Min Register="PRL1"></Min>
        <Max Register="PRH1"></Max>
        <Unit Register="PUNI1" Trans="temperature"></Unit>
      </Init>
      <Value Register="CSP1"> </Value>
      <Alarms>
        <Alarm>
          <Type Register="AL11" Trans="alarmTypesSP"></Type>
          <Value Register="ALM1" Mask="0x0001"></Value>
          <SetValue Register="A11"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL21" Trans="alarmTypesSP"></Type>
          <Value Register="ALM1" Mask="0x0002"></Value>

PV1 values
Error 1

+over, -over

Burnout 1. Masked because the parameter 
contains multiple pieces of 
information.

PV1 alarm information

First alarm (up to four)

Second alarm

Third alarm

Fourth alarm

Alarm type

Alarm value

Alarm setting

SP1 channel settings

Appendix 2  Modbus Device Definition File Example 
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          <SetValue Register="A21"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL31" Trans="alarmTypesSP"></Type>
          <Value Register="ALM1" Mask="0x0004"></Value>
          <SetValue Register="A31"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL41" Trans="alarmTypesSP"></Type>
          <Value Register="ALM1" Mask="0x0010"></Value>
          <SetValue Register="A41"></SetValue>
        </Alarm>
      </Alarms>
    </Channel>
    <Channel Name="OUT1" DecimalPos="1" Min="0" Max="100" Unit="%">
      <Value Register="OUT1"></Value>
      <Alarms>
        <Alarm>
          <Type Register="AL11" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM1" Mask="0x0001"></Value>
          <SetValue Register="A11"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL21" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM1" Mask="0x0002"></Value>
          <SetValue Register="A21"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL31" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM1" Mask="0x0004"></Value>
          <SetValue Register="A31"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL41" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM1" Mask="0x0010"></Value>
          <SetValue Register="A41"></SetValue>
        </Alarm>
      </Alarms>
    </Channel>
    <Channel Name="HOUT1" DecimalPos="1" Min="0" Max="100" Unit="%">
      <Value Register="HOUT1"></Value>
      <Alarms>
        <Alarm>
          <Type Register="AL11" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM1" Mask="0x0001"></Value>
          <SetValue Register="A11"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL21" Trans="alarmTypesOUT"></Type>

Appendix 2  Modbus Device Definition File Example 
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          <Value Register="ALM1" Mask="0x0002"></Value>
          <SetValue Register="A21"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL31" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM1" Mask="0x0004"></Value>
          <SetValue Register="A31"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL41" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM1" Mask="0x0010"></Value>
          <SetValue Register="A41"></SetValue>
        </Alarm>
      </Alarms>
    </Channel>
    <Channel Name="COUT1" DecimalPos="1" Min="0" Max="100" Unit="%">
      <Value Register="COUT1"></Value>
      <Alarms>
        <Alarm>
          <Type Register="AL11" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM1" Mask="0x0001"></Value>
          <SetValue Register="A11"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL21" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM1" Mask="0x0002"></Value>
          <SetValue Register="A21"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL31" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM1" Mask="0x0004"></Value>
          <SetValue Register="A31"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL41" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM1" Mask="0x0010"></Value>
          <SetValue Register="A41"></SetValue>
        </Alarm>
      </Alarms>
    </Channel>
    <Channel Name="PIDNO1" DecimalPos="0" Min="0" Max="8">
      <Value Register="PID1"></Value>
    </Channel>
    <Channel Name="PV2">
      <Init>
        <DecimalPos Register="PDP2"></DecimalPos>
        <Min Register="PRL2"></Min>
        <Max Register="PRH2"></Max>
        <Unit Register="PUNI2" Trans="temperature"></Unit>
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      </Init>
      <Value Register="PV2">
        <PlusOver Register="PVERROR2" Mask="0x0010"></PlusOver>
        <MinusOver Register="PVERROR2" Mask="0x0020"></MinusOver>
        <DataError Register="PVERROR2" Mask="0x4000"></DataError>
        <Burnout>
          <Type Register="BSL"></Type>
          <Value Register="PVERROR2" Mask="0x0001"></Value>
        </Burnout>
      </Value>
      <Alarms>
        <Alarm>
          <Type Register="AL12" Trans="alarmTypesPV"></Type>
          <Value Register="ALM2" Mask="0x0001"></Value>
          <SetValue Register="A12"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL22" Trans="alarmTypesPV"></Type>
          <Value Register="ALM2" Mask="0x0002"></Value>
          <SetValue Register="A22"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL32" Trans="alarmTypesPV"></Type>
          <Value Register="ALM2" Mask="0x0004"></Value>
          <SetValue Register="A32"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL42" Trans="alarmTypesPV"></Type>
          <Value Register="ALM2" Mask="0x0010"></Value>
          <SetValue Register="A42"></SetValue>
        </Alarm>
      </Alarms>
    </Channel>
    <Channel Name="SP2">
      <Init>
        <DecimalPos Register="PDP2"></DecimalPos>
        <Min Register="PRL2"></Min>
        <Max Register="PRH2"></Max>
        <Unit Register="PUNI2" Trans="temperature"></Unit>
      </Init>
      <Value Register="CSP2"> </Value>
      <Alarms>
        <Alarm>
          <Type Register="AL12" Trans="alarmTypesSP"></Type>
          <Value Register="ALM2" Mask="0x0001"></Value>
          <SetValue Register="A12"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL22" Trans="alarmTypesSP"></Type>
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          <Value Register="ALM2" Mask="0x0002"></Value>
          <SetValue Register="A22"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL32" Trans="alarmTypesSP"></Type>
          <Value Register="ALM2" Mask="0x0004"></Value>
          <SetValue Register="A32"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL42" Trans="alarmTypesSP"></Type>
          <Value Register="ALM2" Mask="0x0010"></Value>
          <SetValue Register="A42"></SetValue>
        </Alarm>
      </Alarms>
    </Channel>
    <Channel Name="OUT2" DecimalPos="1" Min="0" Max="100" Unit="%">
      <Value Register="OUT2"></Value>
      <Alarms>
        <Alarm>
          <Type Register="AL12" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM2" Mask="0x0001"></Value>
          <SetValue Register="A12"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL22" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM2" Mask="0x0002"></Value>
          <SetValue Register="A22"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL32" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM2" Mask="0x0004"></Value>
          <SetValue Register="A32"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL42" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM2" Mask="0x0010"></Value>
          <SetValue Register="A42"></SetValue>
        </Alarm>
      </Alarms>
    </Channel>
    <Channel Name="HOUT2" DecimalPos="1" Min="0" Max="100" Unit="%">
      <Value Register="HOUT2"></Value>
      <Alarms>
        <Alarm>
          <Type Register="AL12" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM2" Mask="0x0001"></Value>
          <SetValue Register="A12"></SetValue>
        </Alarm>
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        <Alarm>
          <Type Register="AL22" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM2" Mask="0x0002"></Value>
          <SetValue Register="A22"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL32" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM2" Mask="0x0004"></Value>
          <SetValue Register="A32"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL42" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM2" Mask="0x0010"></Value>
          <SetValue Register="A42"></SetValue>
        </Alarm>
      </Alarms>
    </Channel>
    <Channel Name="COUT2" DecimalPos="1" Min="0" Max="100" Unit="%">
      <Value Register="COUT2"></Value>
      <Alarms>
        <Alarm>
          <Type Register="AL12" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM2" Mask="0x0001"></Value>
          <SetValue Register="A12"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL22" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM2" Mask="0x0002"></Value>
          <SetValue Register="A22"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL32" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM2" Mask="0x0004"></Value>
          <SetValue Register="A32"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL42" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM2" Mask="0x0010"></Value>
          <SetValue Register="A42"></SetValue>
        </Alarm>
      </Alarms>
    </Channel>
    <Channel Name="PIDNO2" DecimalPos="0" Min="0" Max="8">
      <Value Register="PID2"></Value>
    </Channel>
    <Channel Name="SPNO" DecimalPos="0" Min="1" Max="8">
      <Value Register="CSPNO"></Value>
    </Channel>
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    <Channel Name="AUTO/MAN" DecimalPos="0" Min="0" Max="1">
      <Value Register="MOD1" Mask="0x0001"></Value>
    </Channel>
    <Channel Name="AUTO/MAN/CAS" DecimalPos="0" Min="0" Max="2">
      <Value Register="MOD1" Mask="0x0070" Trans="AMCValue"></Value>
    </Channel>
    <Channel Name="LOCAL/REMOTE1" DecimalPos="0" Min="0" Max="1">
      <Value Register="MOD1" Mask="0x0002"></Value>
    </Channel>
    <Channel Name="LOCAL/REMOTE2" DecimalPos="0" Min="0" Max="1">
      <Value Register="MOD2" Mask="0x0002"></Value>
    </Channel>
    <Channel Name="RUN/STOP" DecimalPos="0" Min="0" Max="1">
      <Value Register="MOD1" Mask="0x0004"></Value>
    </Channel>
    <Channel Name="AutoTuning1" DecimalPos="0" Min="0" Max="1">
      <Value Register="MOD1" Mask="0x4000"></Value>
    </Channel>
    <Channel Name="AutoTuning2" DecimalPos="0" Min="0" Max="1">
      <Value Register="MOD2" Mask="0x4000"></Value>
    </Channel>
    <Channel Name="CTRLMODE" DecimalPos="0" Min="0" Max="100">
      <Value Register="CTRLMODE">
      </Value>
    </Channel> 
   <Channel Name="CTRLTYPE1" DecimalPos="0" Min="0" Max="100">
      <Value Register="CTRLTYPEL1">
      </Value>
    </Channel> 
   <Channel Name="CTRLTYPE2" DecimalPos="0" Min="0" Max="100">
      <Value Register="CTRLTYPEL2">
      </Value>
    </Channel> 
    <Channel Name="C_AUTO/MAN" DecimalPos="0" Min="0" Max="1">
      <Value Register="AMR">
 <Write Register="AMW">
 </Write>
 </Value>
    </Channel>
    <Channel Name="C_AUTO/MAN/CAS" DecimalPos="0" Min="0" Max="2">
      <Value Register="CAMR">
 <Write Register="CAMW">
 </Write>
     </Value>
    </Channel>
    <Channel Name="C_RUN/STOP" DecimalPos="0" Min="0" Max="1">
      <Value Register="RSR">
 <Write Register="RSW">
 </Write>
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      </Value>
    </Channel>
    <Channel Name="C_LOCAL/REMOTE1" DecimalPos="0" Min="0" Max="1">
      <Value Register="LRL1R">
 <Write Register="LRL1W">
 </Write>
      </Value>
    </Channel>
    <Channel Name="C_LOCAL/REMOTE2" DecimalPos="0" Min="0" Max="1">
      <Value Register="LRL2R">
 <Write Register="LRL2W">
 </Write>
      </Value>
    </Channel>
    <Channel Name="C_AUTOTUNING1" DecimalPos="0" Min="0" Max="9">
      <Value Register="ATL1R">
 <Write Register="ATL1W">
 </Write>
      </Value>
    </Channel>
    <Channel Name="C_AUTOTUNING2" DecimalPos="0" Min="0" Max="9">
      <Value Register="ATL2R">
 <Write Register="ATL2W">
 </Write>
      </Value>
    </Channel>
    <Channel Name="C_SPNO" DecimalPos="0" Min="1" Max="8">
      <Value Register="SPNOR">
 <Write Register="SPNOW">
 </Write>
      </Value>
    </Channel>
    <Channel Name="C_MOUT1" DecimalPos="1" Min="0" Max="100" Unit="%">
      <Value Register="MOUTL1R">
 <Write Register="MOUTL1W">
 </Write>
      </Value>
      <Alarms>
        <Alarm>
          <Type Register="AL11" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM1" Mask="0x0001"></Value>
          <SetValue Register="A11"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL21" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM1" Mask="0x0002"></Value>
          <SetValue Register="A21"></SetValue>
        </Alarm>
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        <Alarm>
          <Type Register="AL31" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM1" Mask="0x0004"></Value>
          <SetValue Register="A31"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL41" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM1" Mask="0x0010"></Value>
          <SetValue Register="A41"></SetValue>
        </Alarm>
      </Alarms>
    </Channel>
    <Channel Name="C_MCOUT1" DecimalPos="1" Min="0" Max="100" Unit="%">
      <Value Register="MOUTCL1R">
 <Write Register="MOUTCL1W">
 </Write>
      </Value>
      <Alarms>
        <Alarm>
          <Type Register="AL11" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM1" Mask="0x0001"></Value>
          <SetValue Register="A11"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL21" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM1" Mask="0x0002"></Value>
          <SetValue Register="A21"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL31" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM1" Mask="0x0004"></Value>
          <SetValue Register="A31"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL41" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM1" Mask="0x0010"></Value>
          <SetValue Register="A41"></SetValue>
        </Alarm>
      </Alarms>
     </Channel>
    <Channel Name="C_MOUT2" DecimalPos="1" Min="0" Max="100" Unit="%">
      <Value Register="MOUTL2R">
 <Write Register="MOUTL2W">
 </Write>
      </Value>
      <Alarms>
        <Alarm>
          <Type Register="AL12" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM2" Mask="0x0001"></Value>
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          <SetValue Register="A12"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL22" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM2" Mask="0x0002"></Value>
          <SetValue Register="A22"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL32" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM2" Mask="0x0004"></Value>
          <SetValue Register="A32"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL42" Trans="alarmTypesOUT"></Type>
          <Value Register="ALM2" Mask="0x0010"></Value>
          <SetValue Register="A42"></SetValue>
        </Alarm>
      </Alarms>
     </Channel>
    <Channel Name="C_MCOUT2" DecimalPos="1" Min="0" Max="100" Unit="%">
      <Value Register="MOUTCL2R">
 <Write Register="MOUTCL2W">
 </Write>
      </Value>
      <Alarms>
        <Alarm>
          <Type Register="AL12" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM2" Mask="0x0001"></Value>
          <SetValue Register="A12"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL22" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM2" Mask="0x0002"></Value>
          <SetValue Register="A22"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL32" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM2" Mask="0x0004"></Value>
          <SetValue Register="A32"></SetValue>
        </Alarm>
        <Alarm>
          <Type Register="AL42" Trans="alarmTypesCOUT"></Type>
          <Value Register="ALM2" Mask="0x0010"></Value>
          <SetValue Register="A42"></SetValue>
        </Alarm>
      </Alarms>
    </Channel> 
 </Channels>
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  <TransTables>
    <Table Name="AMCValue" ToDataType="Int">
      <Value From="0x0020" To="0"></Value>
      <Value From="0x0040" To="1"></Value>
      <Value From="0x0010" To="2"></Value>
    </Table>
    <Table Name="temperature" ToDataType="String">
      <Value From="0" To=" "></Value>
      <Value From="1" To="°C"></Value>
      <Value From="2" To=" "></Value>
      <Value From="3" To=" "></Value>
      <Value From="4" To=" "></Value>
      <Value From="5" To="°F"></Value>
    </Table>
    <Table Name="alarmTypesPV" ToDataType="String">
      <Value From="0" To="OFF"></Value>
      <Value From="1" To="H"></Value>
      <Value From="2" To="L"></Value>
      <Value From="3" To="ETC"></Value>
      <Value From="4" To="ETC"></Value>
      <Value From="5" To="ETC"></Value>
      <Value From="6" To="ETC"></Value>
      <Value From="7" To="ETC"></Value>
      <Value From="8" To="ETC"></Value>
      <Value From="9" To="ETC"></Value>
      <Value From="10" To="ETC"></Value>
      <Value From="11" To="ETC"></Value>
      <Value From="12" To="ETC"></Value>
      <Value From="13" To="ETC"></Value>
      <Value From="14" To="ETC"></Value>
      <Value From="15" To="ETC"></Value>
      <Value From="16" To="ETC"></Value>
      <Value From="17" To="ETC"></Value>
      <Value From="18" To="ETC"></Value>
      <Value From="19" To="ETC"></Value>
      <Value From="20" To="ETC"></Value>
      <Value From="21" To="ETC"></Value>
      <Value From="22" To="ETC"></Value>
      <Value From="23" To="ETC"></Value>
      <Value From="24" To="ETC"></Value>
      <Value From="25" To="ETC"></Value>
      <Value From="26" To="ETC"></Value>
      <Value From="27" To="ETC"></Value>
      <Value From="28" To="ETC"></Value>
      <Value From="29" To="ETC"></Value>
      <Value From="30" To="ETC"></Value>
      <Value From="31" To="ETC"></Value>
    </Table>
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    <Table Name="alarmTypesSP" ToDataType="String">
      <Value From="3" To="H"></Value>
      <Value From="4" To="L"></Value>
      <Value From="9" To="H"></Value>
      <Value From="10" To="L"></Value>
      <Value From="11" To="ETC"></Value>
      <Value From="12" To="ETC"></Value>
      <Value From="13" To="ETC"></Value>
      <Value From="14" To="ETC"></Value>
    </Table>
   <Table Name="alarmTypesOUT" ToDataType="String">
      <Value From="15" To="H"></Value>
      <Value From="16" To="L"></Value>
    </Table>
    <Table Name="alarmTypesCOUT" ToDataType="String">
      <Value From="17" To="H"></Value>
      <Value From="18" To="L"></Value>
    </Table>
  </TransTables>
</ModbusDevice>[EOF]

Appendix 2  Modbus Device Definition File Example 



App-24 IM 04L51B01-01EN

Appendix 3 GA10 Storage Data Size

The following table shows a guideline of the GA10’s record file sizes.
Note that using the report/print function (/RP option) to perform printing will consume a free 
hard disk space twice the total file size shown in the following table.

Calculation of Each Block Size in Files
Block Size (Byte)
Common 2568
Group information 24 + (208 + 216 x the number of channels assigned to each display group) x 

the number of groups
Channel information 24 + 408 × the number of channels
Message information 72 + 200 × the number of messages
Recorded data 424 + 16 × the number of channels + (16 + data size × the number of 

channels) × the number of data points.

•	 Substitute the following for the “data size” and “number of data points” of recorded data.
 Data size: Up to 6 bytes
 Number of data points: Recording time/recording interval.
•	 Use the calculated file size as a rough guide.

Calculation Example
The file size will be calculated for 500 channels, 1 s recording interval, 10 display groups, 50 
channels which are assigned to each display group, 10 messages, and 1 hour recording.

Block Size (Byte)
Common 2568
Group information 24 + (208 + 216 x 50) x 10 = 110104
Channel information 24 + 408 x 500 = 204024
Message information 72 + 200 × 10 (the number of messages) = 2072
Recorded data 424 + 16 x 500 + (16 + 6 x 500) x 3600 = 10866024

File sizes = Common + Group information + Channel information + Message information + 
Recorded data = 11184792 bytes
11184792 (byte) /1024/1024 =10.66665 (MB) = Approximately 11 MB. 

Size of the file created will be about 11 MB. Using the report/print function will 
consume about 21 MB of hard disk space.
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